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1. Introduction 

1.1. What is Adlib? 

 

 
 

 
 
 

 
 
 

 
 
 
 
Adlib is the brand name under which Axiell ALM Netherlands produces 
computer programs with which you are able to manage large quanti-
ties of information in a structured manner. 

There is a difference between the Adlib software (programs) and the 
applications. The software contains all code that deals with reading 

and writing in databases, and all accompanying functionality, and is 
executed in files with the extension .exe and/or .dll (and some periph-
eral functionality in bin files). This software has been designed espe-
cially for the management of data from libraries, museums, archives 
and similar institutions. 

The Adlib applications consist of databases and user interfaces (tab 
sheets with fields, for instance) – really only a collection of data – of 
which the software creates a usable program.  
This structure makes it possible for you to install new software regu-
larly, which contains new functionality, with nothing being changed in 
your application (which you may have customized yourself). That is 

why your software can be upgraded regularly to a new version num-

ber (e.g. 7.0) when you install a new release, whilst your application 
version always remains the same (e.g. Museum 4.2). 
 
Adlib is structured much like a card tray, with related data (e.g. from 
a magazine) being stored together. In Adlib however, the equivalents 
of cards are called records. A collection of records is referred to as a 

database rather than a card tray, and a subset (partial collection) of a 
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database a dataset. In an application you can fill or edit such a data-

base or dataset.  

Data is entered and per subject presented on forms or tab sheets 
(screens), but is part of one and the same record. 
Indexes are used so that data can be retrieved as quickly as possible; 
indexes are alphabetical or numerical lists of terms with a link to the 
record in which such a term occurs. You can search and sort, display, 
print and/or store the results in different ways. 

 
Adlib has an exceptionally flexible structure. With Adlib De-
signer, the system can easily be adapted to meet customers’ 
wishes and requirements. For example, customers can choose 
what data is to be stored, and how the data is to be displayed. 

You can also choose for which data indexes are to be made, 
and in what way these indexes are to be made accessible. (For 

Designer, separate documentation is available in the form of 
online Help.) 

 
When you buy Adlib software, you’ll also get one or more applications, 
dependent on your licence. An application is sometimes subdivided 
into various modules, each of which represents a separate aspect of 
the activities in your library, museum or archive.  

Adlib Museum for example, is sold as a standardized application. Each 
application minimally contains a module to register objects from the 
collection in and to retrieve them again. Extra modules might be 
added, for instance to manage books or periodicals, or to be able to 

search the collection via the internet. 
And for Adlib Library there is a module for serials management, and a 

module that visitors to the library can use to search the catalogue.  
These and similar modules are extra, and have to be purchased sepa-
rately to the catalogue or collection module.  

1.2. About this user guide 

The manual before you focuses on the functionality of the Adlib soft-
ware that is mainly concentrated in the adlwin.exe file. It’s this soft-
ware that is the basis of your Library, Museum, Serials, Acquisitions, 

Archive and/or Loans Management application. The functionality in all 

these applications is the same and therefore one user guide is suffi-
cient. 
 

For some application-specific aspects of Adlib Library, Adlib 
Museum and Adlib Archive, see the appendices at the back of 
this user guide. For specific aspects of the other applications 

and modules, see the relevant application or module guides, if 
available. 
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So, in this user guide you will find examples from all the above men-

tioned applications to illustrate the software functionality, but in your 
application based on adlwin.exe you can find that same functionality 
too; databases and tab sheets might be different, but not what you 
can do with them. 
 
Moreover, you’ll find an introductory paragraph in a blue box at the 

beginning of most chapters, summarizing the relevant chapter with 
references to paragraphs containing more information. You can use 
these introductory paragraphs to quickly obtain an overview of the 
most relevant functionality in Adlib, or to navigate through the manual 
more easily. If a page number or paragraph number is mentioned in 

the text, and you are reading this manual from the computer screen, 
then you may Ctrl+click that number to jump to the relevant page or 

paragraph immediately. 

 

 
 
In this user guide you’ll also find grey boxes containing technical 
information or warnings: the technical information is meant mainly for 

experienced users and application managers, and is usually not re-
quired for regular work in Adlib.  

 

 
 
To distinguish between descriptive text and text that you see on 
screen, different typefaces have been used.  

 
• Text that is displayed on screen and used in menu titles and on 

buttons is in italic type, e.g.: 

Full catalogue 
Combine 
Search 
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• Text that you type in yourself is printed in monospace type, like 

that produced with a typewriter, e.g.: 
You typed this yourself... 

 

• Keys on your keyboard are indicated with a narrow, bold font, 
corresponding with what is printed on the keyboard, e.g.: 
Enter 

Page Down 

F1 (Help) 

Sometimes, you have to press two keys. This is indicated by a 
plus character (or hyphen) between the two key names. In this 
case, you should press the first key and then the second key, 
keeping the first key pressed down, e.g.:  
Ctrl+C 

 

Remarks and warnings are printed in a frame like this, or just as an 
indented paragraph. 

The way screen shots in this manual are displayed might differ from 
the display on your own monitor, for instance being dependent upon 
your Windows version and your monitor screen resolution. 
Moreover, if you run Adlib 7 or higher under Windows XP, Windows 
Vista (older than SP2), Windows Server 2003 or Windows Server 2008 
(older than SP2), you’ll still see the old menus and toolbar, instead of 
the ribbon. Only Windows Vista SP2, Windows Server 2008 SP2 and all 

newer Windows versions, like Windows 7, display the ribbon. This 

manual only refers to the ribbon, which might be confusing if you’re 
using an old Windows version: in that case it is probably best to use 
the Adlib 6.6.0 manual and have the release notes of higher versions 
on the side for information about new functionality. 

1.3. Important for Adlib Lite users 

Adlib Lite is the free version of Adlib Museum or Adlib Library and is 

meant for a single user. It cannot be used in conjunction with a Mi-
crosoft SQL Server or Oracle database. Because it is a free version, 
some limitations apply. For example, only the following databases are 
available to you in Adlib Museum Lite: 

 
• Objects (maximum of 5,000 records) 

• Documentation (maximum of 5,000 records) 

• Visual documentation 

• Persons and Institutions 

• Thesaurus 

• Currencies 
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The available databases in Adlib Library Lite are: 

 

• Full catalogue, consisting of the datasets Books, Audio-visual 

materials, Articles, Serials and Resources (per dataset up to a 

maximum of 5,000 records) 

• Thesaurus 

• Persons and Institutions 

• Series 

• Visual documentation 

Adlib Lite offers a selection of the functions contained in a full version 
of Adlib. Frequently used features like repeatable fields, validation, 
long text fields, Boolean searches, predefined output formats in the 

Print wizard and help texts are obviously present. Please note that 
printing to Word templates is only possible if MS Word has been in-
stalled on your computer, and has been restricted to 4 predefined 

templates. 
The following list shows the features which are only present in a full 
version of Adlib: 
 
• advanced search using the Adlib query language; 

• search by form (active in Library Lite though); 

• searching in multi-field indexes; 

• persistent storage of result sets and queries (in so-called pointer 

files); 

• copying records; 

• multilinguality; 

• derival of records from other data sources (active in Library Lite 

though); 

• import of ASCII files in a single text field; 

• RTF fields for laid out text entry; 

• the Adlib clipboard for copying fields; 

• bulk search-and-replace in records; 

• Windows Image Acquisition; 

• spelling checker; 

• printing interactively with the Print Wizard; 

• printing to your custom Word-templates; 

• printing of linked images, via the Media Viewer; 

• use of an external thesaurus to validate your data entry; 

• the File > Device Management menu; 

• viewing the edit history of a field; 

• searching the record hierarchy (via the Hierarchy browser); 
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• locking a field; 

• SQL and Oracle support. 

Note that the list above is only an indication and may not be com-
plete. The list should not be regarded as a definitive product descrip-

tion. 
This user manual describes the functionality of the full versions of 
Adlib. However, if you’re an Adlib Lite user you can very well use this 
manual too. Please just keep in mind what the limitations of Adlib Lite 
are and skip the matching chapters or paragraphs. All other function-
ality applies to both paid and free Adlib versions. 
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2. Starting an Adlib application 

Abstract 

After installation, you can start an Adlib application simply via the 
shortcut on the Windows desktop or via the Windows Start menu (if 
present), underneath All programs.   

See the Technical information box on page 8 and also the Installing 
Museum, Library and Archive reference guide for information about 
creating or changing shortcuts. 

 
Provided the Adlib software and the application have been correctly 
installed, you can start Adlib from Windows. The system administrator 
will probably have created shortcuts on your desktop that you can 
double-click to start the application.  

 

Or you’ll find several Adlib icons in the Programs group of the Win-
dows Start menu (not present in Windows 8); click the desired icon 
once, to start the relevant application. If you have questions about 

this, please consult your system administrator.  
After start-up the Adlib logo is displayed briefly, after which you enter 

Step 1 of the Search wizard directly (see Figure 3.2). Dependent on 
the application, this step offers several options.  
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Technical information: shortcuts, folders and files 

If there are several Adlib applications installed on the same comput-

er, they will each have their own application directory. The directory 
in which Adlib is started therefore determines which application is 
started. So a shortcut (desktop icon) to start an application points 
explicitly to a specific folder. Click a shortcut with the right-hand 
mouse button and choose the Properties option in the pop-up menu. 
On the Shortcut tab in the entry field Start in, the folder in which the 

application resides has been set, for instance: C:\Program Files\Adlib 
Software\museum basis for a Museum Basis application. (In the entry 
field Target however, the path to the executable file of the Adlib 

software is set.) On your own system the main directory can have a 
different name, dependent on the choices that were made during 
installation. 

The Adlib programs consist of different files that have different func-

tions. Especially relevant is the distinction between executable files 
(with the .exe extension) that take care of accessing a database, and 
application files in which, amongst others, the user interface and the 
screens have been defined. The executable file that starts Adlib (for 
instance adlwin.exe) is used for different applications (e.g. for Adlib 
Library, Adlib Serials, and Adlib Loans management). Each applica-
tion is installed in its own folder. (See your Adlib installation guide for 

an overview of these folders.) 

The software (executable files) and the applications have their own 
version number; software and applications are developed inde-
pendently from each other. When you buy an Adlib system, you’ll get 
software and applications; the applications you can change yourself, 
so Adlib does not provide you with upgrades for these, because 

otherwise all the alterations you made would be lost. Typical version 
numbers for the applications are 3.4 or 4.2. 
The executable files are regularly revised and improved by Adlib. If 
you have a maintenance contract, you can download a new version of 
the executables from the Adlib web site, whenever one becomes 
available. On installation of such an upgrade, the new executables 
replace the old executable files; you get improved functionality whilst 

your applications remain unchanged. (So you never have to uninstall 
Adlib!) Typical version numbers for the executables are 6.0, 6.6.0 
and 7.2. 
Both version numbers appear in the title bar of the application win-
dow.  
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If a shortcut is not associated with a directory, and you double-click 

it, then Windows opens the Select a parameter file window. 
Look for the folder in which the application is stored, and in that 
folder choose the Adlib parameter file Adlib.pbk and click Open; the 

application will start, but the shortcut remains unchanged. Use the 
Properties dialog for the shortcut and the entry field Start in to pro-
vide a default folder for this shortcut. (See your Adlib installation 
guide for more information on how to create shortcuts.) 
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3. Basic tasks 

Abstract 

After starting an Adlib application you may have to log in first (see 
paragraph 3.1); this depends on the security policy of your system 
administrator. By default, Adlib will then open the Search wizard in 

which you must always first select the data source in which you’d like 
to work. Subsequently you may create new records or follow the 
consecutive steps in the Search wizard (3.2) to search for existing 
records. The four steps for searching are as follows: 

1. Choose the data source (a database or dataset) which you would 
like to search. 

2. Select the access point for your search: with an access point you 

search an index on a certain field. Indexes provide fast search re-
sults. 

3. Enter the entire or partial search key(s). 

4. If in the searched index multiple terms satisfy your search com-
mand, then now select the index term (or choose all found terms) 
to retrieve records for. 

Usually, the search result is a list of records in brief display. Double-

click a record to present it in detailed display. The data of the record 
will be displayed on several screen tabs. 

With the following buttons you can page through the records of a 
search result (3.3): 

 

Using the following buttons you can go back to the previous search 
step, respectively go back to the first step of the Search wizard to 

start a new search: 

 

If you have the appropriate access rights, you can edit, save or 
remove a selected or opened record (3.4): 
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Also, you can create a new record and fill it with data, from almost 

anywhere in Adlib during searching or viewing of records, after 
choosing a data source in the first step of the Search wizard that is: 

 

If the button is greyed out, it is currently not possible to create new 

records. A possible reason might be that you are working in the full 
catalogue: then first choose a specific dataset in that catalogue and 
try again. 

3.1. Starting and logging in 

Start an Adlib application by double-clicking the Adlib icon (shortcut) 
on your desktop, for example. Every Adlib application or module has 
its own shortcut. 
 

 
 

Or open the Windows Start menu, go to Programs  Adlib software 
and choose the application you want to start, for instance Adlib Li-
brary. By the way, it’s quite conceivable that your Adlib applications 
are located in another menu. 
 

 

Figure 3.1: You may have to log in first. 
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Adlib may open with a login window. That depends on whether your 

system administrator has set this for Adlib users. If this window ap-

pears, you must enter your user name and password, and possibly a 
(Active Directory) domain. Ask your system administrator what to 
enter exactly. No access will be granted to the application until you fill 
in the correct information. 

3.2. Searching with the Search wizard 

 

Figure 3.2: The Adlib Library opening screen. 

When you work with Adlib, you will usually go through a number of 

steps in a fixed sequence. Simply searching for data, for instance, 
goes as follows: 

1. By default, Adlib will open with Step 1 of the Search wizard (see 
Figure 3.2). Step 1 of the Search wizard is also called the ‘data-
base menu’. In the Step 1 you’ll see a list of data sources (refer-
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ences to databases and datasets, for searching and entry of rec-

ords) and procedures (like immediate print tasks), available in this 

application or module. Click the data source in which you want to 
start working. Note that only in undivided data sources (like Visual 
documentation) and sub data sources (like Books) you’ll be able to 
enter new records or edit existing records; so in data sources like 
Library catalogue, existing records from the underlying sub data 
sources can only be viewed. In the Search wizard, click Next to 

proceed to Step 2.  

2. In the Search wizard you specify which data you are looking for, 
step by step. In the Description field you’ll find some help. In Step 
2, a new list will appear, the so-called ‘access points menu’, from 
which you can select an access point on which to continue search-

ing; double-click an access point, or select it and then click the 
Next button or press Enter.  

 

Figure 3.3: Each access point denotes an index in which you can search 

quickly. 
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(You can also use the arrow keys, or repeatedly type the first let-

ter of the desired access point until the right one is selected.) Each 
access point is associated with an index in which Adlib can search 
very quickly. 

3. When you have selected an index, then in the next window you 
can type in what you want to search for: the search key. For 
searching, it suffices to type the first few letters of the index key. 
 

 
 

4. If an index contains more than one term beginning with the char-
acters you entered, all these terms will be displayed in the Search 
results list. (To some indexes this does not apply, like the one for 

Title.) Choose one and click Show, or search further on all keys by 
clicking the All keys button. For the time being, you may ignore 
the Include narrowers checkbox.  
This step will, of course, be skipped if only one term matches your 
search criterion. 

 

Figure 3.4: This first search result displays all found terms in the index you 
chose. 
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5. All the records that are retrieved (the records for which the chosen 

index contains the search key you entered or selected) are then 

displayed as a list on the Brief display screen (see Figure 3.5). You 
can choose a record from this list (double-click or press Enter), 

after which the selected record will be displayed in detail, spread 
out over several screen tabs (screens). 

 

Figure 3.5: The Brief display: the records found for this author. Double-
click a title to open the record in detailed presentation. 
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Figure 3.6: The detailed presentation of one of the records found for this 
author. Click another tab to view more data of this record. 

3.3. Navigating through Adlib 

 

Figure 3.7: A part of the Start menu of Adlib. 
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Working in Adlib usually proceeds in a series of steps; in the Start 

menu in the ribbon (the menu with the integrated toolbar) there are 

always two functions present, with which you can go back to a previ-
ous step. 

 

In Adlib, choose Start  Restart (the Restart button) or press F8 to 

return to the screen with which Adlib opens – in effect you start over 
again – and choose a new data source to work with. 

 

From anywhere in the program, step back one screen or level via the 
Back button in the Start menu or press F7. 

 
For browsing through records (in both brief and detailed display), use 

the buttons for this purpose in the Start menu (First record, Previous 
record, Next record, and Last record): 

 

Note that in this manual, “Start menu” always refers to this menu in 

the ribbon of Adlib, never to the Start menu  of Windows 7 or older 
(unless indicated explicitly as “Windows Start menu”). 

3.4. Creating, editing or deleting a record 

 Creating a record, and saving it 

In general, after you’ve chosen a data source in Step 1 of the Search 
wizard, you can create new records in that data source*. Moreover, 
you can do that at any moment, from within each following step of the 
Search wizard, but also from the detailed display of a record, or from 
the brief display. Click the New button in the Start menu to open a 
new record in edit mode: 

 

* In some data sources, like the Library catalogue or the full Objects 
collection, you cannot create new records. In that case, the button will 
be greyed out. Instead, choose a sub data source, like Books or Inter-
nal object catalogue, to create new records in. 
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Now you can start entering data into any fields you wish. Some fields 

are mandatory, and if necessary, Adlib will notify you so before sav-

ing. Other fields may be validated against a different database. When 
you leave the field, you may therefore have to choose whether the 
entered term or name must be added to the authority database, or to 
replace the entered value by an existing prefered term or name. Read 
more about validation in chapter 12.1. 

When you are done filling in the record (for now at least), you save it 

by clicking the Save record button in the Start menu: 

 

You still have to confirm saving the record.  

Also click this button if you want to close the record without saving it. 
Then choose No in the Save record confirmation window. 

 

 Editing an existing record 

An existing record can be edited easily: 

6. First, search for the record, for instance via the Search wizard. 

7. Then select the desired record in the brief display of the search 

result (by clicking it), or open the record in detailed display. 

8. Click the Edit button in the Start menu to put the relevant record 
in edit mode. 
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You cannot edit the record if the button is greyed out. This may be 

case if do not have sufficient access rights or when you’ve looked 

up this record in the Library catalogue or the full Objects collection 
instead of in one of their sub data sources. 

9. You can now change the data in the record. 

10. Click the Save button when you’re done, to save the changes, or 
to close the record and leave it as it was. 
 

 

 Deleting a record 

To remove a record definitively (!) from the database, open it in 
detailed display and click the Delete button in the Start menu. You’ll 
have to confirm your choice. 

 

 

From the brief display of the search result, you can delete multiple 
records at once. Mark the records to be removed by clicking the 
checkboxes in front of them, and click the Delete button. You’ll have 
to confirm your choice. 
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3.5. Other possibilities in Adlib 

In Adlib there are of course many more possibilities, such as: 

 
• executing complex searches; 
• replacing data automatically; 
• deriving records from other databases; 
• sorting a collection of records; 
• printing selected records; 
• importing or exporting records; 

 
All these functions will be discussed later on in this user guide. 

 
 

We strongly recommend that you make sure regular backups are 
made of your database(s) and your Adlib applications, especially 
before you install an upgrade, import data or start adapting your 

applications. If required, Axiell ALM Netherlands can advise you on the 
best way to make such backups, although we cannot accept responsi-
bility for your backup procedures. See the Installing Museum, Library 
and Archive manual for more information about creating backups. 
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4. The user interface 

Abstract 

Adlib is a Windows program and it uses the same standard window 
elements (see paragraph 4.1) as other Windows software. The title 
bar of Adlib shows the name and version of the current application. 

The status bar at the bottom of the window can display differing 
information, about the current data language (if applicable), the 
sequential record number in the list and some information about the 
active field on a screen, for example. 

Most functions can be found in the ribbon (4.2). When you hover the 
mouse pointer over a button, a tooltip appears in which often a key 
combination or shortcut is mentioned, with which it is possible to 

activate the function from the keyboard. The tooltip also provides 
other information about the function. 
Often used buttons can be copied to a small toolbar above of below 
the ribbon to prevent you from having to switch between the menus 
(the ribbon tabs) too much. 
If your screen resolution is low or the Adlib window is narrow, some 

buttons only become visible after you unfold a hidden part of the 
ribbon via a downward pointing arrow. 

In all lists you encounter in Adlib, you can select an item by clicking it 
(4.3). Sometimes you can use double-clicking to proceed to the next 
step as well, for instance to open the detailed display of a record 
from within the search result. 

In an editable field in which the cursor is blinking, you can enter text 

(4.4). Simply click another field to move the cursor. For cursor 
movements there are key combinations available too. In some fields 
you can only type one line of text, while other fields automatically 
expand for long text. Also it’s possible to repeat certain fields, by 
adding so-called occurrences to it. This allows you to enter multiple 
authors, for example, each in its own field repetition. You can add an 
occurrence to the currently active field using the following buttons, 

but only if they are active for the relevant field: 

    

Help is available from almost anywhere in Adlib (4.5). Press F1 to 

display a help text for the currently active field, screen or window, in 
a separate window pane. This includes examples for data entry. 
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In most Adlib applications you can switch between interface lan-

guages with View > Language switch (4.6). The interface language is 
the language in which menu’s and field labels are being displayed. 
The data language in which you enter records is completely separate 

from the interface language.  

Further, Adlib regularly displays messages to inform you or for con-
firmation of a selected action (4.7). Some messages can be disabled, 
if you don’t want to see them anymore. 

4.1. Window elements 

 

 

 

 

Figure 4.1: Some window elements. 

Close 

Maximize 

Minimize 

Title bar 

The ribbon with five menus 

Greyed out button 

Status bar 

Scrollbar 

with scroll 
box 

Selected 
search key 



Adlib User Guide The user interface 

 25  

Adlib-applications have a typical Windows interface and work much 

like other Windows programs. In Figure 4.1 the Windows labelling of 

frequently used window elements is shown. 

With the three buttons in the upper right corner of the Adlib window, 
you can minimize the window (to a shortcut on the Windows taskbar), 
maximize it (make it fill the screen), resize it to the former dimen-
sions, or close the program. 

The status bar displays additional information, such as the number of 

records in a list, the database field tag of the active field in an opened 
record and the data type and validation type of that field, the charac-
ter set and type of the databases used, or a suggestion about what to 
do next. 

The current data language (that you select with Edit > Data language) 
will be displayed in the status bar as well. This applies to applications 
running on a multilingual Adlib SQL or Oracle database only.  

 

4.2. Working with menus, buttons and keyboard 

In Adlib, functions can often be executed in different ways, with the 

mouse or with a key combination. Almost all functions can be found in 
one of the menus of the ribbon. 

 The default menus in the ribbon 

 

The ribbon is a combination of a menu bar and toolbar. In adlwin.exe 
applications (like Adlib Museum or Adlib Library), this ribbon consists 
of five screen tabbed menus by default, with a row of buttons (icons 
really). Dependent on the situation, extra menus may sometimes 
become visible, like the Media menu when a linked image is being 
displayed. Click (always with the left mouse button, unless stated 

otherwise) the name of a menu (e.g. Edit) if it isn’t open yet and 
beneath it click a function that is not greyed out (e.g. Restart) to 
execute that function. 

Greyed out functions are functions that you cannot execute because 
they are not applicable right now; they do become active in other 
windows or under other circumstances. 
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The five menus are: 

• File – The menu to the left of the 
Start menu is the File menu. This 
menu still folds out like a true menu. 
The functions you’ll find here, have 

something to do with periferal devices 
and files, like printing, importing and 
exporting. You can also use it to 

quickly open any of the nine most 
recently edited records. 

• Start – By default, Adlib opens with 
the Start menu (see the split-up 

image below). In it you’ll find the 
functions most often used, namely the 
navigation buttons, the basic record 
functions, the possibility to choose a 
search method, the pointer file 
functions, the options for marking 

records, the Boolean operators to 
combine search results with new 

queries, sorting and the Print label 
button. 
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• Edit – The Edit menu mostly contains functions which you use 

when the record is already in edit mode: clipboard functions like 

cutting and pasting, field editing functions like adding occurrences, 
emptying fields, locking fields or translating them, tools for data 
entry like dialog windows to link images or files, to check for 
spelling errors or to view or create linked terms, and a button to 
change the data language. The last three funtions in this menu are 
meant for editing multiple records at once: Replace in record, 

Change locations and Thesaurus update. 
 

 
 

 

• View – The View menu contains functions which aren’t used that 
often: options to switch the Hierarchy browser or the Media 
Viewer on or off, functions to change the display of records and 
menus, and hyperlinks to web pages with frequently asked 

questions and other product information. 
 

 
 

 

• Publish – The Publish menu finally, contains buttons for 
publishing records to The Collection Cloud, a private cloud or 

Europeana. 
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An overview of all Adlib buttons and their function is included at the 

end of this user guide in Appendix 4. Also see chapter 8. 

 Context menus 

Functions which apply to certain floating windows like the Media 
Viewer and Query by form windows, appear in an extra menu in the 
ribbon, yet only when such a window is visible. For screens on which 

the Media Viewer is visible, for example, the extra Media menu ap-
pears in the ribbon. A green tab in the title bar notifies you so. You 
may click either tab. The buttons in this menu are only applicable to 
the Media Viewer.  
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 Minimizing the ribbon 

You can minimize the ribbon, for instance if you think it takes up too 
much space, by double-clicking the label of the currently open menu. 
Or right-click a random button or menu in the ribbon and in the pop-
up menu that opens, select the Minimize the ribbon option.  

 

From now on, the ribbon will only open if you click one of the menus 
(which will remain visible). The ribbon will automatically close again if 
you click a button or somewhere else in the Adlib window. 

 

(In the same manner you can maximize the ribbon again.) 

 The Quick access toolbar 

By default, the Quick access toolbar will be located above the ribbon 
menus. You can adjust this toolbar at will to collect all your often used 
functions in a single toolbar. If you find yourself switching between 
the Start and Edit menus a lot, you might consider setting up this 
toolbar in such a way that you won’t need to use the menus all the 
time. 

 

To begin with, it might be handy to place the Quick access toolbar 

underneath the ribbon: its buttons will be more visible and easier to 
reach. Click the downward pointing triangle to the right of the toolbar 
to open the options menu for the toolbar. 
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Click Show below the ribbon. (You can always move the toolbar back if 
you want.) By default, the Quick access toolbar will contain about ten 

buttons, but you can add more or rebuild the entire toolbar. 

 

In the options for the Quick access toolbar, some buttons have been 
included by default. By checking an unmarked button you place that 

button in the toolbar. Conversely, by unmarking a button you remove 
it from the toolbar. 

However, any button from the ribbon can be added to the toolbar: 
right-click the relevant button and choose Add to Quick access toolbar 
in the pop-up menu. The button will always be added to the right side 
of the toolbar. 



Adlib User Guide The user interface 

 31  

 

You can remove every button from the toolbar by right-clicking the 
relevant button in the toolbar and subsequently selecting the Remove 

from Quick access toolbar option in the pop-up menu. 

 

If you would like to have the buttons in the toolbar to be ordered in a 

certain way, you will first have to clear the toolbar, and then add the 
buttons piece by piece in the proper order. 

Since the arrangement of the Quick access toolbar can be adjusted, it 
is possible that your toolbar may appear different than in the screen 
shots in this and other Adlib manuals. 

 Shortcuts and tooltips 

Often used functions can usually also be executed by using shortcuts 
or key combinations. If you hover the mouse pointer over a button 

(without clicking), a so-called tooltip will appear with the name of the 
button and a small description of the function. In 7.0 these tooltips 
have been extended to offer more information, about the 

circumstances under which the button will be active or deactivated for 
instance. The key combination (if available) with which to activate the 
function without using the mouse and the menus, can also be found in 
the tooltip. 
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All menus and buttons in the ribbon are accessible from the keyboard 

in a different way as well. Press the Alt key and keep it pressed 

down. Around the menu and the toolbar, letters and numbers appear. 
Subsequently press the letter or number which corresponds with the 
desired option. You can let go of the Alt key now. Alt+E for 

example, opens the Edit menu. If you have opened a menu, letters 
and numbers will also appear next to all buttons in that menu. Press 
the letter of a button to start that function. A letter combination like 
T1 means you first have to press t (doesn’t need to be upper-case) 

and then 1. 

 

 

As far as the end result is concerned, it is not important how you start 
a function, but some people prefer working with the mouse, while 
others prefer the keyboard. 

 
For the sake of succinctness, in this manual usually only one of the 

above mentioned ways of executing a function will be mentioned, for 
instance through a button, but instead you can use a shortcut just as 
easily.  
 

 The ribbon in a small Adlib window 

If you narrow the Adlib window or when your screen resolution is too 
small to display the ribbon in full, then the ribbon will first shrink to a 
certain extent, meaning that the label next to some buttons won’t be 
displayed anymore so that at least all icons remain in view. This will 
be the case for a screen resolution of 1024 x 768, for example. Hover 

the mouse pointer over a button to display a tooltip. 

With an even smaller resolution or smaller window, some sections of 
the menu fold in: only a single icon will remain, like for the Marking 
section, with a downward pointing arrow. Click it to fold this menu 
section out and subsequently click the desired button in the submenu. 
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With a yet even smaller resolution or smaller window, the ribbon won’t 

shrink any further and to the left or right side of the ribbon a button 
with an arrow will appear: click it to move the ribbon and make the 
hidden buttons visible. 
 

 

 Adlib menus under old Windows version 

The ribbon, present by default from Adlib 7, is not visible in Adlib if 
you are still working under Windows XP, Windows Vista (older than 
SP2), Windows Server 2003 or Windows Server 2008 (older than 
SP2). The old menus and toolbar will still be present. See an older 
version of this manual for a description of the menus and toolbars in 

that version. 

4.3. Making a selection from a list 

Many Adlib screens and windows allow you to choose from a list of 
options. In such a list always one item is selected, marked with a 
distinctive background colour. Simply choose another item by clicking 
the item; again click the item to use or open it. Sometimes though, it 
takes double-clicking (clicking two times rapidly) an already selected 

item, to obtain the same result, for instance in the Search wizard. 
When clicking once doesn’t do the trick, double-clicking should. 
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A different way to select another item is to use the cursor control 

(arrow) keys   to highlight the desired option and then press Enter 

to open or use the item. 

If the selection list is longer than will fit in the available space, you 
can move up or down through the text using the arrow keys. You can 
also do this by dragging the scroll box in the scrollbar using the mouse 
pointer. By clicking the scrollbar just above or below the scroll box, 
you can move through the list whole pages at a time. You can also do 
this with the Page Up and Page Down keys. Alternatively (in the 

Search wizard), you can type in the first letter of the option. The next 
option starting with the letter you just entered will be highlighted.  

4.4. Entering text 

Text is always entered in the same way in Adlib. On the line where 
you want to enter or edit text, a blinking line (the cursor) will show 
the insertion point and the entry field that is active. There is always 
only one active field and text you type will be inserted in this field. The 
cursor is where the next character will be placed. During typing the 
insertion point will move to the right. 

  Moving the cursor with the mouse 

You can move the cursor by moving the mouse pointer to an entry 
field where you want the cursor to be and clicking once. This way you 

can enter text in different entry fields. 

  Moving the cursor with the keyboard 

There are a number of key combinations that you can use when enter-
ing text. These are listed in the table below. 

 

Key Function 

 Cursor to the left 

 Cursor to the right 
Home Cursor to the beginning of the line 
End Cursor to the end of the line 
Ctrl+Home Cursor to the beginning of the occurrence 
Ctrl+End Cursor to the end of the occurrence 
Backspace Delete the character to the left of the cursor 
Delete Delete the character to the right of the 

cursor 
Shift+Enter/Enter Insert new line within this field occurrence. 
Enter/Return End of input in the Search wizard 
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When creating or editing records, you can jump to the next field using 

the Tab key. Shift+Tab will take you to the previous editable field. In 

descriptive fields, such as Title in Serials, Comments in Loans man-

agement, or Notes in Museum Plus, you can continue typing as long as 
you like. If the last word does not fit on the line, it will automatically 
move to the next line on the screen. You may also force the cursor to 
the next line, via Shift+Enter or Enter. 

This “word-wrap” function does not work in the other fields, because 
there you are not supposed to enter lengthy text. For certain fields 
you can add repetitions though (called occurrences) of that field, in 
order to be able to store more terms. You can add an occurrence by 

placing the cursor in the concerning field and then clicking one the 
buttons Append occurrence above, Append occurrence beneath, or 

Add occurrence below: 

    

Or press Ctrl+Enter to insert an occurrence beneath the active field, 

via the keyboard. 
Jump to the next tab (screen) with Ctrl+Tab and to the previous 

screen with Shift+Ctrl+Tab.  

4.5.  Contextual help 

If you require more information than is given in the status bar, you 
can call up extra information about the active field or screen by press-
ing F1 (Help). This Help can also be opened by clicking the icon with 

the question mark, in the top right corner of the Adlib window, or via 
the Help button in the Search wizard. 

   

The help texts are displayed in a separate window pane (see Figure 
4.2). The help text shown by Adlib is context-sensitive, i.e. it depends 
on the screen or the menu and the highlighted option. Click another 
option (in the Search wizard) or another field (when entering records) 
and the Help window immediately displays an explanation. Close Help 

via the Close button in the upper right corner of the Help window or 
by pressing F1 again. 

The Help window can be made wider or smaller by moving the cursor 
over the (left) border until you see a double arrow, and then dragging 
that border to the left or right. Adlib saves the new width for the next 
time that you open the Help, even after Adlib has been closed in the 
meantime.  
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You can position the Help window on the other side of the screen too. 

Right-click the Help window and choose Dock left or Dock right in the 

pop-up menu. 

 

Figure 4.2: Adlib Help. 

4.6.  Language switch 
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The application builder may have applied an interface language switch 

option. In most Adlib applications, you can choose between at least 

English, Dutch, German and French, but the full spectrum of lan-
guages in which Adlib is able to work is as follows: English, Dutch, 
French, German, Arabic, Italian, Greek, Portuguese, Russian, Swedish, 
Hebrew, Danish, Norwegian, Finnish and Chinese (although actual 
translations are not always present yet). You can change the interface 
language at any time* while working in Adlib, using the Language 

switch button in the View menu. For this to work, the application 
builder must have installed the necessary text files. 
The first time you start Adlib, it will be in English. After that, Adlib will 
open in the language in which the last user closed the application. 

Note that the language in which you enter data in records (in Adlib 

standard applications), is separate from this interface language. You 
may very well set the interface language to Dutch, for example, while 

you enter data in the English language. 

* In the Advanced search and in the Pointer files window you can 
switch interface languages as well, but keep the following in mind 
when doing so: search statements and pointer files which contain 
English field names, can be executed or updated in all interface lan-
guages, but search statements and pointer files which have field 
names in another language can only be executed or updated in the 

relevant interface language. So if you would create a pointer file of a 
search statement with Dutch field names, then for updating (using 
Profile) this pointer file at a later time you would have to set the 

interface language to Dutch too, otherwise you’ll receive an error 
message reporting that a field name cannot be found. English field 
names do not have this problem. 

4.7. Messages in Adlib 

Adlib regularly displays messages, to inform or for confirmation, like 
before storage of a record or when you leave an mandatory field 
empty.  

 



The user interface Adlib User Guide 

 38  

Some of those messages are not strictly necessary and therefore you 

may decide to hide a certain type of message from now on, by mark-

ing the Do not show this message from on checkbox. 

To have Adlib display all hidden messages again, click the Show all 
messages button in the View menu. 
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5. Choosing databases and procedures 

Abstract 

In Step 1 of the Search wizard you must choose a data source (a 
database or dataset) to search, or to edit records in. New records can 
only be entered in datasets or non-subdivided databases: for exam-

ple, in the Objects database you cannot enter new records, but you 
can in the two datasets underneath it. 
However, not all options here are data sources: some applications 
also offer procedures in this list, mostly print tasks, like for order 

letters, for example. When you double-click such a procedure, Adlib 
will first ask for confirmation and you can still abort the task. 

 

 

Figure 5.1: Choose a database or dataset to work with. 
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In the first window of the Search wizard you choose a data source to 

work in, or you start certain procedures. From anywhere in Adlib you 

can return to the first step in the Search wizard by clicking the Restart 
button: 

 

Move the selection bar, which highlights the first data source by de-
fault, to the data source or option of your choice with the mouse or 

arrow keys ( and ), or type the first letter of the data source and 
double-click it, click the Next button, or press Enter. 

The listed data sources can point to whole databases or parts of them 
(datasets). In Figure 5.1 of an example of a Museum application, you 

can choose from fifteen databases, of which Objects (Total collection) 

is divided into two datasets and Library catalogue (Documentation) 
into five datasets. Dependent on your installation, this menu may list 
more or fewer, and different files than in this example. 

Click the minus icon in front of a subdivided data source to hide the 
datasets from view, and click the plus icon to expand the node again. 

When searching for data you can use databases as well as datasets. 
For instance, when you are searching for an object the Museum’s own 
collection, then you can do that in the Objects as well as in the Inter-

nal object catalogue. The advantage of choosing a dataset is that it is 

smaller and that all operations you perform on it will execute faster 
than on the full catalogue. Further, in this case you do not get results 
that contain objects from other owners. 

For entering or editing data it is important to always choose the small-
est collection of data: if a database has been divided into datasets, 
then always choose a dataset; if a database has not been divided, 

then simply choose the database itself. So, if you want to register a 
newly acquired object in the example above, select Internal object 
catalogue, not Objects. 

Not all options in Step 1 of the Search wizard are data sources, some 
applications also offer procedures in this list, mostly print tasks. In the 

Serials module 4.2 for example, you’ll find the following procedures in 
between the data sources: 
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After you open a procedure, you still have to confirm the task before 

Adlib actually executes it. When the procedure has finished, you’ll 

return to the Search wizard. 

 Selecting a different data source 

If you’d like to continue working in a different data source, after 
you’ve been searching, viewing or editing records, you may select the 

other data source in one of two ways: 

• From anywhere in Adlib, return to the Step 1 in the Search wizard 
by clicking the Restart button and then choose the desired data-
base or dataset. 
 

 

• You can open a different data source from anywhere in Adlib 
(except while editing a record) via the File > Select database 

menu as well. Simply click File > Select database and select the 
desired data source in the submenu. Move the mouse pointer over 
the thin bar with the arrow at the top or bottom of the submenu to 
have the list scroll up or down and show you more data sources. 
(The databases and their datasets won’t be displayed in a hierar-
chical structure here.) Immediately after your choice, Step 2 in 

the Search wizard will open, for the relevant data source. 
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6. Search methods 

Abstract 

After selecting a data source, you can search for records in three 
ways: via the easy-to-use Search wizard, via a Search by form if you 
would like to search different fields simultaneously or via the Ad-

vanced search with which you can enter a simple or complex search 
statement manually. Per search you can select the best method. 

In the Search wizard (3.2) you use access points (6.1) to search 
with. With an access point you search one index. Often you have to 

type a word to search on: you can provide a full search key or just 
the first letters of the search key (6.1.1). Person names usually start 
with a surname. On the other hand, sometimes you have to enter 

two numerical values or dates; then you’ll be searching on a range. 
How Adlib will search on the key you entered, depends on the type of 
the index for the access point (page 50): in term indexes (for short 
fields), Adlib searches from the beginning of the term, while in word 
indexes (for long text fields) Adlib can search on multiple search keys 
simultaneously for words appearing randomly in the text. Any accents 

and the difference between capitals and lower case letters will be 
ignored during searching. 
In term indexes (6.1.2), the entire field content is used as the index 

value. For searching in such an index, you can enter a partial search 
key (starting at the beginning of the index value): this is called 
automatic (right) truncation (page 51). Sometimes left or middle 
truncation is possible too. For a search, Adlib can also automatically 

replace any entered non-preferred terms by the preferred terms 
(page 53, 55). Often, the result is a list of found terms or names. At 
first you’ll see no more than the first 100 keys maximally, but you 
can scroll for more keys. You can then retrieve all records for one of 
those keys, or for all keys at the same time (page 54). (If a search 
takes too long, you can abort it by pressing any key on your key-
board.) The retrieved records will be displayed in a list presentation: 

per record only a small selection of data is shown. 

In word indexes (6.1.3), each word from the field contents is indexed 
separately, so you can search (truncated) on individual words. If you 
enter multiple search keys, then Adlib will first search for records in 
which the relevant field contains all those search keys. 
In numerical indexes or date indexes (6.1.4) you’ll often search by 

providing a value range in two entry fields: so for searching you’ll 
have to enter two full values. 
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Further, there are some specialist indexes with which advanced 

searching within the Search wizard is possible on date range (6.1.5) 
or on word sound via phonetic indexes (6.1.6). 

If Search by form (aka Query by forms or QBF) is available (6.2), 

those forms can be found in the Start  Search by form menu. In a 
QBF you’ll find a small selection of repeatable, empty fields. You can 

use it to put together a complex search in a clearly set out manner 
(across several fields, or several values in one field). Enter the de-
sired term(s) on the form. When you click the Search button in the 
Search form context menu, Adlib will search for records that match 
the criteria you set:  

 

Truncation is not automatic here, so any partial search keys must end 
with an asterisk (*) or slash (/). We call this explicit truncation. 

Between search keys in one entry field in a QBF, there exists an 
implicit AND relation: all keys must appear in one field in the record 
you are looking for (page 64). If you enter more than one value in a 
field by adding one or more occurrences, Adlib assumes an OR rela-
tionship between the values: this means that at least one of the keys 
must be found. If you enter values in different fields, Adlib assumes 

an AND relationship betwee these keys: all keys must appear in the 
relevant fields in the record. 

The Advanced search (aka the expert search language) can be 
opened in different ways, for example using the key combination 
Ctrl+F (6.3). In the search language you specify the expression of 

the search statement yourself, in the Search statement box. To do 
so, you need to know the required syntax (page 67) and the available 
functionality. An entered search statement can be executed via the 
Search button, while the search result can be presented in the brief 

display by double-clicking the relevant set (page 71). You have the 
following possibilities: 

• You can search all bold typed fields (6.3.1) (or their tags, 6.3.4), 
not just indexed fields. The field names in the Fields list may dif-

fer from the field labels on the screen. You can open the field 
properties from a detail screen, to look up the real field name. 

• With the = operator you compare field contents with a partial or 
full search key (6.3.2). It is possible as well to search on empty 
fields (<field>="") or filled fields (<field>=*). Truncation is ex-

plicit, using a * or /. Preferably place the key including the trun-
cation character in between double quotes. Non-preferred terms 
will be replaced by preferred terms (unnoticed) if you are search-
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ing an Adlib CBF database (does not apply to SQL or Oracle). You 

can also use = to search on multple words simultaneously, alt-
hough mainly in word indexed, long text fields (page 73). 

• Besides the = operator, the search language offers some other 
comparison operators as well, namely: >, >=, <, <=, contains, 

narrower, generic, related, parents and topterm (6.3.3). You 

can use the first four to compare numerical values or dates (page 
77), contains (with implicit truncation) to find some part of a 

word anywhere (page 76), and the other operators to simultane-

ously search for keys hierarchically related to the search key 
(from page 78).  
Dates can always be compared as ISO dates (yyyy-mm-dd) and 

in numerical numbers you must use a dot as the decimal separa-
tor (never a comma). Further, you can use record contains 

<value> to search all fields simultaneously on a value, with today 

you can use the date of today, and with the search statement ALL 

you retrieve all records from the database (6.3.9). 

• In authority databases like the Thesaurus, terms are usually 
linked to to one or more domains. That way, a term can be both 
an object name and a keyword, for example. In such a database 

you can search not only on the term, but on an associated do-
main as well (6.3.6). 

• The result of a search will be held in a set in the bottom half of 

the search language window (6.3.7). For future use, you can save 
this set in a so-called pointer file, via the Write set button. In this 
case, the pointer file stores the search statement plus any found 
record numbers. With a pointer file you are able to quickly display 

search results from the past again, of have the stored search 
statement executed again. In the search language window, click 
Pointer files to list all pointer files for this database; elsewhere in 
Adlib you do that by clicking the following button: 
 

 

• Boolean operators can be used to combine single search state-

ments (6.3.8). One operator always combines two expressions, 
but each expression can be a combined search statement itself. 
Combined search statements can be grouped using parentheses, 
e.g.: (<field1> = x OR <field2> = y) AND <field3> = z. 

With the AND operator both expressions need to be true, while 

with AND NOT the first expression must be true but the second 

must be false, and with OR at least one of the two expressions 
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should be true. 

• You can use the operators WHEN and WHEN NOT with grouped and 

repeated fields (6.3.10). WHEN is an AND operator which says that 

the two entered values must be found in the same occurrence. 
WHEN NOT works in the same way as WHEN, only here, the first 

value must and the second must not occur in the same (group) 
occurrence. WHEN(NOT) must not appear more than once in a full 

search statement. 

• In Adlib applications running on (XML) multilingual Adlib SQL or 
Adlib Oracle databases, you can not only enter data in multiple 

languages, but also (optionally) search for that data per language 
via the search language by providing a language code behind the 

field name (6.3.11). With the Search wizard and Search by form 
you search all languages together.  

• In principle, you can sort search results (also pointer files and 
sets) after carrying out a search statement, but it’s also possible 
to add a sort command to the search statement itself, so that, for 

instance, a pointer file of the search will already be sorted the 
right way (6.3.12). 

• You can let Adlib select a random set of records from the search 
results. For this option you can indicate how many records must 
end up in the resulting set (6.3.13). 

• To further limit a search result and/or to process fields before the 
search result is presented (possibly sorted), you can use adapls 

in the search statement (6.3.14). (Adapls are small programs in 
Adlib’s own programming language ADAPL.) 

• Normally, to print one or more records following any type of 
search, the records must be marked and then the output format 
must be chosen (14). However, it is also possible to print all the 
results of a search by using the print command in the search 

statement and an output adapl (6.3.15). 
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After you’ve chosen a database or dataset in Step 1 of the Search 

wizard, you can search for records in three different ways everywhere 

in Adlib: 

• Access points. In Step 2 and the following steps of the Search 
wizard, choose an access point to search on. A search is per-
formed only in the relevant index. 

• Search by form. Go to the menu option Start  Search by form 
to search for multiple terms simultaneously. This option is not 
available for all data sources. 

• Advanced searching. Go to the menu option Start  Advanced 
search (Ctrl+F) to perform advanced searches. You can submit 

simple queries, but also very complex ones. 

 

 

The last method offers more possibilities than the first, but the Search 
wizard is more intuitive than both the search language and the search 
form. Per search you decide which method you’d like to use. 

6.1. Access points 

After selecting and opening a data source, you arrive in the access 

points menu in the Search wizard (see Figure 6.1). On this screen, 
you can choose which access point you want to use to access records. 

An access point provides a means of searching the database or da-
taset by a certain aspect of the records.  

The application builder determines which access points are available 
for each data source.  
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Figure 6.1: The available access points for the Internal object catalogue da-
taset in a Museum application. 

Instead of navigating to Step 2 in the Search wizard to select an 
access point, you may use an alternative approach from anywhere in 
Adlib to quickly start a new search in the active data source, like from 

the detailed record display or list display of a search result, by select-
ing the desired access point from the Quick search drop-down list in 
the Adlib Start menu.  

 



Adlib User Guide Search methods 

 49  

The list contains the same access points as Step 2 of the Search 

wizard, for the currently opened data source. 

 

6.1.1. Submitting a search key 

After selecting an access point, Step 3 of the Search wizard opens, 
usually displaying a small search form. Here, enter the value you’re 
searching for. If, for example, you chose the Author access point in a 
documentation data source, then type the last name of the writer, or 
only the first few letters thereof. This value is known as the search 
key. 

Note that in between the access points there may also be options 
which start a fixed or partly fixed search query as soon as you click 
Next in the Search wizard, for example to be able to request a list of 

recent accessions, or to search for all object records of that artist with 
the difficult name who is the focus of a lot of attention at that mo-
ment. It may be that such a query skips the search form in the Search 
wizard. Such options are not standard, but may have been added by 

your application manager. 

For some access points, in this window of the Search wizard you’ll see 
a second drop-down list, called Used thesaurus. For now you may 
ignore this. In chapter 13.10 you’ll read more about it. 
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When you click the Next button or press Enter, Adlib searches for 

terms or names which comply to the query. During a search, the key 
will be compared to words/terms that appear in the index of that field 

(in all data languages together, if you use a multilingual database). 
Sometimes this means that Adlib subsequently shows you a list of 
found terms or names in the Search wizard, in which you have to 
indicate on which word(s) you want to continue searching for records, 
and other times it means that directly a list of found records will be 
presented in the Brief display. 

The way the search is carried out depends on the type of data (the 

field type) you are searching on, and on the way the data is indexed 
as an access point. The possibilities are as follows:  

• indexing on a term (e.g. Author in Library, Reference code in 
Archive, or Material in Museum): fields which usually need only 
one or just a few accurately defined terms to specify them. In the 
latter case searching is always done starting at the beginning of 

the first word in the term. 
For example: suppose that in one or more records in your objects 
database an object name "oil heater" appears. You can find these 
records using the object name access point, by searching on e.g. 
oi, oil or oil hea etc., but not on heater. The first search result 

in a term index is usually a list of found terms or names in the 
Search wizard. For more information about searching term index-
es, see chapter 6.1.2. 

• indexing of text on words (e.g. Title and Free text in Library, in 

which you enter multiple words or sentences). Fields in which you 
can enter long texts, are usually (barring some exceptions) not in-
dexed as one term because then you wouldn’t be able to search 
on random words from the text. That is why each word from the 
text has been indexed separately. 
For example: a book record with the title “A comprehensive histo-

ry of the universe” can be found using the Title access point, by 
searching on e.g. com, universe, a or hist, but not on verse or 

story. The search result from a word index is a list of retrieved 

records presented in the list display (Brief display). For more in-
formation about searching word indexes, see chapter 6.1.3. 

• numerical data and dates. See chapter 6.1.4. 

During a search, Adlib will ignore any letters with diacritical characters 
(accents), and will not distinguish between upper and lower-case 
letters. That is to say: for searching, letters with and without diacriti-
cal characters are treated equally. So when you’re looking for cafe 

you’ll also find records with café and the reverse is also true. 

In indexes on term or on word, you can search with just one letter. 
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And in a term index you can even search with an empty key (filling in 

nothing). 

6.1.2. Indexing on term 

With indexing on term, the entire content of the field is used as an 
index key, even if it includes spaces or punctuation marks. The index 

key for a term index may therefore also contain spaces and punctua-
tion marks, and at the beginning of a field there may also be spaces. 
Adlib will ignore preceding spaces when indexing.  
Indexes on term include: Author, Subject term, Publisher, Shelf mark, 
and Copy number in Library, and Object name, Creator, Condition, 
and Material in Museum.  
Type in the first letter or several letters for the required term. Spaces 

preceding a search key will be ignored. 

 Truncation 

It is possible, but not necessary, to type in the full term. Not entering 
the end of the key is known as right truncation. One speaks of a 

‘truncated search key’ or a ‘truncated search’. The default setting for 
automatic truncation in the Search wizard in all Adlib applications is 
on.  

Automatic truncation for the search key: al in the access point Author 

in Library might result in Alcock, Pete, Aldinger, F., and Allen, Robert. 

If you want to enter the full key (non-truncated searching) , then you 
must enclose the search key in double quotes ("). With for instance: 

"Bond" you will only find the full authors name Bond, but not Bond, 

J.M. 
A term which itself is registered including double quotes, for example 
“Marital happiness”, can be found by enclosing the entire search key 

again with double quotes: "“Marital happiness”". 

It is possible for the application builder to set left instead of right 

truncation for certain fields. The search key computer will then yield, 

besides computer, for instance also minicomputer, microcomputer, 
etc.  

Left and right truncation cannot be applied simultaneously in the 
Search wizard, if your application runs on a CBF database (Adlib’s own 
database format). In the ribbon, click View > Info to find out whether 
a CBF or SQL database is in use. 
However, if your application runs on an Adlib SQL database, you may 

truncate to the left, middle and right simultaneously, if you wish. 
Assuming that automatic truncation has usually been set to right 
truncation, you’ll have to use an asterisk (*) where you want to trun-
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cate to the left and/or middle. For instance, if you search on *m*n, 

you’ll search left and middle truncated and also automatically right 
truncated. You could find the term dominant or community, for exam-

ple. 

 Substituting terms 

If you use an access point for a field which is linked to an authority 
database (such as the thesaurus), you may have used a non-preferred 
term as the search key. Adlib can automatically replace your search 

key with the associated preferred term from the authority database, 
and search on it, instead of on the key you entered. In CBF databases 
this is always the case, but in an Adlib SQL or Oracle database a non-
preferred term will only be replaced if you marked the Use relations 

checkbox in the Search wizard. (See the status bar to find out whether 
a CBF, SQL or Oracle database is in use.) 

When you come across a red coloured term in the list of found keys, 
this means that the term itself has not been found in the current 
database, but that one or more of its narrower terms do occur in the 
database; those narrower terms will then also be shown in the list 
(coloured red if the narrower term is not used in the catalogue, other-
wise black). 

 

Figure 6.2: The red term does not appear in the current database. 
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 Searching with relations 

In CBF databases, Adlib will automatically use relations when search-
ing fields which are linked to an authority database. When searching 
SQL or Oracle database fields which are linked to an authority data-
base, Adlib will only use relations if you mark the Use relations check-
box in Step 3 of the Search wizard. Searching with relations means 

that: 

• in the background, a non-preferred term will automatically be 
replaced by its preferred term; 

• any narrower terms of the (preferred) term you are searching on 
will be included; 

• and any equivalent terms of the submitted (preferred) term will 
also be searched on. 

 

Figure 6.3: Leave Use relations unmarked if you are not interested in any non-
preferred term replacement, equivalents or narrower terms. 

If you are searching on a non-preferred term, this will result directly in 

a list of records in which the preferred term or any of its narrower or 
equivalent terms occur in the searched field. 
If, on the other hand, you are searching on a preferred term, this will 
usually result in a list of found terms (the search key itself and terms 

starting with search key) and any of their narrower terms, in the next 
step of the Search wizard. (Equivalent terms won’t be shown, but they 
will be searched on.) There, you can still select the desired search 
key(s) to find records with. And you can also use the Include narrow-
ers checkbox to specify whether you want to search on any narrower 
terms (expanded or not) of the selected term. The final step of the 

Search wizard will be skipped if for the search key no “near” terms are 
found. 

If you leave the SQL Use relations checkbox deselected, Adlib will not 
perform any non-preferred term substition, nor will it retrieve any 
narrower terms or search on equivalent terms: you’ll really only be 
searching (truncated) on the search key itself. 

Searching with relations, aka hierarchical searching, does influence 

the speed of searching though, especially in Adlib SQL and Oracle 
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databases: non-hierarchical searching is just faster because you’ll only 

be searching on the entered term, nothing else. 

So for each access point to a term index in the Search wizard, users of 
applications which run on an Adlib SQL or Adlib Oracle database can 
easily indicate whether or not search keys must be searched hierarchi-
cally, by selecting or deselecting the Use relations checkbox. Per user 
and per data source, Adlib will remember which access points must be 
searched hierarchically, even after closing Adlib, so that you have to 

make each setting only once. 

Technical information 

Settings which are “remembered” by Adlib per user, are stored in the 

registry of Windows. This may be per workstation, or may apply to 
the whole network in the case of a “roaming profile”. Adlib’s settings 
in the Windows registry can be found underneath 
HKEY_USERS\[username]\Software\ADLIB Information Sys-
tems\ADLIB. To be able to store settings, the user must have write 

access in (this part of) the registry.  
By the way,do not make any changes in the registry manually, unless 
you know what to do. Also see chapter 27. 

 Searching for key values 

When you have entered your search key, the system will search the 

index and will then show a list of all terms for the selected access 

point, beginning with your search key. (If only one term has been 
found, Step 4 of the Search wizard will be skipped and a search for 
records with the relevante term will automatically commence.) From 
this list you can choose the term(s) with which you’d like to search for 
records.  

If you want to continue the search for records on all found keys, then 

click the All keys button.  

 

Figure 6.4: Found index values for the search key ‘fin’ in a Library application. 

During the index search a counter shows how many index terms have 
been searched so far. This counter is normally incremented in steps of 
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10. The application builder may alter this setting if required. However, 

searching can finish so fast that the counter hasn’t been visible at all. 

The application builder may also set a limit for the number of terms 
that can be retrieved. When this limit has been reached, a message 
will appear that Adlib has stopped searching. 
There is also a limit on the number of keys that Adlib will display 
initially. When the search yields more than 100 terms, then still only a 
100 terms will be displayed. Behind Search results always the exact 

number of keys found is stated. Only a part of the search result will be 
displayed because showing the entire list (including possible tree 
structure) may take too long and can take up a lot of memory space, 
when the list is very long. Press the Page Down key a number of 

times, or use the arrow key , to expand the list with a following part 

each time you press that key, until the complete index is being dis-
played. 

The application builder can determine what happens if you click Next 
in Step 2 without entering a search key. If this is not permitted, 
nothing will happen. If it is permitted, all index values will be included 

in the term list.  

Warning sign in front of found term 

If a warning sign with an exclamation mark is displayed in front of a 
term or name, then Adlib is not able to read the linked record be-
cause of some error in it, for instance because a narrower term in 

that record is identical to the term itself (a circular definition is not 
allowed). 

 

You may encounter this icon in other windows with term lists as well. 

Always try to look up the relevant term in the linked database itself, 
check the record for irregularities and if possible, repair it. 

 Retrieving records 

Choose one of the found terms and click the Show button or press 
Enter. Adlib will now select all records that contain the full key value 

for this access point and will display them in the Brief display list 
screen. (If only one record is found for the full key, then Adlib will 

display the relevant record in detailed display directly.) If you had 
marked the Include narrowers checkbox, Adlib will also retrieve rec-
ords in which a narrower term of the selected (main) term occurs. 
If, on the other hand, you select All keys, all (main) terms in the list 
will be used to retrieve the appropriate records which will then be 
displayed in the Brief display screen. (The possibilities of this presen-
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tation are discussed in chapter 8.1.) If you had marked the Include 

narrowers checkbox, Adlib will also retrieve records in which a nar-

rower term of one of the main terms occurs. 

The Expand term button will only be active for a selected term with 
narrower terms. You recognize such a term by the plus sign in front of 
it. Click the plus sign to show the narrower terms directly (one level 
down) below the relevant term or click the Expand term button to 
display all hierachically linked narrower terms for the relevant term. 

For the operation of the Include narrowers checkbox it doesn’t matter 
whether you’ve made any narrower terms visible in the list or not. A 
further description of generic searching can be found in chapter 
13.9.4. 

 Interrupting a search 

You can interrupt a search by pressing any key. Adlib will then break 
off the search process and will ask you if you want to stop the current 
search (see Figure 6.5). 

If you select No, Adlib will continue searching. If you select Yes, Adlib 
will stop searching and will display the results found thus far. 

 

Figure 6.5: When a search takes too long, you can break it off. 

6.1.3. Word indexes: free text 

With word indexing, Adlib uses each separate word in the field as an 

index key. Examples of word indexes  (or free text indexes) are: Title 
and Abstract in Library; Object title, Description, and Inscription 
content in Museum; and Free text in Archive. In a word index you can 

search on one letter (the first letter of the word you are looking for). 
For instance, the document title ‘C++’ can be found upon submitting 
c, but also upon submitting c++. If you enter spaces or punctuation 

marks in the search key of a free text  field, you will find these words 
with or without their separators and concatenators. Example: l’arbe 

can be found on l’arbe as well as on arbe. 
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Separators are: [];,!@()|{}<>? and blank spaces, new lines and 

tabs. Concatenators are: `-=\./~#$%^&_+:"'* 

You can indicate that a key is complete by embedding the word in 
double quotes. However, the application builder may suppress auto-
matic right truncation for free text keys; in this case, it will not be 

necessary to embed the term in double quotes. You will then have to 
end a search key with an asterisk (*) or a forward slash (/) if it should 
be a truncated key. 

Now Adlib will search for the records that contain all the words en-
tered for the selected access point. If no matching records are found 
(for all submitted words), those records are selected that contain as 

many of the words entered as possible. 

An example: you are looking for a painting in a Museum collection and 
you know that the title includes the name ‘Pearce' and the word 'Mrs'. 
What you don't know is whether ‘Pearce’ is spelled ‘Pearce’ or ‘Peerce’. 
You select the access point Title and in the search screen you type: 

 pe mrs 

If automatic right truncation has been switched off for ‘free text’ 
searches in your Adlib application, you will get the same result with: 

 pe* mrs 

Adlib will then search (truncated) on the partial key pe and the full 
key Mrs in the title word index and will find the title: Portrait of Mrs 

Pearce by Francis Wheatley. 

So, with 'free text' searches, it is not necessary to type the full index 
key.  

6.1.4. Numeric, date or period 

If you have selected an access point for a number or date, e.g. Record 
number or certain date fields, you can enter two index keys (in two 
entry fields) in the search screen in the Search wizard: the start key in 
the first entry field (From) and the end key in the second (To). Then, 
Adlib will display a list of all full index keys that come under the given 

range. 

For searching on record number, records with a value within the 
submitted range are selected and displayed in the Brief display. Adlib 
automatically searches on full keys. 

With numeric searches, the keys must consist exclusively of digits and 
possibly a decimal dot.  
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For searching on a date you submit keys in the format yyyy-mm-dd. 

This happens automatically when you open the drop-down list of a 

date entry field and choose a date in the calendar. Note that you 
search one particalur date field here. The date you are looking for 
must come after the begin date and before the end date entered here 
in the Search wizard. 

Any value you enter in the From field will be copied immediately to the 
To field, in case you want to search on just one value. Of course, if 

you want to search on a value range, you can still enter a different 
value in the To field. 
 
The application builder can also set the application so that it is not 
necessary to include start and end keys. Then don’t type anything in 

both entry fields and click Next to display all records. If only the start 
key is entered, Adlib will select everything from that key onwards. If 

only the end key is entered, Adlib will select index keys up to that 
value.  
 
These types of indexes do not allow you to search with a truncated 
term. 

6.1.5. Date ranges 

It is possible that your application manager built in a special type of 
access point to enable you to search on date range, if your application 
runs on an Adlib SQL or Oracle database. We are talking about a date 

range like a production period, for example, consisting of two dates 

registered in a record (a start and end date). To search on a date 
range, you have to enter two dates in the Search wizard as well. The 
date range you are looking for must fall “in between” those two dates, 
although you must also select the search type to indicate to what 
extent the date range must fall in between the entered dates (see the 
image above). 
In principle, a search result can be put together in different ways: for 

example, is the entire production period supposed to fall within the 
search date range, or is it enough that the end or start date of the 
production period falls within the search date range?  

To allow specific searching on date range, you can choose from four 

ways of searching when entering a search date range in the Search 
wizard: 

• Wide range - as long as at least a part of the date range in the 

record falls within the search date range, the record will be includ-
ed in the search result. You have to enter both a From and To 
search date. 
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• Narrow range – the entire date range in the record must fall within 

the search date range, to be included in the search result. You 

have to enter both a From and To search date. 

• Before – the end date of the period in the record must come 
before the To search date. In the access point you can only enter 
a To search date. 

• After - the start date of the period in the record must come after 
the From search date. In the access point you can only enter a 

From search date. 

 

 

Figure 6.6: Advanced date range searching. 
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 The processing of incomplete dates 

To be able to search correctly on date range, in principle the following 
requirements apply to a registered date range: 

1. If in a record two date fields are available to indicate a period, for 
instance a production period of a historical artifact, then both 
fields must always be filled in, not just one of them. If the precise 

date is known, then that date must be present in both fields. 

2. The dates registered in a record may remain incomplete and won’t 
be automatically completed in the record. 

3. The indexes must contain complete dates only. 

4. Start dates must come before end dates, of course. 

5. The date fields must be ISO date fields. 

At moment, Adlib does not perform any checks on these require-

ments: you’ll have to do that manually or the application manager 
must have built in an automatical check via a so-called storage adapl, 
for instance to make sure that if one of the two date fields is still 
empty when the record is saved, the other date is copied to that field, 
and also to make sure that the begin date comes before the end date. 
Incomplete dates won’t be completed though: all incomplete dates 

entered in the record, remain as they are. 

Adlib does do some other work for you, namely: 

• date completion* during the (re)indexing of date indexes. On 
storage of a record, the completed dates are included in the rele-
vant indexes: so, saving of records will always add complete dates 
to the indexes.  
Any existing incomplete dates (from date ranges) in indexes must 

still be completed though. In that case, your application manager 
needs to reindex the relevant indexes once, manually. 

• date completion* in the access point. In principle, when you are 
about to search on a date range, you may enter incomplete ISO 
dates in the access point. Adlib then completes the provided dates 
(in the background), to be able to guarantee the correct search 
result. 

*Date completion 

For date range searching to work well, the relevant ISO date indexes 
need to contain complete dates. Since it is possible that existing data 
contains incomplete dates, Adlib makes sure that processed dates are 
automatically completed during (re)indexing and during searching on 
date range. For example: incomplete dates in the index, like 1900, 
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1900-01 or 1900.0101 will be changed to 1900-01-01 during reindex-

ing. Also, in the case of a date range, an incomplete start date (only a 

year or year and month) will be made equal to the first day of the 
year or month, while an incomplete end date probably will be made 
equal to the last day of the month or the year. For example: 

Start date in 
record 

End date in 
record 

Start date in 
index 

End date in 
index 

1960 1960 1960-01-01 1960-12-31 

1950 1952 1950-01-01 1952-12-31 

2000-03 2000-03 2000-03-01 2000-03-31 

Adlib does this automatically for you if the date completion for these 
indexes has been set up correctly (via Adlib Designer).  

Note that the automatic date completion in relation to leap years 
always calculates the last day of February correctly. For searching, 
you only need to take this into account if you were to enter the last 
day in February as a complete date: an incomplete date, for instance 

2008-02, would be completed correctly by Adlib, automatically. 
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 Named date ranges 

It is possible too that your application manager has created an access 
point in which you can search on a period, for example on 17th cen-

tury or renaissance, while Adlib actually searches on the associated 

date range specified in the relevant term record. The period names on 
which you can search, will have been registered in the Thesaurus, 
probably underneath the Period domain. 

6.1.6. Phonetic indexes 

It is possible that your application manager has made phonetic index-
es for one or more fields, and made those available via access points 
so that you can search those fields phonetically. Phonetic searching 

means that words can be found which sound the same as the word 
you are searching for, even when your search key is spelled the wrong 

way. This applies especially to words in the English language. 

In the Search wizard, and only when your application runs on an Adlib 
SQL or Oracle database, you must choose whether you wish to use 
phonetic searching or not: after all, the search result may increase, 
and it may have a negative impact on the speed of searching. If you 
are sure about the spelling, you can leave phonetic searching off. In 

phonetic access points for CBF databases you cannot choose: search-
ing will always be executed phonetically here. 

 

Figure 6.7: In Adlib SQL and Oracle databases you can choose whether or not 
to search phonetically in phonetic access points.  

Technical information 

The Double Metaphone search algorithm is a phonetic algorithm, 
developed by Lawrence Philips. With a phonetic algorithm, words are 
indexed encoded according to their pronunciation, so that the correct 
variant of an incorrectly spelled search key can still be found as long 
as the pronunciation is the same. (Equally sounding words share the 

same phonetic code in the index.) Phonetic algorithms are therefore 
used in many spell checkers. Double Metaphone is suited for most 
words and names in the English language: encoding of terms to be 



Adlib User Guide Search methods 

 63  

indexed follows English pronunciation rules. The use of this search 

algorithm in other languages may yield unexpected search results. 

A phonetically encoded index for a CBF database only contains the 
phonetic codes; the user will automatically search phonetically in 

such an index, and cannot switch it off. 
A phonetically encoded index for an SQL or Oracle database on the 
other hand, contains a column for the normally indexed terms and a 
column for the phonetically encoded indexed terms. So here, the user 
does have the possibility to switch phonetic searching on or off. 

6.1.7. Ligatures 

A ligature is a combined character. The ligature “ĳ” for example, 

consists of one character, while the normal “ij” (in Dutch pronounced 
as a vowel) consist of two characters. In (SQL) index tables, any 
ligatures are always expanded into the two characters of which they 
are composed, while the display value still is the ligature. This means 
that terms starting with a ligature can be found by using either the 

ligature itself or the expanded characters, at the beginning of the 
term. 

6.2. Search by form 

 

Figure 6.8: In a search form you’ve got more search possibilities than in the 
Search wizard. 

After starting Adlib and having chosen a data source, you may select 
your search method: continue in the Search wizard, open the Ad-
vanced search window for advanced queries or choose a search form 
(if available) underneath the Search by form option in the Start menu 

to be able to submit combined queries. Note that you can open a 
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search form from almost anywhere in Adlib, even from the detailed 

display of a record for example. You always search the currently 

selected database or dataset, in all data languages at the same time.  
For most other data sources than the catalogues, the option to search 
with a search form has been left out. This may also be the case for 
catalogues in customized Library, Museum and Archive applications. 

For example, choose Start  Search by form  Query by form… to 
open the window with the same name. In this window you see an 
empty form with a small selection of fields. You can use it to compile a 
complex search in a clearly set out manner (across several fields or 

several values in one field). 

Enter the desired term(s) on the form. When you click the Search 

button in the Search form context menu in the ribbon (or press F2), 

Adlib will search for records that match the criteria you set:  

 

By clicking the Clear search screen button, you delete the entire 
contents of all the fields on the form and of any added occurrences 
(entry fields). 

 

If you start the search with a completely empty search form, you will 

usually* simply retrieve all records from the current data source. 

Fill in the form by clicking the fields and entering (parts of) the terms 
you are searching for. Automatic truncation is switched off here. You 
can truncate by typing an asterisk (*) or forward slash (/) after the 
beginning of a search key. For instance, if you enter B* for Object 

name in a Museum collection, then the result contains records of 
which the object name starts with a ‘B’, such as badge, bag, bank 
notes, etc. 

You can also search on multiple words at a time, in an Archive applica-
tion in the Title field in the Archives (catalogue) data source for in-
stance, but then all searched words or parts of words have to be 

present in that particular field of the resulting record; so between 
search keys in one entry field in a search form there exists an implicit 
AND relation. The order in which you enter the keys is not important, 
and you may truncate or not, per (partial) word.  

You may enter multiple occurrences of a field, for instance when you 
want to search for two author’s names. For this, use the Append 
occurrence beneath, button. 
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If you enter more than one value in a field by adding one or more 
occurrences, Adlib assumes an OR relationship between the values. If 

you add two or more values in different fields not belonging to a single 
screen field group, Adlib assumes an AND relationship; if those fields 
do belong to a single screen field group (data dictionary field groups 
will be ignored), then Adlib assumes a WHEN relation between the 
entered values, meaning that those values will be searched in one and 
the same field group occurrence. If you combine the above possibili-

ties, then Adlib will first search separately within the different fields, 
and only then the results will be combined. See chapter 6.3.8, 6.3.10 
and 7 for more details on OR, AND and WHEN relationships. 

If the cursor is in a linked field (such as Author in Library, or Object 
name in Museum), Adlib will activate the List button in the Search 
form context menu in the ribbon. 

 

The relevant field is linked to a database from which you can choose 

accepted index keys, or possibly add one to those (for more infor-
mation about this, see chapter 12.1). Click the List button to open the 
list of possibilities for the relevant field (in effect to open the linked 
database), in the Find data for the field… window. Adlib displays a part 

of the searched index for the letters you already typed in the field, or 
typed in the Find entry field at the bottom of this window. Select the 
desired key and click Select. The key is copied to the search form. 

Note that after entering a non-preferred term the search will actually 
take place on its preferred term. Moreover, if a term has equivalent 
and/or narrower terms, these will be included in the search as well. 

* From Adlib 7.3 it is possible that your application manager has set 
up a hidden search statement for a search form, with which the query 
you implicitly put together in the search form will be combined in the 

background. This will force your search with the search form to always 
be executed within a limited set of records, so you won’t be searching 

within the entire data source. This is valid too when you start search-
ing with an empty search form: in that case, only the hidden search 
statement will be executed and you won’t retrieve all records from the 
data source, like you would otherwise. 



Search methods Adlib User Guide 

 66  

6.3. Advanced searching 

When you search your database for data that meets certain condi-

tions, you will often use the access points menu in the Search wizard; 
this method is perfectly suited for relatively simple searches.  
However, if you have complex queries, you can enter them as a 
search statement in a special search screen, the Advanced search 
window.  

 

Figure 6.9: The advanced search tool, useful for complex queries. 

You may combine searches in one search statement, search on non-
indexed fields (although this does take some time because Adlib will 

sequentially search through the entire database), and you can search 
on terms from drop-down lists of enumerative fields (but this is also 
possible in the Search wizard).  
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To open this window, click the Advanced search button in the Start 
menu or press Ctrl+F. You can open the search language window 

from almost anywhere in Adlib. You always search the database or 

dataset that you selected in Step 1 of the Search wizard. 

You enter your query in the Search statement entry field. To make 
sure that Adlib properly understands your query, you must couch it in 
a specially developed language designed to prevent misunderstand-
ings. The grammar of this language, the Adlib search language, is 
unambiguous and direct. A simple query always has the following 
syntax: 

field operator value 

You automatically search all occurrences of the field: you can’t search 
one specific occurrence. Moreover, you search all data languages by 
default (should your database be multilingual). The field name must 
be the name in the current interface language or the English name. 
Moreover, field names and values containing a hyphen must be en-
closed by double quotes. 

You can type your query directly, but sometimes it’s easier to assem-

ble the search statement entirely of partially with the help of the three 
list boxes. First, you select a field name from the Fields box by dou-
ble-clicking the desired field (displayed in bold type), which is then 

automatically placed in the Search statement entry field. You can 
browse through the list of fields with the vertical scroll bar or by 
typing the first letter of the field you are searching for (after clicking a 

random field). Field names which are not displayed in bold type are 
partial names: click the plus sign in front of the name to show all 
fields names starting with the partial field name. Field names preced-

ed by the  icon are indexed fields. Searches in indexes are faster 
than searches in non-indexed fields. The icon will only be used when 
both indexed and non-indexed fields are present in the list (when the 
Show all non-indexed fields too checkbox has been marked). When 
the checkbox is left unmarked, all listed fields are indexed fields, so to 
flag all of them with an index icon would then be redundant. 

After you have selected a field, the cursor will be in the Operator list. 

You can choose one by double-clicking it, and it will automatically be 
added to the search statement. You can now complete the search 
statement by entering a field value. 

You can alternate between choosing an item from a list and typing an 
item. Do note that you cannot type the descriptions for the operator 
characters in the search statement; use the symbols that Adlib enters 
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when you double-click an operator description in the list. Some exam-

ples of simple queries are: 

author.name = adams* 

object_name = spoon 

copy_number <= 5 

title _ woman 

input.date > "2009-11-01" 

In the first example you can see that here in the search language you 

will have to truncate explicitly (using the asterisk) when you enter a 
partial search key. 

The third box contains Boolean operators. With these you can make 
complex selections by combining queries into plural search state-

ments. 

6.3.1. Fields 

 

Figure 6.10: In the fields list, blue and bold indicate full names of indexed 
fields. 

The list of field names in the Advanced search window comes from the 
structure definition of the database you are searching in. It reflects 
the names as written in the data dictionary, so there may be a vari-
ance between the entry field names as presented on detail screen tabs 

and the field names in the database.  
The most common variance on this is the use of either an underscore 

or a full stop between words. For instance on the screen the field 
name might be Object name but in the database it is object_name. 
This is because the programming language that is used does not 
support spaces between words, since it assumes they are then sepa-
rate concepts. 

Another common variance is to invert the order of the wording so on a 
form the field might be Input date but in the database it might be 
date_input. 
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Nonetheless it can sometimes be hard to deduce the data dictionary 

field name from the screen field label. Then it is easier to look up the 

field name via the field properties from within a record in detailed 
display. Put the cursor in the field of which you would like to know the 
real field name, and press Alt+Enter (or right-click the field and 

choose Properties in the pop-up menu) to open the Field properties 

window. Subsequently click the drop-down list at the top of the Data 
dictionary tab to view the translations of the field name from the 
database definition. In the search language you must use the field 
name either in English or in the language currently set for the inter-
face of Adlib. So if the menus of Adlib are displayed in German, you 
can use the English field name as well as the German field name. 
If you’d like to save the search statement (as a so-called pointer file, 

see chapter 6.3.7), it is recommended to use the English field names. 
This is because pointer files using foreign field names in the search 
statement can only be updated (“profiled”) when the user interface is 
displayed in the relevant language, while search statements using 
English field names are always functional. 
 

 

Figure 6.11: In the Field properties you can find the field name which can be 
used in the search language. 

If there is a field on the form that does not appear on the list of fields 

in the Advanced search, then the field is not defined in the database 
but is only defined at screen level or the application manager has 
decided to exclude this field from lists. The Library field [display_only] 
on the other hand, can occur on the field list but is only used internal-
ly to generate compound texts on the Catalogue card screen, in the 

detailed presentation of records. 
The available fields will of course vary from system to system. 
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From the field list in the Advanced search window you can deduce the 

following information about a field: 

• The  icon, to the left of a field name in blue, indicates that it is 
an indexed field: for searching in that field, an index is used, 
which ensures the quickest results. Initially, this list will only show 

indexed fields. 
Note that some field names are built up hierarchically, like associ-
ation.period; the dot in the name is responsible for the tree 
structure in the list display. In this example, association itself is 
not a full field name, so you can’t search on it. The difference be-
tween (parts of) field names on which you can double-click to 
copy them (including any higher parts of the name) to the search 

statement, and parts of field names for which you can’t do that, is 

indicated by the difference between a bold display and normal 
display: you can only double-click bold displayed (parts of) field 
names, to copy the entire field name. Normally displayed parts of 
names can always be expanded by clicking the plus sign in front of 
them. By the way, sometimes bold displayed (parts of) field 

names can also be expanded. 

• Right-click a field in the Fields list and choose Properties in the 
pop-up menu that appears. In the opened window you can find 
the field properties. This is useful, for instance if you don’t know 
the type of a field, and thus which values you can search on. 

• If you mark the Show all non-indexed fields too checkbox (below 

the list), then from now on Adlib will also display all non-indexed 

fields in this list. You can search these fields too, it just takes 
longer because there is no index for the relevant field. (As a rule, 
a database only has indexes for fields in which users search fre-
quently: this is because having Adlib keep an index up-to-date for 
every field also has its disadvantages, like saving of records will 
take more time.) 
As soon as you mark this checkbox, Adlib will inform you that 

searching in non-indexed fields is slower. You may disable this 
message if you like, by marking the relevant checkbox in the mes-
sage itself. Adlib remembers these settings, even if you close the 
program, so the next time you open the Advanced search window, 

all fields will be displayed in the list. The non-indexed fields are 
coloured black. For these, it also applies that you can only double-

click bold black coloured fields, to copy the full field name to the 
search statement. 



Adlib User Guide Search methods 

 71  

6.3.2. ‘=’ operator 

The search language is used to ask questions about the contents of a 
field. For example, you may want to know what Rembrandt painted, 
or which titles contain the word dog. In general, you will want to 
compare the contents of a field with a value in a certain way.  

First, choose a field from the Fields list, for instance Author in the 
Books data source in Library. Then choose an Operator: you must 
indicate how Adlib is to compare the field with the value you have 
entered, for instance is. Finally, complete the search statement with 

the value with which you want to compare field values, e.g. Dickin-

son. If you do not keep to the syntax field operator value, Adlib will 

display an error message (see Figure 6.12). 

 

Figure 6.12: This search statement doesn’t comply with the required syntax. 
Create another search statement. 

For example, if you want to know for which records in an objects 
database the object name is equal to model, you can choose is from 

the Operator list or enter the ‘=’ sign yourself (or type equals instead 

of =). The full statement then becomes: 

object_name = model 

Put this query together in the Search statement entry field and press 
Enter or click the Search button, to execute the query. 

In the Set(s) list the search statement and its result will be displayed. 
(Execute yet another query and this search will be added to the list.) 
The number of records that satisfies the search criterion is displayed 

in the Hits column. In this example there are nine (see Figure 6.13). 
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Figure 6.13: A query has been executed. 

You can display the search result in a normal Brief display screen (or 

detail screen) by double-clicking the relevant set.  

A term which itself is registered including double quotes, for example 
“Marital happiness”, can be found by enclosing the search key with 
single quotes: '“Marital happiness”' or by truncating the search 

key, for instance: “Marital* 

Complete or partial search keys are allowed to end with a punctuation 
mark like e.g. a comma, colon, semicolon, hyphen and single or 

double quotes and can still be truncated. Put the search key including 
the punctuation mark in between double quotes to prevent syntax 
errors. The truncation character must also be placed between double 
quotes. 

Punctuation marks which appear separately (enclosed by spaces), 
somewhere in the text you are looking for in word indexed fields (like  
title and abstract), as well as one or more connected spaces, won’t 

be indexed, making it impossible to search for them using the  ‘=’ 

operator: use the contains operator instead.  

If in term indexed fields (like author.name, publisher and ob-

ject_name for example) only a punctuation mark appears and no 

other text, so just a hyphen or asterisk for example, then that charac-

ter will indexed as a term and you can search for it with the ‘=’ opera-
tor. To search for a single quote or hyphen you enclose it by double 
quotes. For  one double quote the opposite applies: enclose this char-
acter by single quotes. All text in a term indexed field will be indexed 

as a single term, so you can’t search on just a comma which may 
appear in between surnames and first names, for example. Punctua-
tion marks can still be part of the term you are searching for though, 

as long as you do enter a partial term from the beginning of the whole 
term. Partial search keys must be truncated explicitly with a * or /. 
From 6.6.0 SR1, search keys (terms and dates) as well as field names 
in which a hyphen (minus sign) or plus sign appears (enclosed by 
spaces or not) must always be enclosed by double quotes, otherwise 
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the hyphen will be interpreted as AND NOT and the + character as an 

AND operator. 

Truncation characters (* and /) may appear at the end of a term as 
well: see the paragraph Truncated and empty searching for more 
information about this. 

 Non-preferred term substitution and relational searching 

When searching a linked field in a CBF database, a non-preferred term 
in an advanced search statement will always be replaced (in the 
background) by its preferred term which will be used in the actual 
search. So it makes no difference if you search on the preferred term 
or on (one of) the non-preferred term(s) associated with it. In an Adlib 

SQL database, non-preferred term substitution will only take place if 
you’ve marked the Use relations checkbox. 

Besides non-preferred term substitution, Adlib can automatically 
search linked fields on narrower terms and terms which are equivalent 
to the search key or its preferred term. In CBF databases this happens 
automatically – so the Use relations checkbox will be greyed out here 
– while you have to mark it explicitly in SQL databases. Adlib will store 
this setting for next time. 

However, relational searching does influence the speed of searching: 
non-relational searching is just faster because you’ll only be searching 
on the entered term, nothing else. 

 Searching on multiple terms 

Another query might be: in which book titles do the words cup and 

saucer occur? Assuming that the field name is title, the question in 

the search language would be: 

title = "cup saucer" 

The words have to be embedded in double quotes to show that to-

gether they constitute the value to be searched. With the current 
statement we search for titles containing the words cup and saucer, 

in this case regardless of the order in which the words have been 
entered. That means that A saucer without a cup will be found as well. 
You can also search for terms that have quotes in them, e.g.: 

abstract = "Martin’s story" 

Every search key that is meant to be a partial key, must be truncated 
explicitly (also see the next paragraph), inside the double quotes. 
You can search this way on multiple terms in fields with a word index, 
like the title, abstract and notes fields: long text fields. 
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In term indexed fields (like author.name, publisher and ob-

ject_name for example) and in non-indexed fields you can search on 

multiple terms as well, but it works differently: the search keys which 
you enter between the double quotes cannot occur randomly in the 
field contents, they must be entered in the correct unbroken sequence 

and should start from the beginning of the field contents you are 
looking for. Moreover, only the last search key can be a partial search 
key: if the search keys together are not the complete field contents 
you are after – there may be trailing text – then you must always 
truncate the last whole or partial search key explicitly. 

 Truncated and empty searching 

Just like in the Query by form, there is no automatic truncation in the 

Advanced search. To truncate, you must use an asterisk (*) or a 
forward slash (/), for example: 

title = constit*  

This is also possible when you are searching for multiple terms in one 
occurrence of a word indexed field (also see the previous paragraph): 

title = "wom* dress" 

If slashes or asterisks literally appear at the end of your search key, 
like in http://, then the following rules apply: 
- If you wish to make a truncated search on a search key that ends 
on one or more literal slashes or asterisks, then you have to enter the 

other truncation character behind it, for instance: if you want to 
search truncated on http:/, you’ll have to enter http:/*, while for a 

truncated search on *1*2*, you must enter *1*2*/ . 

- If you wish to make an untruncated search on a search key that 
ends on one or more literal slashes or asterisks, then you have to 
double the final character, for example: if you want to search untrun-

cated on http://, you must enter http:/// . 

When, in Library you want to find out where there are empty author 
fields, then use the following query (without space between the double 

quotes): 

author.name = "" 

If you search this way in a repeated field which is part of a field group, 
you search for records in which all occurrences of the field are empty. 
The opposite, all author fields that are filled, can be found like this: 

author.name = * 



Adlib User Guide Search methods 

 75  

If you search this way in a repeated field which is part of a field group, 

then you search for records in which at least one of the occurrences of 

the search field is filled. 

 Dates 

Dates in the search language may always be entered as yyyy-mm-dd 
(ISO date format), regardless of the date type of the field. You may 

also enter a date in the format of the date type of the field: for exam-
ple, if the date type is “European date”, you may enter a date in the 
dd/mm/yyyy format or in the yyyy-mm-dd format. Always enclose a 
date by double quotes! (Right-click a field in the list to open the field 
properties, in which you find the date type.) 
The date type of a date field is the format in which the date is stored. 

For ISO dates, a presentation type may have been set as well, causing 

dates in such a field to be presented in European format for example, 
while they are stored as ISO dates. In the Advanced search you can 
search in differently presented ISO date fields in two ways, namely on 
ISO date and on the date in the presentation format. So, an ISO date 
field which has the European format as presentation format, can be 
searched equally well with ISO dates as with European dates. An 

exception to this rule is the ISO date with the Locale date (long) 
presentation format (with which days and months are written in 
words): these fields can be searched on ISO dates and on Locale date 
(short) dates only (your local format, the European format for in-
stance), not on Locale date (long) dates. So you can’t search these 

fields on, for example, "Wednesday 15 April 1970". 

 Numericals 

In the search language, numericals must be entered with the dot as 
decimal character, even if those numbers (e.g. monetary amounts) 
must be entered into fields normally using a comma (as could be the 
case in the Netherlands). For example: subscription_price = 80.50 

 Checkboxes 

If you want to search for marked checkboxes, then search on the 
letter ‘x’.  Fictive example: edited = ‘x’ 

 Using a prior search statement 

With the Copy button you can copy the search statements of one of 
the sets you have made (namely the selected set), to the Search 
statement entry field, for instance when you want to expand an earlier 

created query.  
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 Sorting a search result 

With the Sort button you can sort a set. See chapter 6.3.12 and 14. 

6.3.3. Other relational operators 

The searches described so far can also be carried out using the normal 
search screens. However, the search language offers more possibilities 
than normal search screens. In addition to the condition "is equal to" 
(= or equals) the search language offers the following equations: 

Equation   Operator/term 

Greater than  > or greater 

Less than  < or smaller 

Greater than or equal to  >= or from 

Less than or equal to  <= or to 

Contained anywhere in field _ (underscore enclosed by spaces) or 
contains 

Narrower   narrower 

Generic    generic 

Related    related 

All broader   parents 

Broadest   topterm 

 Contains 

The operator “contains” means that you want to search for the value 

anywhere in the field, e.g.: 

title contains and 

Adlib will search all titles for the letter combination and. So apart from 

the word “and” itself, words like hand, dandelion, and scandal will also 
be found. When you have a large database, this search will probably 

take a long time, because Adlib will go through all the records sequen-
tially, and cannot use an index. 

With contains you can also search on multiple words, but those 

words must be considered an unbroken search key. Suppose you want 
to find the following title: A brief history of Holland: from past to 
present in 100 pages. If you want to do that with contains, you can 

use search statements like the following, for example: 

title contains "history of Holland" 

title contains "past to present" 

title contains "ief hist" 
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Yet you can’t with a search statement like: 

title contains "history past" 

Instead of contains you should use the = operator if you want to 

search on random words in a word indexed field (like the title field). 

You can also search for spaces. If you want to know for instance, 
whether double spaces occur in titles, then search for two spaces by 

enclosing them in double quotes: 

title contains "  " 

If you place the double quotes in this example next to each other, 
without spaces in between, you search for records in which this field is 
empty. 

If you want to select all records in which a particular field does not 
have a certain value, then you might do that as follows: 

priref = * and not title contains bullet 

This query searches all records via the record number (priref) of 

which the title does not contain the word “bullet”. (Instead of priref 

you can also use the %0 tag.) 

The search term behind contains will automatically be truncated left 

and right. So do not use * or /. 

If you want to search for titles that contain an asterisk, enclose it in 

double quotes, for instance: 

title contains "*" 

Further, you can search on a single quote via for example: 

title contains "’" 

In the same way you can search for / or other special characters. The 
only exception is the double quote itself: you search on the double 
quote by enclosing it in single quotes, for example: 

title contains '”' 

For searching with contains it doesn’t matter if you search in word, 

term or non-indexed fields. So you can search with contains in fields 

like author.name too. 

 >, <, >=, <= 

You cannot always establish whether a field is greater than or less 
than a particular value you enter. For example, you cannot ask 

whether a title field is greater than a number, unless that number 
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relates to a number in the title. Use >,<, >=, and <= preferably for 

comparing dates or numbers, for instance: 

input.date from "2001-01-01" AND input.date to "2001-12-31" 

Note that in some applications, like Museum, there are fields in which 
you can enter a date  (complete or incomplete, and/or with text), 
whilst they aren’t date fields but text fields in the data dictionary. For 
these fields, this means you cannot properly search on dates using >, 
<, <=, and >=. You must search these fields like you search on text.  

 Narrower 

The narrower operator in the search language is for use in an authori-

ty file, or in a catalogue that is linked to an authority database 
through the field you are searching on. The authority database we are 
talking about are the kind in which terms can be defined hierarchical-
ly, via related terms; this will often mean the thesaurus. When you 
are searching using narrower, you search on a term and all narrower 

terms that may be defined for it. So on the title field you cannot 
search with narrower, but you can on e.g. keyword.contents (Library), 
object_name (Museum), content.subject (Archive), or term (Thesau-
rus), for instance: 

object_name narrower box 

This would retrieve all records with ‘box’ as object name but also all 
records with terms under ‘box’ (more specific than), for instance: 

 

Broader term  (Search) term Narrower terms 

Container  
  Box   
     band box 
     tool box  
     knife box 
     hat box 

     pencil box 
     shoe box 
 

In this example, records will be retrieved in which one or more of the 
above object names occur, except for Container because that is a 
broader term than Box, and narrower only finds the records with the 

term itself or with narrower terms. 
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 Generic 

The generic operator in the search language is for use in an authority 
database, or in a catalogue that is linked to an authority database 

through the field you are searching on. The authority database we are 
talking about are the kind in which terms can be defined hierarchical-
ly, via related terms; this will often mean the thesaurus. When you 
are searching using generic, you search on all one level broader terms 
of the search term and all narrower terms underneath them up to the 
lowest level, that may be defined for them. So on the title field you 

cannot search with generic, but you can on e.g. keyword.contents 
(Library), object_name (Museum), content.subject (Archive), or term 
(Thesaurus), for instance: 

object_name generic box 

 
Broader term  (Search) term Narrower terms 

Container  
  Box   

     band box 
     tool box  
     knife box 
     hat box 
     pencil box 
     shoe box 
 

In this example all records will be retrieved in which one or more of 
the above object names occur (broader and narrower). 

 Related 

The related operator in the search language is for use in an authority 

database, or in a catalogue that is linked to an authority database 
through the field you are searching on. The authority databases we 
are talking about are the kind in which terms can be defined hierarchi-
cally, via related terms; this will often mean the thesaurus. When you 
are searching using related, you search on the term itself and all 
related terms on the same level, as specified in the entry field Related 

term (in the thesaurus). So on the title field you cannot search with 

related, but you can on e.g. keyword.contents (Library), object_name 
(Museum), content.subject (Archive), or term (Thesaurus), for in-
stance: 

object_name related "orange juice" 

In this example all records will be retrieved that are related to the 
term ‘orange juice’, for example: apple juice or pineapple juice. 



Search methods Adlib User Guide 

 80  

 Topterm 

The topterm operator is for use in an authority database, or in a 
catalogue that is linked to an authority database through the field you 
are searching on. The authority database we are talking about are the 
kind in which terms can be defined hierarchically, via related terms; 
this will often mean the thesaurus. When you are searching with 

topterm, you search on the top most broader term(s) of all broader 
terms of the entered term, that may be defined for that entered term, 
or the term itself if broader terms aren’t present. So you do not 
search on the entered term, but on its broadest term(s), the so-called 
top terms; only if the entered term has no broader terms, the entered 
term will become the search term. So on the title field you cannot 
search with topterm, but you can on e.g. keyword.contents (Library), 

object_name (Museum), content.subject (Archive), or term (Thesau-
rus). With for instance: 

object_name topterm "pencil box" 

in the example below, you would retrieve all records with ‘Container’. 
If ‘Container’ would have an equivalent term, then that term would be 
searched on too. So when the search term has one or more broader 
terms, the search term itself is not searched on. (Duplicates will be 
removed from the search result automatically.) 

 
Top most broader term “Middle” term Narrower 

Container  

     Box   
      band box 
      tool box  

      knife box 
      hat box 
      pencil box 
      shoe box 
 

 Parents 

The parents operator is for use in an authority database, or in a cata-

logue that is linked to an authority database through the field you are 
searching on. The authority databases we are talking about are the 
kind in which terms can be defined hierarchically, via related terms; 
this will often mean the thesaurus. When you are searching with 

parents, you search on all broader terms of the search term (including 
the search term), that may be defined for it. So on the title field you 
cannot search with parents, but you can on e.g. keyword.contents 
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(Library), object_name (Museum), content.subject (Archive), or term 

(Thesaurus), for instance: 

object_name parents "pencil box" 

in the example below, would retrieve all records with ‘Container’, ‘Box’ 
or ‘pencil box’. If ‘Container’ and/or ‘Box’ have an equivalent term, 
then those/that term would be searched on too. (Duplicates will be 
removed from the search result automatically.) 
 
Top most broader term “Middle” term Narrower 

Container  

     Box   
      band box 

      tool box  
      knife box 
      hat box 
      pencil box 

      shoe box 
 

6.3.4. Tags 

Instead of selecting entire field names from the Fields list, or entering 

them into the Search statement, you can also type in Adlib tags, thus 
making your search statements shorter. Every field used in Adlib has a 
tag, a code consisting of two characters. If you do not know the tag 

for a certain field, you can access this in the edit mode of a record or 
in the Fields list in the search language. Place the cursor in the appro-
priate field, press the right mouse button and select Properties. A 

window displaying the field properties and tag will appear. For exam-
ple, the tag of the Books database author field is: au and of the object 
catalogue object_name field: OB. Tags are case-sensitive; so in search 
statements, type them exactly as they are defined in the database. 
The tags AS, OR and TO (also in lowercase) can only be used as tags 
if you enclose them in single quotes, e.g. 'to' = *, otherwise they’ll 

be interpreted as operators and a syntax error will be generated. 

Note: on the Link info tab in the Field properties window, long system 

paths appear not to be displayed completely, because they are cut off 

at the right edge. But when you hover the mouse pointer over a 
partially displayed path, a tool tip appears, showing the whole path. 
You can also click the path and then move the cursor to the beginning 
or end of the path, with the arrow keys. You cannot edit these fields. 
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6.3.5. Word and term indexes or whole record 

When you want to compare the contents of a field with a value, the 
type of index defined for this field is relevant. In the case of a term 
index, you must in principle enter the full term as the search key, 
because the index key is stored as a whole. For a creator field, that 
means Wheatley, Francis for example. If the index key contains 

spaces or a + or -, you must embed the key in double quotes. That 

can be rather laborious, considering that you could probably find what 
you are looking for with only the first couple of letters. For that rea-
son, Adlib offers you the possibility of truncating the search key for 
term indexes, for instance creator = wheat*. 

You can also apply this method to word indexes. Adlib will search on 

all words in the field, also on short words like articles and preposi-
tions. 

Adlib can search extremely quickly on (word or term) indexed fields. 

Searching on non-indexed fields is much slower. As an illustration, 
imagine searching for information in a book that doesn’t have an index 
or table of contents. If there is no index, Adlib has to read all the 
records in the database, and check whether they meet the condition. 
Searching with the contains operator also takes much longer than 
searching with the other above-mentioned operators. Incidentally, you 
can always interrupt a search by pressing any key.  

Note that in fields merged in with a linked field, a search can only be 

succesful if for the merged-in field there exists a term index (not a 
word index) in the linked database. If you try to search a word in-
dexed, merged-in field anyway, an error message will appear. 

In addition to the field names in your database, you can use the 
special field name record. This field does not occur explicitly in your 

database. It is a combination of all the fields in one record. You can 
use this to check whether a certain character string occurs somewhere 
in the fields of the record, for instance: 
record contains feast 

This is the most comprehensive but also the slowest way to search. 

There is also a statement for including all records in the data source in 
a set: ALL. This is a quick way to find out how many records there are 

in a data source. 

6.3.6. Domains 

In some authority database, such as the Thesaurus and Persons and 
institutions, data is specified in more detail by means of domains. A 
person in Persons and institutions for example, can in principle be an 
author as well as a translator, and author and translator can then be 
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defined as domains in that database. If the person is a publisher then 

that is a separate domain as well. In every term or name record, one 

or more domains can be linked to the term or name. 

If you want to search on a specific domain in the current database, 
then the search statement must be structured like this: 

Field_name operator domainValue::search_value 

It is necessary though that the field on which you search here is 
indexed (including the domains). Also note that not all fields on which 
you can search via the search language are indexed, but the fields 
with domains usually are. 

For example, if you want to search for all records in the Thesaurus of 

which the term starts with a “u” and is a place, then you will only want 
to search the place domain. This way, in principle you won’t find 

terms that are provinces or country names or other types of terms: 

term = place::u* 

Note that because a term can be linked to multiple domains, the 
above search can for instance also find the term Utrecht, which is 
indexed with the place domain as well as with the province domain. 

Technical information 

The domain names that you can use can be found in the database 

setup in Designer, on the Enumeration values properties tab of the 
domain field, in the Value column of the static enumerative list. This 
means you cannot (!) use the “translated” domain names that you 
also come across in the Term type drop-down list of a term record or 
Name type drop-down list of a name record, in edit mode. 

6.3.7. Sets and pointer files 

A set, as can be found in the bottom list of the Advanced search 
window, contains a search statement and the records (really the 
references to those records) which were found after the search was 
carried out; these results won’t be saved though, if you decide to 
continue working in a different dataset or when you close Adlib. In a 

so-called pointer file on the other hand, a search statement can be 
saved indeed, together with the record numbers of any records result-
ing from the search. Instead, you can also use a pointer file to store 
references to records that you selected manually (although in SQL any 
sorting applied to the search result will then be lost). 
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 Sets 

As you continue to enter search statements, the Set(s) list in the 
Advanced search window will fill up with more and more selections. 
Normally, Adlib will save these selections until you close the program 
or open a different data source. You can therefore still use the other 
search methods without losing your sets. You can delete individual 

sets by selecting a particular set and pressing the Delete key. 

To make Adlib run a search statement from a set in the list again, just 

select the set and click Copy to reinsert that query in the Search 
statement field; adjust the search statement as you please and then 
click the Search button to start the search process. If you are about to 
combine earlier executed search statements into a single compound 

search statement, you may refer to a present set via the following 
syntax to keep the new search statement succinct: 

set <number> 

Replace <number> with the number in front of the desired set. You can 

include these references in search statements, for example: 

(set 1 AND set 2) AND NOT object_name = auto* 

Here, set 1 and 2 must be present already in the Set(s) list. Execute 
the combined query and the resulting set will be added to the list. 

 Creating pointer files based on search statements 

If you’d like to save a set for another session, you’ll have to turn it 
into a pointer file: select the desired set and click the Write set button 

in the Advanced search window or in the Start menu.  

 

The Write results to pointer file window opens, in which you may 
specify the number of the pointer file to be created and a title for it 
(provide a clear descriptive title).  
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We recommend you just enter a title: when no number is specified, 

Adlib will automatically assign a number unique to the Adlib database 

(from Adlib 7.2 this will always be the lowest free pointer file number) 
so you can be sure no existing pointer file will be overwritten. 

If you enter a number anyway and it turns out to be the number of an 
existing pointer file, Adlib will ask you if the old pointer file should be 
overwritten. You can then choose to overwrite it with the new data 
(the old data in the pointer file will be lost partially or completely: also 

see the Visibility and divisibility of pointer files topic, further down in 
this chapter), or still assign a new number.  

Adlib will now store the original search statement in a pointer file (so 
that you may quickly execute it again at some future occasion), if the 

length of the search statement doesn’t exceed 4000 characters (also 
see the Maximum length of the search statement topic, further on). 
The full result of the search (consisting of references to records) will 

be stored in the pointer file too, regardless of the original length of the 
search statement. 

 Retrieving and displaying pointer files 

In Advanced search, click the Pointer files button to open the Pointer 

files window with a list of all available earlier stored pointer files. 
Which pointer files you actually get to see and whether you can view 
all referenced records or not, depends on your access rights, on the 
current dataset and whether you’re working on the SQL or CBF data-

base platform: for example, on SQL you will only see the pointer files 
which relate to the current dataset/data source, while on CBF you will 
see all pointer files within the Adlib database. (See the Visibility and 

divisibility of pointer files topic for more information about this.)   

The progress bar 

A window or tab with a pointer file list is already opened while the list 
is still being retrieved. During the build-up of the list, a progress bar 
will be displayed underneath it, which disappears as soon as the list is 
complete. You may select a pointer file or close the window or tab 
before the list has been completed. 

 

 
In the Pointer files window, double-click the desired pointer file to 

copy the set to the Set(s) list in the Advanced search window (if that’s 
where you came from). (If the Pointer files window is still open, drag it 
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to the side, if necessary, to be able to see the copied set in the Ad-

vanced search window.) So far the search statement that originally 

resulted in this set, is not executed again! When you double-click the 
set in the Set(s) list, Adlib will display the records that were found 
when it executed the search statement originally. This is a good 
method to display the results of time-consuming search queries again 
quickly, without having to carry out the search statement again. 

If you want to include the search result as stored in a pointer file, in a 

new search statement in the Advanced search, then in the Search 
statement field refer to the appropriate pointer file  like this: 

pointer <number> 

(For <number> enter the desired pointer file number.) 

You can also call up pointer files by clicking the Pointer files button in 
the Start menu which is active from Step 2 in the Search wizard or 
from a brief display or detailed display: 

 

If you then select a pointer file and click Select or press Enter, then 

Adlib will immediately show the records belonging to the selected 
pointer file. (This way you skip the Advanced search window.) 

If you don’t know anymore which pointer file contains your search 

query, then select a pointer file and click Properties. In the Pointer file 

properties window that opens, you’ll find the search statement for this 
pointer file on the General tab. 

Visibility and divisibility of pointer files 

In principle, a pointer file could reference records from different 
datasets of one and the same database, although this might get 
confusing for the average user. Moreover, Adlib applications which 
run on a SQL database deal with this issue differently than applica-

tions running on CBF databases. 

SQL: 

• In a dataset (a sub data source like Internal object catalogue or 
Books) you’ll only see a particular existing pointer file if it con-
tains references to records from that dataset: the Hits column for 
that pointer file only indicates the number of references to those 
records. So there may be more record references present in a 

pointer file than can be seen in the current dataset. However, in 
an all datasets encompassing data source like Objects or Library 
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catalogue you can see the total amount of record references con-

tained in a pointer file and which records they actually point to. 

• Since an existing pointer file will only show up in a dataset if the 
pointer file contains references to records from that dataset, 

there may exist other pointer files in the database which are just 
invisible here. For that reason alone it is usually not a good idea 
to provide a number for a new pointer file yourself, since num-
bers are unique per Adlib database, not per dataset. If you were 
then to also ignore the possible message that a pointer file with 
the entered number already exists (even though you don’t see 
it), then for a SQL database the pointer file won’t be overwritten 

completely, just the part relating to the current dataset: any rec-

ord references to other datasets will remain intact. 

• The options (Pointer files) Add and Remove, to add or remove 
manual record selections to and from existing pointer files, can 
only be used for pointer files which are visible in the current data 
source. If you never create or edit pointer files in the main data 
sources (you can switch this possibility off) and never use the 

improper way to overwrite existing pointer files from within the 
wrong sub data source, as described above, then on SQL you’ll 
only ever create or edit pointer files per dataset and you’ll never 
accidentally include record references from other datasets. 

CBF: 

• In each dataset of a database you’ll see all existing pointer files 

for the database, even if they contain some or all references to 
records from other datasets. The Hits for those pointer files al-
ways indicate all present record references. 

• If you create a new pointer file with an existing number, then the 
entire existing pointer file will be overwritten. It makes no differ-
ence from which dataset you are doing this. 

• You can add record references to a pointer file from within any 

dataset, but when you are trying to actually open a pointer file 
with references to records from different datasets, you’ll get a 
warning that not all record references relate to the current da-

taset and that now only records from the current dataset will be 
retrieved. 

It applies to both SQL as well as to CBF, that when you remove a 
pointer file, regardless of the dataset, you’ll always be deleting the 

entire pointer file (even if it contains references to records from 
different datasets). 
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 Sorting a pointer file 

If you’d like the records from a pointer file to be sorted automatically 
when you print them or list them in the brief display, then you should 
either include sorting instructions in the search statement itself before 
you create the pointer file (see chapter 6.3.12) or add sorting instruc-
tions to an earlier created pointer file. In the latter case you must 

select the desired pointer file in the Pointer files window and then click 
the Sort button at the bottom of the window. The Sort window will 
open, in which you can assemble the sorting instructions (see chapter 
10.2 for more information about that). The sorting instructions created 
this way will be added to (stored in) the pointer file: they will over-
write any earlier added sorting, even if it was part of the search 
statement itself. 

 Updating pointer files via Profile 

By clicking the Profile button in the Pointer files window, you instruct 
Adlib to carry out the search statement from the selected pointer file 
once more and to save the new, up-to-date search result in the same 

pointer file or in a different one. You’ll be asked under which title the 
current set must be stored. Usually you’ll leave the number and title 
as they are and click OK; subsequently a message appears which 
warns you that you are about to overwrite the existing pointer file, but 
that is usually fine too. 
If you are not looking to overwrite the existing pointer file but wish to 
store the search statement and the new search result in a new pointer 

file, then preferably empty the Pointerfile number field (so that Adlib 
can assign an available number for you) and enter a suitable title in 
the Pointerfile title field, before clicking OK. 

Note that a pointer file can only be profiled or executed again in the 
Advanced search if the field names in the search statement are field 
names in the current interface language or the English names, other-
wise you’ll get an error message saying that a field name cannot be 

found. Moreover, you can only profile pointer files which are based on 
a search statement: manually selected pointer files (see next para-
graph) cannot be updated this way. 

To quickly execute a search statement from a pointer file via the 

Advanced search again and have the new search result available in 
the Set(s) list immediately, while the pointer file itself remains un-

changed, you can enter a search statement with the following syntax: 

profile <number> 

(For <number> enter the desired pointer file number.) 
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Maximum length of the search statement 

If your application runs on an Adlib SQL database, you’ll have to take 
into account that there exists a limitation on the length of search 

statements which can be stored in a pointer file: a search statement 
must not be greater than 4000 bytes. Depending on the character set 
you are using and the characters which occur in the search state-
ment, this comes down to 4000 characters or less. This limitation 
does not apply to pointer files for CBF databases. 
In a pointer file, search statements consisting of more than 4000 

characters will be cut off at 4000 bytes. If this happens, the remain-
ing broken search statement will be marked with /* to make the 
pointer file non-profilable (as other hand-picked sets can’t be updated 

either: see next paragraph). The set of record numbers which is 
stored in the pointer file too, is of course the result of the original, 
intact search statement. 

 

 Creating pointer files based on manual record selections 

From the Brief display screen, you can save a manual record selection 
as a pointer file, although in SQL any sorting applied by you then 
won’t be stored in the pointer file. In the Brief display of a search 
result – it is irrelevant how that search result came about – mark the 
records that you want to store in a pointer file together and click the 

Write set button:  

 

This button becomes active when you have marked one or more 
records; only the marked records will be saved in the pointer file (not 
the records themselves actually, but references to them). However, 
you cannot use the Profile command on such pointer files, because 
there doesn’t exist any search statement which can be stored when 

you’ve selected records by hand.  

The difference between this method of saving a pointer file and point-

er files based on a search statement can be seen in the Pointer files 
window: for manually selected pointer files, the Profile button is 
greyed out and in the properties of such a pointer file you can see that 
its “query” starts with /*. 
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 Saving empty pointer files 

Empty pointer files can be saved in the following two situations:  

• Whenever you enter a search statement in the Advanced search 
window and execute it, and no records are found, you’ll still be 
able to save the resulting set as a pointer file. 

• When a Profile of an earlier saved pointer file yields no records 

(this time), you can save the new result in the pointer file anyway. 

So in both cases, after saving the pointer file, it will only contain the 
search statement, and no references to records. This way, you can 
update your pointer files and save them again whenever you want to, 
even for an empty search result. And you can preserve the search 

query. 

 Adding records to existing pointer files 

You can add a selection of records to existing pointer files: 

1. In a search result, mark the records you want to add to a pointer 
file. 

2. Click the Add button in the Start menu. 

 

 

3. In the window that opens, select the desired pointer file and click 
the Add button. 
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Instead of adding the marked records to an existing pointer file, you 

may still choose to save the record selection in a new pointer file, 

from within the Add to pointer file window. To do so, click the New 
pointer file button; subsequently provide a title and possibly a number 
for the new pointer file, as usual. 

Another way of adding records to an existing pointer file is the follow-
ing: you can drag one or more thumbnails from the Thumbnails and 
Filmstrip tabs to a pointer file in an opened Pointer files window, to 

add the relevant records to the pointer file. You may even create a 
new pointer file this way. 

1. Make sure that a search result is present in the brief display and 
that you have opened the Pointer files window. 

2. Select one or more thumbnails of records you wish to add to a 
pointer file, on one of the Thumbnails and Filmstrip tabs. It con-
cerns selected records here, not marked records: one way to se-

lect records would be to Ctrl+click the desired thumbnails (see 

chapter 9 for more information about that). 

3. Click one the selected thumbnails again, keep the mouse button 
pressed down and drag the mouse pointer to the desired pointer 
file. The mouse pointer changes into an arrow accompanied by a 
plus sign. 
 

 

4. Release the mouse button. The standard window for the writing of 
a pointer file appears. Now you can do two things: 

 
a. accept the pointer file number and click OK the append the se-
lected records to the existing pointer file. Any records already pre-
sent will be retained. (Selected records which already occur in the 

pointer file, won’t be doubled.) Before you click OK, you can still 
change the title if you want. 
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b. you can remove the pointer file number or change the pointer 
file number to a number that does not exist yet and also change 
the title. This way you’ll create a new pointer file based on the 

pointer file you initially seemed to want to overwrite. For example: 
suppose you have a pointer file 3 pointing to 9 records; then you 
add 2 records, but before saving you change the pointer file num-
ber to 4 (and you also change the title); now a pointer file 4 will 

be created, pointing to 11 records, while pointer file 3 remains un-
changed. 

Further keep in mind that existing pointer files which are based on a 
search statement and which therefore can be updated automatically 
using the Profile button, can no longer be profiled after manually 
adding records. 

The dialog for adding records will not close automatically since you 

might want to continue adding records to other pointerfiles. 

 Removing records from existing pointer files 

You can delete a selection of records from existing pointer files: 

1. In a search result (e.g. the relevant opened pointer file), mark the 

records you want to remove from a pointer file. It is not a problem 
if records are marked which do not occur in the pointer file. 

2. Click the Remove button in the Pointer files section of the Start 
menu. 
 

 

3. In the window that opens, select the desired pointer file and click 
the Remove button. 
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The dialog for removing records will not close automatically since you 

might want to continue removing records from other pointerfiles. 

 Other possibilities of the Pointer files window 

In the Pointer files window you can decide if that window must remain 
open after you’ve opened a pointer file or if it should close automati-
cally. To this end, a pushpin icon is present in the lower left corner of 

the window. Click the pushpin to switch between the two modes: blue 
means pinned down, grey means unpinned. Adlib stores your setting 
for next time. 

 

A pinned Pointer files window remains opened after you’ve chosen a 
pointer file and remains opened until you close it manually or until you 

start editing or outputting marked records in some way. The window 
closes automatically as well when you return to Step 1 of the Search 

wizard. Still, in detailed or brief display, amongst others, you can 
leave the window open, for instance to be able to quickly view several 
pointer files, one after the other. A pinned window can be closed 
manually via the Cancel/Close button or via the white-red cross in the 

upper right corner of the window. 
Preferably drag the Pointer files window to an unused spot on the right 
side of the Adlib window, so that it doesn’t cover other dialog windows 
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or data from the record. Adlib will remember the current position of 

the Pointer files window for next time. 

The Pointer files window can be resized by dragging one of the edges. 
You cannot make it less wide than the length of the row of buttons. 

 

The columns themselves can be made wider or narrower too, by 
dragging a column separator to the left or right. This might be handy 
for the Title column, for example. 

 

You can sort the list of pointer files at will by clicking one of the 
column headers, like Title or Owner, once (for an ascending sort) or 

twice (for a descending sort). 

When you click the Properties button, the Pointer file properties 
window opens. 
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Technical information: pointer file properties 

In the Pointer files window, select a pointer file and click the Proper-
ties button to open the Pointer file properties. On the General tab you 

can find some general information about the pointer file. A Search 
statement will be displayed only if you didn’t create the record selec-
tion manually. 

 

In the Owner box on the Access rights tab, you can choose who is 
allowed to set or change access rights for this pointer file, if you 
created it yourself: you can leave your own name or select a role 
from the drop-down list – the drop-down list contains all roles availa-

ble to users of your application (as defined in the .pbk). The ad-
vantage of a role as the owner is that when you change employer, 

your pointer files can at least still be edited by co-workers with the 
proper role. 
The Add, Remove and Edit buttons can be used by the owner to 
assign or edit access rights to all other roles, or to remove access 
rights. If a certain role is not listed underneath Access rights, then 
users with that role have have full rights to the pointer file by default. 
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The owner can assign any of the following rights to a role here: None, 

Read, Read/write and Full. Only with Full access rights can this point-
er file be deleted by another user; to update the record selection in 
this pointer file, a user needs Read/write access rights, while None 

access rights makes the pointer file invisible to users with the rele-
vant role. 
By the way: the Edit role window, and with it the Role drop-down list, 
is resizable by dragging the right edge of the window. 
The access rights mechanism for pointer files works on CBF as well as 
on Adlib SQL and Oracle databases. 

 

To base an SDI profile on a pointer file (see chapter 17 for more 

information) or to view the properties of an existing SDI profile, you’ll 
have to open a separate window called Scheduled searches. You can 
only open it by right-clicking the desired pointer file, to select Sched-
uled searches in the pop-up menu. (The Properties option opens the 
normal pointer file properties.) 

 

6.3.8. Combined searches  

You may wish to combine conditions. For example, to search for all 
oil paintings done on panel or for all paintings by Fuseli. In 

Adlib, you can combine two or more conditions by entering them with 
a command in between to state how you want to combine them (with 
Boolean operators, see chapter 7). If you want both conditions to be 
met, put AND between the conditions. If it is sufficient that one of the 

conditions is met, though they may also both be true, then you can 

connect the conditions with OR.  

 Sets 

To combine conditions, you can first enter the two conditions sepa-
rately. In Museum for example: 

object_name = "oil painting" 

material = "oil on panel" 
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This results in two sets. When you combine sets, you are actually 

constructing a new search statement, after which this can be execut-

ed. The result is put in a new set.  

Let’s take the above example. You could combine the conditions with: 

set 1 or set 2 

(You can choose the Boolean operator from the list with the same 
name, but you can enter it by typing too. It’s not important whether 
you type Boolean operators in upper or lower case.) 

You would then get a list of all oil paintings and objects for which the 
material is oil on panel, and all oil paintings for which the material is 

oil on panel. To only find all oil paintings on panel, your query must 

look like this: 

set 1 and set 2 

In the Set(s) list, you will see that Adlib automatically translates the 
combinations with 'set' into combinations with the worked out condi-
tions. You can also use this way of entering combined searches, but 
combining sets is quicker. 

 The + -  , operators 

Instead of the words AND and OR, you can use a plus sign (+) or a 
comma (,) respectively. A - sign (with or without spaces on both 
sides) can be used instead of AND NOT. This is useful only if you are 

searching for multiple values in one field, for example: 

author = smi* + smy*  is the same as: 

author = smi* AND author = smy* 

and 

author = smi* , smy*  is the same as: 

author = smi* OR author = smy* 

 AND NOT (NAND) 

In addition to AND and OR, you can combine sets with AND NOT. Such 

‘negative’ selections cannot be achieved with single searches. For 
example: 

NOT author this won’t work because Adlib will read 

NOT as a field name. 

author = NOT smi* this is not permitted either, because 

Adlib will read NOT as an author’s sur-

name, i.e. as a field value.    
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So, in negative combined searches you use AND NOT or NAND  (which is 

the same as AND NOT). In this way, you indicate that the first condi-

tion must be true and the second false. For example: 

author = woolf* nand title = mrs 

With this you will find all books by Woolf in whose titles the word 
“Mrs” does not occur. 

all nand author = "" 

Adlib will now look for all fields in which the author field is not empty. 

 Nesting queries 

If you use multiple Boolean operators within one search, you must use 

parentheses to specify the order in which the search is to be carried 
out. The partial queries within the innermost brackets are carried out 

first, after which executing expands outwardly, step by step. For 
example: 

author = woolf* AND (title = mrs* OR title = lighthouse*) 

Adlib will first carry out the part between brackets, the OR combina-

tion, the result of that is then combined with the part in front of AND. 

The next example is simply carried out from left to right. Do note that 
the order is important because different orders may yield different 
results. 

title = mrs* OR title = lighthouse* AND author = woolf* 

6.3.9. Special syntax 

 Today 

Today represents the date of today, and can be used as a quick meth-

od of indicating that you want to search for all records that have been 
made today. This is especially useful in pointer files that need regular 
updating, since it will always take today’s date rather than the date 

originally entered into the query. For instance,  

input.date = today 

would retrieve all records input today. It is also possible to retrieve 
records at a set distance from today, by subtracting or adding the 
number of days. For instance:  

input.date = "today-30" 

would retrieve all records input thirty days ago.  
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To retrieve records input in the last month, enter: 

input.date from "today-30" and input.date to today 

Note that although it may be tempting to shorten this search state-

ment to input.date from "today-30" (which Adlib translates to 

input.date >= "today-30"), this shortened search statement only 

yields the same result if this field cannot contain future dates. This is 

probably the case in the current example, but not for delivery dates, 
for instance. Therefore, it is wiser to use the combined search state-
ment since it makes the search much more precise. It also makes it 
easier to construct alternative search statements, like: 

venue.date.start from "today-15" and venue.date.start to 

"today+21" 

By the way, you can only search a field on today if the field is a date 

field (ISO date or European date). The field doesn’t need to be in-
dexed for this, yet if it is, the index type is irrelevant. 

 All 

All will retrieve all records. It is the only exception to the rule that all 

search statements must consist of field operator value. 

 Record 

Record is a special field name. It is generally used in conjunction with 

a contains search. For instance: 

record contains smi 

Adlib will search (automatically truncated) every field of every record 
and retrieve all records where the character string smi occurs in any 

field. 

 %0 

This is the tag for the primary reference number of a record, the 
record number; instead, you can use priref as well.  

 Expand 

Suppose you have a database with a hierarchical structure, an archive 
for instance, and you would like to be able to execute searches with 

which you hope to find not only a single specific record but all underly-
ing records as well. 
From Adlib 7.3 you can do so with the expand operator which can be 

used in advanced searching and fixed queries. The syntax is as fol-
lows: 



Search methods Adlib User Guide 

 100  

expand(<search statement>) 

Take the hierarchy in the screenshot below, for example. If you’d like 
to retrieve the record with reference BW/GG/M and all underlying 

records (child records, grandchild records, etc.) by searching on the 
terms minutes board committees from the title, then execute the 

following search statement: 

expand(title = 'minutes board committees') 

 

However, the expand operator does need an index on the link refer-

ence tag for the broader term field to function and many applications 
do not have that yet. If you execute an expand search statement and 

the error message below stops you in your tracks, you’ll know what 
time it is. It’s easy to fix the problem though, by actually creating the 
relevant index, if Adlib Designer is at your disposal. The error mes-
sage already indicates for which tag an index must still be created: in 
the example below that’s tag 1l but in your case another tag might be 

applicable. (If required, see chapter 1.14 in the Adlib 7.3 release notes 
for a step-by-step instruction.) 

 

 

http://www.adlibsoft.com/support/manuals/release-notes/release-notes-73
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6.3.10. Searches in repeated and grouped fields 

You can use the operators WHEN and WHEN NOT with grouped and 

repeated fields. WHEN is an AND operator which says that the two 

entered values must be found in the same occurrence. 

 Combined searches in repeated fields 

Copy_number in Library is a repeated field. When searching in repeat-

ed fields, a combined search like:  

copy.number > x AND copy.number < y 

yields different results than you might expect. All records with at least 
one copy number greater than x and one copy number less than y will 

be found. This is because the system looks at the copy number value 
at record level.  

If you want only records to be found for which one copy number value 
is both greater than x and less than y, you will have to use the WHEN 

operator: 

copy.number > x WHEN copy.number < y 

This will produce all records with at least one copy number value 

between x and y. 

 Combined searches in grouped fields 

The Creator (Maker) field in Museum is grouped with the creator.role 
(Role) field. M.C. Escher is the engraver of some engravings and is 

also the printer of some other engravings. If you want to select the 
engravings for which Escher was the printer, than use the following 
search statement: 

creator = escher* WHEN creator.role = printer 

So WHEN doesn’t necessarily have to be used in a query with only one 

field. It’s possible to compare values in different fields too, and com-
bine queries as long as those fields are grouped, and this is carried 
out per occurrence: in a WHEN combination two simple queries are 

repeatedly combined for the nth occurrence of both fields in those 

queries. 

If there are an unequal number of values on both sides of the WHEN, 

the last value from the shortest list will be used again: 

creator=escher*,anthonisz* WHEN 

creator.role=printer,artist,engraver 

is the same as: 
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(creator = escher* WHEN creator.role = printer) OR (creator 

= anthonisz* WHEN creator.role = artist) OR (creator = 

anthonisz* WHEN creator.role = engraver) 

 WHEN NOT 

WHEN NOT works in the same way as WHEN, only here, the first value 

must and the second must not occur in the same (group) occurrence, 
for instance: 

creator = escher* WHEN NOT creator.role = printer 

This query returns all objects that contain occurrences of Escher as 
creator where the corresponding role is not ‘printer’, even if the record 
contains another occurrence of Escher as creator where the corre-

sponding role is ‘printer’. 

Limitations of WHEN and WHEN NOT 

WHEN or WHEN NOT can only appear once in a search statement, like 

in the syntax: <equation> WHEN (NOT) <equation>. It is not possi-

ble to combine more than two equations via multiple WHENs. Not 
even by using sets, because a set only stores a list of found records, 
not information about which occurrence caused a record to end up in 
the result set: so by definition, sets cannot sensibly be combined with 
WHEN (NOT). 
Also, you can’t use hierarchical operators, like narrower, in combina-

tion with WHEN. 

6.3.11. Language specific searching 

In Adlib applications which run on (XML) multilingual Adlib SQL or 
Adlib Oracle databases, you can not only enter data in multiple lan-
guages, but also (optionally) search for that data per language via the 
search language by providing a language code behind the field name. 
With the Search wizard and Search by form you search all languages 

together. 

The syntax is as follows: 

<tag or field name>[<language code>] = <search value> 

In the ribbon, click View > Info to find out what type of database(s) 
are employed, and from the active Data language button in the Edit 
menu you can tell if your application is multilingual on data level and 
which languages are available. The database type and the language 
code of the current data entry language (that you chose via the Data 

language button), can also be seen in the status bar: 
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It is these language codes that you can use for language specific 
searching via the expert search language. 

Examples of search statements in the search language: 

title[en-GB] = "house*"  

Meaning: search the English area of the title index for words 
that start with house. 

title[it-IT] = "casa*"  

Meaning: search the Italian area of the title index for words 
that start with casa. 

If you do not provide a language in the search statement, like you 
normally would, then Adlib will search all languages in the relevant 
index. 

6.3.12. Sorting in the search statement 

In principle, you can sort search results (also pointer files and sets) 
after carrying out a search statement: when you construct the search 
statement you don’t have to take sorting into account. How this way 

of sorting a search result works, will be discussed in chapter 14. 
However, it’s also possible to add a sort command to the end of the 
search statement itself, so that the pointer file you want to create is 

already sorted the right way. In Library you could search and sort as 
follows, for instance: 

title = arc* sort author 

The records found, will be alphabetically sorted on author in the re-
sulting set. 

You can sort on more than one field too, by listing the sort fields (in 
the desired order of sorting) behind sort, separated by commas. For 

example: 

title = arc* sort author, title 

 Ascending or descending 

A sort carried out in the above method is automatically in ascending 
order (alphabetically this would be a-z). If it is required to reverse the 

order, you want to sort descending, e.g.: 

title = arc* sort author descending 
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When sorting ascending, records in which the field to be sorted on is 

blank will appear first in the list. 

 Sorting types 

Since there are different types of fields there are different types of 
sorting. The default sorting is sorting on the searched term. Unless 
otherwise stated all sorts will sort alphabetically (as text) on the whole 

term. When you want to sort on fields that contain dates or numbers, 
you should use the parameter date for sorting on date, and the pa-
rameter numeric for sorting on numbers, e.g.: 

input_date >= "2001-01-01" sort input_date date 

or 

number_of_images > 1 sort number_of_images numeric 

If you would sort date and numerical fields as text anyway, then 111 
would come before 2, and 01/06/2001 before 02/01/1970, which is 
probably not what you want. 

 
Alphanumerical sorting is possible as well, for example: 
 
object_name = * sort 'object_number' alphanumeric 

 
For more information about these sorting methods, see chapter 14. 

6.3.13. Sampling search results 

You can let Adlib select a random set of records from the search 
results. In the Search statement you have to indicate how many 
randomly chosen records you wish to reduce the total search result to. 

The random command must be added behind a search statement, and 

has the following syntax: 

random <number> [seed <seed number>] [unique] 

1. Replace <number> by an actual number to provide the maximum 

number of records you want the search to yield. 

2. The <seed number> is optional. When randomly selecting records 

from the total search result, Adlib implicitly uses the current date 
and time as seed number to calculate a “random” number. Strictly 

speaking, a computer cannot generate really random numbers, 
but if the user has no control over the seed number then the se-
lection does appear random to human users. A seed number gen-
erated by Adlib will automatically be added to your search state-
ment. However, you can influence the calculation of the random 
number by providing a seed number yourself. Precede a seed 
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number by the reserved word seed. Each time you enter this 

search statement with the same seed number, the same search 
result will appear; only without seed and seed number, the search 

statement will yield a different result every time it is executed. 

3. The reserved word unique is optional and with it you indicate that 

you wish to see each record in the randomly chosen search result 
only once. If you leave out unique, then it’s possible that the 

completely random selection of records yields the same record 

more than once; moreover, if the total search result is smaller 
than the provided <number> then records will definitely occur more 

than once. With unique the randomized search result can never 

be greater than the total search result. 

Extra functions in a search statement, for example to sort and/or print 
the search result, but also the randomize function, are optional of 
course, but have to appear in the search statement in a particular 
order when you do use them. They will be executed in that order as 
well:  

<search statement> [random] [sort/adapl] [print] 

Examples: 

all random 10 unique print MyOutputformat 

title = a* random 5 seed 82 sort author descending 

6.3.14. Using an adapl 

To further limit a search result and/or to process fields before the 
search result is presented (possibly sorted), you can use adapls in the 
search statement. (Adapls are small programs in Adlib’s own pro-

gramming language ADAPL.) By default, there are no select/sort 
adapls present in Adlib, but in customized applications the possibility 
exists; your application manager should be able to tell you about it.  

1. When you don’t want to sort, but want to limit a search result via 
an adapl to records that meet certain conditions (through a 
SELECT NO statement), then refer to that so called select adapl as 

follows: 

 
<search statement> adapl <adapl name> 

 
for example: all adapl MySelectAdapl 

 
The adapl must be located in the folder that holds the application 
in which you are currently working. 
See the Designer Help for an example (search the relevant topic 

http://documentation.axiell.com/alm/en/index.html?ds_adaprogramminginstructions.html#statements


Search methods Adlib User Guide 

 106  

for “findmultipleoccs”) of an adapl with which you can look up all 

records in which a field has two or more filled-in occurrences. 

2. When you do want to sort, but on a field that you want to edit 
through an adapl first, then refer to that so called sort adapl as 
follows: 
 
<search statement> sort <tag> adapl <adapl name> 

 
for example: all sort xx adapl MySortAdapl 

 
The adapl must be located in the folder that holds the application 

in which you are currently working. 
”Sort adapl” might be a confusing name, because the adapl itself 

does not sort anything: it’s just used in combination with a sort in 
the search statement. You can do two things in a sort adapl: just 
like in a select adapl you can remove certain records from the 
search result through the SELECT NO statement, but you can also 

process fields, by merging them, or something like that. Then use 
the tag of the field that is the result of that processing, to sort on. 
In the example above that is the fictitious tag xx. This may be a 

temporary field for instance. 

Note that first the adapl is executed for each record, and that only 
after that, sorting on the provided tag takes place. 

6.3.15. Printing 

Normally, to print one or more records following any type of search, 
the records must be marked and then the output format must be 
chosen. However, it is also possible to print all the results of a search 
by just using the search statement and an adapl.  

At the end of the search statement, type the print command and the 

name of the print adapl to be used, for example: 

object_name = shopping* print object 

This will print a list of all records in which the object name starts with 
“shopping”. 
You can only use this method of printing if you know the names and 

function of the print adapls. You can find the possibly usable output 
formats (print adapls) via the definition of the data source in which 
you are currently working, in the application setup of Adlib Designer 
(see the Designer Help for more information). 

The printout will go to the default printer for your PC. 

http://documentation.axiell.com/alm/en/index.html?ds_appspropertiesoutputjobs.html
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6.3.16. Reserved words 

If you use a field name or tag in your search statement, which hap-
pens to be identical to one of the reserved words in the expert search 
language – these are words which already have another function – 
then you’ll receive a syntax error. The solution is to enclose the rele-

vant field name or tag by single quotes, and re-execute the search 
statement. 
The reserved words (in capitals and lower case) are the following: 
greater, smaller, from, to, contains, narrower, generic, related, par-
ents, topterm, as, or, and, not, set, nand, pointer, profile, today, all, 
record, when, sort, descending, date, numeric, adapl, print. 
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7. Combined searches 

Abstract 

You can combine the search result of the previous search with a new 
search task in the Search wizard. Use the Boolean operators AND, OR 
or NOT in the Refining section of the Start menu for reducing or 

expanding the current search result: 

   

After choosing a combination option, the access points menu in the 
Search wizard opens again. From there you put together the second 
search. 
In a Search by form or in the Advanced search, combining is done in 
a different way (7.2). 

 
You can combine a search result with a new search by choosing one of 

the available Boolean commands from the Start menu in a brief dis-
play screen or a detailed presentation screen. 

When combining is allowed in your application, there are three possi-
bilities to combine the result of a search with a new search, namely 

the Boolean operators AND, OR and NOT. Use these functions in the 
Start menu or the buttons with the same name, for reducing or ex-
panding the current search result. 

 
AND reduces the current search to records that also contain the 
new search key to be entered. The result will therefore be 
smaller.* 

 
OR expands the current selection with other records that con-
tain the new search key to be entered. The result will therefore 
be greater.* 

 
NOT removes from the current selection all records that contain 

the search key to be entered. The result will therefore be 
reduced.* 

 

* if the new search does not result in any reduction or expansion of 
the number of records, the result will, of course, stay the same and 
the current selection will remain in place. 
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7.1. Combining via the Search wizard 

An example: a search on the title word work has resulted in seven 

records. 
If you choose AND, OR or NOT, the access points menu in the Search 

wizard opens again. You may choose a new access point and enter the 
search key for it. The application builder can determine whether 
during combining a pick list of full index keys will be displayed or not. 

If you carry out an AND action with this example, on author names 
beginning with W (author = w, and use All keys), two records will 

remain: the record for which the word ‘work’ appears in the title and 
for which the author’s name starts with a ‘w’, in this case Handbook of 
work and organizational psychology edited by a/o Charles J. de Wolff, 

and Working with objects by a/o P. Wold.    

If you use OR for a combined search on authors that start with a ‘w’, 
then all records that have an author with a ‘w’ are added to the selec-
tion. In this example this results in 15 records. 

A NOT combination on authors whose names begin with ‘w’ results in 
such authors being removed from the previous selection. There will be 

five records left, from authors whose name doesn’t start with a ‘w’ 
(but who have written a book with ‘work’ in the title). 

If you return to the access points menu in the Search wizard with 
Back (not after combining) you will lose the selection you achieved by 

combining. 

After combining, you will see a brief display with the results of the old 
and the new searches together (or you will go directly into a detailed 

display screen if there is only one record). By combining again you can 
adjust the search result further, if you wish. 
If Adlib does not find any records after a combined search, a message 
will appear and Adlib will keep the result of the previous search. 

7.2. Combining in a search form 

If you enter more than one value in a field by adding occurrences, 

then Adlib will create an OR relationship between these values. If you 

enter values in different fields, Adlib will create AND relationships 
between the terms. In special cases, a WHEN relation might be appli-
cable as well: see chapter 6.2 for more information about this. 
In fact, you now use one complex combined search, while through the 
Search wizard you combine two separate searches. If you only use 
Search by form, then in principle you don’t have to use the And, Or or 
Not buttons. 
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7.3. Combining in the search language 

The Advanced search (the Adlib search method for performing com-

plex searches with literal Boolean operators) allows you to also com-
bine sets (selections of records) and pointer files (saved searches) 
with Boolean operators, by explicitly typing these in the Search state-
ment. (Sets and pointer files are discussed in chapter 6.3.7.)  
Here, you can always execute one complex combined search, and 
even include results from previous searches in the shape of sets and 
pointer files, if needed. 

7.4. Combining through different search methods 

You can also make combinations using different search methods*. For 
instance, use a combination of an access point and a search form. For 
this, search for records with the desired access point in the Search 
wizard, then click the And button and open Search by form in which 
you enter other keywords. 

* (Primary) searches in the Search wizard or Search forms can not be 

combined with (secondary) searches in the Advanced search. 
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8. Presentation screens and buttons 

Abstract 

The list screen, aka Brief display screen (8.1), shows the list of 
found records (the search result), with or without miniature images. 
Of each record some data is presented. If thumbnails are available, 

the three available screen tabs offer different presentations of the 
record list. The Thumbnails tab shows the list as a table of thumb-
nails, while the Filmstrip tab presents the miniature images in a row, 
with an enlarged version of the selected miniature right above it. 

In the list display there are several functions at your disposal (page 
116). For instance, you can mark records in order to print them 
together, to save them in a pointer file or to delete them all. In 

marked records it is also possible to semi-automatically search and 
replace specific data.  

      

Further, you can change the order of the records by sorting the list. 
Double-click a record to show it in detail. 

The detailed presentation (8.2) of a record is spread out over 
multiple tabs (screens). Which data and screens will be displayed, 

and which screen first, has been set per access point by the applica-
tion manager. You can navigate between the screen tabs by clicking 
the tabs.  
Sometimes, a value on a detailed display is underlined (8.2.1). Mostly 
this is a reference to the linked record for that term or name in the 
same or another dataset/database (an underlined file name however, 
is a link to an external document or other file). You may click such a 

link to display details of the relevant term or name record, as they 
are registered in the linked dataset/database. The linked record will 
be opened in a separate, so-called zoom screen if that record is 
located in a different database (like a Thesaurus), while a linked 
record from the current database will be presented in full detailed 

display (instead of the currently opened record). If, in the second 
case, you want to return to the previous record, you will have to click 

the mirrored link.  
In the detailed display there are several functions at your disposal 
(8.2.2). For instance, you can navigate to previous and following 
records, edit the record and save the changes, copy, remove or print 
the record, or add the record to a pointer file. 
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In detailed display you can hide any unused screens via the View > 
Select screen tabs menu (8.2.3), until you decide differently. Your 
settings will be saved for next time.  
Sometimes screen tabs or fields are automatically hidden or displayed 

as soon as you enter a certain value somewhere: these are so-called 
conditional screens/fields (8.2.5). You won’t see this in standard 
applications yet. 
In some applications, images, movies or music files can be linked to 
records. When a record contains one or more media files, those 
images will automatically be shown in a separate window, called the 

Media Viewer, during the detailed presentation of a record (8.2.6). If 

multiple media files have been linked to the record, you can display 
them in succession using the arrow buttons in the Media menu, or 
use the Thumbnails and Filmstrip tabs in the Media Viewer for an 
overview. 
Further, you can resize the Media viewer or make it visible on every 
record detail screen, and zoom in on the current image or print it. 

   

Right-click an image to open a list of properties (EXIF metadata) of 

the image (page 133). 

8.1. List screen (Brief display) 

The Brief display screen (or list screen) shows a list of retrieved rec-
ords, with or without miniature images, dependent on your application 
(see Figure 8.1). 

In here, each record has one or more lines with data. For each access 
point, the application builder defines which data from the records is to 
be used for this brief presentation, how many lines are allocated for 

each record, and the sorting criteria for the list. By default, the list 
screen is sorted ascending on the field you searched. 

The main purpose of the brief display is to present the current search 
result as a list of records. You can double-click either the text or the 
image of a record to view the detailed display of that record.  

If the selected key only occurs in one record, the brief display is 
skipped and you go straight to the detailed display. The application 

builder, however, may set the application in such a way that when 
only one record results, the brief display still appears first. 



Adlib User Guide Presentation screens and buttons 

 115  

 

Figure 8.1: An example of a list screen. 

Besides the tab for the brief display, there are two tabs called Thumb-
nails and Filmstrip when miniature images are shown in the brief 
display. The tab Thumbnails shows all thumbnails from the list in a 
table, to present a quick overview. Select one of the miniature dis-
plays and press Enter to open the detailed display of that record. The 

tab Filmstrip shows the miniature images in a row, with an enlarged 
version of the selected miniature right above it; so you do not have to 
first open a record before you can view an enlarged version of the 

image in the Media Viewer. If you wish to see the record for a selected 
image, press Enter to open the relevant detailed display. 

Instead of selecting a miniature image and pressing Enter, you can 

also click it twice to open the record. 

The screen tab on which you leave the brief display will be remem-
bered by Adlib, via the Window registry, per user and per access 
point. The next time you choose the same access point in the Search 
wizard, the search result will opened on the same tab. 
For example: in a Museum application you search on the Object name 
access point via the Search wizard. In the search result you can see 
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the Brief display objects, Thumbnails and Filmstrip screen tabs. You 

switch to Thumbnails, for instance, and pick the record you wish to 

edit or view. The next time you search on this access point, even after 
you have had Adlib closed, the brief display immediately opens on the 
Thumbnails tab, although you can switch to the other two tabs when-
ever you want of course. As soon as you leave the brief display, the 
last opened tab is associated with the current access point, for next 
time. 

 Buttons for the Brief display screen (in different menus) 
 

 

Restart: choose another database to work with.  

 

Back: go back to the previous screen. 

 

First: jump to the first record in the search result. 

 

Previous. go to the previous record in the search result. 

 

Next: go to the next record in the search result. 

 

Last: jump to the last record in the search result. 

 

Edit: edit the currently selected record. If the button is 
greyed out, then Restart and choose the dataset, not the 
database, in which the concerning record occurs. It’s also 

possible that if you have no permission to edit records, then 
this button will remain inactive. 

 

New: add a new record to the current dataset. This button is 
only present when you are working in a dataset or in a 
database that is not subdivided into datasets. 

 

Copy: create a new record but copy all data from the cur-

rent record to it. This button is only present when you are 
working in a dataset or in a database that is not subdivided 
into datasets. 

 

Delete: from the Brief display, delete either the current 
record (the highlighted record) or all marked records (with a 
checkmark in front of them) from the data file; Adlib offers 
you that choice after you’ve clicked this button, while at 
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least one record is marked. Click OK to confirm your choice 

and remove those records permanently. The button is only 

present when you are working in a dataset or in a database 
that is not subdivided into datasets. Note that Adlib also 
asks for confirmation if you delete the current record while 
no records have been marked. 

 

And: reduce the current selection using an AND search (see 
chapter 7).  

 

Or: expand the current selection using an OR search (see 
chapter 7). 

 

Not: reduce the current selection using a NOT search (see 

chapter 7). 

 

Mark record: mark the selected record (see chapter 14). 

 

Toggle marks: mark all unmarked records and unmark all 
marked (see chapter 14). 

 

Remove all marks: delete all marks (see chapter 14). This 
button is only active when there are marked records. 

 

Sort: specify on which fields the record list must be sorted 
(see chapter 14). 

 

Replace in record: in marked records, replace text you 
specify in fields you select (see chapter 12.4). This button is 

only active when there are marked records. 

 

Open Print wizard: open the Print wizard dialog for the 
currently opened record or for the marked records, to inter-
actively put together a print format (see chapter 14). 

 

Find Word template: print the currently opened record or 
the marked records by means of a custom Word template 
available somewhere on your system (see chapter 14). 

 

Output formats: print the currently opened record or the 

marked records by means of a ready-made print format 
which can be selected from a list (see chapter 14). 

 

View selection: click this button to browse only the marked 
records; do not click it if you want to browse all records. 
When you are browsing only through marked records in the 
detailed presentation, then click this button again, and in 

the list screen only the marked records will be left.  
This function is only available when records have been 
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marked. 

 

Change layout: click this button to open a submenu in which 

you can choose from four options to set the size of the 
thumbnail images which can be seen on the three screen 
tabs of the Brief display. 

 

Write set: save the marked records in a pointer file, so you 
can retrieve the set later. 

 

Add: add the marked records to a pointer file of your choice. 

 

Remove: remove the marked records from a pointer file of 
your choice. 

 
Information: context-sensitive Help for the active (selected) 
item. 

 

When a button is greyed out, it means that it cannot currently be 
used. An example is the button you use to jump to the first record, 
when you are actually on that record. Then the icon is light grey 
instead of blue. 

  

 Editing a record 

In the Brief display click the Edit button to edit the currently selected 
record. See chapter 11 for more information. 

 Marking records 

The different ways of marking records (and unmarking them) for 

editing, will be discussed in chapter 9. 

 Sorting records 

The sorting of records will be discussed in chapter 10. 

 Automatically replacing data 

You can perform a search-and-replace on marked records. It is possi-
ble for instance, to replace incorrectly spelled terms everywhere 
automatically. How this works, is described in chapter 12.4. 
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 Combining searches 

It is possible to combine multiple searches, and to create selections of 
records for which one search statement would be insufficient. See 
chapter 7 for more information about this subject. 

8.2. Detailed presentation 

The detailed presentation of a record is spread out over multiple tabs 
(screens). Which data and screens will be displayed, and which screen 

first, is set per access point by the application builder. You can navi-
gate between the screen tabs by clicking the tabs. Alternatively, you 
can use the arrow keys ← and →  to page through the tabs (in display 

mode only), or use the key combination Ctrl+Tab to page to the next 

tab, and Ctrl+Shift+Tab to open the previous tab. 

Sometimes more information has to be shown than will fit on the 
screen. In that case, a scroll box will appear in the scroll bar of the 
window, and the arrows on the scroll bar will become active. You can 

move up or down in the screen by dragging the scroll box or clicking 
the arrows. You can scroll with the arrow keys on your keyboard as 
well, and usually* also with the scroll wheel that is present on many 
computer mice. 

* Scrolling with a mouse wheel in Adlib under Windows 98 
doesn’t work, though under Windows 2000 it always works, 

but under Windows XP only if you first click the caption (the 

name) of the (current) tab sheet and click it again after each 
time that you have clicked somewhere in the tab sheet (e.g. to 
activate a field) and want to scroll with the mouse again.  

The application manager can link a special ADAPL program to the 
presentation of a record. Such an added program could edit data and 
display messages, or ask for input or start an external program. After 
execution of the ADAPL program, Adlib displays the record and contin-
ues where it left off. 

8.2.1. Underlined values in display mode 

Sometimes, a value on a detailed display is underlined. Mostly this is a 
reference to the linked record for that term or name in the same or 

another dataset/database (an underlined file name however, is a link 
to an external document or other file). For instance, you have a Per-
sons and institutions data source to register personal details, among 
which the proper way of writing the name, but also any erroneous or 
non-preferred spelling. Now, if you enter a record of a book or object 
in another database, and somewhere you enter the name of the writer 
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or maker, then such a field is validated against the linked database 

Persons and institutions. That means that when you enter a name in 

this field that does not occur in Persons and institutions, Adlib will ask 
you if you want to add that name to it. Instead of adding it, you may 
also pick an existing name and have it entered in the current field, in 
the preferred spelling. In the detailed presentation of a record, such 
linked terms or names will be displayed underlined. 

 

Figure 8.2: The detailed presentation of a museum record for a drawing, with 
on the right the zoom screen for the Thesaurus term “drawing”. 

You may click such a link to display details of the concerning term or 
name record, as they are registered in the linked dataset/database. 
Those details may be presented in two ways. If the link refers to a 

record in another dataset or database, like in the example above, then 
a so-called zoom screen will be opened: this is one screen in a sepa-
rate window, in which you can see a selection of details from the 

linked record. If you’ve seen enough, you can close that zoom window 
via the button with the little cross on it, in the upper right corner of 
this window. 
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On the other hand, if the linked record is located in the same dataset 

as the current – this applies for instance to hierarchical relations in a 

Thesaurus – then you switch directly to the full detailed presentation 
(so no zoom screen) of the linked record, in which you can view all 
data on all tab sheets in the same way as in the record from which 
you clicked the link; and accordingly, the new detailed display has 
been opened in the same Adlib main window and has come in place of 
the presentation of the original record.  

If you want to return to the previous record, you will have to click the 
mirrored link. So for instance, if you are in the detailed display of the 
Thesaurus record “motorized transportation”, and you click the nar-
rower term “car”, then the term record for “motorized transportation” 
disappears from the Adlib window, and the detailed display of the 

“car” record will be presented instead. If you would like to go back to 
the previous record in this example, then click the broader term “mo-

torized transportation” in the current record. 

8.2.2. Buttons in the detailed presentation 

The following buttons can be found in different menus when a record 
is being shown in detailed display: 

 

Restart: choose another database to work with.  

 

Back: go back to the previous screen. 

 

First: jump to the first record in the search result. 

 

Previous: go to the previous record in the search result. 

 

Next: go to the next record in the search result. 

 

Last: jump to the last record in the search result. 

 

Save: stop entry/editing (with or without saving). 

 

Edit: edit the current record. If the button is greyed out, 
then Restart and choose the dataset, not the database, in 
which the relevant record occurs. If you have no permission 
to edit records, this button will always be inactive. 
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New: add a new record to the current dataset. This button is 

only present when you are working in a dataset or in a 

database that is not subdivided into datasets. 

 

Copy: create a new record but copy all data from the cur-
rent record to it. This button is only present when you are 
working in a dataset or in a database that is not subdivided 
into datasets. 

 

Delete: delete only the current record from the data file, 

and ignore other possibly marked records. This button is 
only present when you are working in a dataset or in a 
database that is not subdivided into datasets. Adlib will ask 
you for a confirmation before a record really is deleted. You 

cannot undo a delete. 

 

And: reduce the current selection using an AND search (see 
chapter 7).  

 

Or: expand the current selection using an OR search (see 
chapter 7). 

 

Not: reduce the current selection using a NOT search (see 
chapter 7). 

 

Mark record: mark the current record (see chapter 14). 

 

Toggle marks: mark all unmarked records and unmark all 
marked. (see chapter 14). 

 

Remove all marks: delete all marks (see chapter 14). This 
button is only active when there are marked records. 

 

Replace in record: replace text you specify in fields you 
select, in marked records (see chapter 12.4).  

 

Open Print wizard: open the Print wizard dialog for the 
current record (whether this is marked or not), to interac-

tively put together a print format. So, in the detailed display 
this button is always active. Other marked records will not 

be printed. (Also see chapter 14.) 

 

Find Word template: print the current record (whether this 
is marked or not) by means of a custom Word template 
available somewhere on your system. So, in the detailed 
display this button is always active. Other marked records 

will not be printed. (Also see chapter 14.) 
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Output formats: print the current record (whether this is 

marked or not) by means of a ready-made print format 

which can be selected from a list. So, in the detailed display 
this button is always active. Other marked records will not 
be printed. (Also see chapter 14.) 

 

View selection: click this button to browse only the marked 
records; do not click it if you want to browse all records. 
When you are browsing through the marked records in the 

detailed presentation, then click this button again, and in 
the list screen only the marked records will be left.  
This function is only available when records have been 
marked. 

 

Write set: save the marked records in a pointer file, so you 
can retrieve the set later. 

 

Add: add the marked records to a pointer file of your choice. 

 

Remove: remove the marked records from a pointer file of 
your choice. 

 
Information: context-sensitive Help for the active (selected) 
item. 

8.2.3. Continue searching on equal field contents 
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From within every indexed field in detailed display of a record you can 

search directly for all records with the same field contents, simply via 

the pop-up menu. 
In detailed display of a record, suppose you encounter the value 
‘canvas’ in the Material field. If you decide you’d like to see all records 
with the material ‘canvas’, just right-click the relevant field and in the 
pop-up menu select the Find records for … option (Find records for 
‘material=canvas’ in this example). The search will be performed 

untruncated and without relations. The search result will be presented 
in the brief or detailed display, as usual. 
When the option is greyed out, the field will have no index so you 
won’t be able to continue with this search option. 

8.2.4. Hiding unused screens 

In some applications the number of screen 
tabs in the detailed presentation has in-
creased to such an extent that displaying 
the tab headings takes up too much space 
on small monitors. That is why it’s possible 
to easily set which tab sheets must be 

visible and which can remain hidden (e.g. 
because they are rarely used), per applica-
tion per user. In your adlwin application 
(for instance a library, archive or museum 
application) go to the View > Select screen 

tabs menu and you will see a list of availa-

ble screens. Mark a screen to hide it, and 
deselect it to display it again. (Of course, 
the data in hidden screens is still saved.) 
Certain screen tabs contain mandatory 
fields and cannot be hidden, these are 
recognizable because they are greyed out 
in the drop-down list. The individual set-

tings are stored for the next session with 
the same user. 

However, not only can you hide tabs in the 
detailed display of a record via the Select 

screen tabs button, but also by right-
clicking the caption (the title) of the screen 
tab, and clicking Turn off tab in the small 

pop-up menu that opens. Again, note that 
some screen tabs cannot be hidden. 

You can show a hidden tab sheet again by 
clicking the name of the desired tab in the 
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drop-down list underneath the Select screen tabs button. You can also 

display all hidden screens again at once, using the Show all screen 

tabs button in the View menu: 

 

All screens are displayed again.  

However, it may be so that some hidden screens cannot be made 
visible via this menu, because those screens have been hidden condi-
tionally. Such screens will be displayed automatically again when 
certain conditions are met in the record. See the next chapter for a 

more elaborate explanation. 

8.2.5. Conditional screens and fields 

The purpose of conditional screens and fields is to be able to handle 
screens and fields more dynamically, to hide or show a screen or field 

automatically, for instance if the user enters a certain value some-
where. This allows little used screens or fields to be shown only if the 
need arises, and with it, keep the user interface as clean as possible. 
Your application manager can tell you if conditional screens or condi-
tional fields appear in your application; these are not present by 
default in model applications up to and including version 4.2. 

 Precedence of hiding 

Since there are different ways of hiding a screen, it must be clear 
which method takes precedence. Succinctly put: access rights come 
before the manual hiding of screens which in turn comes before condi-
tional hiding. This has been implemented as follows: 

• If access rights prohibit a screen from being shown, then you can’t 
switch it back on via the Select screen tabs button, nor can it be 
displayed again via a condition set for the screen. 

• If access rights do allow a screen to be shown, but you hid the 
screen via the Select screen tabs button, then it cannot be dis-
played again via a screen condition until you manually switch the 
screen back on again. 

• If a screen is hidden by a condition set for it, you can’t display it 
again via the Select screen tabs button.  

8.2.6. Images, movies and music in the Media Viewer 

In some applications, such as Adlib Museum, Adlib Library or Adlib 
Archive, images, movies or music files (like mp3’s) can be linked to 
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records. See chapter 12.2 for instructions about how to add a media 

file to a record. 

When a record contains one or more media files, like images, those 
images will be shown in the Media Viewer during the detailed presen-
tation of a record. So the Media Viewer is always automatically opened 
if you display a record that has a linked media file, or when you add 
such a link to a record. 

 

Figure 8.3: The Media Viewer is playing an mp3 file. 

 Screen tabs and basic functionality 

So you can link more than one media file to a record. By default, a full 
representation of the first occurrence is shown on the Normal tab in 
the Media Viewer. Then use the arrow keys in the Media context menu 

(in the ribbon) to jump (from left to right) to the first, the previous, 
the next, or the last image. Movies and audio files can be played and 

paused. 
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The Thumbnails tab gives an overview of all the images linked to this 

record in a smaller size. Click one of the small images to display it on 

the Normal tab. Maximise the Media Viewer window to display the 
image greatly enlarged. 
 

 

Figure 8.4: The Thumbnails tab in the Media Viewer. 

The Filmstrip tab actually combines both the other tabs. Click a minia-
ture image to view an enlarged version right above it (if necessary, 
enlarge the Media Viewer itself first). 

You can also zoom in or out, delete the current occurrence (when you 
are editing the record) or drag this window to another size, like you 
can with all windows. 

In the Media context menu in the ribbon you’ll find the following 
buttons: 

 

Display the Media Viewer on each screen. (Also see the Place, 
size and visibility of the Media Viewer paragraph below.) 

 

Print the current image. The image is printed to fit centred on 
one page. 

 

With this button you can save a displayed image (again) in a 

folder of your choice and in a different image format if de-
sired. The supported formats are: jpeg, png, bmp, gif and tiff. 
This function is particularly useful if your linked images are 
located in an SQL or Oracle database, and you wish to use 
one or more of those images for other purposes and need to 
copy them to your hard drive. 
This function will create a copy of the displayed image which 

will only be identical to the original image file if the image 
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was retrieved by Adlib unchanged (in its original size) for 

display in the Media Viewer. If that is the case or not, de-

pends on the settings for the image field, made by your 
application manager. 

 

From scanner or camera (in the Media context menu): 
through WIA (Windows Image Acquisition), create a link to an 
image to be created. The image can be created using a device 
for making still images that is connected to your computer: 

these are devices like scanners, digital photo camera’s, web 
cams or digital video camera’s. 
This button is only available when you use images in your 
application, for instance for the Reproduction reference entry 
field in the Visual documentation data source of several appli-

cations, and if your application has been set up to use WIA 
(by default not the case). 

So first connect a WIA-compatible device to your computer. 
Then open Adlib with the record to which you want to add a 
new image in edit mode, put the cursor in the prepared image 
field and click the button discussed here. Depending on the 
settings for this field, you’ll either first have to provide a 
folder, a name and file type for the new file, or directly create 
the new image with an automatically generated name via a 

WIA-device dependent dialog (for instance for the scanner). 
Then the created image will be linked to this record and be 
visible in the Media Viewer. (See chapter 12.2 and the Adlib 

Designer Help for more information.) 

 

Import image: create a link to an existing digital image. Click 
this button to open the Find image window, in which you can 

look for the desired file in the usual way. When you find the 
image you want to link, select it and click the Open button. 
The file name (or names in multiple occurrences) in the image 
field will be underlined after saving this record. The image will 
appear in the Media Viewer in the detailed display of this 
record. (See chapter 12.2 for more information.) 

 

Go to the first image. 
 

 

 

Previous image. 

 
     

 

Next image.  
 
     

http://documentation.axiell.com/alm/en/index.html?ds_generaltopicswindowsimageacquisition.html
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Last image. 

 

 

 

Start playing the music or movie file. 
 
 

 

Pause playing the music or movie file. 
 

 

 

The Set start point button can be used to mark the beginning 
of a fragment in a movie or audio file. This comes in handy if 
the current record is meant to describe the fragment, not the 
entire media file. However, this functionality is only available 

in your application after your application manager has added 
two fields especially for the registration of start and end 

points. See further in this chapter for more information. 

 

The Set end point button can be used to mark the end of a 
fragment in a movie or audio file. Also see the explanation of 
the Set start point button above. 

 

Zoom in (Ctrl+= or Ctrl++). You can zoom images in varia-

ble steps out, down to 7% of the original size or zoom in up 
to 2000%. The height/width ratio will always remain the same 
as in the original. If the image is too large to fit in the screen, 

scroll bars appear that will let you view the rest of the image. 
Note that on zooming in, the display of the image becomes 

increasingly less sharp because the resolution of the photo is 
limited: the higher the resolution (call it the number of mega-
pixel) of the photo, the further you can zoom in sharply. (See 
the paragraph below for more information about zooming.) 

 

Zoom out (Ctrl+-). 

 

Back to the window-size presentation of the image (Ctrl+0). 

 

 

Temporarily rotate the large image clockwise a quarter of a 

turn. The rotation won’t be stored in the record or in the 
image itself. 

 

 

Temporarily rotate the large image counterclockwise a quar-
ter of a turn. The rotation won’t be stored in the record or in 
the image itself. 

 

 

Remove the link to this image from the current record. 
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Some of the functions listed above are also available in the pop-up 

menu of the Media Viewer: right-click a large image in the Media 

Viewer to open the pop-up menu. 

 

 More zoom options 
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Click the image on the Normal tab, keep the mouse button pressed 
down and drag the mouse pointer to another spot on the image. A 

dotted rectangle will be displayed. When you release the mouse but-
ton, the image display will be zoomed in on the part of the image you 
just selected, as much as possible. 

In principle, you can zoom in up to 65000% this way. Click the Back 

to normal display button to zoom out again. 

 

Moving around on a zoomed-in image is possible as well: right-click a 
zoomed-in image, keep the mouse button pressed down and move the 
mouse to move the part of the image which is being displayed. 

 Place, size and visibility of the Media Viewer 

The location and size of the Media Viewer on opening a screen are set 
originally during the design stage of a screen. The Media Viewer is 
then visible only on that particular screen when you open the applica-
tion for the first time. Changes in the dimensions and location of the 
Media Viewer, made by the user*, will be stored by Adlib per database 
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and per screen for the next time, even after closing your Adlib applica-

tion. (Only a maximized Media Viewer is not remembered by Adlib that 

way, but still in its previous size.) A Media Viewer window can be 
present on multiple screens by default, and may have different dimen-
sions on each one of them. 

* You change the position of the Media Viewer by dragging its title bar 
to a different position, whilst you change the size of it by moving the 
mouse cursor over a border of the Media Viewer until a double arrow 

appears, and then dragging that dimension greater or smaller. Or 
right-click the Media Viewer title bar and in the pop-up menu which 
opens, choose either Maximize (full screen view) or Restore. 

From a screen with a Media Viewer you can let that Media Viewer 

appear on every other screen of the detailed presentation as well and 
on the same location and with the same size, by clicking the Pin view-
er button in the Media context menu. However, the size and position 

of a Media Viewer window on screens which show the Media Viewer by 
default will remain as they were. 

 

Click that button again to let the Media Viewer only appear again on 
the screens that were designed to hold it. 

When you have closed the Media Viewer, you can reopen it by switch-
ing screens, or by clicking the underlined reproduction reference on 

the Reproductions tab. 

With the Media Viewer button in the View menu you can show or hide 
the Media Viewer window. The button is only active when the currently 
opened tab shows the Media Viewer by default. 

 

If you’ve hidden the Media Viewer, it is hidden on all tabs in all rec-
ords, until you switch the Media Viewer back on. 
Hiding or showing the Media Viewer does not depend on whether it 

has been “pinned down” (visible on all tabs) with the Pin viewer but-

ton. 

The Reset Media Viewer button in the View menu, which becomes 
active when a record is in detailed display mode, allows you to restore 
the size and position of the Media Viewer window to its default set-
tings. This comes in handy if you had moved the Media Viewer outside 
the current monitor screen boundaries earlier and now you’d like to 

get it back. 
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If you had hidden the Media Viewer by closing it, then the Reset Media 
Viewer function won’t bring it back: the Media Viewer button in the 
same View menu is meant for showing or hiding the Media Viewer. 

 Image properties 

You can request some properties of images in the Media Viewer. 

Right-click an image or thumbnail in the Media Viewer – this is possi-
ble on every tab of the Media Viewer – and click Properties in the pop-
up menu which opens.  

 

Figure 8.5: Right-click an image in the Media Viewer to request its properties. 
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This will open a window in which some properties of the image are 

displayed. The relevant properties are derived from the EXIF metada-

ta* that cameras and scanners and the like include with images. Also, 
there exists image processing software, like Adobe Photoshop, in 
which you may add certain metadata to an image, like a Title, De-
scription and Keywords. If a property is empty, like Description, Title 
and Keywords in the screen shot below, then that metadata is simply 
missing from this image: the camera didn’t store that datum, or you 

never added a title manually, for example. Close the window by click-
ing the white-red cross in its upper right corner. 

 

Figure 8.6: Metadata of an image. 

* Many image files contain not just the image itself, but also metada-
ta: information about the image, like camera settings or descriptions 

of the photographed subject and the name of the photographer and 

such. It depends on the way in which an image has been created and 
edited if, and which, metadata is present. With some software, like 
Adlib, this metadata can be extracted from an image. Adlib can read 
EXIF and IPTC photo metadata. Note that IPTC metadata, for the 
description of photos, has no overlap with technical metadata, like 
EXIF, which is added to a photo automatically by the camera. A selec-
tion of the available metadata can be seen in the image properties in 
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the Media Viewer. It is also possible that in your application, in the 

Visual documentation data source, fields are present in which metada-

ta of a linked image is retrieved automatically. 

 Images with colour profiles supported in Adlib 

Adlwin.exe supports images with embedded ICC or WCS colour pro-
files, meaning that the embedded profile will actually be applied 

whenever images are displayed in Adlib. (In Adlib versions older than 
7.2, such images were displayed without the colour profile being 
applied.) 

Clarification: certain types of images files, like jpeg and tiff, can have 
embedded, generic colour profiles which were embedded explicitly 

when the image file was created or edited. The effect of a generic 
colour profile is that it alters the colours of the relevant image to some 

more desirable spectrum, although the changes are usually minute. 
Combined with monitor and/or printer specific colour profiles, a pub-
lisher has full control over the resulting colours. Typically, such pro-
files are used in (desktop) publishing environments or other profes-
sional media processing businesses where colour fastness of images is 
very important. 

 Registering media fragments 

When the Media Viewer is visible, the Media context menu in the 
ribbon also contains the Set start point and Set end point buttons. 

  

These buttons become active after you’ve linked a movie or audio file 
to a record and if this functionality has been set up* properly in your 

application (by default not the case). The functionality allows you to 
set a start point and end point of a fragment in the linked movie or 
audio file, to which the current record must apply. This way you could 
create several catalogue records, all linking to the same Visual docu-
mentation record for a media file, yet all describing a different section 
of that movie or audio file. 
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It works as follows: 

1. Suppose you’ve created a Visual documentation record for a movie 
file called Wildlife.wmv and from an object record you have made 
a link to this record, then on e.g. the Reproductions tab in the ob-

ject record you can play the entire movie in the Media Viewer as 
you would expect. You can use the Play button in either the Media 
Viewer itself or the one in the Media menu in the ribbon. 
 

 

2. With the Pause button (in menu or Media Viewer) you can pause 
the movie at any point. 
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3. To mark a fragment, pause the movie at the desired start point 

and click the Set start point button in the Media menu. The start 

point value (in seconds) then appears on this screen in the field 
created for this purpose. In the example presented in the screen-
shot above, the field is named Movie fragment start point. If you 
want the fragment to start at zero, there’s no need to define a 
start point. 

4. Click either Play button to continue the movie and pause again 

when you reach the desired end point. Then click the Set end 
point button to mark the location. The value in seconds will auto-
matically be entered in the special field for it. If you want the 
fragment to end at the very end of the movie, there’s no need to 
define an end point. 

5. You can empty any of the two fields if you want to start over or if 
you do not wish to specify a fragment after all. You can also over-

write earlier set points by clicking the Set start point or Set end 
point button again. You’ll find that if you’ve already set both 
points, it depends on where the movie is currently paused whether 
the Set start point or Set end point buttons are active or not. 

6. After you’ve set a start or end point, and on a later viewing the 
movie is not running yet when the screen tab has been opened, 
then the Play buttons in the ribbon menu and the Media Viewer 

function differently. The one at the bottom of the Media Viewer 
always plays the movie from beginning to end, regardless of a 

start or end point, while the Play button in the Media ribbon menu 
always plays the movie from your custom start point to the end 
point.    

* See the Designer Help for information about the setup. Search the 

Help on the term “inpoint” or “outpoint” to find the relevant documen-
tation. Or see the relevant chapter in the Release notes 7.1 for  step-
by-step instructions. 

Technical information 

To show images, Adlib uses a Microsoft DLL (a collection of procedu-
res), which is a standard Windows feature. The Media Viewer can 

display the following file formats: jpeg, tiff, bmp, gif, png, wmf, emf, 
icon, and exif. 

For playing movies and music files, Adlib uses the Microsoft Windows 
Media Player – so this software needs to be available on your com-
puter; therefore, all file types which can be played in the Windows 
Media Player, can in principle** be played in the Adlib Media Viewer. 
When playing audio files, the same dynamic visualization is shown as 

http://documentation.axiell.com/alm/en/index.html?ds_dbfieldspropertiesimageproperties.html
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the Windows Media Player would display. 

When via Adlib Designer the Retrieval path option for an image field 
has been set to a URL to an online service which may serve image 
files and other static media files as well as streaming video, Adlib will 

first try to get the file type of the media reference in the current 
record from the server, before displaying anything. If it succeeds, 
Adlib will download the file if it is a static file or stream the streaming 
media to the Adlib Media Viewer. If the type can’t be determined, 
Adlib will only try to download the file. 

** Which files can be played by Windows Media Player depends on 
which codecs have been installed. Codecs compress or decompress 

media files and are specific to certain file types. Media software 

requires codecs to enable it to play media files. Windows Media Player 
includes most popular codecs, but if you’d like to be able to play 
more exotic media file types in Windows Media Player, you’ll have to 
install the relevant codecs first. In principle you should then be able 
to play those files in the Adlib Media Viewer as well. Unfortunately 
that is not always the case because Adlib must first retrieve the 

extension of the media file to be displayed, from a certain location in 
the Windows registry, while newly installed codecs are sometimes 
registered in a different location in that registry. So the Windows 
registry must sometimes be adjusted by hand to allow the special 
media files to be played in Adlib. Moreover, if you have a 64-bit 
Windows version, you also need to use 64-bit codecs and 64-bit Adlib 

(adlwin.exe). 
We recommend not to edit the Windows registry yourself unless you 
know what you’re doing. Please ask the Adlib Helpdesk for assistance 
if certain media files cannot be played in Adlib. 

8.3. Web browser boxes 

It is possible that your application manager has placed one or more 
web browser boxes on detail screens in your application; in the 4.2 
model application this box is not present yet though. A web browser 
box displays record data as a web page on a detail screen. The box is 

only meant for display, and possibly printing, but not for editing. 
Such a web browser box can be used to display a nice presentation of 
the record in a single box. Or maybe your institution has a website 
which shows records in detail, while the same presentation is available 
in Adlib as well, so that during record entry you can already see how 
the record will look on the website.  
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Figure 8.7: An example of a web page display of a record. 

Every time the screen is redrawn during entry or editing, for instance 

when you switch tabs, the web page display will be updated.  

You can copy the web page display if you want, and paste it in a Word 
document. Right-click the display and choose Select all. Press Ctrl+C 

to copy everything. Switch to your Word document and paste the text 
(Ctrl+V). 

If you like, you can even print the web page display directly. Right-
click the display and choose Print in the pop-up menu. With the 
standard Windows print dialog you can then actually start the printing. 
It is possible that on the printout a page numbering, date and other 
header and footer information can be seen, and that background 

colours won’t print. This is caused by page settings in Internet 
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Explorer, because the web browser box uses IE functionality for 

printing. In Internet Explorer 9 you can change these settings via the  

(press Alt) File > Page setup menu or via the Tools button (Alt+X) 

Print > Page setup. For example, mark the Print background colours 
and images option to be able to print background colours. The headers 
and footers can be changed here as well. 
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9. Marking records 

Abstract 

To print or delete multiple records at once, or to save multiple rec-
ords in a pointer file, export them or perform a search-and-replace in 
them, you’ll have to mark those records. In the brief display of a 

search result you can mark records by clicking the checkbox in front 
of a record or by selecting one or more thumbnails and then clicking 
the Mark record button. Or you mark all records at once with the 
Toggle marks button in the Start menu: 

 

In detailed display you can mark the current record with the Mark 
record button: 

 

 

The marking of records is used to print or delete records, but also to 

refine the selection further or to export records. 

In detailed display you can mark the record by clicking the Mark 
record button (with a grey background) in the Start menu:  

   

For an already marked record, the button has an orange background. 
In the brief display, you can mark a record by selecting the checkbox 
to the left of the record.  
Click that checkbox or the orange Mark record button again to unmark 

a marked record. 

On the Thumbnails and Filmstrip tabs you can mark a single record by 

clicking the thumbnail and then clicking the Mark record button. The 
marked records on the Thumbnails and Filmstrip tabs are marked in 
dark blue or dark red, the currently selected thumbnail (shown 
enlarged) has a light blue highlight. 
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The Thumbnails and Filmstrip tabs of a search result also allow you to 
select multiple records in order to mark them all at once afterwards. 
On these tabs, simply hold the Ctrl key on your keyboard down while 

clicking thumbnails: they will all be selected with a light blue highlight 
bar. To select a whole range of records at once, you can work even 
faster by first clicking the first record in the range, then pressing and 

holding the Shift key while clicking the last record in the range. 

When you hold the Ctrl key while clicking an already selected record, 

it will be deselected. 

After you’ve selected all the records you need, click the Mark record 
button to mark the selected records. As mentioned above, marked 
records on these tabs are indicated by a dark blue (or dark red) high-
light bar when not selected. 
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Note that if any of the selected records were already marked, then 
after clicking the Mark record button those records will now be unmar-

ked. 

Clicking the Toggle marks button marks all unmarked records, and 
unmarks all marked records. For this it doesn’t matter which display 
mode is active. 

  

All marks are automatically removed when you change the search 
query or open another data source; all marks can be removed manu-
ally, by clicking the Remove all marks button: 

 

Click the Keep marked records button or press Shift+F3 to keep all 

the records that you have marked and remove the rest from the 
search result in the brief display. (The records themselves won’t be 
removed.) 

 

Saving or expanding your selection 

The Keep marked records function doesn’t actually save the marked 
records as a selection permanently: if that’s what you’re after, please 

use the Write set button, to store the selection as a pointer file (more 
about pointer files in chapter 6.3.7, paragraph Pointer files for manu-

al record selections). 
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If you’ve used the Keep marked records function and you to wish to 

add records from a different search in the same data source to the 
currently remaining search result, you should use the Or button. 
You’ll be allowed to perform a new search after which the resulting 

records will be added to your manual record selection in the Brief 
display. (More information about Boolean operators in chapter 7.1.) 

 

 

When you have marked one or more records, the following buttons 
will become active in the toolbar: 

 

Click the Replace in record button to start a search-and-
replace action for the marked records. See chapter 12.4 for 
more information. 

 

Thesaurus update. With this you can update specified fields in 
all marked records in the current database, to another thesau-
rus. (See chapter 13.10.) 

 

In the brief display screen, click the View selection button to 
open the first marked record from your selection in detailed 
display. In detailed presentation click this button again to 
return to the selection; only the marked records remain in the 

selection. 

In detailed display of a record from the selection, you can 
browse through the other marked records and/or edit them 
via the following buttons: 

     

 

Click the Write set button to save (references to) the marked 
records in a pointer file. See also chapter 6.3.7. 

 Printing marked records 

   

From the Brief display, click one of the print buttons in the File menu 
to print all marked records at once. (From within the detailed display 
of a record you may also start the Print wizard, but then you’ll only 
print the currently displayed record.)  
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If the Print label button in the Start or File menu is active, then the 

marked records can be printed to labels as well. 

 

See chapter 14 for more information about printing. 

 Exporting marked records 

From the Brief display choose File > Export to export all marked 
records. (From the detailed display you’ll only export the currently 

shown record.) 

See chapter 16 for more information about exporting. 

 Deleting marked records 

From the Brief display, click the Delete button to remove all marked 
records from the database: 

 

Before deletion, Adlib will ask you for confirmation (see Figure 9.1). 
The removal of records is definitive: you cannot undo a deletion! 

 

Figure 9.1: Do you only want to remove the current record, or all marked 
records? 

See chapter 11.4 for more information about removing records. 
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10. Sorting 

Abstract 

By default, Adlib will sort a search result in the brief display ascend-
ing according to the (first) index in which you are searching, and 
within that on record number. Your application manager can set a 

different standard sorting per access point though. You can sort a 
search result differently yourself too:  

• The fast method (10.1) is to right-click the list display and select 
another sorting field in the pop-up menu, underneath the Fields 

option. 

• The extensive method (10.2) is to set the sorting conditions in 
the Sort window; you open this window with the Sort button: 

 

 

 

When you perform a search via the Search wizard, or when you 
search one or more indexes by means of another search method, then 
by default Adlib will sort the search result in the brief display ascend-

ing according to the (first) index in which you are searching, and 
within that on record number. If it concerns an index on a repeated 
field then for sorting, the occurrence value which ranks the record at 

the highest possible position in the sort order will be used. So if you 
were to search the indexed, repeated material field in an objects 
database for example, then a record with the material bronze will be 
positioned before (above) a record with the material carbon, while it 
doesn’t matter if the first record lists other materials besides bronze. 
If multiple records with the material bronze exist, then those will be 

sorted ascending according to their record number. 

If, after a Search wizard search, the default sorting is not the sorting 

you wish to see, then you can change that. If you would like to change 
the sorting of the current search result just this once, use the possibil-
ities described in the following two paragraphs. If, on the other hand, 
you would like to see the search result of certain access points to be 
sorted differently always, then your application manager must make 

some settings for those access points via Adlib Designer first. 
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Technical info: sorting beforehand and multilingual sorting 

To have the search result automatically sorted after searching via an 
access point, your application manager must set a sort adapl or sort 

field(s) for the relevant access point. Possibly, sorting is also influ-
enced by the Locale database setting which may have been set to a 
specific language region. 
In multilingual databases you automatically search all data languages 
together if you use the Search wizard. The sorting of the search 
result is determined partly by the current data language too. If you 

select another data language while the brief display is on screen, 
then the sorting of the search result will not be adjusted automatical-
ly, so you’ll have to reapply it manually. 

Further, the Windows locale is the cause of separate sorting of com-
pletely different languages: in Latin-based language regions, terms in 
Latin languages will always come before all terms in Greek, for ex-
ample. 

 

When a search result is already shown, you can still sort that search 
result afterwards differently in two ways, via a pop-up menu in the 
brief display or via the Sort window. 
Note that if you create a pointer file of marked records in a search 
result which has been sorted afterwards, the applied sorting will 
(implicitly) only be stored in the pointer file if you are working with 

CBF databases: in SQL databases, this type of sorting will be lost! In 

SQL, a sorting will only be saved if you include it in the (advanced) 
search statement explicitly or if you apply it to a pointer file itself. 

10.1. The fast method 

A search result listed in the brief display, can be sorted very quickly as 
follows: 

1. Right-click a random spot in the brief display to open a pop-up 
menu (see the screenshot below). 

2. Move the mouse cursor to the Fields option in that pop-up menu, 
and a second pop-up menu opens, containing all fields which can 
be used for sorting. It is possible you get to see all the fields at 
once, or only one column which can be scrolled using the black ar-
rows at the top and bottom of the list. You can also type the first 
letter of the field name to scroll the list to that letter immediately. 
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3. Click the field on which you wish to sort and the brief display will 

be sorted alphabetically straight away. 

Each time you sort the brief display to a field this way, the selected 
field will be stored in the first pop-up menu, so that you won’t have to 
select that field from the complete fields list next time.  

 

Figure 10.1: Pick a sort field from the pop-up menu. 

In the screenshot you can see the first and second pop-up menu next 
to each other. The first pop-up menu shows that the brief display has 
already been sorted once on title and on creator. Click such a saved 
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sort field to immediately sort the brief display on this field. 

This way, Adlib remembers the last ten chosen fields per database per 

user. (This information is saved in the Windows registry.) 

10.2. The extensive method 

 

Figure 10.2: You can set three sort parameters per field. 

If you want to sort more specific, then you can do that via the Sort 
window. This window can be opened in different ways: 

 

• Click the Sort button in the toolbar of the Brief display. 

• Select the desired set in the search language and click the 
Sort button.  

• Select the desired file in the Pointer files window, and 

click the Sort button.  

 
Adlib will now open the Sort window, in which you can set how sorting 
must take place. 

The list on the left is a list of fields on which you can sort the records. 
You can only choose field names in bold type. In the Sort field proper-

ties list, you can see the fields on which sorting will be done and the 
field-specific settings that Adlib takes into account while sorting. 
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In the Sort ADAPL entry field you may enter the path and name of an 

ADAPL program which must pre-process the search result just before 
sorting. 

10.2.1. Sort field parameters 

 Field 

In the Available fields list in the Sort window you’ll find all fields on 
which you can sort (in bold type). The fields you actually want to sort 
on should be copied to the Key column in the Sort field properties list 
on the right. Double-click a desired field to copy it to the sort selec-

tion, or select a field and click the arrow button pointing to the right. 
This way you can add several fields to the selection. When you add 

the next field to a selection, it will be inserted below the field that is 
highlighted in the selection. 

The order in which selected fields appear in the Sort field properties 
list, is the one in which Adlib will sort. You can change the current 

order easily: in the Sort field properties list, select the name of the 
field that you’d like to move and use the key combination Ctrl+ (the 

Ctrl-key combined with the arrow-up key) or Ctrl+ to move the 

sorting field up or down. 

To remove a field from the sort selection, you must select the name of 
the field in the list on the right and click the arrow button pointing to 

the left, or press Delete.  

 Occurrences 

In this column, you can indicate whether account has to be taken of 
only the First or of All the occurrences of a field within a record 

during a sort. In the latter case, Adlib will look at the record separate-

ly for every repeat of a field. A record may therefore occur more than 
once in the list. 

Click the setting (the word First or All) and a drop-down list opens in 
which you can choose the other option by clicking it. 

 Type 

The type of sort is normally determined by the index type of the sort 
fields. If there is no index for the field, the type that you select here 
will apply (Text / Numeric / Date / Alpha numeric). 

Click the setting (the word Text, Numeric, Date, Alpha numeric) and a 
drop-down list opens in which you can choose one of the other options 
by clicking it. 
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When you sort dates or numbers as Text anyway, then 111 will come 

before 2 and 01/02/1999 before 06/05/1970, which is probably not 

what you want. 

Alphanumerical sorting is intended for sorting on fields which contain 
values consisting of both letters and digits, while you wish to consider 
subsequent digits to be one number. 
Suppose you use object numbers (a text field) built up from letters 
and numbers. See the fictious numbers below to clarify the difference 

between sorting on text and alphanumerical sorting. (Note that nu-
merical sorting (not alphanumerical) on a text field yields unpredicta-
ble results: only numerical fields can be sorted numerically correctly.) 

Text Alphanumeric 

00101A 

100A 

20A 

7A 

A20A 

A7A 

C01 

7A 

20A 

100A 

00101A 

A7A 

A20A 

C01 

 

When sorting on text, the field values are compared character by 
character: 20A then comes before 7A because 2 comes before 7 in the 
character set. When sorting alphanumerically, (0)1, 7, 20, 100 and 
(00)101 are seen as numbers, putting 7A before 20A, and since in the 
character set digits come before letters, 00101A comes before A7A. 

 Order 

Here, you can state whether the sort should be in Ascending order 
(0…9, a…z, from top to bottom on the screen) or Descending order 
(z…a, 9…0, from top to bottom on the screen). 

Click the setting (the word Descending or Ascending) and a drop-down 

list opens in which you can choose the other option by clicking it. 
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10.2.2. Sort adapl 

This is a procedure with which you can influence the sorting of a 
search result. The sort adapl you can enter in the Sort ADAPL entry 
field in the Sort window, is carried out immediately after the field data 
is read from the record and before the actual sorting. So you can still 

perform conversions or combine fields, if you desire. Your system or 
application manager can tell you which ADAPL procedures you can 
enter here. 

Technical information 

In a sort adapl the possibility exists to use the select no statement, 

to exclude records that do not meet the conditions which you specify, 
from the sorted output. For more information on select no, see the 

ADAPL reference in the Designer Help. 

 

http://documentation.axiell.com/alm/en/index.html?ds_adaprogramminginstructions.html#statements
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11. Entering or editing records 

Abstract 

After you have selected a non-subdivided database or dataset, click 
the New record (Ctrl+N) button in the Start menu to open a new 

record for entering data. 

The different fields in a record have their own entry conditions (11.1). 
Right-click a field and choose Properties in the pop-up menu for 

information about the field. For instance, you will often have to enter 
broken numbers with a period as the decimal character, but in some 

applications a comma is the norm. And dates may have different 
formats as well. Press F1 for data entry examples. 

With the following buttons (11.1.1) you can insert or remove occur-
rences (field repetitions), or create a link to an external file or image: 

       

In Adlib there is no function to undo changes (11.1.2), but if you do 
not save an incorrectly edited record, the record will remain as it was 

before: not a single change will be saved. Sometimes it is possible 
though that the history of saved changes is being logged by Adlib. In 

that case you can restore earlier field contents from within the Histo-
ry window.  

 

You leave a field via Tab (next field) or Shift+Tab (previous field) or 

by clicking the mouse pointer in another field (11.1.3). With Enter 

you insert a new line in the current long-text field. 

You can change the order of already filled-in field occurrences. With 
Ctrl+ you move the active occurrence one place up, or use Ctrl+ 

to move that occurrence one place down. 

The standard Windows cut (Ctrl+X), copy (Ctrl+C) and paste 

(Ctrl+V) functions are available, to move or copy text from one field 

to another, within the same record or outside of it. However, if you 
want to copy multiple fields from one record to another (e.g. a new 

record), a better option is to use the Adlib clipboard. Place the cursor 
in a field you want to edit, and from the Edit menu choose one of the 
following commands: Cut field (Ctrl+Y), Copy field (Ctrl+D), Copy 
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all fields, Paste field (Ctrl+K) to current identical field, or Paste all 

fields (Ctrl+J) to paste all copied fields in the right place. 

You have the possibility to perform a spelling check (11.1.5) on non-
linked text fields, in a record in edit mode. The spell checker, which 
can be started with Ctrl+F7, automatically checks the contents of all 

these fields in the currently opened screen. 

If your application uses Unicode databases, you’ll be able to enter 
special characters from other languages and symbols (11.1.6). More-
over, the alphabetic sorting and searching of terms then complies 

with the language characteristics of your region or country.  

Data which you have entered, will not be saved definitively until you 

click Back or Restart (or Start  Save or Start  New). Adlib will ask 
whether you want to save the changes (11.1.7). 

 

If you have sufficient access rights and you are working in a dataset 
or database that is not subdivided, you can edit (11.2), copy (11.3) 
or delete (11.4) a selected, existing record. You cannot undo the 
removal of records. 

   

11.1. Entering a record 

After you have selected a non-subdivided database or dataset, click 

the New button in the Start menu to open a new record for entering 
data. One database can hold up to 2,147,483,646 records. 

The different fields in a record have their own entry conditions: some 
fields are required, some are not, and in some you can enter several 
lines of text whilst others require a number in a specific format. The 
most relevant information (field tag, data type, mandatory, linked, 
multilingual) is presented in the status bar at the bottom of the Adlib 

window. You can also right-click an entry field and choose Properties 
in the pop-up menu which opens (or use the Alt+Enter key combi-

nation) to view the technical properties of the field. Data entry exam-
ples can be found in the contextual Help (F1); see chapter 4.5 for 

more information.  

In numerical fields, for monetary amounts for example, numbers 
normally have to be entered with a dot as decimal character, like 
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34.10. But it may be that in your application, numbers have to be 

entered with a comma as decimal character in some or all numerical 
fields, like it is the norm in the Netherlands. You cannot deduce this 

from the field properties, but if Adlib produces the Invalid number 
error message after leaving a filled-in numerical field, you may have 
used the wrong decimal character. Then replace the comma in the 
number by a dot, or vice versa, and see if the problem is solved.  
It is also possible that dots (in Dutch) or comma’s (in English) to 
separate factors of thousand, like in 1,000,000.50, are used in the 
presentation of a number (although those won’t be stored in the 

record). If for example in the Dutch language region, you must use a 
comma as the decimal character, then you can also use dots to sepa-
rate factors of thousand, although that is not mandatory. If you enter 

a number without the separator character, Adlib will add it to the 
presentation as soon as you leave the field. In the English language 
region, you typically use the dot as the decimal character, but it still 

depends on the setup of the numerical field, if it will accept and pre-
sent comma’s to separate factors of thousand: just try typing a com-
ma in the number: only if the field accepts that input, it is set up 
correctly for using comma’s to separate factors of thousand. In that 
case, if you enter a number like 123498.90  in such a field, then Adlib 
will change this number to 123,498.90 when you leave the field.  
Also, never enter letters into numerical fields. 

In date fields, you can usually pick a date from a small calendar, after 
which the relevant date is entered into the field by Adlib in the proper 

format. It depends on the field definition which format that is: you 
may encounter ISO dates (yyyy-mm-dd) as well as European dates 
(dd/mm/yyyy), for example. There are also text fields in which you 
can enter a date and/or other text: you recognize these fields by the 
missing calendar. Here, you are free to choose a date format and even 

if you fill in an incomplete or complete date; these fields are not 
validated. 

The field tag, its data type and possibly the validation type of the field 
that currently holds the cursor can also be read from the status bar in 
the Adlib window - if only the data type is mentioned, then the field is 
not validated. (See chapters 13 and 12.1 for more information about 

validation.) See the Designer Help for a list of all possible data types 

that a data dictionary field may have, and what kind of data you can 
enter for each type. For the validation types, you may encounter the 
following: Field must not be empty in group; Field must not be empty; 
Field must be filled completely; Before edit procedure; After edit 
procedure. These types correspond with the five validation types that 
can be set for screen fields. Again, see the Designer Help for more 
information about validation types. 

http://documentation.axiell.com/alm/en/index.html?ds_dbfieldspropertiesfield.html#datatype
http://documentation.axiell.com/alm/en/index.html?ds_scrscreenfieldpropertiesdata.html#datavalidation
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11.1.1. Special buttons for entering or editing data 

 

Append occurrence beneath: add a new occurrence beneath 
the current field. Note that this button, and the four buttons 
below, is only active if the cursor is in a field that can be 
repeated (set this way by the maker of the application), and a 

lot of fields cannot be repeated. 

 

Append occurrence above: add a new occurrence above where 
the cursor is now. 

 

Add occurrence below: add an occurrence at the bot-
tom of the list. 

 

Delete occurrence: remove the current entry field 

occurrence. 

 

Empty field (Ctrl+T): remove all text from this entry field. 

You cannot undo that deletion (unless you do not save the 
changes in the record). 

 

Find file: create a link to a document outside Adlib, for in-
stance a Word document, or a URL (reference to an internet 

page). This button is present for e.g. the Library Reference 
field on the Title | Imprint | Collation | Shelf mark tab and the 
Museum Reference field on the Numbers | Relations tab. 
Click this button to open the Select file window, in which you 

can look for the desired file in the usual way. When you find 
the file you want to link, select it and click the Open button. 
The file name (or names in multiple occurrences) in this kind 

of field will be underlined after saving the record. From display 
mode you can open the file in the associated program by 
clicking the link; from edit mode, use Ctrl+clicking to open 

the file. 
Further, make sure that the files you link are on the network, 
because other users probably won’t always have access to 
your own hard disk. However, if the path to a linked file is 
automatically hidden, then the file location is not important: 

on linking of the file, the file is automatically copied to a 
specific folder on the network set up by your application 

manager. 

 

Import image: create a link to an existing digital image. This 
button is only available when you use images in your applica-
tion, for instance for the Reproduction reference entry field in 
the Visual documentation data source of several applications. 

Click this button to open the Find image window, in which you 
can look for the desired file in the usual way. When you find 
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the image you want to link, select it and click the Open but-

ton. The file name (or names in multiple occurrences) in the 

image field will be underlined after saving this record. The 
image will appear in the Media Viewer in the detailed display 
of this record. (See chapter 12.2 for more information.) 

 

From scanner or camera (in the Media context menu): 
through WIA (Windows Image Acquisition), create a link to an 
image to be created. The image can be created using a device 

for making still images that is connected to your computer: 
these are devices like scanners, digital photo camera’s, web 
cams or digital video camera’s. 
This button is only available when you use images in your 
application, for instance for the Reproduction reference entry 

field in the Visual documentation data source of several appli-
cations, and if your application has been set up to use WIA 

(by default not the case). 
So first connect a WIA-compatible device to your computer. 
Then open Adlib with the record to which you want to add a 
new image in edit mode, put the cursor in the prepared image 
field and click the button discussed here. Depending on the 
settings for this field, you’ll either first have to provide a 
folder, a name and file type for the new file, or directly create 

the new image with an automatically generated name via a 
WIA-device dependent dialog (for instance for the scanner). 
Then the created image will be linked to this record and be 

visible in the Media Viewer. (See chapter 12.2 and the Adlib 
Designer Help for more information.) 

11.1.2. Checking or undoing changes 

In Adlib there is no function to undo changes. Whenever you empty a 
field, remove a field occurrence or edit the value in a field, there is no 
way to quickly retrieve the previous field contents. Nonetheless there 
are two ways to correct a mistake: 

• Close the record in which you are currently working, but do not 
save the changes (also see paragraph 11.1.7). All changes made 
during editing of the record will not be stored. So when you put 

the record back in edit mode, you will have to re-enter those 
changes, but at least the data you deleted by accident is present 
again. 

• From Adlib 6.6.0, your application manager may have made a 

setting enabling the automatic journaling of all changes saved at 
some point. This applies to applications running on an Adlib SQL 
or Adlib Oracle database only. The journal is stored in the same 
database. If that is the case, then old field contents can be viewed 

http://documentation.axiell.com/alm/en/index.html?ds_generaltopicswindowsimageacquisition.html
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in the History window. The journal also indicates the name of the 

user who made a change and when the change was made. Only 

changes in linked fields and any merged-in fields won’t be logged. 
You can view the field journal as follows: 

1. Open a record in display or edit mode. 

2. Right-click a field of which you would like to see the edit 
history, and choose History in the pop-up menu which appears 
or click the History button in the Start menu. 

 

 

3. View the registered changes in this field from the moment 

your application manager made the required settings. Use the 
scroll bars to scroll to the side or downwards, to see more 
data. 

4. If you want to reuse old data, then right-click the data of an 
earlier change and choose Copy in the pop-up menu to copy 

the relevant value to the Windows clipboard. After closing this 
window you can paste the value in the currently active field: 
right-click the field and choose Paste in the pop-up menu. 

11.1.3. Working with occurrences 

When entering data, you can use Tab to move to the next field, and 

Shift+Tab to go to the previous field. After entering text in a field, 

also press Tab to close this line and go to the next field. 

Within a field, Adlib will automatically move the cursor to the next line 

(within this occurrence) if you reach the end of the current line. If you 
want to lay out the text in an occurrence as separate paragraphs, then 
use Shift+Enter or Enter to go to the next line. (Also see chapter 

4.4.) 

To add multiple occurrences of a field, e.g. several authors, press 
Ctrl+Enter. To delete an entire occurrence, click the Delete Occur-

rence button. To remove the contents of one entry field from a group, 
use the Empty field (Ctrl+T) button. You’ll find these options in the 

Edit menu. 

 Changing the order of occurrences 

You can change the order of already filled in field occurrences, either 
in a field group or not. You achieve this by placing the cursor in the 
field (group) occurrence which you want to move to a different spot, 
and then use Ctrl+ (keep the Ctrl key pressed down and then press 
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the arrow-up key) to move the relevant occurrence one place up, or 

use Ctrl+ to move that occurrence one place down. You can do this 

repeatedly until you have the desired order. 

In the example below you can see how the third field group occur-
rence is moved one place up. In a field group it doesn’t matter which 
field you select in the occurrence you want to move. In the example 
below, for moving the third field group occurrence, you may put the 
cursor in the third occurrence of Part, in the third occurrence of Di-
mension, or in the third occurrence of Value, etc. 

Cursor in third field group occurrence: 

 

After Ctrl+, the order is as you can see below: 

 

Note that moving field group occurrences this way only works if you 

have at least read access rights to all fields in the field group. 

11.1.4. Copying and pasting fields 

 Via the Windows clipboard 

The standard Windows cut, copy and paste functions are available, to 
move or copy text from one field to another, within the same record 
or outside of it. Select the desired text by clicking and dragging from 

beginning to end in a field, or press Ctrl+A to select all text in the 

field where the cursor is. Copy or cut the text via Ctrl+C or Ctrl+X 

respectively, place the cursor in the field in which you want to paste 
the text, and press Ctrl+V. (Press Ctrl+V again to paste the text 

again.) Only when you copy or cut a new text, the other text will be 
removed from the Windows clipboard. 
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 Via the Adlib clipboard 

If you want to copy entire fields from one record to another (e.g. a 
new record), there is a faster way. To copy filled-in fields between 
records, you can use the Adlib clipboard. This clipboard is completely 
independent from the Windows clipboard, and cutting and pasting in 
and from one clipboard has no consequences for the other. 

In this clipboard you can place more than one field, by cutting or 

copying several fields successively. Choose Edit  View clipboard to 
see which fields have been copied to the Adlib clipboard.  

 

Press Alt+F4 or click the Windows Close button in the upper right 

corner of the Adlib clipboard to return to the previous screen. Select 

Edit  Clear clipboard to remove all fields from the clipboard (for 
example before you want to make a new selection of fields to copy). 

 

Place the cursor in a field you want to edit, and from the Edit menu 
choose one of the following commands: Cut field (Ctrl+Y), Copy field 

(Ctrl+D), Copy all fields, Paste field (Ctrl+K) or Paste all fields 

(Ctrl+J).  

You can use the Copy all fields function to copy the entire contents of 

the currently displayed record (in display or edit mode) to the Adlib 
clipboard. The function is intended to be able to quickly copy the data 
of a single (exemplary) record to multiple other pre-existing records 
still containing little data. Since you usually do not want to copy any 

management details (input and edit dates) in such case, it’s best to 
open a new record, fill it with the desired data to be copied, then click 
Copy all fields and close the record without saving it. The copied data 

can now be pasted repeatedly in other records via Edit  Paste all 
fields. Note that values which might be present by default in certain 
fields in a new record, will never be overwritten by Paste all fields: a 
value to be pasted in a repeated field which already contains a value 
by default, will there therefore be inserted as the second ocurrence. 

Instead of Copy all fields, you can use the Copy field function to copy 

fields (more precise: field occurrences) to the Adlib clipboard indivi-
dually: this comes in handy if the base record you are copying from, 
also contains data which you do not want to copy, like management 
details or unique codes or references. 
With Paste field you can only paste a field in an equal field: for in-
stance, if you copy the Author entry field and you open a new record, 

then first place the cursor in the Author field of that record before 
pasting. If the target field already contains data, then the new data 
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will be inserted in the occurrence that holds the cursor; the existing 

occurrences will move downwards. 

If you copied multiple fields and would like to paste those all at once, 

then choose Edit  Paste all fields; Adlib now automatically pastes the 
copied fields in the right places (below any field occurrences that 
might have been filled in earlier).  
Note that pasting with Paste all fields only works correctly in repeated 
fields and in empty, non-repeated fields: pasting in filled-in, non-
repeated fields may give problems (see the warning below). When you 
copy and paste (Ctrl+J) field occurrences from field groups, the 

values from the clipboard will be added as new occurrences beneath 

any existing field group occurrences in the target record. The coher-
ence within the pasted field group occurrences remains intact, and 

their sorting order remains correct as well. And if a value from a non-
repeated field is pasted in an empty, non-repeated (according to the 
data dictionary) target field there is no problem of course, but if the 
target field already contains a value, then that value won’t be over-
written by the value to be pasted, because of security considerations: 

you will first have to empty the target field before you can paste a 
value into it. 

Warning when using Paste all fields 

A field can be set to non-repeatable in two ways: in the data diction-
ary (the database definition) and in the screen definition. Non-
repeatability always has priority, and in the end this determines if 

you are allowed to add new field occurrences during editing of a 
record. The Paste all fields function however, only looks at the data-

base definition. And sometimes the situation occurs that a field has 
been set to repeatable in the database definition, while it has been 
set to non-repeatable in the screen definition. If such a field has been 
filled in, and you use Ctrl+J to paste a different value into it, then 

Adlib regards the field as repeatable and pastes the new value as 
second or following occurrence in the field, while in the screen you 
can only see the first occurrence! (You can see the extra occurrences 
via Ctrl+R and with search-and-replace you are able to remove any 

data stored this way, if necessary.) To prevent this undesirable 
situation from happening, remember that when you paste data in a 

partially filled-in record using Ctrl+J, you must only copy repeated 

fields or ensure that all target fields are either repeated fields or 
empty, non-repeated fields. If the target record is empty, the above 
considerations are not relevant and you can copy and paste with 
Ctrl+J at will. 

 
So, for copying and pasting selected fields, proceed as follows: 
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1. Open the record for editing, from which you want to copy, via the 

Edit record button in the Start menu. 

 

 
 

2. Place the cursor in a field that you want to copy to a another 
record. 
 

3. Open the Edit menu and click Copy field. 

 

 
 

4. Repeat steps 2 and 3 for each field you want to copy. 
 

5. When you have copied all necessary fields, then open a new or 
other record for editing, go to the Edit menu and choose Paste all 
fields to insert all fields automatically in the right places. Of 

course, you may still fill in the rest of the record before saving it. 
 

 
 

6. Copied fields remain stored, so you can paste them in each new 

record via Edit  Paste all fields. If you want to copy new fields, 

then first select Edit  Clear clipboard. 

11.1.5. Checking spelling  

You have the possibility to perform a spelling check on text in non-
linked fields of the data type Text. The spell checker automatically 
checks the contents of all these fields in the currently opened screen. 

 Checking the spelling of field contents 

A record has to be in edit mode, but it doesn’t matter where the 
cursor is. You don’t need to select text, because the entire contents of 
all applicable fields will be checked. Simply press Ctrl+F7 to start the 

spelling check. If at least one error has been found, the Check spelling 
window will open (this may take a few seconds) to show you the error 
and to let you choose a correctly spelled term. By the way, you can 
also start this function via the Edit > Check spelling option: 
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At the top of the Check spelling window you can see the name of the 

currently checked screen, and the name of the field and the word in 

which the current error has been found. 

This spelling check is based on the same function in Microsoft Word, 
and by default uses the main dictionary in the language that you have 
set there, although here you can choose another Dictionary language 
if you want.  

 

Figure 11.1: The spell checker in Adlib. 

If you use multilingual databases then automatically the dictionary for 
the current data language will be used (if installed on your computer). 
You set the current data language (see chapter 12.3) via the relevant 
button in the Edit menu. If the button is greyed out, then your data-

bases are not multilingual. 
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In the case of multilingual databases, all (non-linked) text fields on 
the current screen will be checked in the current data language, even 

fields which haven’t been made multilingual. If because of this some 
fields are being checked in the wrong language, you can skip them by 
repeatedly clicking the Ignore button or by temporarily selecting the 
proper Dictionary language manually. 

If you have ever added words to that dictionary, for instance by 
means of the Add word button here or via the spelling check in MS 

Word, then you’re probably working in the Custom dictionary named 
custom.dic. Here too you may select another file, if that is available in 

the drop-down list. 

In the Not in dictionary box you’ll see the whole text from the checked 
text field. Note that the “Not in dictionary” caption only applies to 
words displayed in bold type (and in some Windows versions those 
words in bold type are also underlined with a red wave line). You’ll 

only see one word in bold type at a time (even if there are more 
incorrectly spelled words in the text); in the Suggestions box you’ll be 
presented with similar words that could serve as a substitute. If the 
desired word is in the Suggestions list, then select that word and click 
the Change button to replace the incorrectly spelled word. If the 
incorrectly spelled word appears more than once in this field, and you 
want to replace each occurrence of it immediately, then click Change 

all.  
If the word in bold type is spelled correctly, for instance because it 
concerns a name of a person or company, or because it is a word from 
another language, then click Ignore once to skip this word and move 
on to any next incorrectly spelled word. Click Ignore all if you would 
like to skip each occurrence of this word in the current text. 

After changing or ignoring this word, the spell checker automatically 
searches for the next incorrectly spelled word. If that is not found, a 
message pops up telling you that spell checking has been completed. 
(This message also appears if you just started the spelling check, and 
no errors have been found.) Click OK in the Check spelling window to 
actually copy the changes to the field content in the record. Click 

Cancel to disregard any changes you’ve made, and close the spelling 

checker without changing the field contents. 

 Limitations of the spell checker 

The spelling check functionality and dictionary of MS Word, that is 
used here, is not without faults, for example: it contains typing errors, 

abbreviations are not recognized, most technical terminology is ab-
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sent, and words that you have added yourself are sometimes not 

recognized while they do appear in the Suggestions list, etc. Unfortu-

nately Adlib cannot fix such errors; updates for your Microsoft Word 
software may resolve some problems. 

Another limitation is, as mentioned briefly, that internally or externally 
linked text fields are not checked for spelling errors. If you still want 
to check the spelling of a linked field, then first open the main record 
of this term (not in a zoom screen) and start the check. (Or you can 

temporarily copy the term to a non-linked text field on the same 
screen, and start the spelling check. But then don’t forget to remove 
the copy again afterwards.) 

 If Microsoft Office automatically wants to install a function… 

The first time that you use the spell checker in Adlib (in a certain 

language), it is possible that you will be asked through a message to 
place the Microsoft Office or Word CD in the CD player of your com-
puter because certain functionality needs to be installed. Simply follow 
the instructions on screen, and after this additional installation you’ll 
be able to execute the spelling check. 

11.1.6. Entering special characters 

You can work with Unicode databases as well as with databases that 
still use the DOS character set, or the ANSI (WinLatin1) character set, 
in your existing applications. The Adlib software recognizes the type of 

your databases automatically, and doesn’t change anything by the 

way. 

For you, as a user, the only difference is that in Unicode databases 
you can enter characters from languages like Hebrew, Chinese, and 
Greek in your Adlib records, and that the alphabetic sorting and 
searching of terms complies with the language characteristics of your 
region or country. So for the registration of, for example, an historic 
artefact you can also enter the text on that artefact in the Adlib rec-

ord. 
In ANSI (WinLatin1) databases, on the other hand, you can only enter 
a limited number of special characters. Most of these are letters with 
diacritical characters, such as é or ë. Figure 11.2 shows all possible 

special characters. 

In most Windows applications, and so in Adlib too (ANSI and 

Unicode), you can enter letters with diacritical characters by first 
typing the diacritical character and then the vowel. 
Each character also has a code. Keep the left Alt-key pressed and 

type (on the numerical pad of your keyboard) the 4-digit code repre-
senting the desired character. For example in the Windows: Western 
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character set: press Alt and type 0128. The euro character € will 

appear. Other often-used codes are: Alt+0153 for ™, Alt+0169 for ©, 

Alt+0174 for ®, and Alt+0177 for ±.  

 

Figure 11.2: The WinLatin1 character set, from character 0128. 

You can set a character set in Windows through Start  All programs 

 Accessories  System tools  Character map. The drop-down list 
Character set, which shows after you mark Advanced view, shows the 
sets currently installed on your computer (the character set Windows: 
Western is the same as WinLatin1). For Unicode, select a Font be-

cause different characters are available for different fonts. Select any 
character to display the code of it (if there is one) in the lower right in 
the status bar of the window. 
In this window, you can Select and Copy one or more characters and 
then paste them into Adlib (in a Unicode database) or somewhere else 
into a document. This way you can enter foreign characters with your 
western keyboard. 

Note that it is quite possible that a Unicode character set has been set 
for Windows on your computer, whilst you are using ANSI databases 
in Adlib. Then leave the character set setting as it is. In Adlib, you can 
then enter letters with diacritical characters and for instance the euro 
character as you would expect, but then you can’t use any “exotic” 

characters in Adlib. 
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11.1.7. Ending entry 

Data will not be saved definitively until you click Back or Restart (or 

Start  Save or Start  New), and confirm Adlib’s question whether 
you want to save the changes. If your answer is Yes, Adlib will update 
all the indexes and you will be able to search on the new or changed 
data immediately. 

Instead of Start  Save you may also use the familiar Windows key 
combination Ctrl+S to store a record. Adlib will ask for confirmation 

as usual, before the record is actually saved. 

11.2. Editing an existing record 

If you have sufficient access rights and you are working in a dataset 

or database that is not subdivided, you can change (edit), copy and 
remove existing records. Select or open a found record you want to 
edit and in the Brief display or detailed presentation click the Edit 
button in the Start menu.  

 

Click in an entry field of your choice and change the contents. When 
you are finished editing, click the Save button.  

 

Adlib asks for confirmation. Click Yes to save, click No to close the 
detailed presentation without saving the changes you made, or click 
Cancel to continue editing the record. 

 Quickly opening recently edited records 

After you’ve chosen a data source in step 1 of the Search wizard, the 

File menu (to the left of the Start menu) contains a list of the nine 
most recently edited records in this data source. Only the record 
number of each record is displayed. Just click one of the records to 

open it in display mode immediately. This is convenient if you still 
have data to change or add to recently edited records. This way you 
don’t need to search for them. The list is available everywhere in 

Adlib, so you can switch from the detailed display of one record to 
another. 

By the way, only edited records will make it to the list: if you’ve only 
viewed a record in display mode, it won’t appear in the list. 
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This functionality is only available in the ribbon (under Windows Vista 
SP2, Windows Server 2008 SP2, or newer Windows versions.) 

 Record locks 

When you start editing a record, Adlib applies a so-called record lock 
to it and also to secondary records linked from certain fields if those 

linked fields have so-called write-back fields (fields which values can 
be written back to the relevant linked record). This prevents col-

leagues from editing these records simultaneously: as long as there is 
a lock on a record, others can only view that record, not edit it. If 
another user still tries to edit a locked record, Adlib will prohibit this. 
Adlib will only release a record when the user editing the record leaves 
edit mode by saving or closing the record unsaved. 
In normal operation, Adlib cleans up the relevant record locks as soon 
as a user stops editing the record, but if during editing of a record a 

malfunction in your system occurs (e.g. because of a crash), it is 
possible that the record lock is not removed, which makes it impossi-
ble for anyone to edit that record again (because it is still locked). 

If you can open a record in display mode, but you cannot edit or 
remove it while no-one else is editing the record and you have write 
or full access to it, this is probably because the record is still locked. 
You may receive an error 34 or 85, and/or a message stating that the 

record is in use or that no record lock can be applied. The record lock 
must first be removed before you can edit or delete the record. 
In such cases, you can use the Record lock manager in Adlib Designer 
to check which records are still locked, and remove the record locks 
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that are no longer applicable. This functionality is a standard part of 

Adlib Designer but is also freely available as a separate tool to all Adlib 

customers so that users of Adlib Basis or Adlib Lite can manage record 
locks as well. 

11.3. Copying records 

With the Copy button in the Start menu, you can duplicate the data 
from the currently selected or displayed record into a new record; this 
new record will be displayed so it can be edited.  

 

In some applications an adapl and/or non-exchangeable fields may 

prevent certain fields being copied. Before saving you will be required 
to change any occurring unique keys. When the copied and possibly 
edited record is saved, a new record number will be assigned to it. 

When copying records it is possible that you are confronted with the 
obligation to fill in certain fields before you can save the record, whilst 
these fields are empty in the original record. This is usually because 
the record has not been created in Adlib or because the relevant field 

originates from another Adlib database that is linked to the field, in 
which that field was not required. So a required field that doesn’t 
contain a value can occur; when editing a record in which that field is 

required, you will be forced to fill in a value. 

11.4. Deleting one or more records 

On the Brief display or detailed presentation (when the record is not in 
Edit mode), you can remove one or more records from the database. 
Adlib will ask for confirmation before permanently (!) deleting the 

record(s).  

 From the Brief display 

In the Brief display click the Delete button (Start menu) or press Del 

to remove a selected (highlighted) record or all marked records (with 
a checkmark in front of them) from the database. 

 

Adlib asks for a confirmation before the current record really is delet-

ed. 
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Figure 11.3: Confirm that the currently selected record must be deleted. 

Be careful with deleting records. You cannot undo the removal of 
records. 

If records have been marked, then first you will be asked which rec-
ords have to be deleted. 
 

 

Figure 11.4: Choose to remove all marked records or just the currently select-
ed record. 

As soon as you click OK, the chosen selection will be deleted. 

During removal it is possible to have an adapl executed for each 
record to be deleted, for instance to update other databases or rec-
ords. Such a removal adapl might still cancel the deletion of the rec-
ord, even when you have confirmed it already. 
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 From the detailed display 

Click the Delete button (Start menu) or press Del to delete only the 

current record from the data file, and ignore other possibly marked 
records. This button is only present when you are working in a dataset 
or in a database that is not subdivided into datasets. Adlib will ask you 
for a confirmation before a record really is deleted. You cannot undo a 
deletion. 

11.5. ADAPL procedures 

At different times, Adlib can execute an extra procedure written by the 
application builder. Such a procedure is written in ADAPL, a program-

ming language especially developed for this purpose. Such a proce-
dure is called an ‘adapl’. 

Often, an adapl is carried out prior to displaying a record, for instance 
to present the data differently than it is stored in the record, or to 
establish the availability of copies of a book. An adapl can also be 

used to check data you just edited, creating the opportunity to correct 
possible errors before storage. This way, it can be ascertained that an 
entered value is not unique, after which you are allowed to enter 
another value. Only after execution of that adapl, Adlib will ask 
whether the edited record should be saved. When you confirm that, 
again an ADAPL procedure can be executed, but this one cannot be 

interrupted. Updating other databases for instance, usually only hap-

pens when the record is stored, because only then Adlib can be sure 
that all screen checks have been performed successfully. 
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12. Extra functionality for data entry 

Abstract 

A number of fields is linked to another database, a thesaurus for 
example. This means that in such linked fields only a reference to 
the linked record will be stored, so that when you are viewing the 

current record you will always see the most up-to-date data from the 
linked record. A change in the linked record will automatically appear 
in all fields which link to it. If the cursor is in a linked field, the List 
button in the Edit menu becomes active (12.1): 

 

Click the button to open the Find data for the field… window with a 
list of existing terms to which you can link. It’s also possible to just 
enter a term or partial term in the field, leave the field and automati-

cally have your data entry validated (12.1.1): if the term already 
exists, the link will usually be created unnoticed (although non-
preferred terms will be replaced by their preferred term, see page 
184), but if the term does not yet exist, then the link window will 
open automatically so that you can select an existing term still or add 
the term as a new linked record (page 179). The window also allows 

you to view or edit details of a record in the linked database. The 
screen tabs (page 182) in the window present a hierarchical term list 
(thesaurus terms can have narrower and broader terms), a list of any 
pointer files in the linked database (allowing you to link to a selection 
of records at once, see 12.1.4), and possibly a table display of the 
term list. 

Terms and names in authority databases may receive a status indi-

cating whether it concerns a preferred term or an obsolete or reject-
ed term, for example (12.1.2). Terms and names which have been 
added from within a different database, receive the candidate status. 
Candidate terms will only appear in the Find data for the field… win-
dow if the Show candidate terms too checkbox has been marked. In 

the authority database itself you can change the status of each term. 

If you often fill in the same texts, but you don’t want to have to type 

them each time, then you can label such texts as favorites for that 
field, so that you’ll be able to select that text directly from the right-
click pop-up menu for that field next time (12.1.5). 
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If you enter an existing value in a linked field, it may very well be 

that other fields, usually near the linked field, are filled in automati-
cally: these are merged-in fields (12.1.6) and the values are re-
trieved from the linked record. Often it concerns read-only fields, for 

your information only. 

In different Adlib applications you can link images or other media 
files to an object or title record, sometimes even without having to 
leave the catalogue (12.2). To be precise: in a reproduction record 
you refer to the image file itself, and in an object or title record you 
link to the reproduction record. There are different ways of linking 
images and/or reproduction records. The possibilities depend on your 

application version. The choice often boils down to either creating a 

reproduction record for an image first and link to it from within a 
catalogue record, or creating a new linked reproduction record from 
within the catalogue, or directly searching for an image from within a 
catalogue record after which a linked record and the link to it will be 
created automatically.  

 

On the Reproductions tab of an object record for example, you’ll find 

the Reference field in which the link has to be created. Search for an 
image directly by clicking the Import image button in the Edit menu, 
if it is active, or simply drag one or more images from Windows 

Explorer to the Media Viewer in Adlib. 

In Adlib SQL and Adlib Oracle databases, the Adlib software allows for 
the possibility of multilingual entry and searching (12.3). This 

means that one record can contain data in several languages, and 
that the record can be displayed in the data language selected by the 
user. However, multilinguality has been implemented in your applica-
tion only if the Data language button in the Edit menu is active.  

 

With the Search wizard you will automatically search all data lan-
guages at the same time, whilst the Advanced search also allows for 

searching through all data languages simultaneously or within a 

specific data language. 

After marking records, you can perform a search-and-replace on 
these records (12.4), where you enter a character string to be found 
in certain fields (which you can select yourself), and possibly in a 
specific data language, which must be replaced by another character 
string which you have entered. With this you are able to quickly 
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replace a consistently incorrectly entered in or antiquated term, in all 

marked records. Click the Replace in Record button in the Edit menu 
to enter your replace command in the Search and replace window. 

 

Replacing data in linked fields is a bit more complex (12.4.2), and 

often not even necessary: an adjustment of the spelling of the rele-
vant term or name in the authority database may be enough. 

It is possible to derive records from a similar database to the 
current database, if such a “friendly” database has been set up for 

this (12.5). You do this via the Start  Derive button. Deriving (in 

other words: copying) records from (local or internet) datasets is 
useful when you are describing documents or objects that contain 
similar data.  

 

12.1. Linked fields 

A number of fields is linked to another database, a thesaurus for 

example. That means that the data for certain fields will be retrieved 
from the other database. This creates a number of extra possibilities. 

If the cursor is in a linked field (the status bar can inform you), then 
in the Edit menu the List button is active: 

 

Click it (or press Shift+F4) to request a list with a selection of availa-

ble keys for the current field; the field may still be empty or you may 
have filled in the first letters of the term you are searching for. The 
Find data for the field … window opens: in Adlib jargon we also call 
this the link screen or the Linked record search screen (old name). 

This window can also be opened by double-clicking the linked field. 

The keys in the selection displayed start as much as possible with the 
same letter(s) as the search key you entered starts; for an empty 
search key the beginning of the index will be shown. You may type 
something else in the Find entry field at the bottom of the window and 
the list will be updated accordingly. Select a key and click Select, to 

choose that term. Any accompanying data to this key is copied to the 
automatically retrieved fields (merged fields) of the catalogue record. 



Extra functionality for data entry Adlib User Guide 

 178  

If the linked database is multilingual, then the list of available keys 

will only display keys in the current data language. 

You can resize the window by dragging one of the edges. 

 

Figure 12.1: An example of the Find data for the field… window. 

12.1.1. Automatic term validation 

A linked field may or may not allow you to add a term which the 
system does not know, depending on the database definition. The 

term is automatically checked when you leave the field occurrence. If 
the term cannot be found – click OK in the message that possibly 
appears – and you are allowed to add terms, then you may force 
(using the Force record button) the entered term into the appropriate 
term index and into the linked database, or you choose a different 
term from the list. 

In Figure 12.2, Enquist, Anna has been entered in the Author entry 

field of a Library application. Leave the field and in the Find data for 

the field window that opens, you’ll find a selection of all previously 
added authors of which the name starts (as much as possible) with 
the same letter. Author is a so-called domain within the linked data-
base Persons and institutions. Unmark the Show only ‘author’ option 
to display a selection of all indexed names (of which the name starts 
with the same letter) from all domains in the linked database, so for 
instance also publishers, suppliers, and creators. The names from the 
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domain that belongs to the current field (in this case authors) will be 

displayed in bold type. 

 

Figure 12.2: Click Force ‘…’ record to add a new author to the index and as a 
record to the linked database. 

This check simplifies data entry and prevents terms being saved with 
different spellings or spelling mistakes.  

If the linked database is multilingual, then the automatic validation of 
a term entered in the linked field, will always take place within the 
current data language only. 

 The functions of the buttons 

• Force record – With this button you add a record for the current-
ly entered term or name to the linked database, but does that in 
the background.  
In the example you confirm this way that Enquist, Anna must be 

added to the linked database as a record. The adding of the record 
takes place in the background. The new name or term will not be 
saved in the catalogue record itself, but in the linked data source 

(Persons and institutions in this case). In the catalogue record a 
reference (the record number) to the new linked record will be in-
cluded. ‘Forced’ terms are only really added to the linked database 
when you save the main record. This prevents Adlib from already 
having added records to the linked database when you would de-
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cide not to save a newly filled record. 

If the linked database is multilingual and an entered term does not 

occur in the current data language in that linked database yet, 
and you choose to add the term, then the term will be saved in 
the current data language in the new record. 

• Create record – With this button, you can directly add a new 
record to the linked database for the term you entered in the Find 
entry field at the bottom of the window, and edit it in a zoom 

screen before you save it. In the example of Figure 12.2 you could 
add personal details or a pseudonym for this author. 
You may as well create a new linked record directly from within 
the linked field in the main record. You’ll then skip the Find data 
for the field… window, but Adlib does check whether the term or 

name already exists. When editing a record, place the cursor in 
the desired linked field, type a new term (for a new linked record) 

or an existing term (to edit an existing record from the linked da-
tabase), and click the Make/edit linked record button in the Edit 
menu. 
 

 
 
If the linked database is multilingual, then the term will be saved 
in the current data language in the new record. (Any translations 

of the term can only be entered in the new linked record after you 

stored that record.) 

• Records featuring keyword - Click this button to open a list of 
records from the current database in which the selected term or 
name appears in the active field. That list will be opened in a sec-
ond window. You could use this list to get a quick overview of the 

works associated with an artist for example: especially if your 
linked database contains identical or comparable names, this is a 
good way to make sure that you are linking the right name to the 
current record. 
The fields (columns) displayed in that list are identical to the ones 
displayed in the brief display of a normal search result in the cur-
rent data source.  
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While the Records featuring keyword window is being shown, you 

can select any other term or name in the Find data for the field… 

window, either on the View hierarchy or View table tab, to update 
the list in the Records featuring keyword window immediately.  
The size of the Records featuring keyword window cannot be 
changed but you can change it’s position on the screen and that 
position will be saved. 
If set up for the current linked field (not by default), double-

clicking a listed record will open a zoom screen to show more da-
ta. 

• Details - Click the Details button to display detailed information of 
a selected record from the linked database, in a zoom screen.  
To be able to edit the data from the linked record in the zoom 

screen, choose Start  Edit from within the opened zoom screen. 
When you close the zoom screen again, Adlib will always ask you 
if the changes must be saved or not. 

• Select - With the Select button you copy the (reference to the) 

selected term or name to the linked field. 
If you click Select in the example of Figure 12.2, the selected term 
(the one marked with a beige or blue bar), Evans, Arthur J., will 
be copied to the Author field, not Enquist, Anna. 

• Cancel – Click this button to leave this window and return to the 
linked field, without changing anything. 

 The filter options 

Underneath Filter options you can choose whether or not to display 
certain terms or names in the list. Some linked fields have been asso-
ciated with a domain (a subdivision on the type of term or name in an 
authority data source like the Thesaurus or Persons and institutions). 

With the Show only… option marked, the list will contain names from 
the domain for the current field only. In the example discussed above, 
this domain is called author. If you also want to see names from other 
domains, then deselect the checkbox. 
The Show only… option won’t be present if no fixed domain or domain 
tag has been specified for the linked field: by default you’ll see terms 

from all domains. 

In new applications, terms and names added to the Thesaurus or 
Persons and institutions from within other databases, get a candidate 
status by default as long as they haven’t been approved yet and/or 
haven’t received a different status yet. Via Show candidate terms too 
you can choose to include those terms or names in the list. 
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 Scrolling through the list 

The vertical scrollbar on the right of the list allows you to scroll within 
the present part of the complete list. (The present part of the com-
plete list always consists of a limited number of keys.) The little arrow 
buttons on top and at the bottom of this scrollbar allow you to do the 
same, but without dragging the scrollbar. Use the tall buttons on the 

left side of the list to display the next of previous part of the list. (By 
default, only the relevant part of the list is displayed at first.) 
Instead of clicking a double-arrow button repeatedly to view other 
parts of the list, you may also enter one or more letters in the Find 
box to have the list immediately jump to keys starting with those 
letters. 

 The screen tabs 

 

Figure 12.3: The View hierarchy tab displays not only the found keys, but also 
all narrower terms of those keys. 

The two screen tabs View hierarchy and View lists are always present. 
In View hierarchy you can see a hierarchical display of the terms in 
the linked database: a term with a plus sign in front of it can be ex-
panded. You can select any term to link to it. A red dot  marks a 
non-preferred term. If you select such a term anyway, the term will 

automatically be replaced by the appropriate preferred term. 
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Figure 12.4: The View table tab shows related data to the found keys. The tab 
has not been set up for every linked field though. 

On the View lists tab you can see a list of pointer files available in the 
linked database: this allows you to link all records in such a pointer 
file at once. We’ll discuss the View lists tab in full, later in this chapter. 
Where a Link screen has been set in the data dictionary for a linked 
field, the Find data for the field window displays yet another screen 
tab which is labeled View table. In there you’ll see a non-hierarchical 
presentation of terms in the linked database, and some accompanying 

details per term (if present in the record). 

 Used thesaurus 

 

Optionally, for some linked fields there might be a Thesaurus drop-
down list present above the Filter options in the Find data for the 
field… window, That list is there only if the possibility of using a differ-

ent authority database for the current linked field has been set: usual-
ly this is not the case though. 
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If you want to validate a new term or name to another database than 

the current, then select the other database here. Read more about it 

in chapter 13.10. 

 Replacing non-preferred terms by preferred terms 

When you enter a non-preferred term in a linked field, or select it in 
the Find data for the field window, then that term will be replaced 

automatically by the preferred term as defined in the linked database 
(e.g. the Thesaurus), when leaving the field or window. 

However, a non-preferred term can have more than one preferred 
term. Then, no automatical replacement can take place, and Adlib 
presents you with the More than one preferred term found window 

instead, with in it all preferred terms for the relevant non-preferred 
term. Simply choose the desired preferred term by selecting it, and 

clicking OK. 
In this case, you can also link multiple preferred terms at once (if the 
linked field is repeated) by clicking each of them in the More than one 
preferred term found window, while you keep the Ctrl key pressed 

down, before you click OK. 

 Truncated searching for preferred terms 

If, in a linked field, you enter a value followed by a * or /, then Adlib 
interprets that as a command to search truncated on the relevant 
value, when leaving that field. If, in the linked database, preferred 

terms exist which begin with the value in front of the truncation char-
acter, then those values will be shown in the More than one preferred 
term found window. From here, you can link one or more terms at 

once: 

• Click the Details button to open the record of the selected term or 
name in a zoom screen, if you want. That makes it easier to 
choose the correct term, especially if identical terms are being 
displayed in the list. 

• Select the desired term and click OK to link only that term. 

• Click All terms to link all terms from the list to the record. Each 

term will be placed in a separate occurrence of the field; of 

course, this is only possible in a repeated field. 

• Click the terms which you want to link, while keeping the Ctrl 

button pressed down. You’ll create a selection of terms. Then click 
OK to link the selected terms to the record. Each term will be 
placed in a separate occurrence of the field; of course, this is only 
possible in a repeated field.  



Adlib User Guide Extra functionality for data entry 

 185  

If, in the linked database, you search for values which actually end 

with a * or /, then you cannot enter that value in a linked field un-

modified without Adlib interpreting the character as a truncation 
character and opening the More than one preferred term found… 
window from which you must choose the proper term manually. As 
soon as the selected term (ending with * or /) has been linked though, 
the character won’t be interpreted as truncation character again the 
next time you move the cursor in and out of the relevant linked field. 

 

Figure 12.5: Multiple preferred terms have been found. 

12.1.2. The role of the term status on data entry  

Terms and names forced from within a catalogue into an authority 
database like the Thesaurus or Persons and institutions by clicking the 
Force record button in the Find data for the field window, are initially 

assigned the “candidate” status if a relevant field has been set up for 
it in the relevant database*. (That status can always be changed later 
on, in the created thesaurus records: see chapter 13.1.1.) In that 
case, a Show candidate terms too checkbox will appear in the Find 
data for the field window (unless your access rights specify different-
ly). Forced terms or names will be added to the displayed list of found 
keys only when you mark this checkbox.  
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Terms and names with the obsolete or rejected status won’t be 

displayed in the Find data for the field window for linked fields, since 

Adlib 7.3. That way you won’t accidentally pick a term here which 
shouldn’t be used anymore. 

• Obsolete terms and names can still be used though and existing 
records with the term or name will remain unchanged and they 
won’t generate any messages either. 
However, when you enter the term or name anew in a linked field, 

you’ll get to see the warning below. Click Yes to accept the 
entered term, here in this field in this record, for what it is or click 
No to delete the entered term or name and place the cursor in the 
relevant field again so that you may enter another term. 
The next time that you newly enter the same term or name in a 

field, the message will reappear. The message won’t show up if 
you leave a field in a record in which the term or name had 

already been entered earlier. 
 

 

• Rejected terms or names can no longer be entered in fields, 
although existing records with the term or name will remain 
unchanged and they won’t generate any messages either. When 
you do enter the term or name in a linked field anyway, you’ll be 
warned that the term can no longer be used. You can only click 
OK, after which the field will be emptied automatically. 

* In model applications older than 4.2 this status management is not 
built-in by default, but it is possible to implement this functionality in 
those applications by means of Adlib Designer.  
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12.1.3. Linked fields with a drop-down list 

 

Figure 12.6: Collection, a normal linked field. 

When you fill in a field which is linked to another database, you can 
usually choose from a list of terms from the other database via the 
Find data for the field… window. Often you’ll have the possibility to 

add a new term from that window, or to edit a linked term in a zoom 
screen. 

 

Figure 12.7: Available terms from the linked database. 

A much more confined way to limit data entry in a certain field, is to 
set up a fixed drop-down list for it. Then it won’t be a linked field, and 
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the list of terms from which the user can choose will be put together 

by your application manager. 

However, an intermediate solution is available too: linked fields which 
present all (maximally 250) available preferred terms from the linked 
database, often from a specific domain as well, in a drop-down list. 
This allows the application manager to offer user-friendly drop-down 
lists without the advanced options of the Find data for the field… 
window, and the relevant terms can still be managed via the 

thesaurus. Since long drop-down lists are not user-friendly either, we 
recommend to use this functionality only if it is known in advance that 
the terms list will be limited to a small number of terms. Long lists are 
still possible though; if a list doesn’t fit on the screen, a scroll bar will 
appear with which you can scroll through the list. 

If your application manager has set up a linked field this way, then on 
data entry of a record you can only choose linked terms via the drop-

down list. As far as visual presentation goes, there is no difference 
between this type of drop-down list and fixed drop-down lists. 

 

Figure 12.8: The available linked terms, now in a drop-down list. 

However, if you have picked a term, you can still edit the linked record 
from within the catalogue by clicking the Make/edit linked record 

button in the Edit menu. 
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If the field is empty (no value from the drop-down list is currently 

selected) then you can add a new term via Make/edit linked record 

too. In the linked data source itself, the Thesaurus for instance, you 
can edit the relevant records as well, of course, or create new records 
within the domain. Changes or additions will automatically become 
visible in the drop-down list. 

12.1.4. Linking multiple records at once 

If the current linked field is repeatable and you want to link more than 
one record, for instance multiple creators, or multiple reproductions, 
then Adlib offers an efficient method to do so. You can select multiple 
terms or names in the Find data for the field… window. Then, when 
you click Select, all selected terms will be linked to the current record. 

To this end, extra field occurrences are added automatically, starting 
at the field occurrence which currently holds the cursor: if one or more 
of the occurrences of the field have already been filled in, then first 
add a new empty occurrence below and put the cursor in that last 
occurrence before you link new records, because otherwise the al-
ready filled-in occurrences will be overwritten.  
Selecting multiple terms or names is only possible on the View table 

tab though, by pressing down the Ctrl-key while you click a term in 

the list. If you want to deselect a selected term, just Ctrl-click that 

term again. (You can let go of the Ctrl-key while scrolling through the 

list.) You can undo the entire selection by selecting one term without 
pressing down the Ctrl-key. By pressing down the Shift-key and 

clicking a term, you even select all terms from the previous selected 

term up to and including the newly selected term. Click the Select 
button to link all selected terms. 

Technical information 

With some linked fields in model applications no Link screen has been 
associated, in which case no View table tab will be present. If you still 
would like to have the above functionality for those fields, you could 
associate an appropriate existing or newly made link screen with the 

relevant fields in the data dictionary, via Adlib Designer. In the Adlib 
Designer Help you’ll find extensive documentation about making such 

a screen and how to set it up for a data dictionary field. 
By the way, always back up your Adlib applications and databases 
before you apply changes to your Adlib system. 

 

Example: in the Exhibitions data source, we open a new record. On 
the Linked objects tab we want to link a number of photographs by 

Claude Cahun of which the title contains the text “self portrait”. 

http://documentation.axiell.com/alm/en/index.html?ds_scrconstructingdifferentscreens.html
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1. On the Linked objects tab, the cursor is in the Object number 

field.  

 

 

2. Shift+F4 opens a QBF and we fill it in. 

 

 

3. Click the Search button in the Search form context menu (in the 
ribbon) and in this example we find a number of objects which are 
shown in the Find data for the field… window.  

 
Via Ctrl+clicking we select four of the photographs. 
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4. We click Select and the visual documentation records are auto-

matically linked to the exhibition record. 

 

 

 Alternative methods 

Two alternatives to the above have been implemented as well. With 
these methods you can link records from a pointer file to the current 

record; you can do this from within the search form with which you 
search for objects to link to, or from within the Find data for the field… 
window. 

1. Alternative 1 is to first search the catalogue for photographs by 

Claude Cahun of which the title contains the text “self portrait”, 
and save that selection in a pointer file.  

2. Then open the Exhibitions data source and for instance a new 
record in there. Go to the Linked objects tab, and press Shift+F4 

from the Object number field to open the Query by form Objects.  

 

3. Simply click the Pointer files button in the Search form context 
menu, and in the opening Pointer files window then choose the 

desired pointer file. All records from the pointer file will be linked 
to the exhibitions record. 

 

 

1. Alternative 2 is more suited for situations without a search form. 
Suppose you have a series of objects which all have the same 
group of creators. Then save those creators in a pointer file in Per-
sons and institutions first. 
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2. Then open for instance the Internal object catalogue with a new 

record, and go to the Production/dating tab. Put the cursor in the 

Creator field and press Shift+F4 to open the Linked record search 

screen. 

3. Open the View lists screen tab and choose the desired pointer file. 
All records from the pointer file will be linked to the object record. 

 

12.1.5. Favorite terms per field in pop-up menu 

If you often fill in the same texts, terms, names or numbers in certain 
fields (text fields, linked fields or numerical fields), but you don’t want 
to have to type them or (in the case of linked fields) select them from 
the Find data for the field... window each time, then you can label 
such texts as favorites for that field, so that you’ll be able to select 

that text directly from the pop-up menu next time. This is especially 
handy for fields which contain longer, frequently occurring texts. 

It works as follows: 

1. Open a record in edit mode and put the cursor in a field for which 
you want to add a favorite, for instance the Bibliographical notes 
field in a library application. 

2. Type the desired text in the relevant field, or retrieve it via the 

Find data for the field... window if it concerns a linked term or 
name. If the field already contains a value, then that one can be 
added to the favorites as well, of course. 

3. Right-click in the field, Bibliographical notes in this example, and 
in the pop-up menu that opens, choose Add to favourites. 
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4. From now on, each time the cursor is in the Bibliographical notes 

field, e.g. in a new record, and you right-click that field, then in 

the pop-up menu you can immediately select the text Contains a 
bibliography which will be copied to the Bibliographical notes field. 
 

 
 

In the same way you can store up to ten favorites per field. If you 

save an eleventh favorite, Adlib will automatically remove the oldest 
favorite so that ten remain again. 

Further, it is possible to delete earlier collected favorites or to change 
the order of the favorites in the pop-up menu. Simply right-click the 

field for which to want to manage the favorites and in the pop-up 
menu select the Manage favorites option. 

 

In the Manage favorites window you can move a selected text up or 
down using the blue arrows or remove it with the red cross. Click OK 
to store the changes. 
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12.1.6. Automatically retrieved fields (merged fields) 

The application builder may define fields in such a way that they are 
automatically filled on the basis of the value in a key field. If you 

change the value in the key field, the automatic field will also change. 

For example, the application builder can have the address of a pub-
lisher automatically filled in based on the publisher name. You can 
then change the name field but not the merged-in address fields.  

The data for an automatically merged-in field is retrieved from a 
linked database. The key field that has been filled in is used as the 
search key for the linked database. 

12.2. Adding images, movies or music 

In Adlib Museum (from application version 2.0.1), Adlib Library and 

Adlib Archive you can link existing or new images or other media files 
to an object or title record, sometimes even without having to leave 
the catalogue. To be precise: in a reproduction record you refer to the 
image file itself, and in an object or title record you link to the repro-
duction record. There are different ways of linking images and/or 

reproduction records. The possibilities depend on your application 
version. The version number can be found in the title bar of your Adlib 
application:  
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12.2.1. Application version 2.0.1 up to and including 3.4 

 

Figure 12.9: Linking reproduction records in 2.0.1 up to and including 3.4. 

• With this first method you will explicitly create a reproduction 
record via a zoom screen from within the catalogue: for example, 
open an object record for editing, and go to the Reproductions 
tab. Place the cursor in the Reference field and click the Make/edit 

linked record button in the Edit menu. 
 

 
 
Data about the relevant image reproduction can now be filled in in 
the zoom screen that opens, including Identifier (URL) and Repro-
duction reference: the Identifier (URL) is the path to an image 
while Reproduction reference. is a name or number of your choice 

with which you can refer to the reproduction record. The reference 
can be identical to the name of the image, but not necessarily. 
You can type the Identifier (URL), but there are better ways: see 

the Referring to the image itself paragraph below. 
When you close and save this zoom screen, the data will be re-
trieved and displayed in the entry fields with the same names, on 

the Reproductions tab of the catalogue object. 
Via the zoom screen you have, in fact, created a new record in the 
Visual documentation data source very quickly. 
You can add new field group occurrences of the Reproduction field 
group (Ctrl+Enter) on the Reproductions tab, to be able to link 

multiple reproduction records. 

• The second method entails first having to register all your images 
in reproduction records in the Visual documentation database, and 
only then linking those reproduction records to the object records 

in the catalogue. Then, after placing the cursor in the Reference 
entry field on the Reproductions tab, you’ll only have to click the 
List button (Shift+F4) in the Edit menu to search for the desired 

image reproduction record via a search form. 
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The Identifier (URL) will then be shown automatically, in accord-

ance with the data in the image reproduction record. 

You can link movie and audio files as well as images in fields of the 
Image data type (like the Identifier URL field), in the same way as you 
would link images. 

 Referring to the image itself 

 

Figure 12.10: Preparations for dragging an image to Adlib. 

There are three ways of referring to images: 

Method 1: You can search your system for the image itself, via the 

Import image button in the Edit menu, when the cursor is in the 
Identifier (URL) entry field in an image reproduction record (either 
from within the Visual documentation data source or from within a 
catalogue in a Visual documentation zoom screen). This way you can 
link one image to the reproduction record. 
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Method 2: When you have opened an image reproduction record in 

edit mode (either from the Visual documentation data source or from 

a catalogue in the relevant zoom screen), you can add an image very 
quickly via drag and drop as well, for instance as follows:  
 
1. Open a new or existing record in the Visual documentation data 

source. 
 

2. Place the cursor in the Identifier (URL) field. This entry field 
needn’t be empty. When no images have been linked yet, the Me-
dia Viewer is empty, as you can see in figure 12.10. 
 

3. Open Windows Explorer and open the folder in which you keep 

your images. Resize the explorer so you can see it together with 
Adlib in the screen. If necessary, switch to Adlib and then to Ex-

plorer, and move it around until your screen is arranged like in 
figure 12.10. 
 

4. Now click the image you want to link to the record, keep the 
mouse button pressed down and drag the cursor to the Media 
Viewer, as you can see below. 
 

 
 
5. Let go of the mouse button and the link will be created. Identifier 

(URL) will be filled with the path to the image, and the image ap-

pears in the Media Viewer. You may still change the full path into 
a relative path (relative to the application folder); also see the 

paragraph below. 
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Figure 12.11: The dragged image is now registered in the record. 

 

Relative path names and URLs 

To refer to images in your visual documentation records, you should 

use a relative path name, so for instance: ..\images\Obj1234.jpg. 
Relative paths have the advantage that you could move the entire 
Adlib folder to a different location, without having to enter new path 
names everywhere. 
If the images cannot reside in the Adlib folder, and are located sepa-
rately on a (IIS) server somewhere, then that’s possible too. In that 
case you refer to the images via a URL, for instance: 

http://myimageserver/ adlib/images/. 
However, when you link an image to a record via the Import image 
button or via drag and drop, automatically the full path name is filled 

in. The best thing to do after creating a number of reproduction 
records, is to replace the character string ‘C:\Adlib Software’ (or 
whatever is applicable in your situation) in all path names, by ‘..’ 

via a search-and-replace, to convert all paths to relative paths in one 
go. 
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Method 3: images which are not yet present on your computer as 

files, but are only available to you as prints for example, can be 

scanned on the spot and processed in Adlib at the very moment you 
want to link the image. For more information about this subject, read 
the chapter called Adding images yet to be created, through WIA, 
hereafter. 

12.2.2. Application version 3.5 and higher 

 

Figure 12.12: Linking reproduction records in 3.5 and higher. 

You can link images and/or reproduction records in five different 

ways: 

• With this first method you will explicitly create a reproduction 
record via a zoom screen from within the catalogue: for example, 
open an object record for editing, and go to the Reproductions 
tab. Place the cursor in the Reference field and click the Make/edit 
linked record button in the Edit menu. 
 

 
 
Data about the relevant image reproduction can now be filled in in 
the zoom screen that opens, including Reproduction reference: 
this is both the name of an image file as well as the reference with 
which you can point to the reproduction record. (In older applica-
tions there still was a separate field for the path to the image and 

another field for a reference of your chosing. In the newer applica-
tions, the reference is always equal to the name of the image file.) 
You can enter the Reproduction reference manually or you can 
search your system for the image itself, via the Import image but-
ton in the Edit menu, when the cursor is in the Reproduction ref-

erence entry field. This way you can link one image to the repro-
duction record. 

 

 
 
There is yet another important difference between application ver-
sion 3.5 and application version 4.2 or higher, concerning the ref-
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erence: in 3.5, the full path to the image is stored and displayed 

in the (Reproduction) Reference field, and the image file remains 

where it is. From 4.2 however, only the name of the image file 
(without path) is stored and displayed. When you link the image, 
that image will be copied (!) from the original location and by de-
fault pasted in the /images subfolder of your Adlib Software folder 
(unless the image is already there of course). 
When you close and save this zoom screen, the data will be re-

trieved and displayed in the entry fields with the same names, on 
the Reproductions tab of the catalogue object. 
Via the zoom screen you have, in fact, created a new record in the 
Visual documentation data source very quickly. 
You can add new field group occurrences of the Reproduction field 

group (Ctrl+Enter), on the Reproductions tab, to be able to link 

multiple reproduction records. 

• The second method entails first having to register all your images 
in reproduction records in the Visual documentation database, and 
only then linking those reproduction records to the object or title 
records in the catalogue. Then, after placing the cursor in the Ref-
erence entry field on the Reproductions tab, you’ll only have to 

click the List button (Shift+F4) in the Edit menu to search for 

the desired image reproduction record via a search form. 
 

 
 

• The third method is even faster then the above two. You can 

search your system for the existing image directly from within the 
catalogue as well, via the Import image button in the Edit menu, 
when the cursor is in the Reference entry field on the Reproduc-
tions tab. 
 

 
 

As soon as you save the object or title record, in the background a 

linked reproduction record will be created for the relevant image, 
without notification. This linked record will only contain the refer-
ence to the image file, and can be opened by clicking the under-
lined reference, for example. 

• The fourth method – drag and drop – is well suited for (implicitly) 
creating multiple reproduction records for as many images, and 

directly linking them to a catalogue record (although the method 
can also be used to link one image to a reproduction record). 
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a. Open a catalogue record for editing, for instance in the In-

ternal object catalogue, and place the cursor in the Refer-
ence field on the Reproductions tab. 
 

b. Open Windows Explorer and open the folder in which you 
keep the images which you want to link. Resize the explor-
er so you can see it together with Adlib in the screen. If 

necessary, switch to Adlib and then to Explorer, and move 
it around until your screen is arranged like in figure 12.13. 
 

c. Keep the Ctrl key pressed down while you click the imag-

es which you’d like to link to the record. Let the Ctrl key 

go, click one of the selected images, keep the mouse but-
ton pressed down and drag the cursor to the Media Viewer, 
as you can see below. 
 

 
 

d. Let go of the mouse button. Reproduction records will now 

be created for all selected images, and the links to those 
reproduction records will then be stored in (repetitions of) 
the Reference field. 
 

As mentioned, you can also use the method to link one image 
to a reproduction record. When you have opened a reproduc-

tion record in edit mode (either from the Visual documentation 
data source or from within the relevant zoom screen in the cat-
alogue), you can add a single image via drag and drop. For ex-

ample, open a new or existing record in the Visual documenta-
tion data source and put the cursor in the Reproduction refer-
ence field. Then select an image in the Windows Explorer and 
drag it to the Adlib Media Viewer. 
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Figure 12.13: Preparations for dragging images to Adlib. 

• The fifth method allows images which are not yet present on your 
computer as files yet, which are only available to you as prints for 
example, to be scanned on the spot and processed in Adlib at the 
very moment you want to link the image. For more information 
about this subject, read the chapter called Adding images yet to 

be created, through WIA, hereafter. 

You can link movie and audio files as well as images in fields of the 
Image data type (like the Reference field), in the same way as you 
would link images. 
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12.2.3. Adding images yet to be created, through WIA 

Adlib offers support for Windows Image Acquisition. With this func-
tionality you can create and save images as you link them to records 
in Adlib. You can save these new images in a desired format in a 
folder of your choice, using a device for making still images that is 

connected to your computer: these are devices like scanners, digital 
photo camera’s, web cams or digital video camera’s. In other words: 
when you fill in a visual documentation record, you can scan an image 
or make a picture from within Adlib, save this image any way you 
choose, and link it to the current record immediately. All this takes a 
few simple steps.  
A prerequisite is that the relevant device supports WIA* (you can 

check this in the documentation of the device), and that you have a 

Windows Vista system or higher. To be able to read in images with 
WIA when you create a visual documentation record, it is sometimes 
necessary that a few settings have been made for the image reference 
field (usually B1 or FN) in your visual documentation database (usual-
ly photo), through Adlib Designer. (See the Designer Help for more 
information about that.) Also note that if you are using a 64-bit oper-

ating system, you’ll have to use the 64-bit adlwin.exe as well. 

Technical information 

* Whether a device supports WIA actually depends on its driver 
software. Driver software (which can be updated), is either provided 

by Microsoft and is built into the Windows operating system by de-
fault, and/or provided by the manufacturer of the device. The user 
manual for the device  should provide information about WIA support. 

If the documentation doesn’t mention WIA support, then please 
contact the relevant manufacturer (e.g. through their website). 

 

To link new images from within Adlib, follow these steps: 

1. Connect your WIA compatible device to the computer, if that 
hasn’t been done yet. 

2. In your Adlib application, open the database in which the adjusted 

Image field appears, for instance Visual documentation. 

3. Open a new or existing record to which you want to link a image 
yet to be created, and place the cursor in the image field. In a 3.4 
application this would be the Identifier (URL) field, but in a 4.2 
application the Reproduction reference field. 

4. Click the From scanner or camera button in the Media context 
menu (in the ribbon). 

http://documentation.axiell.com/alm/en/index.html?ds_generaltopicswindowsimageacquisition.html
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5. Dependent on the WIA settings for this field, you either have to 
select a folder to save the new image in and enter a new file name 
and choose the file type, or the new file name will be generated 
automatically. 
If in the first case you receive an error message 32, know that this 
arises from the fact that you are trying to save the image in the 

same folder as to which Adlib itself wants to copy the image: then 
choose a different colder to store the first copy of the image in so 
that Adlib may copy the file correctly to the real target folder (to 

which the created link refers); so the file will be created in both 
folders. You can remove the first copy at any time, if you want, 
using Windows Explorer, unless you want to keep it as a backup. 
In the second case (automatic file names), take into account that 

a redundant copy of the image might be created in the application 
folder while the link can point to the proper copy in e.g. the 
\images folder. The redundant copies in the application folder can 
be removed at any time, if you want.  

6. A WIA device dependent dialog appears with which you can make 
the new image. 
If you have connected a scanner, for instance, then a dialog win-

dow comparable to the following might appear: 
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In this case, you can first generate a preview, then you can drag 

the dotted frame around the part that you really want to scan, and 

subsequently click Scan to create the desired image, have it saved 
automatically, and directly include the appropriate link in the im-
age field. The created image is also immediately visible in the Me-
dia Viewer. 
Other devices have other dialog windows. See the documentation 
of the relevant device for an explanation of the options that the in-

terface offers. 
 

 

12.2.4. Image formats 

For adding images to object descriptions in Adlib, it’s necessary to 

obtain digital images. The way in which you create them is not rele-
vant to Adlib. You may scan existing photo’s, but you can also record 
your objects with a digital camera. Either way, the result will be a 

digital file. You can store photos in different formats – Adlib supports 
all commonly used formats. The difference between formats is in the 
compression applied, and with that in the disc space required for an 
image. And the more compressed a photo is, the less detail will be 

visible sharply. So depending on your needs, you can store photos in 
high or low quality. 
When disc space is not a problem, the following advice can be given: 
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• Save the original of the photo in (uncompressed) TIFF format, for 

a high quality. 

• The name you give to the photo’s should refer to the object num-
ber. For multiple images of one object, you may add serial num-
bers, for instance: Obj1234-01.tif, Obj1234-02.tif, etc. 

• For display in Adlib it’s better to use compressed images in JPEG 
format, because that takes less time to process. So you can also 
store your TIFF images as JPEG files with the same name, but with 

the .jpg extension; converting TIFF files to JPEG can be done with 
photo editing software, like Adobe Photoshop, ACDSee or GWS 
(Graphics WorkShop). When converting, you need to provide a 
compression factor. You may experiment with it until you find a 

compression factor that is acceptable to you, but a factor of 7 or 8 
usually yields good results. 

• An image file always has a resolution, expressed in pixels width x 

height, 600x400 pixels for example. This resolution is determined 
by your camera or scanner settings and actually specifies how 
much information (details) the image contains: more details than 
that will never be available, not even when you enlarge the pic-
ture. So an image with a high resolution can display more details 
than an image with a low resolution. 
Besides the resolution, some file formats support the inclusion of a 

DPI (dots per inch) or PPI (pixels per inch) setting, manually ap-
plied or automatically added by a scanner, to store the size of the 

originally scanned image (PPI) and/or to specify what the dimen-
sions of a printout of the stored image should be (DPI or PPI). This 
is because a digital file does not have an inherent print or display 
size in centimeters or inches: a computer screen only knows pixels 

and in photo editing software or Adlib it will just try to display all 
pixels of the image resolution (for an unscaled image). So, on a 
screen with a high display resolution, a certain image will be 
shown smaller than on the same screen with a lower display reso-
lution. 
However, when an image is being printed and also when an image 
is inserted into a Word document/template manually or via Adlib, 

the specified DPI/PPI becomes important since it indicates the tar-

get size in inches of the image to be printed. You could say that 
for printing, the DPI/PPI determines how many dots of ink should 
be printed per inch (2,54 centimeter) of paper, provided the print-
er can handle that specification. Then, for an unscaled image, a 
single pixel from the image file will be used to print a single dot of 
ink. So if you have an image with a resolution of 600x400 pixels 

and imagine you have manually set a DPI of 600x600 for it, then 
that image wil be printed or inserted into a Word document within 



Adlib User Guide Extra functionality for data entry 

 207  

a rectangle of 1x0,67 inch (2,54x1,68 cm). If such a small print 

format is undesirable, then store the image with a smaller DPI 

value: for example, 96x96 is a good standard value for digital im-
ages. In photo editing software you can lower an earlier stored 
DPI/PPI value for an image; in some software you can even do 
that for multiple images at once. (For security, do create a back-
up of all your images before you perform such a “conversion”.) 

• Put the JPEG photos for use in Adlib together in one folder, for 

instance in the \images subfolder of your Adlib software folder. 

12.3. Multilingual data entry and searching 

The Adlib software has the possibility for multilingual entry and 
searching. This means that one record can contain data in several 
languages, and that the record can be displayed in the language 
selected by the user. The Adlib standard applications do not use this 
functionality. Therefore, your application builder must apply the prop-

er changes to an application, or your custom built application must 
already be suited, to be able to use this functionality. If indeed you 
have multilingual databases in your customized application, this may 
have been implemented in one of the following three ways:  

 Implementation 1 (only in Adlib SQL and Oracle databases) 

Adlib applications which run on SQL or Oracle databases can be multi-

lingual on data level (“XML” multilingual). In the database, all transla-
tions of a field value will be stored in the one tag for that field, sepa-
rated by language. 

The language in which the user wants to enter data into a field in a 
record or just read out data, must in principle first be chosen via the 
Data language button in the Edit menu. This data language is com-

pletely separate from the interface language. The chosen data lan-
guage is made visible in the status bar via a flag icon in front of the 
code for the current data language: 

 
 

 
 
Whether the active field is multilingual (usually only some fields are), 
can be learned from the status bar in both display and edit mode: an 
“M” behind the field properties means this field is multilingual.  
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When you place the cursor in a multilingual field (no linked field) in a 

record in edit mode, the Edit multilingual texts window opens by 

default so that translations can be edited easily in a single dialog; then 
the current data language is irrelevant momentarily. If this window is 
not open for a multilingual field (for instance because you closed it), 
you must enter data in the current data language and you’ll subse-
quently have to switch to a different data language to enter a transla-
tion in that language. 

 

Figure 12.14: The fastest way of entering translations for a field value. 

Tip 

If you don’t want the Edit multilingual texts window to open for every 
multilingual field, then at the bottom of that window deselect the 

Show this dialog when editing multilingual fields checkbox and click 

OK or Cancel. The window must then be opened manually again if 
you choose so. 

Right-click a multilingual field in edit mode (no linked field), and 
choose Edit multilingual texts in the pop-up menu to open the win-
dow manually. 
This window can also be opened by clicking the Edit multilingual texts 

button in the Edit menu, or by using the key combination Ctrl+M. 
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(All these options are only active if the cursor is in a multilingual 

field.) 

 

 

In the Edit multilingual texts window, click a language to enter, edit or 
remove the desired value in the Editing text for language … box. You 
can also indicate or change the so-called invariant* language. To do 

this, click the checkbox for the language which you want to make the 
invariant one. In the figure above, no invariant language has been 
markde, while the English value can be edited right now. 

A linked field can be multilingual as well: it will be linked to a multilin-
gual field in another database. For example, if you would have a 
multilingual thesaurus, then you could store multiple translations of a 

term in a single thesaurus record. 
If, from a catalogue record, you would then link to an existing multi-
lingual record in the thesaurus, for instance, then you would always 
have to enter or look up the translation of the term in the current data 
language. So if the current data language is English, then type the 
English translation of the term in the linked field. This also means that 
validation of an entered term in a linked field always takes place in the 

current data language only. If you open the Find data for the field… 
window (via Shift+F4), then indeed only terms in the current data 

language are listed. 
If you then switch to another data language while you’re in detailed 
display or edit mode, Dutch for example, and the linked term record 

also contains a Dutch translation of the term, then that Dutch transla-
tion will automatically appear here. Note that it doesn’t matter in 
which data language you save the record in the end: this is because in 
linked fields the term itself is not stored, only the number of the linked 
record is.  
When entering a term which does not yet occur in the current data 

language in the linked database, it is important that you really save 
the linked record first before you may start entering translations of 
the term in the linked field: Adlib only knows that a translation of a 

linked term in the current data language belongs to a linked record, if 
the record number of the linked record is already being stored in the 
main record. In other words: after entering and adding a new linked 
term (via the Find data for the field… window) you must not switch 

data language and directly enter a translation of the term. In such a 
case, only for the translation you entered last a linked record will be 
created, without the translations you entered earlier. However, if you 
create a new linked term via a zoom screen, you can enter transla-
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tions immediately in that zoom screen while entering this record for 

the first time as long as you do that via the Edit multilingual texts 

window: you must not switch to another data language in this case. 
In normal, non-linked fields in a multilingual database, a catalogue or 
thesaurus for example, you actually can switch data language after 
typing new field contents, to enter translations; in this case you don’t 
need to store the record first. 

The detailed display of a record will show data in the currently set 

data language or, if that data is missing, data in the so-called invari-
ant language*. From Adlib 7.2 that is no longer optional: therefore the 
Show/Hide invariant data button is no longer present. So if a multilin-
gual field has no value in the current data language while there exists 
an invariant value in a different data language, then that value will be 

displayed (greyed out) by default. This makes translation of the rele-
vant data more comfortable. 

An invariant field value from another data language will be displayed 
in a different colour: light grey. The distinction clarifies that it con-
cerns invariant data and that the relevant field value(s) haven’t yet 
been stored in the current data language in the record. However, as 
soon as you place the cursor in such a field with light grey text, the 
text colour will return to normal and that means that the value, unal-
tered or edited, will indeed be stored in the current data language in 

the relevant field as soon as you save the changes in the record. As 
long as field values are displayed in light grey, they won’t be stored. 

 

If a multilingual field hasn’t got a value in the current data language 
while it does in one of the other languages and no invariant value 
exists for the field in this record either, then in display mode light grey 
suspension points will be displayed in the field (underlined if it con-
cerns a linked field).  

 

In edit mode, the suspension points will be displayed too as long as 
the cursor is not located in the field: as soon as the cursor is placed in 
the field, the suspension points will disappear. In no case will the 
suspension points be stored in the record: they’re only meant to 
indicate that data in another data language has already been entered 

in the field. 
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* Using invariant values 

Several Adlib versions ago, when you first entered a value in a multi-
lingual field in a record, that value in the current data language 

became the invariant value. That functionality has changed in 6.5.2 
SP2. Only in the Edit multilingual texts window you can still indicate if 
a translation must be the invariant. 

By default, the value in the invariant language appears (greyed out) 
in the edited field when you switch to a data language which has no 
value yet, so that translating in the field itself becomes easier. Im-
portant to remember is that when an invariant value is displayed in a 
field without value in the current data language, the value won’t be 
stored in the record as long as you haven’t placed the cursor in the 
relevant field, but that the value will indeed be stored as value in the 

current data language in the record if the cursor has been in the field 
while editing the record, even if you didn’t edit the value. The colour 

of the value will be equal to that of the other data again. 
However, if you’ve entered a value in only one language (and made it 
invariant) in a multilingual field of a record, and you then save the 
record, then that value will also appear only once in the stored rec-
ord, in the relevant language. But as soon as you switch data lan-

guage, you’ll see that the invariant value of the multilingual field is 
displayed anyway (although still not stored in the record). The rea-
soning is that if Adlib cannot find a field value in the current data 
language, then it should display the value in the invariant language 
instead: a compromise of course, since it is the right value, but the 
wrong language. 

 

Enumerative fields (drop-down lists) are never multilingual on data 
level. The language of the terms in the drop-down list depends only on 
the interface language (see the View > Language switch menu), not 
on the data language. The value which is actually being stored in the 
field is a language independent, neutral value which you normally 
don’t get to see. 
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Searching in a multilingual SQL or Oracle database via the Search 

wizard or a QBF, means searching in all data languages, whilst via the 

expert search language you also have the possibility to search lan-
guage specific (see chapter 6.3.11 for more information about this). 

The present sorting of the search result is determined by the sort 
option for the current access point and possibly by the Locale data-
base setting which may have been set to a specific language region, 
both in Adlib Designer. The Windows locale influences the sorting as 

well: in for example Latin language regions, terms in Latin languages 
will always appear before all terms in for instance Greek, in the brief 
display. If the sort options haven’t been set, no alphabetical sorting 
will take place. 

 Implementation 2 (obsolete, mostly in CBF databases) 

Some entry fields, or each entry field on a screen tab or every screen 
in its entirety, is clearly aimed at data entry in one specific language, 
for instance by naming the relevant language in labels; you can view 
all your translations in one record simultaneously. You never need to 
change a data language via a menu. 
For searching e.g. an English fieldname or access point (which hap-

pens automatically when you run Adlib in English) this means that 
Adlib only searches the English-language tag for this field. (Each 
translation is saved in its own tag.) 

 Implementation 3 (obsolete, mostly in CBF databases) 

One or more entry fields may contain content in more than one lan-

guage, while you can only see one translation at a time. As soon as 
you change the interface language via the Language switch button in 
the View menu, you also change the data language for these fields. 
This becomes apparent when the field that just now contained e.g. an 
English term, has become empty or contains the translation in the 
new interface language if you had entered that before. So in these 
multilingual fields you’ll always only see its content in the current 

interface language, and data entry in these fields must always be done 
in the current interface language. For searching e.g. an English field-
name or access point (which happens automatically when you run 

Adlib in English) this means that Adlib only searches the English-
language tag for this field. (Each translation is saved in its own tag.) 

12.3.2. Monolingual data in multilingual fields 

If your existing monolingual Adlib SQL or Adlib Oracle application has 
been made “XML” multilingual by your application manager, without 
performing an applicable data conversion, then the uncomfortable 
situation will arise in which existing values in now multilingual fields 
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will not have any associated data language while field values in new 

records do get an associated data language. 

Adlib will repair that situation semi-automatically. This will work as 
follows: if in a record multilingual fields occur in which data is present 
without any associated data language, then on retrieval or display of 
the record – it doesn’t need to be in edit mode – the currently active 
data language will be assigned to the relevant field values in memory, 
but not stored in the record yet. You can observe this preliminary 

language assignment while viewing the current contents of the record 
using the Ctrl+R key combination. If the record is put in edit mode, 

the following message will appear:  
Monolingual data detect and promoted. One or more multilingual fields 
contained monolingual data. This data has now been promoted to the 

current data language. Please review all data before saving the record. 

You can still edit the translation(s) of the field values of course, by 
switching data language or via the Edit multilingual texts window. 
Save the record to store the changes; if you do not save the record, 
all remains the same and the field values without associated data 
language will still be present. 

Note that terms without associated data language can still be found 

when searching all languages together. 
In detailed display of a record, data without language will be visible 
too as long as you do not switch to another data language while in 
detailed display mode. As soon as you start editing the record, data 

without language will be assigned the current data language, so al-
ways make sure that the proper data language is active before you 

start editing a record containg data without language. (Strictly speak-
ing, the current data language is already assigned while the record is 
still in display mode, but that assignment won’t be stored when you 
leave the record.) 

12.3.3. Merge terms 

If you have an Adlib SQL or Adlib Oracle database which is not “XML” 
multilingual, but has separate records for each translation of a term or 
name, and you either want to start storing all translations of a term or 
name in one record (the XML multilingual way), or you want to apply 

preferred-term relations between the translations, then you’ll want to 
do this as efficiently as possible. For this purpose, Adlib offers the 

Merge terms function, which you can find in the Edit menu. See the 
separate Adlib document Merge terms.doc for an explanation of this 
function. 
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12.4. Replacing or adding data automatically 

12.4.1. Searching and replacing 

After marking records, you can perform a search-and-replace on these 
records, where you enter a character string to be found in certain 
fields (which you can select yourself), which must be replaced by 
another character string which you have entered. With this you are 

able to quickly replace a consistently incorrectly entered in or anti-
quated term, in all marked records. 
Click the Replace in Record button to open the Search and replace 
window (see Figure 12.15). 

 

 The entry boxes 

In the Available fields list select the field(s) in which you want to 
search for the string of characters you want to replace. Select a field 
and copy it to the Selected fields list by clicking the arrow pointing to 
the right. Repeat this for any other field(s) that you want to update 
the same way. If you want to remove a field from the Selected fields 
list, then select it and click the arrow pointing to the left. 

 

Figure 12.15: Replacing a text in marked records. 
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Then type the character string to be updated in Replace and the 

character string that is to replace it in With. If you leave the With 

entry field empty, the character string in Replace will be deleted in the 
selected field(s) of the marked records; if the relevant field has more 
than one occurrence, then the resulting empty field occurrence will be 
removed as well, but a resulting empty occurrence of a field in a data 
dictionary field group will only be deleted if the same occurrence of 
each field in the group is empty too. 

 

Warning for replacement by empty field 

A field group can be recognized easily by the fact that when you add 

a new occurrence of a field, new occurrences of one or more fields 
next, above or underneath the relevant field will be added as well. 
Usually, field groups have been specified in the data dictionary (the 
database definition), but in some older applications, field groups may 
have been defined on a screen instead. In the latter case this means 

that a replacement by an empty field might remove a field occurrence 
while the number of occurrences of the other fields in the screen field 
group remains the same, which then corrupts the contents of your 
record. So, do not use search-and-replace to replace a character 
string by nothing, if the string might appear in screen field group 
occurrences. You can check if a field group has been defined in the 
data dictionary: right-click the relevant field in an opened record and 

choose Properties in the pop-up menu. Then open the Data dictionary 

tab in the Field properties window. If a name is displayed behind 
Group name, then that field group has been defined in the data 
dictionary, and you can search and replace normally. 
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Search and replace is possible in enumerative fields as well (fields with 

a drop-down list): use the texts which are present in the drop-down 

list in the current interface language (although the With entry field 
also accepts the so-called neutral value – the actually stored value – 
of a text from the drop-down list). 

 The options 

 

Figure 12.16: It is sensible to confirm each replacement, so you know for sure 
that the replacements are performed in the right place.  

Mark the Match entire field option to replace the text to be replaced 
only if that is the full contents of the field. With this option marked, 
you could search on, for instance, The Oxford Dictionary (to re-

place it with, for example, The Concise Oxford Dictionary) and 
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only the contents of those fields will be replaced which literally are 

identical: The Oxford Dictionary. A field that has more or fewer char-

acters in it will not be replaced. 
With the Match whole word option you can specify that you only 
want to search on complete words. In that case, a search-and-replace 
action on organisation (to replace it with organization) will only 

replace the complete word organisation by the word organization. 

A word like organisational will not be modified.  

If you mark the Match substrings option, organisational would 

also be replaced, and become organizational.  

Match case - You can also indicate that the search should be case-
sensitive (by marking the Match case option to turn case-sensitivity 
on), or specify the opposite (the case of letters will be ignored) by 

unmarking this option.  

Confirm replacement - Also, it is usually wise to select the Confirm 
replacement box (except maybe for large selections). In that case, 
every time a character string is going to be replaced, the system will 
ask if you are sure you want to replace it here. The character string is 
also shown in context, e.g. the title or the subject term (see Figure 
12.16). If you choose Yes the character string will indeed be replaced. 

If you choose No, the character string will not be replaced, and the 

search for the next replacement possibility is continued. If you choose 
Cancel, the search-and-replace procedure will be stopped. 

Add new occurrence - The Add new occurrence option is meant for 

adding data, not for search and replace. See paragraph 12.4.3 for 
more information. 

Language - The Language drop-down list is active in multilingual 
applications. In a multilingual field you can use it to search and 

replace, or add, values in a particular data language only, if you have 
a multilingual Adlib SQL or Oracle database.  
If you do not select a language while you do have a multilingual 
database, you will search the current data language only or add the 
new value in the current data language of the new occurrence. 
A special case presents itself when one of the language values in a 
multilingual field has been marked as the invariant value. When you 

switch a record to a data language in which you haven’t filled in the 
multilingual field yet, the invariant value will then be entered for you 
automatically. (This is meant to make translating more comfortable.) 
For search-and-replace this has the consequence that you must treat 
the multilingual field as if the invariant value has already been filled in 
for the languages in which you hadn’t explicitly entered anything yet. 

So, in the data language in which you want to search and replace you 
must then search on the invariant value or a part thereof, not on an 
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empty value. Suppose you have a multilingual Title field in a record 

(with the available data languages English and Dutch) and only in the 

current data language English you’ve  entered a title (“Count Dracula” 
for example), marked it as the invariant* and saved the record. Now if 
you start a search-and-replace in this field in this record and in the 
Search and replace window you set the Language option to Dutch, you 
need to remember that you are searching in the invariant title (“Count 
Dracula” in this example), not in an empty field, when you enter 

anything in the Replace entry box. If you’d want the Dutch title to 
become “Graaf Dracula”, you would have to enter Count in the 

Replace field, Graaf in the With field, after which you’d also mark the 

Match whole word option. 
* Right-click a multilingual field and select the Edit multilingual texts 

option in the pop-up menu to check whether one the language values 
is invariant. You can make one of the language values invariant, if you 
want, by marking the checkbox for the relevant language. You can 
remove any invariancy here as well. 

 All or nothing 

If you want to replace all strings in a certain field by a new one, then 
type an asterisk (*) in the Replace entry field and the new string in 
the With entry field. To only fill empty fields with a certain value, leave 
Replace empty and type the value in With. In these two cases, it 

doesn’t matter which Match option you select.  

 Progress 

During or after the search-and-replace action, a Find and replace 
progress message will be shown, reporting how many records have 
been searched and changed and also the total number of replace-

ments. 

12.4.2. Replacing in linked fields 

When you are replacing terms and this will add a new term to a linked 

database, then the system will ask you explicitly whether you really 
want to add the new term to the linked database. The term you have 
replaced remains in the linked database though. (This possibility is 

available only when you have sufficient access rights.) 

As a result of this, here are a few recommendations for replacing 
terms in catalogue fields that are linked to authority databases: 

• Applications with feedback links (from model 4.2) - Feed-

back links from within authority databases to the catalogues, as 
present by default in model application 4.2 and higher, make sure 
that when a term used in catalogues must be converted into a 
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non-preferred term, the only thing you need to do is to add a Use 

term (preferred term) in the relevant thesaurus record to have all 

catalogue records which link to the now non-preferred term up-
dated automatically to link to the new preferred term without you 
having to perform any search-and-replace procedure. The auto-
matical update, in which every link to the old record will be re-
placed by the link to the new preferred term record, may take 
some time if many catalogue records must be updated. 

• Applications without feedback links - If, for instance, you 
want to replace the object name bike by bicycle, search the au-
thority data source (in this case the Thesaurus) whether a record 
for bicycle already exists. If not, search the record for bike, and 
change the term in it to bicycle. In catalogue records you now 

don’t have to perform this search-and-replace action anymore, 
because the link with the authority database automatically re-

trieves the term in its new spelling for all existing records. 
If there is already a record in the “new” spelling, you will have to 
perform a search-and-replace in the catalogue, and possibly in 
other data sources, so that a reference to the new term is made in 
the proper linked records in each dataset. It’s safest to leave the 
old term record in the authority database, because it’s possible 
there are still (catalogue) records somewhere in which there exists 

a link to this record, and the data in those records must be kept 
intact.  
If you know for sure though, that there aren’t any catalogue fields 

with the old term anymore, and it is your intention that in new 
records the old term should no longer be used, then it is recom-
mended that a use/used-for relationship is created between the 

old and the new authority record, so that the old term becomes a 
non-preferred term (see chapter 13 for more information about 
this subject). Now, if the old term is entered in a new record, it is 
automatically replaced by the new term. (Creating a use/used-for 
relation has no effect on existing records, unless you open them 
for editing. Only then will non-preferred terms be replaced by pre-
ferred terms. So, a search-and-replace action beforehand remains 

necessary.) 

 Search-and-replace checks for multiple preferred terms 

When you try to replace a term in a linked field by a non-preferred 
term which has more than one preferred term, via search-and-

replace, then on replacement you’ll first have to select the desired 
preferred term. 

In the image below we try to replace the object name workstation by 
pc. However, in this case, two possible preferred terms have been 
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specified for pc in the thesaurus, namely personal computer and 

computer. After search-and-replace has started and the object name 

workstation has been found in a record, the More than one preferred 
term found, select from list window opens. Select the desired term 
and click OK.  
Every time the searched term is found during search-and-replace, 
you’ll have to pick a preferred term. 

 

Figure 12.17: If the term to be inserted has multiple preferred terms, you’ll still 
have to select the right term during replacement.  

12.4.3. Adding extra field occurrences in batch 

You can add an occurrence to a field, beneath already present 
occurrences, via the Search and replace window. If the field is still 
empty, the first occurrence will be filled. If the field is part of a field 
group, an empty occurrence will be added to all other fields in the 
group; you cannot add values to multiple fields in a single group 

occurrence at once. Use the Replace in record button in the Edit menu 
to open the Search and replace window. 

 

1. Mark the Add new occurrence checkbox. Several other options will 
now be greyed out because they have no relevance for adding 
field occurrences. 
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Figure 12.18: The Search and replace window can also be used to add an 
occurrence to a field in the marked records.  

2. Select the (bold typed) field to which you want to add the 
occurrence, by copying it to the list on the right using the blue 
arrow. You can select only one field, not multiple fields at once. 
Before you start search and replace, first check if the field is 
repeatable indeed: place the record in edit mode and try to add an 

empty occurrence to the field. If you can’t, then don’t add any 
new occurrences via search and replace either because they will 
usually be stored in the record but you won’t see them in detailed 
display!  

3. In the Add: field, type the value to be inserted into the new 
occurrence. Make sure that you know the data type of the field in 
the data dictionary and that you insert a proper value into the new 

occurrence. Adlib itself does not validate the data type. You can 
find the data type of the field by placing the cursor in the field in a 
record: the data type will then be stated in the middle of the 
status bar at the bottom of the Adlib window. The Accession date 
field for example, has the tag HC and the ISO date data type in 

which you have to enter values like 2012-02-15. 

 

 
 
For linked fields, Adlib checks if the value to be added in the extra 
occurrence appears in the linked database. If not, then you’ll be 
asked (as usual) if you want to add the term or name as a record 
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to the linked database. If you choose No, the occurrence won’t be 

added either. 

12.5. Deriving records 

Deriving records from other (local or internet) databases or datasets is 
useful when you are describing documents or objects that contain 
similar data. Your application builder can enable this option by creat-
ing a ‘similar’ or ‘friendly’ database, from which records can be copied. 
(It’s possible to have more than one friendly database.) 

You can call up or derive a record when you want to create a new 

record for a document or object (or when you want to update an 

existing record) for which you need that data. The Derive function can 
be found in the Start menu. In the submenu of the button, one or 
more friendly databases may be offered; choose the database or 
dataset from which you wish to derive. 

 

If, for instance, your application builder has set up dataset x as a 

friendly database in dataset y, then open data source y, choose Start 

 Derive  x to open a zoom screen (e.g. a search form) with which 
you can search in the similar database x.  

 

The search result will be shown in the Available data window. Click the 
Details button to display a record from x, and click Select to copy the 
data from that record to a new record in y. Whether the record from x 
will be deleted after deriving, depends on your application setup. By 
the way, any deletion of the original record will only be executed if the 
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new record is saved. (See the appendices at the back for specific 

examples of deriving records.) 

When you have an existing record in edit mode, then for deriving data 
from another record you will be asked first whether the current record 
may be updated:  

• If so, then only the filled in fields from the external record will be 
copied to overwrite the same fields in the current record, regard-
less of whether those were already filled in or not.  

• If not – you do not wish to update the current record – a new 
record will be created in which the data from the external record 
will be copied.  

(Fields for which the data dictionary Exchangeable option is set to No, 
won’t be overwritten or copied.) 

12.6. Filling in HTML fields 

An HTML field is a database field meant for long, laid-out text. Layout 

can be applied to the text during editing of the record. You can print 
the contents of such a field to a Word template or with the aid of an 
XSLT stylesheet, whilst keeping the layout intact. Although you will 
see just the laid-out text while you are editing an HTML field, the field 
contents will actually be stored as HTML code in the background.  
HTML fields do not appear in the 4.2 model application, but it is possi-

ble that your application manager set up one or more of such fields in 

your application, for example the field for label text on the Accompa-
nying texts tab of a museum object record.  

 

Figure 12.19: An HTML field with pre-existing plain text, in edit mode.  

It is very well possible that your application manager has replaced a 
normal text field with an HTML field. The existing field contents may 
then at first be visible as plain text in the HTML field. The text has no 
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layout yet and hasn’t been stored as HTML code either. Put the record 

in edit mode to apply layout. Note that existing text in a converted 

field will only be saved as HTML when you have placed the cursor in 
this field once and saved the record again. When the cursor is in the 
HTML field in edit mode, a floating toolbar appears to lay out the text. 

The buttons have the following meaning: 

 Text layout buttons for HTML fields 

 

Choose a font type. 

 

Apply bold layout to text. 

 

Apply italic layout to text. 

 

Underline text. 

 

Align text to the left. 

 

Centre text. 

 

Align text to the right. 

 

Number the paragraphs. 

 

Place bullets in front of paragraphs. 

 

Reduce the indentation. 

 

Enlarge the indentation. 

 

Insert a horizontal line. 

 

The buttons largely work the same way as they do in Windows text 
editors. For instance, you must first type text, select it or just a part 
of it, and then apply a layout to it. 
Moreover, you can copy (Ctrl+C) formatted text from other Windows 

applications, like Microsoft Word, and paste (Ctrl+V) it in an HTML 

field, or vice versa, while conserving the layout. However, when copy-
ing from within Word, it is possible that not all layout characteristics 
will be included, like the colour of text for instance. 
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For inserting new lines you can use Enter for a new paragraph, and 

Shift+Enter to begin a new line within the same paragraph.  

After layout has been applied the text might look as follows, for ex-
ample: 

 

Figure 12.20: An HTML field with laid out text, in edit mode.  

 Advanced: editing the HTML code 

However, you can also edit the HTML code itself, in a separate win-
dow. If you know how to code HTML, you can use it to include URLs to 
images or websites, create tables and apply other possibilities of 

HTML; you just can’t use CSS styles though. 

 

Figure 12.21: Editing the HTML code.  

Right-click an HTML field and select Edit the HTML source in the pop-
up menu which opens. The HTML Source Editor window opens. The 
HTML of already present field content will be shown. Here you can 
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adjust the HTML code directly. It’s possible as well to copy (Ctrl+C) 

and paste (Ctrl+V) code from and to this editor, which might be 

convernient if you prefer to edit your HTML code in a different HTML 
(web page) editor first. Click OK to close the window. The result of 
your changes can be viewed in the Adlib record. 

The HTML code in these fields always starts and ends with <DIV> and 

</DIV> respectively and has no <head> section. If you add a <head> 

section anyway, then this will be removed as soon as you click OK.  

In the example above you can see that in the HTML field an image is 
retrieved and a table has been created, which is only possible here by 
adjusting the HTML code itself. 

Technical information: printing and exporting 

The laid out text in HTML fields can only be printed correctly to Word 
templates or XSLT stylesheets which have been set up as output 
formats. You can print to output formats and Word templates via the 

Print wizard (see chapter 14). In principle, you (or your application 
manager) must create these templates or stylesheets yourself, but 
templates do not require any special instructions for HTML fields - 
you can refer to the field tag normally (see chapter 15) - and an 
example stylesheet is available for download from our website.  

If you still print HTML fields via an adapl (also via the interactive Print 
wizard method), then the HTML field contents will be printed: the 

layout won’t be visible but the HTML codes will be 

When you export (see chapter 16) records with HTML fields, the 
HTML field contents will be extracted as HTML code: the code begins 
and ends with <div> and respectively </div>, and has no <body> or 

<head> tags. When exporting to XML, the HTML field contents will 

actually be produced as HTML within the XML field tags; the same 
applies to the XML search result of wwwopac. An Adlib Internet 
Server uses stylesheets to convert the XML output of wwwopac to 
HTML.   

For both printing and web display, XSLT stylesheets need to be coded 

for HTML fields in such a way that the HTML field contents will be 

copied from the XML literally, like for the label.text field in our 

example: 

  <xsl:template match="label.text"> 

 <xsl:copy-of select="."/> 

  </xsl:template> 
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 Note 

The first time you print a record with an HTML field to a Word tem-
plate, Word may ask if you would like to set Word as the standard 
editor for HTML pages. Answer No if you don’t want that, and Yes if 
you are fine with it. Either way, the resulting printout may not be okay 
after that. Then try to print again. Microsoft Word shouldn’t pose the 

question anymore and the printout must now be correct. 

12.7. Filling in Rich text fields 

Rich text fields contain text that can be formatted, namely by specify-
ing the alignment of it, by adding bullet points or numbering, by 

choosing another font or by applying Bold, Italic, or Underlined types 
to the entire text (or just a part of it). 
This layout is not only visible on screen: when printing the contents of 

a Rich text field to a Word template, the layout is used as well. When 
printing by means of a print adapl though, the text will be printed as 
plain text (and RTF codes won’t be visible). In a standard web applica-
tion the layout won’t be used either. So, the applicability of this type 
of fields is limited. 

 

Technical information: RTF content in your web application 

An Adlib Internet Server web application can run on wwwopac.exe or 

wwwopac.ashx. The layout characteristics (i.e. the RTF codes) of text 
in Rich text fields can be included in a wwwopac.exe XML search 
result, but not in wwwopac.ashx search result. Any present RTF codes 
will probably be shown as text on the web page, since they can’t 
easily be converted to layout; white space (line breaks) is displayed 
on the web page by default though, if RTF codes are present. Wheth-
er the codes are included at all, depends on certain configuration 

settings. Wwwopac.ashx web applications on the other hand, do not 
retrieve RTF codes and consequently can’t display them, regardless of 
configuration settings; line breaks won’t be included either so text 
will be displayed as a single paragraph. 

By default, line breaks in normal, non-RTF fields won’t be included in 
XML output for web applications. However, for a wwwopac.exe web 

application it is still possible, via certain configuration settings (see 
the wwwopac reference guide, search on “richText”), to display line 
breaks from non-RTF fields in the web display. 
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Although in most existing Adlib applications no Rich text fields appear, 

it may be that your application manager has built in such a field. You’ll 

notice it immediately you place the cursor in a Rich text field, because 
a floating toolbar will appear on the screen. 

 

The buttons have the following meaning: 

Text layout in Rich text fields 

          
-   

Choose a font. 

          
-   

Choose the colour in which the font must be displayed. 

          
-   

Apply bold layout to text.. 

          
-   

Apply italic layout to text. 

          
-   

Underline text. 

          
-   

Align text to the left. 

          
-   

Centre text. 

          
-   

Align text to the right. 

          
- 

Place bullets in front of paragraphs. 

          
- 

Number the paragraphs. 

 

The buttons work the same way as they do in Windows text editors. 
For instance, you may first type text, select it or just a part of it, and 
then apply a layout to it, or choose a font and layout first, and then 
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start typing: the chosen layout will be applied to what you type. 

Moreover, you can copy formatted text from other Windows applica-

tions, like Microsoft Word, and paste it in a Rich text field while con-
serving the layout. 

12.8. Inserting date occurrences in bulk 

For a repeatable date field in a record in edit mode (and only for date 
fields from which a small calendar can be opened), the Enter date 
option becomes active in the right-click pop-up menu: 

 

Through the window that opens this way, you can submit a date range 

via a Start date and End date, and mark days of the week in that 
range. The dates for the selected days will be remembered by Adlib 
briefly as soon as you click OK to close this window. If you now insert 
an occurrence for the current date field, you’ll notice that not just one 
but a series of occurrences for all set dates is created automatically. 
This can save you time when entering many occurrences of a repeata-

ble field group with a date field in it. 

12.9. Go to field 

From Adlib 7.3 you can quickly jump to any field on any screen in 
detailed display of a record (without having to browse all your screen 
tabs), using the Go to field functionality:  

1. In detailed display of a record (either in display or edit mode) 
press the Ctrl+G key combination to open the Go to field dialog. 

2. Start typing the first letters of the name of the field you are look-
ing for. It concerns the field name as it is registered in the data-

base definition (which is often different from field labels on 
screen), in the current interface language. So if the Adlib menus 

are in English, type the English field name. 
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As soon as you start typing, the auto-complete function fills in the 
first suggestion. It consist of a field name, a colon and a screen 

label. In the example above, we’ve just entered ob. 

3. From here, you may continue in the following ways: 
- if the auto-complete suggestion is what you were after, just click 

OK to jump to the relevant screen. If your record is in edit mode, 
the cursor will automatically be located in the proper field too. 
- or open the drop-down list by clicking the arrow, select the field 
and screen you’d like to jump to and click OK. 
 

 
 
- instead of opening the drop-down list, you may keep on typing 
until the desired field and screen are found by the auto-complete 
function. After which you must click OK to make the actual jump. 

- you may also type just the first few letters of the field name you 
are looking for, possibly followed by a colon and the first few let-
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ters of the desired screen. Auto-complete won’t help out in this 

case, but when you click OK, Adlib will try to match your entry as 

well as possible. For example, for an object record, simply enter 
rep:rep as the go-to field name and screen and click OK: you’ll 

jump to the Reproductions tab immediately. If there are no other 
fields than reproduction fields that start with rep, just entering 

rep is enough too. 

 Notes 

• If nothing happens after you’ve selected a field : screen com-

bination and clicked OK, you’ve accidentally chosen a screen that 
is not active in the current dataset (because of limited access 
rights, for example). 

• In display mode you’ll only jump to the proper screen, while in 
edit mode you’ll jump to the desired screen and the cursor is 
placed in the proper field (if it is editable). 

12.10. Conditional fields 

It is possible that certain screen fields in your application are condi-
tionally hidden or set to read-only. That means a screen field may be 
visible or not, or may be editable or not, dependent on the value(s) in 

certain other fields. This is separate from access rights and is meant 

to be able to create more surveyable tab sheets by only showing fields 
if an associated key field is filled in by the user. 
When a field is not visible during editing of a record as a consequence 
of a condition that has been set for it, then no strange empty spot will 
be present in the relevant screen, because all fields and labels under-
neath will have moved one line up. And as soon as the field does 

become visible, the other fields will move back down again. 
Note that this functionality has not been applied in current Adlib 
applications yet. But if your application manager has built such fields 
into your application, you’ll notice conditional fields quickly if “missing” 
fields suddenly appear or if read-only fields can be edited suddenly, 
after you have filled in a value in an associated field. Also it may be 
that the value you enter in the associated field must be formatted a 

certain way before the condition is met. In this case, your application 
manager can tell you what this format should be. 

12.11. Locking field contents 

Sometimes you enter data into a field in a record, which you would 
like to protect from accidental changes by yourself or by anyone else. 
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That’s why you are able to lock the contents of a field, if your 

application runs on an Adlib SQL Server or Oracle database. Only 

users with the $ADMIN role can unlock the field if desired, to change 
the contents or to allow other users to change the field contents: 

1. Put the cursor in the field with the data you wish to protect from 
changes by others. 
 

 

2. Choose either Edit > Lock field for editing in the ribbon or right-
click the field and choose Lock field for editing in the pop-up 
menu.  

 

 
 
The field display now turns to read-only (although contrary to 
fixed read-only fields, the field box is still visible), and can no 
longer be changed accidentally. 
 

 

3. Only users with the $ADMIN role in the application – your applica-

tion manager can set this up – are allowed to unlock the field 

again, so that you or other users can change the contents of the 
field. As an $ADMIN user you unlock a field by right-clicking the 
field and selecting Unlock field for editing in the pop-up menu. 

Even if you’ve locked a field, you can still add or remove occurrences 
if it concerns a repeatable field: only the locked occurrence cannot be 
removed. So repeatable fields are always locked per occurrence and if 
that occurrence must move up or down because above it occurrences 

are being removed or inserted, then the lock moves with it. 
The same applies to repeatable field groups, with the added detail that 
you can no longer remove a field group occurrence in its entirety as 

soon as at least one field in that field group occurrence has been 
locked, in at least one data language if it concerns a multilingual field. 
By the way, multilingual fields are also locked per data language, 

except when it concerns linked fields: then all available languages are 
locked together because it concerns a link to a single multilingual 
record. 

Further, it is relevant to note that once you’ve locked a field in a 
record, this record can no longer be opened in Adlib versions older 
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than 6.5.2 SP3. This is because an extra field attribute (for the lock) is 

added to the XML format in which records are stored in SQL databases 

at the moment a user locks that field (although only definitively when 
the record is saved). Older versions of Adlib however, do not recog-
nize that attribute, and therefore the relevant record cannot be 
opened. Still, if you do not use this new functionality at all, then 
neither will the problem ever occur should you revert to a previous 
version of Adlib. 

12.12. Inheritable fields 

From Adlib 7.3, your application manager may have set up so-called 
inherited fields (see the Designer 7.3 release notes for more infor-

mation about that). This functionality allows you to automatically 
display and possibly copy data from the accordingly set up fields from 
the first record higher in the hierarchy in which these fields have 
actually been filled in.  

An example might clarify things: suppose you have an object record 
for a "dollhouse" which has Parts (child records) describing the 
contents of the dollhouse. And maybe some of those parts, like a 
"closet (miniature)", may even have Parts of their own. If you are 
registering such hierarchies regularly and you find you often need to 
copy the contents of some field from the top record of the hierarchy to 
its child records (or just be able to see its contents) – e.g. a 

description that applies to all parts, like condition notes about the 

dollhouse and its parts or some other notes relevant to all children – 
then a mechanism for copying that content might come in handy. And 
that is just what inherited fields do. Once set up for a field, every time 
you view or edit a record with this field, Adlib will automatically look 
upwards in the hierarchy (if present) to see if the parent record has 
data in that field. If not, Adlib will check the grandparent (if present) 

and so on, until a record has been found in which the relevant field 
has been filled in. If so, Adlib will display its contents greyed out in the 
same field of the current record, if it was still empty. Even though the 
copied content is displayed in the record, it is not yet part of the 
current record. To save the copied contents, put the record in edit 
mode and simply double-click the relevant inhereted field or put the 

cursor in the field and start typing new text and/or delete copied text 
to fully activate the field contents (the text colour changes to normal). 
Now saving the record includes the activated field contents: a quick 
way to (partially) copy data from other records! Remember that 
typing new text in such fields is possible as well, so you're not stuck 
with the copied text. 

http://documentation.axiell.com/alm/en/index.html?ds_releasenotes7_3.html
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Per field you can always choose whether to activate the copied 

contents or not. If you don't want to duplicate data from the higher 

records at all, you'll probably never activate the data and just enjoy 
the fact that data from parent records is conveniently visible in the 
record you are viewing or editing. 
Do observe that inherited data may come from different elders: one 
field might display data from the direct parent record, while another 
field shows data from the grandparent record because the relevant 

field is empty in the parent record too.  

 Best practice example of working with inherited fields 

1. If you know certain fields have been set up as inherited fields by 
your application manager and you are about to register a new 

hierarchy of items, you profit most from data inheritance if you 

start by registering the top item in the hierarchy and work your 
way down. Below, you can see an example of such a top record in 
a Museum application, for a dollhouse. 
 

 

2. Next, register one of the parts of this dollhouse, a miniature closet 
in this case. First thing to do when you create the child record is 
to link it to its parent, like you would normally do on the Numbers 
| Relationships tab.  
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3. As soon as you've created the link to the parent, the inheritance 

functionality can do its thing. For this example, know that the 

(Object name) Notes and Title field are the inherited fields. When 
you switch back to the Identification tab, you'll see the Notes and 
Title fields showing greyed out data copied from the parent record. 
As long as this data is greyed out, it won't be stored in this record, 
just displayed. If you do want to store the data in such a field, 
simply double-click the field to activate the data: the text colour 

will change to normal. You can also change the activated data by 
typing over it. 
 

 

4. If you save the record without having activated any inherited data, 
it won't be stored in the record but it will still show in display 

mode. And child records of this "closet" will inherit this data too, 
even though to those records the data must be inherited from the 

grandparent. 
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 Notes 

• If multiple occurrences exist of a destination field for an 
inheritable field in the current record, of which at least one has 
already been filled in, then no inherited data will be shown in  any 
empty occurrences. 

• If the higher record contains multiple filled-in occurrences of an 

inheritable field, then all those occurrences will be displayed in the 
same occurrences of the destination field in the current record, on 
the condition that all occurrences of that field in the current record 
are still empty. 

• If at least one of the data languages in a multilingual destination 

field already contains data, then no data will be inherited in any of 
the languages. 

• Of multilingual inheritable fields, all translations will be inherited if 
all data languages in the field in the destination record are empty. 
For example, if the current record inherits English and German 
data of a higher record, you’ll only see that data in the current 
record if you’re viewing it in the English or German data language. 
In the other languages you’ll see three dots in the field to indicate 

that the field does contain data, just not in the current data 
language. 

• If a multilingual destination field is empty and in one or more data 
languages inherited data is being displayed, then that data will 

become active as soon as you enter new data in a data language 
in which no data is present in the field yet. Also if you edit one of 
the inherited translations, the other inherited translations will 

become active as well. 
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13. Authority databases 

Abstract 

An Adlib authority database (often still called an authority file) is a 
database which contains records of preferred terms or names with 
their related terms or names. (And each related term and name also 

has its own record.) The Thesaurus and Persons and institutions 
databases are examples of authority databases. Other databases, like 
catalogues and collections, contain several fields which are linked to 
an authority database. Your data entry in those fields will always be 

validated automatically: this means that Adlib checks whether the 
term or name already exists, and if so, if any substitution by a pre-
ferred term is required. On data entry you can also choose from 

existing terms, or add a new authority record. 

Between the terms in an authority database, relations can be estab-
lished to define their interrelational hierarchy and preferred-relations. 
Relations allow Adlib to search on a preferred term even if you pro-
vide a non-preferred term or synonym, and you’ll be able to search 
generically, namely not only on the term itself but on all its narrower 

terms as well. The relations that can exist between the terms in an 
authority database are:  
 

• Use/Used for (page 243) 
• Narrower term/Broader term (page 244) 
• Related term (page 245) 
• Equivalent term (page 245) 

• Semantic factors (page 246) 
 
Of each relation, a mirrored record will be created automatically: 
saving a preferred term record with a non-preferred term in the Used 
for field, causes the creation of a second record with the non-
preferred term as the main term and in Use the preferred term. 
 

Domains (13.2) appear in the Thesaurus (Term type) and Persons 

and Institutions (Name type). The use of domains creates different 
virtual sections in the database. One or more domains can be linked 
to a single thesaurus term or name. One of the benefits of using 
domains is that in the Thesaurus for instance, different types of terms 
can be stored, while those terms in the catalogue are still carefully 

validated per field type, although you may still choose to validate 
field input to terms from all domains by deselecting the Show only… 
option in the Find data for the field… window. 
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An authority record must meet certain conditions before it can be 

stored (13.3). For instance: a non-preferred term cannot have rela-
tions, the term in Use must be a preferred term and in applications 
older than 4.2 the term or name must be unique. 

In the detailed presentation of records from hierarchically built data-
bases like an archive database or the Thesaurus you can display the 
tree structure of all records that are linked internally to the currently 
displayed record through broader and narrower terms (13.5). Click 
the Hierarchy browser button in the View menu: 

 

In the hierarchy browser you can drag a term to another term to 
make the dragged term a narrower term of that other term, and via 

the right-click pop-up menu you can also insert a new term. 

Records in authority database can’t always be deleted safely just like 
that (13.7). Especially in older applications it is usually wise to re-
move or replace all references to the term or name from catalogues, 
and delete the term or name record only after that. 

A list of all keywords and their relations can be printed easily (13.8) 
by retrieving all records in the Thesaurus and marking them all, and 

choosing the Thesaurus listing or Generic thesaurus list predefined 
output format in the Print wizard. 

  

In a catalogue, the Thesaurus is used in the following ways: 

1. validation of data entry in linked fields (13.9.1); 

2. replacement of a non-preferred term by a preferred term when 
submitting a search key (13.9.2); 

3. automatic searching on equivalent terms (13.9.3); 

4. the possibility to search on narrower terms of the search key as 
well (13.9.4). 

Further, it is possible to use multiple thesauri (13.10). After all, 
there are excellent ready-to-use thesauri that contain the terminolo-
gy for separate fields of expertise, such as the AAT. Your application 
manager can decide per linked field to which thesaurus or thesauri 

terms can be validated. If during searching or validation a Used 
thesaurus drop-down list is present, you can pick the thesaurus to be 
used yourself. 
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An Adlib authority database (often still called an authority file) is a 

database which contains records of preferred terms or names with 

their related terms or names. (And each related term and name also 
has its own record.) The Thesaurus and Persons and institutions 
databases are examples of authority databases. Other databases, like 
catalogues and collections, contain several fields which are linked to 
an authority database. Being linked means that the term or name 
which you enter in such a field either must already occur in the au-

thority database as a preferred term/name, or that the term or name 
is new and you add it immediately to the authority database. There-
fore, when entering data into a linked field, you can request a list of 
all already existing preferred terms or names which may be filled in, 
and if the term/name which you are looking for is not present, then 

you add the new word directly. And if you fill in a linked field without 
requesting a list, Adlib will automatically validate your input when 

leaving that field: if the term or name does not yet exist, you’ll still 
have to choose between filling in an existing term or name and adding 
the apparently new term/name. The advantages of such a link to an 
authority file is that you’ll be able to prevent identical terms or names 
from being registered in different spelling or that non-preferred terms 
are still used, and when searching on terms or names you do not have 
to wonder whether you might find other records if you would search 

on the term or name in an alternative spelling. 
Between the terms in an authority database, relations can be estab-
lished to define their interrelation hierarchy and preferred-relations. 
Relations allow Adlib to search on a preferred term even if you provide 

a non-preferred term or synonym, and you’ll be able to search generi-
cally, namely not only on the term itself but on all its narrower terms 

as well. The relations that can exist between the terms in an authority 
database include:  
 
• Equivalent term;  
• Use/Used for; 
• Narrower term/Broader term; 
• Related term;  

• Semantic factors. 
 
The Thesaurus normally contains examples of the first four types of 

relations. Semantic factors may also occur in a Thesaurus, but in most 
existing Adlib applications this type of relation is not present. In the 
Persons and institutions and the Series titles authority databases it is 
not possible to create hierarchical relations between terms; these data 

sources are primarily used to store preferred spelling related infor-
mation and synonyms. 
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13.1. Entering data 

The examples discussed below use the Thesaurus file because a the-

saurus may contain all possible relationships, but when applicable the 
relations also apply to other authority databases. 

13.1.1. Fields and their relations 

For each field its purpose will be described, as well as how the rela-

tionships reappear in other records. Where relevant, examples will be 
given. In these examples, you will only see the field names and field 
contents. Different records will be separated by two asterisks (**). 

 Term/Name 

This is the keyword itself. This is an indexed and mandatory field. In 
model applications older than version 4.2, it must be unique within the 
relevant database. From version 4.2, terms and names need not be 
unique anymore. 

 Term type/Name type/domain 

Domains are a built-in feature of the Thesaurus and the Persons and 
institutions files. These will be discussed extensively in chapter 13.2. 

 Status 

In model applications 4.2 and higher, status management has been 

implemented in the Thesaurus and Persons and institutions (older 
applications may have been customized to include this functionality). 
With the definition of the term or name you’ll then also see a Status 
field, in which the current status of the term or name can be regis-
tered. You can set or change that status if you have appropriate 
access rights. 
In the drop-down list you’ll see that the status of for example a term 

can have one of six (or seven*) different values: undefined (neutral 
value 0), approved preferred term (1), approved non-preferred term 
(2), candidate (3), obsolete (4) or rejected (5) (or possibly group*, 
value 6). Terms forced into the Thesaurus from within another data-
base, initially automatically receive the value 3 “candidate” to indicate 

that the term and the automatically created record still need work or 

approval. Undefined means that no status has been assigned yet, 
approved preferred term must be assigned to approved preferred 
terms, approved non-preferred term to approved non-preferred terms, 
candidate to candidate terms (forced terms are candidate terms 
automatically), obsolete to obsolete terms which probably may still be 
used, and rejected to rejected terms. The advantage of assigning the 
status rejected instead of removing a rejected term altogether is that 
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the information about rejecting the term is saved: no-one will ever 

attempt to enter an earlier rejected term as a preferred term again, 

simply because it is still present in the database as a rejected term. 

The status of a term or name also determines how Adlib responds if 
you try to enter such a term or name in a linked field in a catalogue 
record or when you search for it in the Find data for the field window. 
Because of this, rejected terms are not allowed as data entry at all, 
while obsolete terms can still be entered manually (although you’ll be 

warned of the status of the term). Terms and names with one of the 
other statusses can always be entered, but candidate terms will only 
be included in the list of found keys in the Find data for the field 
window after you’ve marked the Show candidate terms too checkbox 
in that window (also see chapter 12.1.2). 

Optional: “group” term status (neutral value 6) 

From version 7.3, Adlib supports a new term status that has the 
neutral value 6 and display value group. The group status is intended 

for terms which are useful or important in your thesaurus manage-
ment to distinguish term collections and which themselves can be 
part of the term hierarchy but are not allowed to be used as a term in 
catalogue records. 
An example might illustrate this concept. Suppose that in your the-
saurus you’d like to construct a term hierarchy of body armour: 

armour 

    armour (by construction) 
        mail armour 
        plate armour 
        scale armour 
    armour (by form) 
        cuirass 

        gambeson 
        gauntlet 
        helmet 
        leg guard 
        shoulder plate 
    armour (by function) 

        battle armour 

        horse armour 
        parade armour 

Although the terms armour (by construction), armour (by form) and 
armour (by function) come in handy here in the term hierarchy, you 
would probably not want anyone to link to such a term from within 
the catalogue (contrary to the other terms). Precisely for this purpose 
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you could assign the group status to the mentioned three terms in 

this example (if the field definition of the status field has been ad-
justed accordingly*).  

 

Terms which have been assigned the group status, adhere to the 
following specific rules: 

• Within the authority database you can link to such a term as a 
broader or narrower term so you can include it in a term hierar-
chy. 

• Terms with this status will be indexed in the thesaurus and you 
can search on them normally. 

• In catalogue records which link to the thesaurus you cannot store 
terms with the group status in linked fields. 

• In linked fields in catalogue records which link to the thesaurus 

you can use the Find data for the field window to look for terms 
with the group status. In the list of found terms, terms with the 

group status have been marked with a green, square icon: you 
can mark these terms with the selection bar but only the non-
group terms from your selection can actually be copied to the 
linked field. 
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• Avoid using terms with this status in preferred term relations: 

you won’t be using them in the catalogue anyway. 

* Although Adlib supports the new term status from version 7.3, your 
application manager must still add the new status to the field defini-
tion of the enumerative status field in your authority database before 

the Adlib user will actually be able to assign the new status via the 
Status drop-down list in an authority record. 

 

 Use 

Refers to one or more preferred terms. (Use a new occurrence for 

each preferred term.) If there is data in Use, no other field should 

contain data, because in this case the current record defines a non-
preferred term in the Term field. The term referred to in Use cannot 
contain a Use relationship itself. 

When you define a relation, and Adlib is saving this record, a mirrored 
or reciprocal record is created automatically. After all, when, in this 
record the term is a non-preferred term that refers to a preferred 

term, then a record should be created for that preferred term, in 
which a reference to the non-preferred term should be included in the 
Used for entry field. Adlib does this automatically. 

Enter for example: 

term   bike 

use   bicycle 

Adlib will then create the related record: 

term   bicycle 

used for  bike 
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 Used for 

Refers to one or more non-preferred terms. You cannot enter Use and 
Used for in one and the same record. 

Enter for example: 

term   cars 

used for  automobiles 

Adlib will then create the related record: 

term   automobiles 

use   cars 

 

In model applications older than version 4.2, if you add a new pre-

ferred term (Use) to a (non-preferred) term, Adlib will not automati-
cally change all previously entered (non-preferred) terms in catalogue 
databases. If, in this case, you encounter a term with a spelling error, 
collect the appropriate records in a brief display, mark them and use 
the Replace in record button in the Edit menu to change the non-
preferred term into the preferred term. Only then can you enter the 
Use term in the Thesaurus or another validation database. 

In model applications 4.2 and higher on the other hand, non-preferred 
terms in catalogue records do get updated to the new preferred term 
automatically: see chapter 12.4.2 for more information about both 

cases. 

 Broader term/Narrower term 

Refers to more general or more specific concepts. You can have multi-
ple broader terms and/or multiple narrower terms. 

Enter for example: 

term   road vehicles 

broader term  vehicles 

narrower term  motor vehicles 

Adlib will create the following records: 

term   vehicles 

narrower term  road vehicles 

** 

term   motor vehicles 

broader term  road vehicles 
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 Related term 

Enter terms that are related to the main term you entered. Related 
terms work like ‘see also’ references. 

Enter for example: 

term    motor vehicles 

related term  road vehicle engineering 

   road vehicle components  

Adlib will create the following related records: 

term   road vehicle engineering  

related term  motor vehicles 

** 

term   road vehicle components 

related term  motor vehicles 

 Equivalent term 

These are terms that mean exactly the same in your application. All 

terms can occur as a keyword in the catalogue. Equivalent terms are 
often used in a CBF multilingual thesaurus. 

Enter for example: 

term car 

equivalent auto 

 wagen 

Adlib will create the following related records: 

term auto 

equivalent car 

 wagen 

** 

term wagen 

equivalent car 

 auto 
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 Semantic factors 

In semantic factoring, a thesaurus term is regarded as a concept, 
which can be viewed as a combination of several simpler concepts 
called semantic factors. Together, these semantic factors (like an 
AND-relation) have the same meaning as the concept.  
 

By default you won’t find semantic factors in your thesaurus, 
but the Adlib software and the database format make its use 
possible, so it may be that your thesaurus is equipped with it. 

The aim of semantic factoring is to prevent the use of overly specific 
terms (long, compound terms) and the thesaurus becoming too com-
plicated because of too many descriptors (preferred terms). You can 

also use semantic factors and existing descriptors to document con-

cepts that, for whatever reason, cannot be entered into the thesaurus 
(e.g. because of their structure, such as a compound subject). It also 
very much simplifies searching a catalogue, because users will be 
more inclined to enter simple search terms than difficult and unlikely 
terms. 
For example, the concept “automatically inflatable life rafts” is unlikely 

to be entered by users, so you may consider defining semantic factors 
for this concept, such as “inflatables” and “lifeboats”. Now, if the term 
“automatically inflatable life rafts” is entered into a catalogue record, 
it is immediately replaced by its semantic factors (in the form of 
repeated fields). This increases the chance that users will find this 

record, as they are more likely to search for “inflatables” or “life-
boats”. 

 
Note that there is a difference between a concept term and its seman-
tic factors, and a preferred term and a non-preferred term. Prefer-
ences have to do with language use, such as advised jargon or 
spelling, while semantic factoring pertains to the meaning of the term. 
The semantic factors for a concept are simple terms, which together 
mean the same as the concept. (An equivalent term, however, is more 

like a synonym or a translation (without preferential values) in which 
the one term already has the same meaning.) 

The fields that have been added to the thesaurus database for this 

purpose are: Semantic factors (tag SF) and Semantic factors of (tag 

FV). The concept is defined under Term, and the semantic factors in 

(the occurrences of) the field Semantic factors. 
For every relationship you build using semantic factoring, the recipro-
cal (or mirrored) records are generated automatically. In the record of 
one semantic factor, the field Semantic factors of sums up the con-

cepts (as a repeated field) for which this term is a semantic factor.  
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 Source 

The term’s source (e.g. the name of the dictionary or terminology 
list). 

 Number 

The term’s number in its source, if present.  

 Scope note 

Definition and/or scope of the term. 

13.2. Domains (term type and name type) 

Domains appear in the Thesaurus (Term type) and Persons and Insti-

tutions (Name type). The use of domains creates different virtual 
sections in the database. One or more domains can be linked to a 
single thesaurus term or name. For instance, the thesaurus term 
“book” can fall into two domains: object name and material. The 
domain determines the term or name type. Examples of types of 
terms are: Object name, Material, Place, Content keyword, etc. and of 

name types: Name, Institution, Author, Supplier, etc.  
One of the benefits of using domains is that in the Thesaurus for 
instance, different types of terms can be stored, while terms are still 
carefully validated.  

 

If you enter a new object into the Museum Internal object catalogue, 
and you enter an object name and leave the field, or when you click 
the List button when the cursor is in the entry field Object name, the 

Find data for the field... window  will open with only the relevant part 
from the linked thesaurus, namely all the terms from this database 
with the object name term type or domain. 

In the Find data for the field... window you’ll also find the Show only… 
option. Deselect this option to display terms from all the domains 
present in the Thesaurus. The terms from the domain that is linked to 

the current field will be shown in bold type (see figure 13.1). You may 

also choose a term from another domain, to enter in the current field. 
When saving this record, the other domain will be added to the term 
in the Thesaurus. For instance, if you enter the name of a supplier in 
the Library entry field Author, and you save the record, then the 
authority database record for that name in Persons and institutions 
also changes; in the Name type field a second occurrence is added 

with the value author. (The first occurrence remains supplier.) 
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Figure 13.1: Showing terms from all domains. 

 Searching on domains 

In (from within) the authority data sources themselves you can search 
on domain with the access point Term type or Name type.  

How you can search on domains in the search language, is described 
in chapter 6.3.6. 

 Domains in mirrored records 

When you assign a domain to a term or name, and you define rela-
tions, then mirrored records are automatically created on saving the 
term record. These reciprocal records of (non-)preferred terms and 
equivalent terms get the same domain; records of broader, narrower 
and related terms on the other hand, won’t be assigned a domain 

automatically. 

13.3. Field validation 

When you have created or modified a record in an authority database, 
Adlib will ask if you want to save the record. If you confirm, Adlib will 
check the information entered in the fields. In the event of an error, a 
message will be displayed. You can then make the required correc-
tions and try to save the record again. 
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If everything is in order, Adlib will ensure that all the relationships 

between terms, are checked, updated or created. This may take some 

time. The catalogue is also updated. 

The validation procedures are as follows: 

• The Term must be filled in. 

• In applications older than version 4.2, the Term must be unique.  

• Use and Used for must not both be used. 

• Use for a non-preferred term must refer to a preferred term. 

• A non-preferred term cannot have any relationships. 

• Used for must refer to a non-preferred term that is not referred to 

by any other preferred term. 

• Relationship fields, except Used for, may only refer to preferred 
terms. 

• All terms and references in a record must be different. 

• There must not be any circular references. A circular reference 

occurs when a narrower term of Term has Term as its narrower 
term, for example. 

13.4. Switching to linked records 

If a Thesaurus term has related terms (those are then underlined), 
you can switch directly to the corresponding record by clicking the 
underlined term. (Also see chapter 8.2.)  

13.5. Display the tree structure of internal links in 
the Hierarchy browser 

In the detailed presentation of records from hierarchically built data-
bases like an archive database or the Thesaurus, you can display the 
tree structure of all records that are linked internally to the currently 
displayed record through broader, narrower, equivalent and related 

terms (or through the Part of and Parts fields in an archive record). 

Click the Hierarchy browser button in the View menu: 

 

or press F9, and the tree structure appears in a separate window pane 

on the right side of the screen: the Hierarchy browser. (Choose the 
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same button or shortcut again, or click the little cross in the upper 

right corner of the Hierarchy browser to close it.) 

 

Figure 13.2: The Hierarchy browser in the detailed display of a term record. 

By default, the tree view displays all narrower and broader terms of 

the current term. You can click a plus sign in front of a term to show 
its narrower terms, and a minus sign to hide those narrower terms. 
Narrower terms may or may not have been sorted in some way, 
dependent on application settings (see the technical information 

below). 

Technical information: the sorting of narrower terms 

Narrower field occurrences (like occurrences of the Parts field for 
example) in the record and the corresponding values in the Hierarchy 
browser are sorted ascending or descending according to the Sort 
values Designer setting for the internal link (or not sorted at all), 

while the type of sorting will be determined by the Key type (data 

type) of the index on the main term field in the internal link defini-
tion. See the Designer Help for more information. 

 
Double-click one of the records in the Hierarchy browser to have that 
term displayed as the current detailed presentation. (If that record 
was not in the original search result list, it will now be added to that 
list.) 

http://documentation.axiell.com/alm/en/index.html?ds_dbinternallinksproperties.html#sorttags
http://documentation.axiell.com/alm/en/index.html?ds_dbinternallinksproperties.html#sorttags
http://documentation.axiell.com/alm/en/index.html?ds_dbindexesproperties.html#indextypes
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 Multiple hierarchies in the Hierarchy browser 

Prior to Adlib 7.3, the Hierarchy browser could only display a single 
hierarchy, even if a term was part of multiple hierarchies. The current 
version of Adlib offers more possibilities though: 

• If the currently displayed term has multiple broader terms (result-
ing in different hierarchies) then all of those hierarchies will auto-

matically be displayed (below each other) in the Hierarchy brows-
er. Below you can see an example from the Thesaurus in which 
the term ‘helmet’ is part of two different hierarchies. Both hierar-
chies will be shown automatically for the currently displayed ‘hel-
met’ record. 
Note that although the vertical, dotted line between ‘armour’ and 
‘headgear’ may seem to indicate otherwise, there is no link be-

tween both terms: these are separate hierarchies. 
 

 
 
You can also imagine (lucky pun) a record in Persons and 
institutions being part of different hierarchies: 
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• If the currently displayed term is part of different types of hierar-

chical (broader/narrower) relations (which is possible in principle if 

multiple internal link definitions of the hierarchical type have been 
specified for the term or name field in the current database), then 
all of these will be displayed in the Hierarchy browser. 

• If the currently displayed term has equivalent terms then any 
hierarchies for those equivalent terms are displayed as well, below 
any other hierarchies. And an equivalent term does by no means 

have to be the top term of the hierarchy it is part of.  
In the example below, ‘headdress’ and ‘headwear’ are equivalent 
terms of ‘headgear’ and they are not part of some hierarchy of 
their own. To indicate that these terms are equivalent terms of the 
selected term (the record shown in detail), they are being dis-

played in bold red type. 
If you have no interest in any equivalent terms and their hierar-

chies, you can hide them by right-clicking the Hierarchy browser 
and selecting Hide equivalents in the pop-up menu. Similarly you 
can show them again by selecting Show equivalents in the same 
pop-up menu. Adlib remembers your setting (per user) for next 
time you open the Hierarchy browser. In the screenshot below, 
clicking Hide equivalents would hide de terms ‘headdress’ and 
‘headwear’ (equivalents of ‘headgear’). 

 

 
 
In Persons and institutions this functionality may come in handy 
too if a person name has equivalents in the form of a nickname, 
proper name or even writer’s aliasses. 

• From Adlib 7.4, the hierarchy browser (F9) also displays related 

terms, such as those registered in the Related term field of a The-
saurus record for instance. In the hierarchy browser, related terms 
will be displayed in a bold green font. 
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You may first still have to switch the display of related terms on, 
though. Right-click the hierarchy browser to open the pop-up 

menu. Use the Show/Hide related terms option to switch the dis-
play of this type of relation on or off. 
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 Adjusting the hierarchy 

In the Hierarchy browser you can drag a term (or a different hierar-
chically linked record) to another term to make the dragged term a 
narrower term of that other term or just to change the order of the 
listed occurrences (if the occurrences aren’t sorted automatically). So 
this way, you actually change records (term definitions in this exam-

ple) because the contents of the Broader term and Narrower term 
fields will be adjusted automatically in several records! A dialog will 
ask you for confirmation though, before the change is actually pro-
cessed. You can choose between inserting the term as a narrower 
term (child record) underneath the target term (parent record) and 
moving the term to the spot directly above the target term within the 
occurrences order of terms on the same level. You cannot choose to 

move a term if you drag it to a different level: both options will be 
greyed out and you can only insert the dragged term as a narrower 
term or cancel the entire action. Moving won’t have any effect when 
the occurrences in the record are automatically sorted. 

The internally linked fields Part of and Parts in relevant object and 
archive records are automatically adjusted for you as well, so you 

don’t have to do this yourself. But the description level of a moved 
archive record will never be adjusted automatically! So if you have 
moved a unit to a different level of description, you’ll have to set the 
new level of that record manually, by explicitly editing it. 

 Adding a single new, fully editable child record 

It is possible to add new terms or other child records here as well. In 
the Hierarchy browser in the Thesaurus for example, right-click a term 
underneath which you’d like to insert a new term, and choose Insert in 
the pop-up menu which opens. A new record opens for editing; the 
proper related terms have already been entered for you. Complete the 
record as desired and save it. It will immediately be displayed at the 
correct location in the term hierarchy in the Hierarchy browser. 

 

Figure 13.3: Adding a new, internally linked term. 
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 Adding child records in batch 

From Adlib 7.3 you can add multiple (largely empty) child records at 
once underneath a selected record, via the pop-up menu in the Hier-
archy browser. 
If relational rules* have been specified for the internal links which 
form the basis of the displayed hierarchy, then those rules will be 

taken into account and you can only add child records of the record 
type that is allowed for the currently selected record type. (* Please 
see the ”The record type field” and “Relationship dependency rules for 
internally linked record types” Designer 7.3 release notes topics for 
information about how to set this up.) 

When the requested child records are generated, the storage adapl set 
up for the database will be executed normally to fill any mandatory 

fields or certain desired fields automatically. Automatically numbered 
fields in the new records will also be processed normally. It works as 
follows: 

1. So this functionality allows you to insert one or more largely 
empty records underneath one of the listed records in the Hierar-
chy browser (on a lower level that is). Any mandatory fields 

should** be filled automatically. Right-click the record underneath 
which you’d like to insert the new records and choose Add child 
records in the pop-up menu that opens. 

2. The Add children window opens. Set the number of child records 
you’d like to insert now. 

 

 
 

 

http://documentation.axiell.com/alm/en/index.html?ds_releasenotes7_3.html
http://documentation.axiell.com/alm/en/index.html?ds_releasenotes7_3.html
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The Type of children drop-down list is only active (allowing you to 

pick a value from the list) if so-called relational (aka business) 

rules for the internal links have been specified and if you are al-
lowed to insert more than one record type underneath the select-
ed record. In the example above those relational rules have been 
set indeed but a series record can only parent a sub-series record, 
which explains why the user is offered no other choice here. If the 
drop-down list is empty, it simply means no relational rules have 

been set. 

3. Click OK and the records will be created immediately and will be 
added below the other child records underneath the selected rec-
ord. The reverse links from child to parent and from parent to 
children will be made automatically. 

4. Double-click one of the new records to present it in detailed dis-
play. You can edit the record normally to add data where needed. 

** It is of the utmost importance that your application manager en-
sures that mandatory fields in the hierarchical database will indeed be 
filled with data, for instance by adapting the storage adapl for the 
relevant database or by setting up automatically numbered fields. And 
if those mandatory fields are indexed uniquely, then the automatically 
entered values should be guaranteed unique too. 
If these precautions have not been taken, Adlib will warn you about it 

when you try to create child records: in that case, the child records 
won’t be saved. 

 Other remarks 

And finally, you can move the hierarchy browser to the left side of the 

screen, if you wish. Right-click this window pane and choose Dock left 
or Dock right in the pop-up menu to set the position of the window. 

Further note that an opened hierarchy window in the current database 
also means that you’ll see an opened hierarchy window in other data-
bases in this application in which there are internal links through 
broader and narrower terms. 

13.6. Link overviews 

The link overview functionality in Adlib offers a special display showing 
from which databases and fields the current record (often an authority 
term or name) is referenced. You can use this functionality to quickly 
find out where a term or name is being used, which comes in handy 
when you’re planning to clean up your thesaurus for example. 
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The Link overview button in the View menu in Adlib only becomes 
active in detailed display mode of a record if for the current database 
feedback databases have been specified. All model applications 3.6 or 
later have these feedback databases by default, while older applica-
tions may have been customized with this feature. 

 

By default, the Link overview only displays the numbers of the records 
in the other database, which reference the current record, like the 
screenshot below for example, which shows that the object_category 
field in records 1, 2, 3 (amongst 34 others) of the listed feedback 

database has a link to the currently displayed record.  

 

However, your application manager may have decided to have differ-
ent information displayed per record, to make the overview more 
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useful. So instead of "record: #", maybe the record number, followed 

by the title of the record and the first registered object name - all 

fields separated by forward slashes – are displayed for the COLLECT 
feedback database, for instance, as can be seen in the screenshot at 
the top of this chapter. Please see the Customizing the link overview 
functionality Designer release notes topic for information about how to 
set this up.  

The Link overview window pane initially opens on the left-hand side of 

the Adlib window, but you can drag it (by its title bar) to any other 
location. Or right-click the window pane and select Dock right in the 
pop-up menu to move the window pane to the far right. You can also 
resize the window pane by dragging one of its borders. 

 

By default, the Link overview lists all feedback databases that have 
been registered for the current database and for each of those all 
fields that link to the current database, even if there are no references 
to the current record in those fields or databases: (0) behind a 
database name indicates that it has no references to the current 
record. Since you might not be interested in seeing feedback 

databases or fields which have no reference to the current record, you 
can hide them all at once by selecting Hide empty fields in the right-
click pop-up menu. (Vice versa you can show them again by selecting 
Show empty fields in the same menu.) Your pop-up menu choices will 
be remembered by Adlib for next time you open the Link overview. 

Note that the displayed feedback database and field names are their 
system names, not their user-friendly names. 

Besides the possibility to have some record information in the Link 
overview, there’s the Designer option to set a detail zoom screen for a 
linked field (again, see the Customizing the link overview functionality 
Designer release notes topic): this allows you to double-click any of 

the listed records (for the relevant linked field) in the Link overview in 
order to open it for display (not editing) in a zoom screen so you can 
view much more of the relevant record details.  

http://documentation.axiell.com/alm/en/index.html?ds_releasenotes7_3.html
http://documentation.axiell.com/alm/en/index.html?ds_releasenotes7_3.html
http://documentation.axiell.com/alm/en/index.html?ds_releasenotes7_3.html
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Since such a detail zoom screen will have to be set per linked field and 
there may be many linked fields in quite a number of feedback 
databases, there’s a good chance your application manager will only 
have implemented this double-click zoom screen viewing for a limited 
number of fields (if any). 

Also note that a link overview does not show any internal links (within 

the same database that is): if you’d like to see that tree structure, 
please use the Hierarchy browser. 

13.7. Deleting records 

When in a brief or detailed display of the Thesaurus, you can delete a 
term record by clicking the Delete button in the Start menu. In model 
applications older than 4.2, Adlib does not check whether the term is 

in use in the catalogue, and whether there are any relationships with 
other thesaurus terms, and just removes the record. This may lead to 
corruption of the catalogue. Therefore, always first search and replace 

or delete the relevant (references to the) term everywhere in the 
catalogue, before you remove the term record in the Thesaurus. (See 
also chapter 12.4.2 for more information about search and replace.) 

On the other hand, if in your application feedback links are being 

used, then said checks will be performed, and these will generate an 
extra message (with the record numbers and fields in the feedback 
database in which the term still occurs), requiring your confirmation 
before the term record is deleted. If you answer YES, Adlib will delete 
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the record, and all references to it will be removed from the Thesaurus 

and catalogue records automatically. Depending on the number of 

relationships, this might take some time. (See the Designer Help for 
information about feedback links.) 

13.8. Printing 

Thesaurus builders and users alike may find it useful to have a 
printout of all the terms and their relationships in the Thesaurus.  

You can obtain such a printout as follows: 

1. Select the Thesaurus data source in the database menu (when 

present), and click Next. 

2. Select Term, click Next and do not enter a value. Click Next again. 

3. Click the All keys button and mark all records in the Brief display 
via the Toggle marks button in the Start menu. 
 

 

4. Finally, click the Output formats button in the File menu. 

 

 

5. From several output formats, choose one. Dependent on your 
application you may choose between: 

• Thesaurus listing. This list displays the relations for each term 
the way they are entered during input, and is particularly use-
ful for the thesaurus builder creating relations. 

• Generic thesaurus list (with tree structure). The generic the-

saurus list only displays the generic relations of the terms, 
meaning that for each term you will get the hierarchy of nar-
rower terms underneath it. So this list is structured just like 
the terms list for generic searching. 

6. Click the OK button in the Print window to start printing. 

http://documentation.axiell.com/alm/en/index.html?ds_dbfeedbacklinks.html
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13.9. Thesaurus use from the catalogue 

In this and the following paragraphs we will use as our example the 

keyword field (Subject term) in a catalogue, which is linked to the 
Thesaurus. 

The Thesaurus in the standard Library application is used for the 
following: 

5. input of new keywords; 

6. term replacement when submitting a search key; 

7. automatic use of equivalents when searching on subject term; 

8. searching on narrower terms when searching on subject term. 

13.9.1. Input 

Not only can you fill and maintain authority databases from within the 

relevant data sources themselves, but also from within each database 
to which an authority database has been linked. 

When you enter data in an Adlib data source (for instance in a sub 
catalogue), the presence of the List button indicates that the cursor is 
in a field to which an authority database is linked.  

 

You can search for, add, consult, and edit linked records from this 
field. 

Click the List button when entering a Subject term to call up an alpha-
betical list of existing keywords. If you had already entered a few 
letters in the field, the list will begin at, or as close as possible to, the 
word or part of a word that you entered. You can move up and down 
the list in the Find data for the field... window using the scroll bar and 
the arrow keys.  

If you don’t want to enter a new keyword, choose an existing term by 

selecting it and clicking Select. Now, the keyword will be copied into 
the Subject term entry field. 

If you enter a non-preferred term as Subject term, it will automatically 
be replaced by the appropriate preferred term as soon as you leave 
the entry field. For example, if you fill in bike, this can automatically 

be replaced by bicycle (if a preferred term relation between these 
terms exists in the Thesaurus). 
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13.9.2. Term replacement when submitting a search key 

If you submit a non-preferred term as the searcj key when searching 
on a subject term or other validated field in a catalogue, it will auto-
matically be replaced (in the background) by the appropriate preferred 
term as soon as you start the search. This substitution is carried out 

when you type in the full term, but also if you use a truncated search. 
(To CBF database the above always applies whilst to Adlib SQL data-
bases it only applies when you’ve marked the Use relations checkbox 
in Step 3 of the Search wizard.)  
For example: you enter the search key bikes and you have defined 

this term as a non-preferred term for bicycles. Adlib will then show 

you the records in which the term bicycles occurs. You’ll find these 
records even when searching on bike. 

This non-preferred term replacement does not take place if you are 
searching the Thesaurus itself (or another authority database). 

When you are searching using truncation there might also be several 

non-preferred terms that fit the truncated term. All of these will be 
substituted by their preferred term to continue the search. Because of 
this, quite different terms can be found in the search result. 

13.9.3. Automatic searching for equivalents 

When retrieving records for the entered search key(s), records which 
contain an Equivalent term (as defined in the thesaurus record) and 
not the key itself, will automatically be found as well. For example, if 

you search on bicycles, records that contain the Dutch equivalent 

fietsen will also be selected (if this relation has been specified so in 
the Thesaurus). 

(To CBF database the above always applies whilst to Adlib SQL data-
bases it only applies when you’ve marked the Use relations checkbox 

in Step 3 of the Search wizard.) 

13.9.4. Searching on narrower terms too 

When after a search in Step 4 of the Search wizard a list of found 
terms is displayed, you can recognize terms with narrower terms by 

the plus sign in front of them. Those narrower terms can be displayed 

in two ways: for example, click the + in front of a term to show its 
narrower terms. Those narrower terms can have narrower terms 
themselves too: each hierarchical level can be expanded by clicking 
the + in front of the desired term (and collapsed again by clicking the 
-). However, you can expand all lower levels of a selected term at 

once by clicking the Expand term button. This possibility to display 
narrower terms is present to offer you more choice when continuing 
your search. Click the All keys button, for example (regardless of the 
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selected term) to search for records on all found main terms: if for 

that search you’d like to include all narrower terms (whether they’re 

expanded or not) of all main terms displayed in the list, then do mark 
the Include narrowers checkbox before you click the All keys button. 
Or click the Show button to search on the selected term and (with a 
marked checkbox) on any narrower terms (whether they’re expanded 
or not) of the selected term only. A narrower term itself can be select-
ed as well. 

 

Figure 13.4: You can search on narrower terms as well. 

13.10. Using multiple thesauri 

There are several reasons why you would want to use more than one 

thesaurus in your Adlib applications. For instance, it would be better if 
you could use different thesauri for different specialisms. Or better 
still, if you could use a different thesaurus for specific fields in a data-
base, e.g. in Adlib Museum. After all, there are excellent ready-to-use 
thesauri that contain the terminology for separate fields, such as the 
AAT.  
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Figure 13.5 : Click the Thesaurus drop-down list to select a different thesaurus. 

It saves you a lot of time and effort if you can use these standard the-
sauri next to your own thesaurus. That’s why your application mana-
ger may have made it possible for you in specific linked fields to 
search for terms in one or more other thesauri, to use those thesauri 

for the validation of the relevant fields, or to update complete data-
bases with them, including your own thesaurus. Any replacing terms 
in your database will also become part of your own thesaurus. 
In Adlib model applications, this functionality has not been set up. 

These standard thesauri can be used either from CD-ROM, from the 
intranet, the internet or from your own hard disk. So you no longer 
have to convert your data for an update, but you simply use another 

CD, or validate from another thesaurus elsewhere on the system. The 
only condition is that the thesaurus must be available as an indexed 
Adlib database: that is to say that the thesaurus field (e.g. the tag te) 
to which the link has been made, must actually exist in the external 

Adlib thesaurus and is indexed.  
In case one or more external thesauri have been set up for a linked 

field, you as user of the application can choose to use one of those 
external authority databases instead of your own Adlib Thesaurus, in 
three different circumstances: 

1. When entering records. If a field is linked to the standard 
thesaurus, like Object name in Adlib Museum, you can use the List 
button to open the Find data for the field... window to look for a 
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term, or, when the term does not occur in that thesaurus, this 

window will be opened automatically.  

 

Figure 13.6: Select the added thesaurus, and the list of found keys is im-
mediately updated. 

In the top right corner of this window, a Thesaurus drop-down list 

can be present (only if that has been set up for the relevant field 
by your application manager). Click that drop-down list and 
choose the desired thesaurus database (see Figure 13.5). The list 
of available terms is adjusted immediately (see Figure 13.6).  

Note that during your search in the online AAT (Art and Architec-
ture Thesaurus), the list may contain terms which seem out of 

place alphabetically, but that would be because the search key is 
searched in multiple fields at once while (on the View hierarchy 
tab) only the Term field is being displayed. It depends on your De-
signer settings for the external thesaurus if this is the case indeed, 
or if you only search the Term field as you would expect. 

2. Global update. The second way to use this functionality is for a 

global update. A global update lets you update specified fields in 

all marked records of the current database with the aid of a differ-
ent thesaurus (if available). This means that every term in the se-
lected fields that has been defined as a used-for (non-preferred) 
term in the new thesaurus, will be replaced by the appropriate use 
(preferred) term from that thesaurus, but only if the imported pre-
ferred term doesn’t already exist in your own thesaurus as a non-
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preferred term (if it does, the term will not be replaced!). In other 

words: suppose your own thesaurus has the term “motorbike” and 

this term appears in records in your catalogue. If you mark these 
records and select the fields in which this term appears, then “mo-
torbike” will be replaced if the new thesaurus defines the term 
“motorbike” as a non-preferred term. The preferred term, e.g. 
“motorcycle”, will replace “motorbike” in the marked records. This 
replacement will not take place if “motorcycle” happens to be de-

fined as a non-preferred term in your own thesaurus! 
The new thesaurus record is added to your own thesaurus, and 
the old thesaurus record will remain intact, but no relation will be 
made between the old and the new term. So no mirror-record is 
made for the new record. (The old thesaurus record remains intact 

because you may be keeping catalogue records or fields that you 
do not wish to validate with the new thesaurus. The old thesaurus 

term will remain in those records, and should therefore refer to 
the old thesaurus record.) 

 

 

 

Figure 13.7: Move the fields you wish to validate by a different thesaurus 
by double-clicking them or by selecting them and copying them with the 
single arrow button to the field on the right. (Clicking the double arrow will 
copy all fields at once.) 
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For the brief display and the detailed display of marked records, 

the Thesaurus update button is active in the Edit menu. Click it to 

open the Thesaurus update window.  

Click the Browse button to find the desired thesaurus on your sys-
tem, or choose one from the Used thesaurus drop-down list. If you 
want to update automatically, you should uncheck the Confirm re-
placement option (which of course can be risky). 

3. Generic search. You can also use a thesaurus of your choice 

while searching with the Search wizard, if that has been set up for 
the relevant field by your application manager. For this, a drop-
down list is available in Step 3 of the Search wizard. Choose a 
thesaurus from the list. If your search key yields multiple terms, a 

list of those terms will open as before, but the keys from the se-
lected thesaurus that are used in your own database will be high-
lighted in green. With the greyed out keys, you won’t find any 

catalogue records, so choose one of the green highlighted ones. 
 

 

Figure 13.8: Searching with a thesaurus of your choice. 
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Figure 13.9: List of found keys in the Search wizard, with the thesaurus of 
your choice.
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14. Printing 

Abstract 

You quickly start printing the currently opened record (marked or 
unmarked) or the marked records in the brief display by using the 
Ctrl+P shotcut. Subsequently you’ll have to choose your method of 

printing: 

• Create a report with the Print wizard (page 274): after selecting 

this method you’ll step through a simple interactive procedure to 
specify a format and style for printing, although you can’t print 

images this way. Use this method if your ready-made print for-
mats do not offer a solution. 
From the File menu (to the left of the Start menu) you can start 
this printing method directly via the Open Print wizard button: 

 

 

• Create a report with Microsoft Word templates: use this method 
to print to ready-made Word templates, when available. You only 
need to find the proper template on your system. The resulting 
Word document can be saved, e-mailed automatically and/or 

printed. 
If you want, you can create or edit Word templates yourself (see 

chapter 15). 
From the File menu you can start this printing method directly via 
the Find Word template button: 
 

 

• Create a report with a predefined output format: predefined 
output formats automatically perform a complex print task. Such 
a format can be an ADAPL program (Adlib’s own programming 

language for this purpose) and/or a preset Word template or 
XSLT stylesheet. You only need to select the desired output for-
mat from a small list. 
From the File menu you can start this printing method directly via 
the Output formats button: 
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After finishing the Print wizard or having chosen an output format, 

the default Windows Print dialog will open, so that you can select a 
printer and change other standard settings before actually printing 
(14.2). 

The Print label button in the Start and File menus offers a quick way 
to print a label for one or more records (an address or barcode label 
for example), once one or more proper label templates have been 
created and set up (14.3). 

 

14.1. Print wizard 

 

Figure 14.1: Choose your printing method. 

The Print wizard is a very comfortable and simple way of printing. It 
handles three ways of printing in Adlib in a single interface. Open the 
Print wizard by using the Ctrl+P shortcut. 

If you open the Print wizard from the detailed display of a record, 
you’ll only print the currently shown record (whether that record is 

marked or not). If, on the other hand, you open the Print wizard from 
the Brief display, then you’ll print all marked records; the Print wizard 
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will become active here when you’ve marked at least one record. (See 

chapter 14 for more information about marking records.) 

This Print wizard, with all its printing possibilities, can also be opened 
from within the Pointer files window through the Print button. 

Individual or marked records can be printed to Word from the applica-
tion, printed with an existing output format, printed in a predefined 
style or in a style you create interactively by going through the steps 
in the Print wizard. Creating a report interactively with the Print wizard 

is a handy alternative for printing through output formats (adapls) or 
Word templates, you but cannot print images that way. 

The order in which records will be printed is that in which they are 
listed in the brief display. If you prefer another order, then you must 

first sort the records (see chapter 14).  

When you create a report interactively, the Print wizard creates a print 
adapl in the background, in which all settings made here are pro-
cessed, and which handles the final printing. Before printing, you 

determine whether you want to keep this adapl, to alter it program-
matically later on for example, with changes that cannot be made with 
the Print wizard. 

Now open the Print wizard for one or more records.  

 Page 1 
 

As you can see there are three ways of printing: 

 
• To print to a previously created Word template, you mark the 

Create a report with Microsoft Word templates option and you click 
the Finish button; you will be asked to select the desired template 
in the Template window. 
If next time you’d rather skip the Print wizard or don’t want to use 
the Ctrl+P shortcut, then from the File menu (to the left of the 

Start menu) you can start this printing method directly via the 

Find Word template button: 
 

 
 
Microsoft Word can be used very conveniently for creating letters, 
labels and documents in which the company style of an organisa-
tion is very important. For this purpose, default Word templates 
can be edited to enable printing of Adlib data with such a tem-

plate. Documents that are created this way, can be saved, printed 
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or sent through e-mail. (See chapter 15 for instructions about ed-

iting templates.) 

• On the other hand, mark the Create a report with a predefined 
output format option in the Print wizard to print via an earlier cre-
ated or ready-made output format.  
An output format is either an ADAPL program, a Word template or 
an XSLT stylesheet set up as such, that prints data from the se-
lected records in a specified way (preselected fields in a specific 

layout). The application manager may even set up a combination 
of adapl and template output.  
For creating advanced reports, for which some pre-processing of 
data is necessary, the Adlib programming language ADAPL or 
XSLT will be required. Complex calculations, manipulations of field 

contents, etc., cannot be performed interactively with the Print 
wizard, but will have to be managed by ADAPL procedures (output 

formats) or XSLT stylesheets. 
Click Next, select the desired output format in the Select an out-
put format list, and click the Finish button. (Which output formats 
are available depends on your application. And with Designer you 
or your application manager can add new output formats to this 
list.) 

 

Figure 14.2: Choose an output format in the Print wizard. 
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Note that via the Windows registry Adlib remembers per data 

source (dataset/database) the last chosen output method (as cho-

sen in this first window of the Print wizard), so that next time you 
only need to confirm the same print method. 
Adlib also remembers the output format last used, even if you 
printed with another print method the previous time(s). As soon 
as you choose the third option again, you’ll notice the last used 
output format is already selected for you in the next window. You 
only need to click Finish now. 

If you’d rather skip the Print wizard or don’t want to use the 
Ctrl+P shortcut, then from the File menu (to the left of the Start 

menu) you can start this printing method directly via the Output 

formats button: 
 

 

Figure 14.3: Choose an output format from the Output formats submenu. 

Move the mouse pointer to the Output formats button. As soon as 

the mouse pointer hovers over the Output formats button, a sub-
menu opens next to it, containing all available output formats. 
Click one of them to use it for printing.  

Note that via the Windows registry Adlib remembers per data 
source (dataset/database) the last chosen output format, even if 
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you printed with another printing method the previous time(s). In 

the list of output formats, a square blue background is added to 

the icon of the format, as can be observed in the screenshot 
above for the ISBD listing output format. You can use this feature 
next time by clicking the label of the Output formats button (not 
the arrow next to it): this will make Adlib print by means of the 
last used output format immediately. 

• The interactive way of printing is the top most option on the first 
page of the Print wizard: Create a report with the Print wizard. 

Mark this option and click the Next button to interactively make a 
print adapl with the Print wizard, without having to program. 
Choose this possibility if the existing output formats are not what 
you want right now and you don’t want to program an adapl or 

make a Word template: Then, printing this way is fast while you 
can determine which fields you want to print. Note that you can’t 
print images this way. 

From the File menu (to the left of the Start menu) you can start 
this printing method directly via the Open Print wizard button: 
 

 
 

 Page 2 (for Create a report with the Print wizard) 
 

 

Figure 14.4: Open an earlier created Print wizard parameter file, if desired. 



Adlib User Guide Printing 

 275  

If you have used the Print wizard before, and you have saved the 

settings you made earlier into a profile, you may use those same 

settings again to print in the same way quickly. Click the Browse 
button to search the desired parameter file. To go to the next page 
without opening any previously saved settings, click the Next button. 
Print wizard profiles have the double extension .wiz.xml. 

 Page 3 
 

 

Figure 14.5: Select the fields you want to print. 

Repeatedly select a field and click the single arrow button pointing 
right to copy the field into the box on the right. All the fields in the 
right-hand box will be incorporated in your print profile. 
You can also copy all fields by clicking the double arrow. The arrows 
pointing to the left will let you remove one or more selected fields or 
just all fields from the box on the right. 
The order in which the fields appear in the box on the right, deter-

mines the order in which they will be printed.  
Click an option behind a selected field to set the relevant field proper-
ty for printing differently.  
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Figure 14.6: You can set some properties for the fields you want to print. 

• Repeat: set this option to Yes if you want all occurrences of this 

field to be printed. 

• Ignore empty: set this option to Yes if you do not want empty 

occurrences to be printed. 

• Length: set this option to 0 to automatically let the column width 
adjust to the width of the caption of the column. Field values 
which are longer than the column is wide, are wrapped and con-
tinued on the next line. Set the column width to another value to 

specify the width of this column in AUs (Adlib units: a horizontal 
AU is 1/90 of the width of the default printable area of an A4). 
(This width is only relevant for the Record per row layout that you 
can choose on the next page.) 

• Label: by default, the field name in the current interface language 
will be printed, but that is not always desirable. In the example 

above, title and publisher may be perfectly well suited but au-
thor.name isn’t. If you’d like to print a label different from the field 
name, then enter it in the Label column. For example, in the line 
behind author.name you could enter the label author. 

When you have selected all desired fields, click Next to go to the next 
page of the Print wizard. 

 Page 4 

There are two possible global layouts and two orientations. The Rec-

ords in one column option prints the field names in the first column, 
and the values next to it in the second column. The records will be 

listed beneath each other. The option Record per row prints the field 
names in a header row, and the values in rows underneath. Each 
record is in a row of its own. If desired, choose a different orientation 
too. Click Next. 
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Figure 14.7: Choose a global layout for this print job. 

 Page 5 

 

 

Figure 14.8: Choose the style in which the different text elements must be 
formatted. 
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As you will probably also want to influence the layout of the printout 

to be made, the Print wizard offers you the possibility to define a 

style. A style you define here is independent of the fields and other 
settings you selected earlier, and you can save this style separately to 
use later on in another print profile. 

Possibly, a number of predefined styles are already available to you. 
However, if the list is still empty, then you’ll have to create one or 
more styles yourself. The Print wizard searches style files (with the 

double extension .style.xml) in the current application directory, so for 
example \library or \museum. 

Click the New style button to define a new style. The Create a new 
style window opens. 

 

Figure 14.9: Define a new style for each text element. 

To begin with, type a title for this style in the entry field New title. 
Choose a descriptive name for the style; this name will be placed in 
the list of styles later on. 
Next you can set font characteristics for headers, labels (captions), 

data and footers separately, which reflects immediately in the display 
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of the labels for these text elements. For instance, put the cursor in 

the Header entry field and consecutively click the b (bold), i (Italics), 
and u (Underline) buttons. The display of Header now has changed. 

You can also change the font type per text element: click the aA 
button while the cursor in located in the relevant entry field and in the 
font type window then choose the desired font – here you can also set 
Bold and Italics. 
And finally you can select a printing colour for each text element 
separately too, by clicking the button with the palette. Of course, your 

printer must then be capable of printing colours. 
The layout always applies to the entire text element. 

If you want to print headers, footers and/or a record separator then 
replace the words “Header” and/or “Footer” in the relevant entry fields 

by the desired fixed text to be used as header or footer text, and 
choose a value from the Use record separator drop-down list and 

possibly enter a text beneath it. Empty a field if you do not want to 
see any text printed on that location. (The text in the Label and Data 
boxes cannot be adjusted, but it won’t be printed literally anyway.) 
Click one of the three alignment buttons to determine the alignment of 
the active entry field: left, centred, or right. 

 

The three buttons on the far right let you insert a page number, date, 
and/or time in the header or footer. (This is the date and time of 

printing.) The header and footer will contain a special code to make 
sure the right values are used during printing (so they will not be 
printed literally as $[code]$). Footers and headers may contain a 
maximum of two lines of text, and for a large font only one line. This 
is because for the height of such a text a maximum of 2 AU will be 
reserved. 

Page number, date and time comply with the ADAPL equivalents &S, 

date$(8) for an ISO date with a year in four digits, and time$(1) for 

the time in hh:mm:ss format. 

Use a record separator to clearly distinguish separate records on the 

printout. You can choose between Line, New page (each record will be 

printed on its own page), and Text. When you choose text, the rele-
vant text must be entered in the entry field below the drop-down list; 
you can also insert a page number, and date and/or time here. 
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Figure 14.10: Specify the fixed and variable texts on the printout. 

Click OK when all style characteristics have been set. Now the style 
has to be saved before you can use it. So choose a file name, for 

instance the name you also entered as title. (The extensions will 
automatically be added during saving.) Click Open to save the file. 
The style you just defined appears in the Layout list. Select a style to 
display the font characteristics of each text element, next to it. 

You can edit an existing style too. Select the name of it in the list and 
click the Change style button. The same window opens as when you 
define a new style. Save the style after editing, under the same name 

or under a new name, depending on whether you want to replace the 
style, or add an extra style. 

Finally, select the style you now want to print with, and click Next. 
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 Page 6 

 

Should you wish to alter any of the settings, click Back to return to a 
previous page, and make some modifications. 

 

Figure 14.11: If desired, save the settings you made. 

Here, click the Preview button to view a print preview of your current 
settings. A print preview opens in the Adlib main window. With the 
little cross above the scroll bar in the print preview display the preview 
can be closed, while the Print button in the lower right corner allows 

you to print. 
 

   

 

If you think you may need these settings again (the fields selection, 
their arrangement and orientation), then you can save them as a 
profile in a parameter file. Mark the Save the print wizard parameters 
to file option, click the upper Browse button to select a suitable direc-
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tory and enter a file name that will allow you to recognise this profile 

later. These files are automatically saved with the proper extension. 

Preferably save them in the current application directory. 
Note that in this file only a link to the used style file will be included: 
the style itself is stored in a separate file, when you define that style. 

The Print wizard generates a print adapl of all settings and style char-
acteristics, to perform this printing task. If you like to be able to edit 
this adapl later on by means of the ADAPL programming language 

itself, then choose here to store the generated adapl. Mark the rele-
vant option and click Browse to enter a name and path for the .ada 
file. Save the file in your \adapls folder, for instance. 
Note that you won’t be able to open these adapls in the Print wizard 
anymore at a later time; you will only be able to use them as you use 

other (print) adapls. Only a saved printing profile (the parameter file) 
can be opened again in the Print wizard, to print again with the same 

(or altered) settings. 

Finally, click Finish to end setting up the Adlib print job. 

14.2. Windows settings for printing 

After finishing the Print wizard (also when you have selected an output 
format), the standard Windows Print window will open, so that you 
can select a printer and change other standard settings before actually 
printing. 

In the Print window you mainly determine the destination of the 
printout. 

 Printer and Properties  

In the Name drop-down list you can select another printer that is 
connected to your system. Open the list and choose the desired print-

er by clicking it. 

Click the Properties button to set up the properties of this printer. The 
Properties window varies per printer, but here you can, for example, 
set whether you want the orientation of the printout in landscape or 

portrait, and whether you want to print on one side or on both sides of 
the paper. 
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Figure 14.12: The Print window. 

The settings concerning print orientation and paper size can also be 
made in the ADAPL program that generates the output format, and 
just the print orientation also in the Print wizard. When these settings 
are different from those set for the printer properties, then the set-

tings as specified in the ADAPL program or in the print wizard profile 
will be used. 
It may be that the application builder has made it impossible for the 

user to choose another printer; the Properties button and the Name 
list will then be greyed out. 

 Print to file 

Mark the Print to file option if you don’t want to print to the printer but 

to a file, meaning: if you want to save the data to be printed in a file. 
Such a print file is useful if you want to be able to make the same 
printout again quickly at some later time, or when users at other 
computers must be able to make the same printout. 

After marking this option, click OK to create the print file. In the 
Select an output file window choose the folder in which you want to 
save the file, and in the File name entry field type the name for the 

print file. Also choose an extension for the file: if your output is plain 
text (which will often be the case), then choose .out or .txt, whilst if 
your output is HTML (as is possible with output generated by means of 
an XSLT stylesheet), then choose .html. The selected extension 



Printing Adlib User Guide 

 284  

doesn’t change anything to the output itself though. The extension 

.out is no different from .txt, but files with the .txt extension can be 

opened automatically in text editors (even if it really contains HTML or 
something else). And files with the .html extension will usually be 
opened automatically in a browser, which gives a nice result if there is 
actually HTML code in the file.  
Then click Open to actually create the file. If you choose an existing 
file, you will be asked if you want to overwrite the existing file. If you 

select Yes, Adlib will overwrite the information that is already in the 
file. If you select No, the new output will be added to the end of the 
existing file, separated by a page-break.  

The print file may be opened in, for instance, Windows Notepad or 
Microsoft Word to edit its contents. Then you can edit the contents as 

well as the layout of the document. Of plain text output, Adlib will 
make a plain ASCII file in which the page transitions are included as 

form feed signs (hexadecimal: FF). In Windows text editors though, 
this changes into a small square, and page-breaks will not be forced 
that way. Use the Print function in the relevant text editor to print the 
file at a later stage. If you do not edit the print file but still send it to 
the printer from within a text editor, then the output will be the same 
as when you would have printed directly to the printer from Adlib. 

You can’t print images to a file via a print adapl, because this produc-

es a simple text file. For such a purpose you should use Word tem-
plates. 

 Send by e-mail 

To send the printout as e-mail text to one or more e-mail addresses, 

so that the recipients can print it to a printer themselves, mark the 
Send by e-mail option and click OK. The E-mail addresses window 
opens. Fill in the desired e-mail address(es) and click OK to send the 
printout. 

 

Figure 14.13: Sending a printout by e-mail. 
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In the Subject entry field you can enter text that will be visible in the 

subject of the e-mail. That is the header with which an e-mail is de-

noted in an e-mail program. 

Above it you’ll find the To… button*. Instead of entering e-mail ad-
dresses manually, you can click To…, to access the address book of 
your e-mail program. 

It is possible that the Choose profile dialog will open first. If so, select 
in the Profile name drop-down list the profile under which the desired 

e-mail addresses have been stored (e.g. a profile with your own 
name). Click OK to move on. 

If your e-mail program is MS Outlook, the Address book window 
opens. Double-click the desired names in the list to select them. When 

you have collected all desired names this way, click OK. 

The names you chose (representing e-mail addresses) are now listed 
in the E-mail addresses window. If necessary, you may insert addi-

tional e-mail addresses manually (separated by semicolons). Click OK 
to send the e-mails. 

 

Figure 14.14: All information filled in. 

Technical information 

* The To… button is only present and active if a MAPI e-mail program 
is used on your computer, such as MS Outlook, and you actually send 

your e-mail from within Adlib this way (not via SMTP). If the button 
remains absent or greyed out, you’ll have to enter the e-mail ad-
dresses manually or copy them from elsewhere. (See the SDI and e-
mail from Adlib.doc document for more information about MAPI and 
SMTP.) 
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 Number of copies 

Here, you can indicate how many copies of the text must be printed.  

 Preview 

By clicking the Preview button, you can view the printout on screen 

before actually printing and it will look exactly the same as it will look 
on paper. No more than six pages will be shown though. A print pre-
view opens in the main Adlib window. With the little cross above the 
scroll bar in the print preview display the preview can be closed (you 
won’t print anything), while the Print button in the lower right corner 
still allows you to print. 

   

 

 

Click the Multiple pages button to display multiple pages next to 
and underneath each other. In the print preview, the mouse 
pointer changes into a magnifying glass. Click the text to zoom 
in and click again to zoom out.  

 

Click the One page button to quickly return to the preview of 

one page. Zooming in is possible here as well. 

 

Finally, click the Print button to send the print job to the print-
er. 

The application builder may have set an upper limit for the number of 
records that can be printed. 

14.3. Printing a label or barcode directly 

The Print label button in the Start menu is a single-click method to 

print a label for one or more records, an address or barcode label for 

example. However, you do need templates specific to your label 
printer. Although Word templates or adapls are suited for creating 
labels too, with the Print label function you no longer need to step 
through the Print wizard and the printer is controlled much more 
directly. 
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Once one or more proper label templates have been made and set up 

(see chapter 15.12), you simply proceed as follows: 

1. Open a record in detailed display or mark one or more records in 
the brief display. 

2. Click the bottom half of the Print label button (on the Print label 
text actually), in the Adlib Start menu all the way on the right, if 
you haven’t printed to a label before or when you want to select a 
different label template than the currently active one. 

 

 
 
Or, if you have printed labels before, click the top half of the Print 
label button to print data from the record to the previously used 
label template immediately. 
 

 
 
The Print label button can also be found in the File menu. Print 
directly to the previously used template by clicking the button 
name. Or move the mouse pointer to the button without clicking 
it, to open the submenu from which you can pick another 

template. 
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That’s all. If you print to a label for the first time, the default Windows 
Print dialog will appear once. In it you can still select the proper print-
er and look at a preview before actually printing. The next time you 
won’t see this window anymore though. 

In the example above you can see three preset label templates, for a 
database which contains address data, to be able to print an address 
label for a letter. These three templates happen to differ only in the 

font size being used, so that addresses with long names can be print-
ed fully on the label as well. 
The template selected in dark blue is the last used and currently 
active label. Use the mouse pointer to click any of the available tem-
plates and print to it directly. 
Greyed-out templates are not meant for records in the current data-

base: when Adlib starts, the templates will be read from the applica-
tion folder and Adlib will check if at least one field in the template 
appears in the selected records as well. If so, use of that template is 

allowed here. 
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15. Creating print templates 

In the brief display and the detailed display you can print all marked 
records or the currently displayed record, via Microsoft Word. So if you 
have Word on your computer, you can use this program to print 

records the way you want: create a special Word template in which 
you enter the fields you want to print, and determine the page layout 
(fonts, colours and margins) as you would normally do in Windows 
text editors. Exporting to Word is an attractive option for printing Adlib 
records without having to use standard or programmable output 
formats. Printing to Word templates is done via the Print wizard 
(Ctrl+P), via File > Find Word template or via File > Output formats. 

For printing via the Print label button (see chapter 14.3) you cannot 

use Word templates: you must create printer-specific templates in-
stead (see chapter 15.12). 

15.1. Creating a Word template 

Start Microsoft Word. It depends on your version of Microsoft Word, 
how to proceed. The following description pertains to Word 2000 and 
Word 2007. See your Microsoft Word manual if you have a different 
version, or if you seek more information about the functionality of that 

software. 

In Word 2000, select File  New. In the window that opens, select the 
icon Empty document (if you wish to make a new template) or choose 
an existing template to modify. In the bottom right of the window, 
check the Template option. Click OK.  

In Word 2007, choose the Office button  New. Under Templates, 
select either Installed templates or My templates and look for an 
existing template to modify or choose Blank document if you want to 
create a new template. Mark the Template option in the bottom right 
of the window and click Create or OK. 

The template opens and you can add and layout text just like in a 
normal document. Every time you use this template (from Word or 

Adlib), this text will automatically appear in the document. (Every 
Word-document is based on a template.) 

If you wish to output data and/or images from Adlib records to this 
template, you must place a reference in the template for every field 
you wish to include. In the following paragraphs you’ll find elaborate 

example templates for letters, tables and labels, but the basic proce-
dure is as follows:  
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1. At the desired location in the template, type the field name (use 

only the Default, usually English, field names) or tag of the field 

between double angle brackets, and type these exactly as they 
have been defined in the data dictionary of the current database*. 
Field names and tags are case-sensitive, so use <<desired_field 

_name>> or <<desired_tag>>. (Tags starting with % are also al-

lowed.) Use any desired font or font size because record data will 
be added in the same font.  
It is possible to print only a specific occurrence or to print all oc-
currences of a field: see the chapters 15.3 and 15.4 for more in-
formation. 

For a multilingual field (from an Adlib SQL Server or Oracle data-
base), it is not possible to specify the language in which the data 

should be printed on the template**: from a multilingual field, on-
ly the value in the current data language is printed. (Select the 
data language via the Data language button in the Edit menu.) 

You can find field names and tags in the Field properties window 
of a field. Open a new record or modify an existing record and 
place the cursor into the entry field of which you want to know the 

field name. Right-click and select the Properties option from the 
shortcut menu. You can find the field tag behind Tag, and the tab 
Data Dictionary will show the field name in different languages in 
the drop-down list underneath Common. 

2. Repeat this first step for every field you wish to include in the 

template. You can also include the same field more than once; 
just use the same field name or tag. 

3. Save the file as a template (.dot) and choose an appropriate 
name. (See the following paragraph for information about naming 
the template according to its language.)  

* In principle, you can only include fields from the current database 
(plus merged-in fields) in a template. However, in combination with a 
custom ADAPL output format you can use tags from records read from 
so-called FACS databases via the adapl, via the <<desired_FACS_ 

database+desired_tag>> notation. See the Designer Help for more 

information about that. 

** With a custom ADAPL output format you could process field values 
from specific languages and print those via a Word template if desired. 
Ask your application manager for the possibilities. 

http://documentation.axiell.com/alm/en/index.html?ds_adaprogrammingwordtemplates.html
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15.2. Name conventions for templates 

Like text and help files, Microsoft Word templates which are available 

as output formats in your Adlib application, are interface language 
dependent. This pertains to templates which have been added to the 
application via Adlib Designer, and which can be seen in the File > 
Output formats menu or in the Print wizard after you’ve chosen the 
Create a report with a predefined output format option (see figure 
15.1). (Information about setting up templates for your application 
can be found in the Designer Help.) 

For the user, interface language dependence means that a selected 
template will usually contain texts in the current interface language of 
Adlib. For example, if you display the menu’s in Dutch, then you’ll 

automatically be working with Dutch templates (if available). 
For the maker of templates, interface language dependence means 
that you have to create a separate template for each language in 

which users may want to work.  

 

Figure 15.1: This list may contain both print adapls and interface language 
dependent Word templates. 

The interface language dependence of templates does not apply to 
templates which the user has to search for manually on the computer 
system via File > Find Word template or after choosing the Create a 
report with Microsoft Word templates option in the Print wizard. 

http://documentation.axiell.com/alm/en/index.html?ds_appspropertiesoutputjobs.html#templatepath
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So, of the same template there may exist different translations, each 

in its own file, for every interface language that you wish to make 

available to users of your application. For example, if your application 
is being used by Dutch and English-speaking users, then you should 
have at least a Dutch-language template and an English-language 
template for each print task. 

Adlib recognizes the language of a file by the number at the end of the 
file name: 0 = English, 1 = Dutch, 2 = French, 3 = German, 4 = 

Arabic, 5 = Italian, 6 = Greek, 7 = Portuguese, 8 = Russian, 9 = 
Swedish, 10 = Hebrew, 11 = Danish, 12 = Norwegian, 13 = Finnish 
and 14 = Chinese.  
So a new template for printing an accessions list, with English texts on 
it, should be named e.g. accessionslist0.dot. The same template, 

translated to Dutch, then becomes accessionslist1.dot. (Note that you 
must keep the name of the file the same, aside from the language 

number, meaning: untranslated.) 

15.3. Creating standard letters 

Adlib field references can be placed between other text, or anywhere 
else on a page. This lets you create, for instance, a standard letter 
template for the Persons and institutions data source, as in the follow-
ing example: 

To:  <<name>> 

<<address>> 

<<address.postal_code>> <<address.place>> 

 

Axiell ALM Netherlands BV 

Safariweg 18-22 

3605 MA Maarssen 

Re: new service pack 

 

Dear Sir/Madam <<contact.name>>, 

We enclose information about the release of our new service 

pack, in which some major improvements have been made. 

We trust this has provided you with sufficient information, 

The Adlib Helpdesk 

 
Word will repeat this text for every record you export to this template, 
and will fill the field references with data from the current record. 



Adlib User Guide Creating print templates 

 293  

Normally, texts are pasted directly underneath each other; if you want 

every record (every standard letter) to start on a new page in the 

document, you should enter a special parameter into the document. 
(Parameters are not printed, but serve as instructions to Word.) In 
this case, you should place the parameter <<[PageBreak]>> either at 

the top or at the bottom of the template. This parameter will make 
sure that every subsequent record will be placed on a new page. 

This is a good way for making standard letter templates, which you 
can use to generate personalised letters automatically, for instance by 
using contact data from Adlib.  

If the Adlib field references have not been placed in a table (like in the 
example above), then by default only the first occurrence of a field is 

exported.  
Insert a table in the standard letter and enter the field reference to 
the repeated field in the table, to print all occurrences of the field (see 
the following paragraphs for more information about this). 
If you do not wish to print the first occurrence, but only the second or 

another specific occurrence, you can indicate this in the field refer-
ence, as long as it is not in a table: use the <<field name[x]>> 

syntax and enter the specific occurrence number for x, e.g. <<field 

name[2]>>. 

If the occurrence you enter does not exist, the field will not be printed. 

If you enter a 0 or something other than a number for the occurrence, 

Adlib will automatically print occurrence 1. 

15.4. Placing data from several records in a list 

To generate a list containing data from several records underneath 

each other in a table (instead of a standard letter), place the Adlib 
field references inside a table in the template, next to each other in 
separate cells. You should also enter two parameters in the rows just 
above and just beneath the references, to indicate that you wish to 
see a list of exported records in a table. In a top row you can also 
specify table headers, as follows: 

 
First column header Second column header etc 

<<[StartRecordList]>>   

<<field name1 or tag1>> <<field name2 or tag2>> etc 

<<[EndRecordList]>>   
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In a single template, a list of this type cannot be combined with a 

standard letter as described in the previous paragraph. 

For example: 

Title Author Shelf mark 

<<[StartRecordList]>>   

<<ti>> <<au>> <<ey>> 

<<[EndRecordList]>>   

 
The table prints all occurrences of the fields (underneath each other in 
separate rows); you cannot print one specific occurrence in a table. So 

each occurrence will be printed in a subsequent row of the table. In 
the table above this may lead to undesirable results: a record which 
has two titles and three authors would be printed in three table rows, 

with the second title in the same row as the second author. To prevent 
this, and if you include repeatable fields in the record list table, you’ll 
have to place each repeated field in its own single-cellular table inside 
the enclosing table, like can be seen below. 

Title Author Shelf mark 

<<[StartRecordList]>>   

<<ti>> 

 

<<au>> 

 

<<ey>> 

 

<<[EndRecordList]>>   

 
This way, a record will be printed in one row of the big table, while 

field repetitions will be located in subsequent rows of their own little 
nested table, like in the following fictive print preview of a record 
containing two titles, three authors and one shelf mark. 

Title Author Shelf mark 

The house in Mokum 

House in flames 

 

Dalum, P. van 

Akers, H. 

Scot, V. 

 

HU.3928.12 

 

 
Also, you can enter only one Adlib field reference per cell. The cell 
may further contain extra text next to the field reference, although 

that fixed text won’t be repeated. Another limitation of record lists is 
that you can only use one row of field references, and you cannot 
place a line of fixed text underneath them, only a row with the param-
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eter <<[EndRecordList]>>. The parameter <<[StartRecordList]>> 

should be placed immediately on top of the row of field references. 
Only the first row of the four is optional, in which you can enter fixed 

texts to serve as column headers. 
The rows in which records will be printed, can be numbered sequen-
tially if you want. You can achieve this by inserting an automatic 
number in an empty cell of the table row in which the Adlib tags are 
located. Use the Word Numbering function for numbered lists for this. 
The automatic number will be incremented automatically with each 
record inserted in a following table row. 

When a record list is long, the table will automatically continue on the 
next page. If you want the table header row to be repeated at the 
start of every new page, you should set this in Word:  

1. Select the top row of cells in the table by clicking the margin just 
before it.  

2. Right-click the selection, and from the shortcut menu, select the 

option Table properties.  

3. In the Table properties window, select the tab Row.  

4. Check the option Repeat as header row at the top of each page.  

5. Click OK.  

The table borders can be made invisible (or thicker) by adjusting 
Borders and shading, through the Table properties (see your Word 

manual for a list of options). 

15.5. Creating standard texts with tables 

A simple standard letter or text usually doesn’t need tables. A reason 

why it is sometimes desirable to use a table anyway, is when you 
want to have all the occurrences of a field (for the current record only) 
printed in the letter.  

A field that can have multiple occurrences which must all be printed, 
must be placed in a table consisting of a single cell.  

Should you want to print multiple fields in a table (repeated and non-

repeated fields), then first create a large table (vertically or horizon-
tally oriented) and put the non-repeated fields or labels in the desired 
cells. Leave table rows with the <<[EndRecordList]>> and <<[Start-

RecordList]>> parameters out. In the cells in which the repeated 

fields should come, first insert a new table of one cell: you’ll get a 
nested table. In the inner nested cell you then place the reference to 
the repeated field. This construction is necessary because every field 
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repetition will be inserted in a new table row: the new rows will be 

added to the single cellular table, not to the enclosing table. Moreover, 

without the table nesting, repeated fields could overwrite underlying 
fields. 
Note again that in a table you can’t print one specific occurrence of a 
repeated field and that a cell can only hold a single Adlib field refer-
ence (also see the previous paragraphs). 

Examples of two such tables can be seen below. Let’s assume that 

Author is a repeated field here. 
 

Title Shelf mark Author 

<<ti>> <<ey>> <<au>> 

 

 

Title  <<ti>> 

Author <<au>> 
 

Shelf mark  <<ey>> 

 
You can make the borders of the tables, or just the borders of the 
nested table, invisible and edit the cell alignment and margins and 
such, to obtain a decent layout. 

It is not possible to print a standard letter for every record from the 
currently opened database and follow each record by a record list from 
another database. For this you’ll have to create two separate tem-
plates, one for the letter and one for the record list, and print records 
separately from the relevant databases to the separate templates. 

15.6. Using Text boxes 
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With a text box you can have data and text printed on a page in a 

location of your choice, and automatically also specify the maximum 

height and width of that text. You can place one or more text boxes 
on a template, and insert fixed text and/or Adlib tags/field names in 
them. 

On a template opened in Microsoft Word you simply place a text box 

via Insert  Text Box (Word 2000) or Insert  Text Box  Draw Text 
Box (Word 2007). Then draw a rectangle in the desired spot by click-
ing, keeping the mouse button pressed down and dragging. Then 
place the cursor in the text box and type the fixed text and/or field 

references.  

15.7. Printing images  

Images in records can also be printed to Word. In the template, in-
clude a field reference with the tag of the relevant field*, just as you 
would for other fields, to include the image. A reference to an image 
field could be: <<FN>>.  

A reference to an image field can be included in a Word template in 
several ways, with different results, although the aspect ratio of each 
image will always remain intact. What exactly happens with an image 

when it is printed to a Word template (whether it is scaled up or down 
or will be clipped), is completely determined by Microsoft Word. Adlib 
has no influence on that process. Of the methods described below (as 

established in MS Word 2013), choose the one that best fits your 
requirements. 

The original size of the image often plays a role in the outcome as 

well: the physical dimensions of an image (in inches or centimeters) is 
determined by the combination of the resolution of the image and the 
DPI/PPI value stored in the image file. See chapter 12.2.4 for more 
information about image resolution, DPI and PPI. 

 Method 1: directly in a paragraph 

If the field reference appears randomly in a paragraph on a page, the 
image will be printed in its original size. 

Of each record, only one linked image will be printed and by default 
that is the first occurrence of the image field. If you specifically wish 
to print a different occurrence, you can do so by indicating the occur-
rence number between square brackets behind the field tag, for ex-
ample: <<FN[2]>>. This would print the second linked image of each 

record, not the first. 
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 Method 2: in a table cell 

Insert the field reference inside a table cell in the preferred spot on 
the page and specify at least a fixed width of the cell or column to 
indicate the maximum width of the image; the image will be scaled 
down if it is too large or scaled up if it is too small. The height of the 
row, on the other hand, must be kept flexible or must be made fairly 

large (twice the height for example): this is because a maximum, 
fixed height would never scale the image, but cut it off at the bottom 
if the image (resized to the width of the cell) doesn’t fit. By the way, 
for the task at hand it is perfectly well allowed to use a table consist-
ing of only one cell.  
A disadvantage of this method can be that all images linked to the 
record will now be printed: you can’t just print the first linked image. 

 Method 3: in a text box 

You can insert a text box in the template and enter the Adlib field 
reference inside it. By default, only the first linked image of each 
record will be printed (although it is possible as well to print a specific 

occurrence). For the result it is also relevant whether you enter any 
fixed text within the text box, even if it’s just a space: 

• With a space (or other text), a small image won’t automatically be 
scaled up to the dimensions of the text box, but a large image will 
be scaled down until it fits within the text box in its entirety. 
If the edge of the text box is made visible, it might be annoying 

that the space creates an unwanted margin within the text box: 

the solution is to set the font size of the space as small as possi-
ble, to minimize this “margin”. 

• Without space (or other text), an image will be scaled up or down 
until the image fits the width of the text box. If the resulting 
height of the scaled image is still taller than the text box, the text 
box will be expanded downwards to be able to show the entire im-
age. 

 Method 4: in a frame 

You can insert a frame in the template and enter the Adlib field refer-
ence inside it. By default, only the first linked image of each record 

will be printed (although it is possible as well to print a specific occur-

rence). For the result it is also relevant whether you enter any fixed 
text within the text box, even if it’s just a space: 

• With a space (or other text), a small image won’t automatically be 
scaled up to the dimensions of the frame, but a large image will 
be scaled down until it fits within the frame in its entirety. 
If the edge of the frame is made visible, it might be annoying that 
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the space creates an unwanted margin within the frame: the solu-

tion is to set the font size of the space as small as possible, to 

minimize this “margin”. 

• Without space (or other text), an image will be scaled up or down 
until the image fits the width of the frame. If the resulting height 
of the scaled image is still taller than the frame, the image will be 
clipped at the bottom. So the dimensions of the frame remain 
fixed (contrary to those of a text box). If you don’t want the im-

age to be clipped, then make the frame higher than it is wide, 
high enough to contain your tallest image after it has been scaled 
to the width of the frame. 
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When you create a template to which both images and text must be 

printed, there’s a lot to consider: would you like a fixed number of 

records per page and if so, how many; would you like to maximize the 
dimensions of inserted images and if so, how; do you want to limit the 
amount of text to be printed per field or not? It might be easier to 
start by editing an existing template and adapt it to your preferences. 
Therefore, Adlib has made some example templates available, accom-
panied by an FAQ describing the possibilities and limitations of these 

templates in detail. 
Further, see the Microsoft documentation for Word for more infor-
mation about inserting and editing tables, text boxes and frames. 

Technical information 

* In Adlib Designer, with the definition of fields in the database 
specification (also called data dictionary), a data type has been set. 
This type determines what users can and cannot enter in such a field. 

The type of the field containing the hyperlink or path to the image 

must be IMAGE, and it must also be defined as such in the data 
dictionary; this is usually the case. (If the field type is not IMAGE, the 
URL or path itself will be printed, instead of the image.) 

Database fields of the APPLICATION type (e.g. Identifier in library 
applications) can refer to images, amongst others, but these images 
cannot be printed to Word. 

 Printing thumbnails 

By extending the field definition in Designer and adjusting the field 
reference to an image in a Word template, you’ll be able to print a 
thumbnail image. The syntax of such a field reference is <<field_ 

name_or_tag[x].thumbnail>>, for instance <<FN.thumbnail>>. (If 

the field name itself contains a dot, you must always use the field tag 
here.) A prerequisite is that you have filled in the Thumbnail retrieval 
path property for the relevant image field in Adlib Designer (see the 
Designer Help for more information). An image exported to the Word 

template will then be printed in the dimensions which you provided in 
Thumbnail retrieval path. 

The .thumbnail option in a field reference is of course optional. 

Technical information 

Other so-called path format options which you may encounter (in-
stead of .thumbnail), are: .default and .image, but these are practi-

cally redundant since leaving out these path format options gives the 

http://www.adlibsoft.com/support/faqs/creating-word-templates-with-fixed-size-images
http://documentation.axiell.com/alm/en/index.html?ds_dbfieldspropertiesimageproperties.html#thumbretrievalpath
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same result: so, <<FN.default>> and <<FN.image>> are equal to 

<<FN>>. The redundant options are the effect of an already existing, 

implicit formatting, which has become visible after the introduction of 
.thumbnail. Strictly speaking, there is a small difference though: 

.default uses the Storage path field property for formatting (if filled 

in), while .image and leaving out a path format option in principle use 

the Retrieval path field property for formatting, unless that property 
is empty, in which case Storage path will be used (if filled in).  

15.8. Creating a Word template for labels 

In Adlib there are two ways of printing records to labels: as an output 

format or via the Print label button in the Start menu. For an output 
format you must create an adapl (see the Designer Help) or Word 
template (as described below) while for the Print label button you 
must make printer-specific templates (see chapter 0). The two types 

of templates cannot be exchanged. 

You can create a Word template for a label output format as follows: 

1. Open Microsoft Word. 

2. Select Tools  Envelopes and labels (Word 2000) or Mailings   
Labels (Word 2007 and higher). 

3. Open the Labels tab, if it wasn’t opened already. 

 

 

http://documentation.axiell.com/alm/en/index.html?ds_appspropertiesoutputjobs.html
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4. Do not uncheck the option Full page of the same label, even if you 

only mean to export one or just a few records. Do not enter any-

thing into the Address box. 

5. Click the Options button to set the size of your labels, and the 
number of labels that fit on one page. 

6. After you have determined the layout, click New document. A new 
Word document is made, containing one page of labels in the 
specified layout. 

7. Enter the text for the label into just one of the cells in this docu-
ment. Records that are exported to this template will be printed 
on the labels from left to right and top to bottom. Normally you 
would probably want to start at the top left, so you would fill that 

cell, but if some labels have already been used and you do not 
wish to waste the rest of the label sheet, you should fill the first 
unused cell in the template to start printing the exported data 

from that point. 
On labels you can use fixed texts as well as field references (see 
the example below), but no parameters or tables. You can, how-
ever, print a specific occurrence by using <<field name[x]>>, in 

which x represents a specific occurrence number. 
 

 

8. Save this document as a Word template (*.dot). 

Adlib will replace the <<tags>> during output with the contents of 

Adlib record fields (the first occurrence, by default). If you were to 
print for instance four records, then Word would fill four labels (in this 
example three in the first row and one in the second row) on this 
sheet. If you export twenty five records to this template of twenty one 
labels per page, a second page will be printed, and this page will start 
printing at the top left. 
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Note that from within Adlib you can’t just print to a label template like 

you can with the other types of templates. A label template must be 

set up as an output format by the application manager first (also see 
paragraph 0). In the Help of Adlib Designer you’ll find detailed infor-
mation about how to set up an output format. 

15.9. Printing multilingual data via Word templates  

From Adlib 7.3 you can print multilingual data (SQL databases only), 
per language, via Word templates. This is to say that you can use the 
field reference in a Word template to specify which language value 

must be printed. You can provide a specific data language via an IETF 
language code like nl-NL for Dutch or en-GB for British English for 

instance, or no data language at all to print data in the currently set 
data language in Adlib. 
In a field reference in a Word template it simply comes down to being 
able to specify not only an occurrence number but a language code as 
well, <<OB[2,en-GB]>> for example to print the English value of the 

second occurrence of tag OB. Both arguments are optional: you may 
specify just an occurrence or only a language code, like <<title[nl-

NL]>>. 

 Examples 

Below you’ll find some examples to clarify things. Suppose you’re 

using a multilingual database in which you can enter both Dutch, 
English and French data in the Object name and Title fields. As usual, 
you can select a data language via the Data language button in the 
Edit menu. 

 

Then assume you have a record containing two object names and a 

title in all three languages, for example: 

Example data 

(nl-NL) 
Object name (occurrence 1): tekening 
Object name (occurrence 2): topografische tekening 
Title: Tekening in pen en penseel, voorstellende de Grolsteeg te 
Harderwijk, door Joh. van Bijsterveld, 1965 
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(en-GB) 

Object name (occurrence 1): drawing 
Object name (occurrence 2): topographic drawing 
Title: Drawing in pen and pencil, representing the Grolsteeg in Hard-

erwijk, by Joh. Van Bijsterveld, 1965 

(fr-FR) 
Object name (occurrence 1): dessin 
Object name (occurrence 2): dessin topographique 
Title: Dessin a la plume et au pinceau, représentant la rue Grolsteeg 
à Harderwijk, par Joh. van Bijsterveld, 1965 

 

Below you can see an example template which experiments with the 

different possibilities of explicit or implicit printing of a language value. 
(The four table cells automatically print all occurrences.)  
 

Example template 

Tag OB: <<OB>> 
Tag OB[2]: <<OB[2]>> 
Tag OB[fr-FR]: <<OB[fr-FR]>> 
Tag OB[2,en-GB]: <<OB[2,en-GB]>> 

Field object_name[1,fr-FR]: <<object_name[1,fr-FR]>> 

<<object_name>> 

 

<<OB[en-GB]>> 

 

Tag TI: <<TI>> 
Field title[1]: <<title[1]>> 
Tag TI [fr-FR]: <<TI[fr-FR]>> 
Tag TI [1,en-GB]: <<TI[1,en-GB]>> 

Field title[1,nl-NL]: <<title[1,nl-NL]>> 

<<TI>> 

 

<<TI[en-GB]>> 
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The result if the currently set data language happens to be Dutch: 

Printing result 

Tag OB: tekening 

Tag OB[2]: topografische tekening 
Tag OB[fr-FR]: dessin 
Tag OB[2,en-GB]: topographic drawing 
Field object_name[1,fr-FR]: dessin 

tekening 

topografische tekening 

 

drawing 

topographic drawing 

 

Tag TI: Tekening in pen en penseel, voorstellende de Grolsteeg te 
Harder-wijk, door Joh. van Bijsterveld, 1965 
Field title[1]: Tekening in pen en penseel, voorstellende de Grol-

steeg te Harder-wijk, door Joh. van Bijsterveld, 1965 
Tag TI [fr-FR]: Dessin a la plume et au pinceau, représentant la rue 
Grolsteeg à Harderwijk, par Joh. van Bijsterveld, 1965 

Tag TI [1,en-GB]: Drawing in pen and pencil, representing the 
Grolsteeg in Harderwijk, by Joh. Van Bijsterveld, 1965 (en-GB) 
Field title[1,nl-NL]: Tekening in pen en penseel, voorstellende de 
Grolsteeg te Harder-wijk, door Joh. van Bijsterveld, 1965 

 

Tekening in pen en penseel, voorstellende de Grol-
steeg te Harder-wijk, door Joh. van Bijsterveld, 
1965 

 

Drawing in pen and pencil, representing the Grol-
steeg in Harderwijk, by Joh. Van Bijsterveld, 1965 

(en-GB) 
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15.10. Extra functionality through parameters 

You can send specific commands to Word by placing extra parameters 

in the Word templates. The following commands are available: 

• <<[PageBreak]>>  Every new record is printed on a new page. Do 

not use this command in labels or in a template containing a rec-
ord list. 

• <<[EmailTo:e-mail address]>>  If you want every document 

based on this template to be sent automatically through e-mail, 
use this parameter and enter the desired e-mail address or use 

a tag with the e-mail address. 

If you enter an e-mail address as a string, Adlib will send all ex-
ported records together as an attachment in one document. This 
option is mainly suited for sending out reports to an employee. 

When you type an e-mail address in Word, Word usually under-
lines it to make a hyperlink of it, but then this parameter will not 
work! You can undo this by pressing Ctrl+Z directly after the un-

derlining of the address. Or right-click on the hyperlink and in the 
menu select Hyperlink > Remove Hyperlink. 
If you enter an e-mail address in a tag, then every record will be 
sent in a separate attached document to the e-mail address for 
that record. This option is mainly suitable for printing records from 

the Persons and Institutions data source, if you wish to send out 

standard e-mails. 

• <<[EmailCC:e-mail address]>>  If you want every document 

based on this template to be copied to someone else through e-
mail (apart from the main addressee), use this parameter. For e-

mail address, enter the extra e-mail address or use a tag con-

taining an e-mail address. Remember that the main addressee 
and the person mentioned under CC can see each other’s names. 

• <<[EmailBCC:e-mail address]>> If you want every document 

based on this template to be automatically copied to someone else 
through e-mail (apart from the main addressee), use this parame-
ter. For e-mail address, enter the extra e-mail address or use a 

tag containing an e-mail address. The name of the person men-
tioned under BCC is not visible to any of the other addressees. 

• <<[EmailFrom:my e-mail address]>>  When you use the param-

eter <<[EmailTo:e-mail address]>>, you can also use 

<<[EmailFrom:my e-mail address]>> to enter the sender’s e-

mail address (e.g. your secretariat) or a tag containing an e-mail 
address. 
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Note that you can only use this parameter when your e-mail is 

sent through SMTP; ask your application manager if this is the 

case. Said exception applies only to this particular parameter. 

• <<[EmailSubject:subject]>>  When you use the parameter 

<<[EmailTo:e-mail address]>>, you can use <<[EmailSub-

ject:subject]>> to enter a subject for the e-mail, or use a tag 

containing the subject. 

• <<[EmailBody:e-mail text]>>  When you use the parameter 

<<[EmailTo:e-mail address]>>, you can also use <<[Email-

Body:e-mail text]>> to enter a message text for the e-mail. For 

e-mail text enter the appropriate text, or use a tag containing 

the text. 

• <<[StartRecordList]>> and <<[EndRecordList]>>  Use these 

parameters to create a record list with a table. See paragraph 

15.4 for further information. (Cannot be used together with 
<<[PageBreak]>>.) 

For sending e-mails, normally your standard Windows e-mail program 
wil be used (e-mailing through MAPI), Microsoft Outlook for example. 
This has the following disadvantages though: 

• The MAPI e-mail program does not allow you to use a different 
sender than the one currently logged on. 

• Also, the e-mail program will issue a standard warning that anoth-

er program is trying to send e-mail (a safety measure). This 
means you will have to give permission for every e-mail to be 
sent. 

However, from within Adlib, e-mails can also be sent via SMTP. In that 
case you won’t be troubled by the above mentioned limitations, and 
you won’t get any warnings from an external e-mail program. Your 

system administrator may have set up this way of e-mailing already, 
or can still do that for you. (See the “SDI and e-mail from Adlib” 
manual for information about how to set up e-mailing via SMTP.) 

Note that when you use tags from a different database in a template, 
you can only access that template from an adapl, and not through File 

> Find Word template or Create a report with Microsoft Word tem-
plates from within the Print wizard. 
It is possible to include e-mail parameters in a template for use 

through File > Find Word template or Create a report with Microsoft 
Word templates, but you will not be able to use tags from a different 
database as parameter values. Instead, you should enter strings 
(fixed texts) for the parameter values. 
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15.11. Printing records to a Word template 

Once your template is ready, you can use it to export Adlib records to 

Word. There are two ways of doing this: 

• Manual selection of Word templates. In the brief display, mark 
the records you want to print, or open the record you want to 
print in detailed display, press Ctrl+P and select the Create a re-

port with Microsoft Word templates option or choose File > Find 
Word template in the ribbon. You can only use this to export to 
non-label templates. (In the Print wizard you must then click the 
Finish button.) The Template window now opens. Find the tem-

plate you created for this purpose, on your computer system or in-
tranet, select it, and click Open. Word will now open the resulting 

document: the data from the selected records has been entered 
into the template.  
Before you print the document, you can first edit it as desired in 
Word. You might insert remarks for certain data, write an intro-
duction, or change the layout. 

• Choose from preset output formats. All Word templates (label 
and non-label templates) can be specified as output formats for a 
specific data source, through Adlib Designer. (You can only export 
records to a Word label template by setting this template as an 
output format.) The template will then be present in the File > 
Output formats list or via Create a report with a predefined output 

format in the Print wizard of your application. (In this list, print 

adapls may be available as well.)  

15.12. Creating a printer-specific label template 

In Adlib there are two ways of printing records to labels: as an output 
format or via the Print label button in the Start menu. For an output 
format you must create an adapl or Word template (see chapter 15.8) 
while for the Print label button you must make printer-specific tem-
plates. The two types of templates cannot be exchanged. So this type 

of label template must be created specific to a particular label printer 
and to specific fields.  

Please see appendix 4 in the Installing Adlib Museum, Library and 
Archive manual for comprehensive documentation about creating your 
own printer-specific label templates.  

http://www.adlibsoft.com/support/manuals/installation-guides/installation-of-adlib-museum-library-and-archive
http://www.adlibsoft.com/support/manuals/installation-guides/installation-of-adlib-museum-library-and-archive
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15.12.1. Making the label printer available 

The label printer must be accessible from your computer. Start Adlib, 
open the File menu and click Label printer setup. 

In the Print setup window, open the Name drop-down list and see if 
the printer is present in the list. If so, select it and click OK. The other 

options can be probably be left as they are. You’ll only have to select 
your printer once. 

 

If the desired printer is not in the list, you’ll have to Add a printer via 
Start > Devices and Printers first, to make the printer available on 

your computer. See the Windows Help for more information. 
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15.12.2. Printing a label from within Adlib for the first 

time 

When you’re about to print your first label, click the bottom half of the 
Print label button to select a label template. 
In the current data source, a label template is visible and active if at 
least one of the field names has been defined in the database for the 

current data source, as an English field name: so it might happen that 
a label template is active as well for data sources it wasn’t designed 
for: in that case, the print result won’t be very useful.  

 

You’ll then see the default Windows Print dialog appear once. In there 
you must select the desired printer and you can open a print preview. 
Adlib will remember you settings and the next time you print to this 

template, the window won’t open again. 
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A print preview opens in the Adlib main window. With the little cross 

above the scroll bar in the print preview display the preview can be 

closed, while the Print button in the lower right corner allows you to 
print. 

   

See chapter 14.3 for more information about printing to labels. 
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16. Importing and exporting 

You can import and export data in different file formats without using 
Adlib Designer. The Export option in the File menu (to the left of the 
Start menu) can be used as soon as one record is being displayed in 

the detailed presentation (marked or not) or when multiple records 
have been marked in the Brief display: so either only the currently 
shown record will be exported, or all marked records from the Brief 
display.  

 

The Import option in the same menu is only available after you have 
chosen a database or dataset in the Search wizard. 

 

The settings you make in Adlib applications (based on adlwin.exe) for 

import and export jobs, can be saved as a parameter file (in XML-
format), so that you can use the same profile for the same type of job 
later instead of having to make all the settings again. This can be 
compared to the import and export jobs defined in Adlib Designer, 
even though the parameter files are different. In an Adlib application 

you can only make a limited number of settings for import and export, 

fewer than in Designer, and you can only save those settings to a 
parameter file. 

As soon as you start the Import or Export wizard, the first window 
that appears offers the possibility of opening profiles you saved earli-
er. Click the Browse button to find and open the desired profile. Pa-
rameter files have the (double) extension .imp.xml or .exp.xml. The 
settings are automatically copied to the next page of the wizard, and 

you can modify them before you start the actual import or export.  

The last page of the wizard offers the possibility to save your settings, 
so that you can quickly retrieve them another time. You have to 

explicitly save them yourself. This is not done automatically. 

It’s also possible to execute import and export jobs you’ve made in 
Designer (with the extensions .imp and .exp) as parameter files from 
within the import and respectively export wizard. The options that are 

available in the wizards are copied from the jobs you defined earlier; 
you won’t be able to see the other settings. If you would then choose 
to save the settings (maybe after you changed an option in the wiz-
ard) as a (XML) parameter file, then note that by doing this you won’t 
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change the original import or export job! In fact you create a new file 

in which only a reference to the job made in Designer is stored, and 

separately the settings that are visible in the Import or Export wizard. 

 

Figure 16.1: Choose an export format. 

The export results can be opened and viewed in a text editor like 
Windows Notepad. 
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16.1. The Export wizard 

The Export wizard has three pages for the three steps of the export 

process (see Figure 16.1). 

 Step 1 

Here you select the method of exporting: an Adlib tagged file, a CSV 
(comma separated values) file, an Adlib XML file (grouped), an Adlib 
XML file (unstructured) or a custom export definition of which the 

name will be located at the bottom of the list; the latter option is only 
displayed if you have defined an export job in Adlib Designer (through 
the application setup for a data source). 

But here you may also open earlier saved export settings via a pa-
rameter file. 

- Adlib tagged file: The result of this method is a list of tags followed 

by a space and the field value. In case of repeated fields the tag is 
repeated for each occurrence. Of multilingual fields, only the field 
value from the current data language will be exported: owners of an 
Adlib SQL Server or Oracle multilingual database are advised to export 
to the XML format to include language information. The records are 
separated from each other by asterisks, and by default the first tag is 
the record number; for a selection of books for example: 

%0 29 

ti Great Zulu commanders 
ex 70 
ex 71 
au Knight, Ian 
** 
%0 718 

ti The very sleepy pig 
ex 1823 
ex 1824 
ex 1825 
ex 1826 
au Malam, John 

** 

Listing 16.1: Two records with a repeated field, exported as Adlib tagged file. 
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- CSV file (comma-separated values): Only the first occurrence of 

a field is exported and different fields are separated by a comma. This 

method of exporting is not suitable for repeated fields. Of multilingual 
fields, only the field value from the current data language will be 
exported: owners of an Adlib SQL Server or Oracle multilingual data-
base are advised to export to the XML format to include language 
information. The entire list is preceded by an enumeration of the field 
names. Values and names are in between double quotes; for a books 

file for instance: 

"author","copy_number","title" 
"Knight, Ian","70","Great Zulu commanders" 
"Malam, John","1823","The very sleepy pig" 

Listing 16.2: Two records with a repeated field, exported as CSV file. 

 

- Adlib XML file (unstructured): The selected fields of a record are 
exported to a file in unstructured Adlib XML (Extensible Mark-up 
Language) format. In unstructured Adlib XML, all fields and field 
occurrences are listed in one long list underneath the <record> node. 

Of multilingual fields, all language values will be exported too. The 
field name as recorded in the data dictionary, for instance title, is used 

in the following way:  

<title>Monteverdi and his contemporaries</title>.  

(Monteverdi and his contemporaries is an example of a title.) With 
XML you can export data in a standardized form, which is useful for 
exchanging data.  
An XML file does nothing of itself. With style sheets (layout templates) 

you can edit an XML file e.g. for presentation purposes or use it in 
another database application. Example: 

<?xml version='1.0' encoding='UTF-8' ?> 
<adlibXML xmlns:xsi="http://www.w3.org/2001/XMLSchema- 
  instance" xsi:noNamespaceSchemaLocation= "http:// 
  www.adlibsoft.com/adlibXML.xsd"> 
  <recordList> 
      <record> 
        <priref>29</priref> 
        <title>Great Zulu commanders</title> 
        <copy.number>70</copy.number> 
        <copy.number>71</copy.number> 
        <author.name>Knight, Ian</author.name> 
      </record> 
      <record> 
        <priref>718</priref> 
        <title>The very sleepy pig</title> 
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        <copy.number>1823</copy.number> 
        <copy.number>1824</copy.number> 
        <copy.number>1825</copy.number> 
        <copy.number>1826</copy.number> 
        <author.name>Malam, John</author.name> 
      </record> 
  </recordList> 
  <diagnostic> 

    <xmltype>UNSTRUCTURED</xmltype> 
    <hits>2</hits> 
    <search></search> 
  </diagnostic> 
</adlibXML> 

Listing 16.3: Two records with a repeated field, from a books database, ex-
ported as unstructured XML file. 

 

- Adlib XML file (grouped): The selected fields of a record are 

exported to a file in grouped Adlib XML (Extensible Mark-up Language) 
format. Of multilingual fields, all language values will be exported too. 
The big advantage of grouped XML over unstructured XML is that 
grouped XML can be processed with an XSLT stylesheet more easily. 
Moreover, grouped XML exported from within your adlwin.exe Adlib 
application contains more information about values in linked fields, 

like the name of the linked database and the record number of the 
linked record. Do note that grouped XML cannot be imported into 
Adlib. 

In unstructured Adlib XML, all fields and field occurrences are just 
listed in one long list beneath the <record> node, like the occurrences 

of the object_name, edit.name and edit.date fields in the partial 

example below: 

<object_name>interior textile</object_name>  
<object_name>window dressing</object_name>  
<object_name>drapes</object_name>  
… 
<edit.name>erik</edit.name>  
<edit.name>erik</edit.name>  
… 
<edit.date>2012-02-02</edit.date>  
<edit.date>2012-01-26</edit.date>  
 

In grouped Adlib XML on the other hand, fields are grouped within a 

field group node (if a field group exists) and that field group node is 
repeated for each field occurrence, like in the partial example below: 

<Object_name> 
   <object_name.notes />  
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   <object_name.authority linkref="0" linkfield="term" linkreffield="lx" 
linkdb="C:\Adlib 4.2\data+thesau" />  

  <object_name linkref="411" linkfield="term" linkreffield="l3" 
linkdb="C:\Adlib 4.2\data+thesau"> 

          <term>interior textile</term>  
</object_name> 

   <object_name.type linkref="0" linkfield="term" linkreffield="lw" 
linkdb="C:\Adlib 4.2\data+thesau" />  

</Object_name> 
 
<Object_name> 
   <object_name.notes />  
   <object_name.authority linkref="0" linkfield="term" linkreffield="lx" 

linkdb="C:\Adlib 4.2\data+thesau" />  
   <object_name linkref="442" linkfield="term" linkreffield="l3" 

linkdb="C:\Adlib 4.2 NL\data+thesau"> 
          <term>window dressing</term>  
  </object_name> 
   <object_name.type linkref="0" linkfield="term" linkreffield="lw" 

linkdb="C:\Adlib 4.2\data+thesau" />  
</Object_name> 

 
<Object_name> 
   <object_name.notes />  
   <object_name.authority linkref="0" linkfield="term" linkreffield="lx" 

linkdb="C:\Adlib 4.2\data+thesau" />  
   <object_name linkref="443" linkfield="term" linkreffield="l3" 

linkdb="C:\Adlib 4.2\data+thesau"> 
          <term>drapes</term>  
  </object_name> 
   <object_name.type linkref="0" linkfield="term" linkreffield="lw" 

linkdb="C:\Adlib 4.2\data+thesau" />  
</Object_name> 
 
<Edit> 
   <edit.date>2012-02-02</edit.date>  

   <edit.name>erik</edit.name>  
   <edit.source>collect>intern</edit.source>  
   <edit.time>17:04:30</edit.time>  
</Edit> 
<Edit> 
   <edit.date>2012-01-26</edit.date>  
   <edit.name>erik</edit.name>  
   <edit.source>collect>intern</edit.source>  
   <edit.time>16:45:57</edit.time>  
</Edit> 

 
Further note that the grouped XML as shown here (and produced by 
adlwin.exe) is not equal to the grouped XML that the Adlib API 
(wwwopac.ashx) yields. Linked fields in particular, have a different 
format. 

http://api.adlibsoft.com/site/documentation/the-adlibweb-xml-file
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 Step 2 

Here (see Figure 16.2) you select the fields you want to export. In the 
left part you can click on one or more fields and use the arrow point-
ing to the right to transfer the field to the right part. With the double 
arrow pointing to the right you can transfer all the fields from the 
Available fields list to the Selected fields list in one go. (These might 

not be all the fields in the record!) If you make a mistake, you can use 
the arrows pointing to the left to remove fields from the list on the 
right. 

 

Figure 16.2: An example taken from an object catalogue, exporting only a few 
fields, all fields from the data dictionary or all fields from the record. 
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Export all fields from a record 

It is also possible to export all record fields, even those that are invis-

ible in the Export wizard field list. (Fields that have not been defined in 
the data dictionary do not appear in the field list.) Mark the Export 
complete record option to be sure that all fields will be exported. 

The exception to this rule is exporting to csv. When you export rec-
ords to a .csv exchange file from within Adlib via the Export wizard, 
and in the second window of that wizard you mark the Export com-

plete record option, then still only the fields that are defined in the 
data dictionary (the .inf file) will be exported. Database fields that 
have only been specified on a screen will not be exported. This is not a 
bug, but a limitation of the export functionality. The csv format con-

tains a whole record on one line, with a fixed number of fields, even if 
they’re empty. But an Adlib database contains no empty fields. So to 
export a complete record, the export function looks at which fields 

have been defined in the data dictionary, and fills them with the aid of 
the database, but it doesn’t check the records for other possible fields. 
Fields that haven’t been defined in the data dictionary, which are not 
temporary fields, occur incidentally. If you do want to export such a 
screen field to csv, then define the relevant field in the data dictionary 
first. 

 Step 3 

On the third and last page of the Export wizard you can choose a file 

to which you want to export. Click the upper Browse button to select 
an existing file (to overwrite it) or to enter a new file. In the latter 
case, enter a name for the file and click Open. 

You can save the settings you made in this wizard for a later time, by 
storing them in a parameter file. For this, use the second entry field: 
Save parameters to file. 

Finally, click Finish in the Export wizard to start exporting. 
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Figure 16.3: Click Browse to find an appropriate folder for the new file. 

16.2. The Import wizard 

In Adlib you can import data from the Adlib tagged file and Adlib XML 

file (unstructured) formats, into the opened database or dataset. 

 

Create a backup 

Always create a backup of your database(s) before you start import-
ing. Importing can substantially change the contents of your data-
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base(s) and if the result is different from what you expected, it is 

important to have the possibility to restore the old situation. 

 

1. In the Step 1 of the Search wizard, choose the database or the 
dataset in which you want to import data. 

2. Choose Import in the File menu (to the left of the Start menu) to 

open the Import wizard. 
 

 

Figure 16.4: Select the format of the file you are about to import. 

3. Select the format in which the exchange file data is stored: Adlib 
tagged file or Adlib XML file (unstructured). (See chapter 16.1 for 
a description of these formats.) Or open an earlier created param-
eter file with import settings. Click Next. 
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4. In the Source file entry field in Step 2 of 3, specify the path to the 

exchange file from which you want to import data. Click Browse to 

search for the file on your system; the path to the file will auto-
matically be entered in the entry field. 
 

 

5. While importing, Adlib can check whether a record already occurs 
in the database and update it. To do this, mark the Update tag op-
tion and click the Select button to choose the desired (indexed) 

field from a list, a field in which the values are unique for each 
record (the priref or object_number for example). Click a + in 

front of a field name to see more field names starting with that 
word. Only names in bold type can be selected.  
After you’ve chosen a field, Adlib will replace that field name by 
the field tag. So if you chose object_number, Adlib will enter IN. 

You may enter such a tag manually too; you cannot enter field 
names this way. With the object_number as the update field, Adlib 

will check of each object number in the exchange file whether it 
already exists in the database. If so, the existing record will be 
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overwritten ("updated" as it were: already filled-in tags in the ex-

isting record(s) remain as they are, provided they don’t occur in 

the exchange file record). If your update tag is a multilingual field 
and you are working on an Adlib SQL or Oracle database, then all 
translated values in this field will be checked. 
 

 
 
If you leave the Update tag option unmarked, Adlib will not check 

whether records already exist. The records from the import file will 
simply be added to the database. If you leave the Ignore record 
numbers option unmarked too, the imported records will be given 

the same prirefs (record numbers) as they had in the exchange 
file. Any existing records with the same priref will then be com-
pletely overwritten!  

6. Mark the Ignore record numbers option if you want all records to 
be imported to receive new record numbers, for example to import 
previously exported datasets into another dataset without over-
writing existing records. 
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7. If the Process external links option is marked, Adlib wil check for 

an imported value in a linked field if for that value a record 

already exists in the linked database. If so, the link will be created 
immediately, if not, then on import that linked record will be 
created automatically after which the link between both records 
will be made still. By default this option is switched on. Only 
switch it off if you know what the consequences are of not 
processing links: in the Designer Help, see the description of the 

Process external links option for the full story. 

8. If the Process internal links option is marked, Adlib wil check for 
an imported value in an internally linked field (as those appear in 
the thesaurus, for instance) if for that value a record already 
exists in the current database. If so, the link will be created 

immediately, if not, then on import that linked record will be 
created automatically after which the (hierarchical) link between 

both records will be made. By default this option is switched on. 
Only switch it off if you know what the consequences are of not 
processing internal links: in the Designer Help, see the description 
of the Process internal links option for the full story. 

9. For this import job, Adlib will create an import parameter file in 
memory, which you can save for a next time by providing a file 
name in the Save parameters to file entry field. As soon as you 

have entered the file name, the file will be created and the current 
settings stored. The settings (explicit and implicit) for this import 
definition are as follows: 

• Source file = <the exchange file selected by the user, here in 
the assistant>. 

• Destination dataset = <the target database selected by the 

user>. This is the current dataset in Adlib, into which you will 
start importing. 

• File format = <Adlib tagged or unstructured XML, selected by 
user>. 

• Update tag = <the tag selected by the user, which will often 
be %0, but another tag is possible as well>. This option is 
used for overwriting existing records which have identical up-

date-tag values as the records to be imported. 

• Add new records = Yes, by default. This way, records can in 
principle be added, instead of only replacing existing ones. 
This option cannot be set differently here in the Import wizard. 

• Delete old tags = No, by default. If existing records are to be 
replaced, then this setting leaves tags which are not imported 

http://documentation.axiell.com/alm/en/index.html?ds_eiimjobpropertiesoptions.html#processlinks
http://documentation.axiell.com/alm/en/index.html?ds_eiimjobpropertiesoptions.html#processintlinks
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as they are. This option cannot be set differently here in the 

Import wizard. 

• Process external links  = <Yes or No>, selected by the user. 
This setting validates link references, or creates new linked 
records from term values in imported linked fields if those rec-
ords do not yet exist in the relevant linked database. 

• Process internal links  = <Yes or No>, selected by the user. 
This setting validates internal link references, or creates new 

linked records from term values in imported linked fields if 
those records do not exist yet. 

• Clear database first = No, by default. This setting makes sure 
the target database will not be emptied prior to importing. 

This option cannot be set differently here in the Import wizard. 

• Tag list = **->**, by default. All tags will be imported if the 
names of the source tags in the exchange file correspond ex-

actly with the destination tags in your Adlib database. This op-
tion cannot be set differently here in the Import wizard. 

• Counter = 10, by default. The progress report of the import 
will be refreshed after every 10 imported records.This option 
cannot be set differently here in the Import wizard. 

• Ignore record numbers = <Yes or No>. Yes gives all imported 
records a new record number; existing records in the target 

database will not be overwritten. 

• Input buffer size = 32000, by default. The input buffer is 
memory space allocated by Adlib to read in data from the ex-
change file. This option cannot be set differently here in the 
Import wizard. 

• Default wordwrap value = 31999, by default. This is the max-

imum number of characters that can be imported into one tar-
get field occurrence. If there are more characters than this in 
a source field, then the surplus is put in a next occurrence of 
the field. This option cannot be set differently here in the Im-
port wizard. 

• Priref offset = 0, by default. This offset specifies from which 
record number in the current database the records to be im-

ported should be inserted. If to be imported record numbers 
won’t be ignored, they get the value of the record number 
from the import file plus the offset value. Existing records in 
the target database may be overwritten. This option cannot be 
set differently here in the Import wizard. 
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10. Click Next to start importing in Step 3 of the Import wizard and to 

add all records from the source file to the current database. 

You can observe the progress of importing, and any errors will be 
reported. The text that appears in the Error report box can be se-
lected with the mouse and copied, to paste it in a text document 
elsewhere so you can save it. 

For more information on these options and the default settings, see 
the Adlib Designer Help. 

If you are unilingual data in an Adlib SQL or Oracle database in which 

multilingual fields occur, then values imported in such fields will be 
assigned the currently set data language in Adlib. This language can 
be set via the Data language button in the Edit menu, before import. 

 

Warning against multilingual import 

Multilingual data from an XML exchange file can only be imported 
correctly into a multilingual Adlib SQL or Oracle database if in the 
relevant exchange file no linked multilingual fields appear for which 

you want to process the links. The import functionality is not pre-
pared for this option yet and will consequently create new linked 
records for all language values of a linked field that you are import-
ing, instead of validating to existing records in the linked database or 
creating one new linked multilingual record for all language values of 
a single field. 

16.3. Exporting images 

The File menu has an option called Images. This allows you to export 

images from marked records (to a different file format if desired) and 
edit any present IPTC metadata* of the images. In this case, export-
ing means that a (possibly modified) copy of each original image 
linked to the record, will be placed in a different folder.  

 

http://documentation.axiell.com/alm/en/index.html?ds_eiimjobpropertiesgeneral.html
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* What is image metadata 

Many image files contain not just the image itself, but also so-called 
metadata: information about the image, like camera settings and 

other technical details (added to a photo automatically by a digital 
camera, according to the EXIF standard) and/or descriptions of the 
photographed subject and the name of the photographer and such 
(as can be added manually by some photo editing software and by 
Adlib, according to the IPTC standard). IPTC metadata has no overlap 
with EXIF metadata and so-called IPTC headers may occur in Adobe 

Photoshop, JPEG, TIFF and PNG image files. (For more information, 
see http://www.iptc.org/) It depends on the way in which an image 
has been created and edited if, and which, metadata is present.  

And then there's also Windows metadata which is available by default 
for all types of files and which contains the file properties, like the 
creation date and file size and such. The Windows metadata is very 
limited, but is all you have when images do not support any EXIF or 

IPTC metadata. 
With some software, like Adlib, metadata can also be extracted from 
an image. Adlib can read EXIF and IPTC photo metadata. Also, 
Windows metadata, EXIF metadata and some IPTC headers of an 
image file can easily be viewed by right-clicking an image file in 
Windows Explorer, after which you select Properties in the pop-up 
menu and open the Details tab in the Properties window. 

 

Proceed as follows: 

1. In a search result, mark the records from which you’d like to 
export the images and choose File > Images. The Image export 
window opens. 

http://www.iptc.org/
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2. Click the empty button behind the Selected target folder entry 
field to select a folder somewhere on your system or network, to 
which the images to be exported will have to be copied. 

3. Underneath Selected output format, select the file format to which 
all copied images must be converted, or keep the original file 
format. You can convert images to BMP, JPEG, GIF, TIFF or PNG. 
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It is inherent to some conversions that quality loss will occur. GIF 

images for instance, have a colour depth of maximally 8 bit. So a 

conversion from a, let’s say, 24-bit JPEG image to GIF means that 
certain colour information will always be lost: the picture will be 
constructed using fewer colours. Even an explicit conversion from 
JPEG to JPEG is not without loss, because the compressed image 
will be rebuild anew. 
The copied image will only be identical to the original and will 

therefore definitely retain all present EXIF and IPTC metadata, if 
you select the Same as the original file format option here.  
JPEG and TIFF support EXIF and IPTC metadata, PNG just IPTC. 
BMP and GIF do not support EXIF or IPTC metadata, so a conver-
sion to such a file format always means that any metadata present 

in the original will have been lost in the exported copy. 
After a conversion to JPEG or TIFF (even when the original is also 

JPEG or TIFF), very small changes may be visible in EXIF meta-
data, for instance because non-standard EXIF metadata had to be 
converted to a standard value. 
The Windows metadata of the copy, like the creation or modifica-
tion date and the path to the images folder, may also be different 
from the original. (Note that Windows metadata is always present 
in files under Windows.)  

4. In case you select JPEG as the target format, you must set an 
Image quality next: set it to 100 percent to optimise the resulting 
images as well as possible, while lower percentages produce lower 

quality (but smaller files as well). Using the Image orientation 
option, you could even rotate or mirror the images, if desired. 
 

  

5. By default, the exported images will keep their original dimen-
sions, but if you’d like to set the same maximum height and width 

for all images, then mark the Export the images to new dimen-
sions checkbox and provide the (maximum) dimensions in pixels. 
Normally, you’ll probably want images to retain their original 
aspect ratio and therefore you’ll keep the relevant checkbox 
marked: the image will then be resized until at least one of the 
dimensions becomes equal to either the maximum height or 
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width. However, if you don’t mind a distortion of the copied 

images up to the point where they fit the specified frame exactly, 

then deselect the Keep the original image aspect ratio checkbox. 
 

 

6. For the JPEG and TIFF target formats (PNG is not supported here), 

the Export image metadata drop-down list will be become active, 

which lets you decide what to do with image metadata during the 
export. You could choose to either:  
- retain any present EXIF and IPTC metadata (in which case any 
template set in the Image metadata mapping template drop-down 
list below will not be used);  

- remove all EXIF and IPTC metadata from the exported images; 
- add new IPTC metadata to the images (retaining any other pre-
sent metadata).  
For the other target formats and when the target format is equal 
to the original, this option has been set to Keep original metadata 
by default, which means that any present metadata will be saved 
in the copy only if the new file format allows for it. 

 

 

7. For the Export new metadata option (for TIFF and JPEG), you’ll be 
required to select one of the available templates* in the Image 
metadata mapping template drop-down list. The template speci-
fies which IPTC metadata must be added to the converted images. 

Then click the Start button to actually execute the conversion. (If 
you click Start while not having selected a template, then the pro-

cedure will be executed as if you had set Keep original metadata, 
instead of Export new metadata.) 
* If the Image metadata mapping template drop-down list is still 
empty, you’ll have to create a suitable template first. See the next 
paragraph for instructions. 
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8. After the procedure has finished, you may click the underlined 

Toggle log option at the bottom of the window to switch the 

display of the Image export window to that of the logging details 
which have been generated during the procedure. That way you 
can check if every part of the procedure has been succesful. If 
you’d like to save the logging details, click the Copy to clipboard 
option to copy the data to the Windows Clipboard: from there you 
can paste it into any text document and save or print it. Click 

Toggle log again to return to the original display of the Image 
export window. 
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 Creating mapping templates 

To be able to add IPTC metadata to JPEG and TIFF images, or to 
overwrite existing IPTC metadata, you’ll have to create one or more 
mapping templates. You can do that as follows: 

1. Click the Manage button. A pop-up menu will open, showing the 
available options. (If the button is not active, the Selected output 

format must first be set to JPEG or TIFF and the Export image 
metadata option must be set to Export new metadata.) 

2. First click Change template folder to select a folder you find suita-
ble for storing your templates. If desired, you can create a new 
subfolder for those templates in your main Adlib folder.  
(The Open template folder option opens the relevant folder in 

Windows Explorer, so that you may view its contents.) 

 

 

3. Subsequently click New template in the pop-up menu to open the 
Metadata mapping window. 
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4. First enter an applicable template name and description. The 

template will be saved with this name, but Adlib does still add the 

name of the current database as a prefix first (although not visible 
here): this allows Adlib to populate the Image metadata mapping 
template drop-down list with templates applicable to the current 
database only. 
Then right-click somewhere in the large empty box and select New 
mapping from the pop-up menu to insert a single mapping line. 

You may insert as many mapping lines as you need.  
(A redundantly inserted line can be removed by right-clicking that 
line and choosing Delete selected in the pop-up menu.) 
 

 

5. Click the first mapping line, starting with Free text, to activate it. 
Then select the data type you wish to add as metadata: you may 

either add a text you enter here or add data from the record. 

Click the button with the suspension points (…) behind Free text to 
choose something other than Free text. The only other option is 
Field name. Double-click Field name to select this type. 
 

 

6. a. In the Source entry field, again click the button with the sus-

pension points, this time to select a field from your database, from 
which you’d like to copy data. (Double-click to copy the field.) 

Finally, in Destination, choose (double-click) one of the available 
IPTC headers to write the field data to. If you happen to pick an 
IPTC header which already contains data in the original image, 
that metadata in the copy will be overwritten by the new data. 
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b. For the Free text data type, you must type a text of your own in 
the Source entry field. Underneath Destination you must choose 
the IPTC header in which that text must be stored later on. 

7. All templates you create, will become available in the Image meta-

data mapping template drop-down list, but you will only see the 
templates which are applicable to the current database. Always 
select the proper template to be used for the conversion, before 
you click the Start button.  
 

 
An earlier created template can be edited or removed by first 

selecting it, after which you click the Manage button and then 
select Edit template or Delete template from the pop-up menu. 
 

 

 

The Image export window may open slowly 

If you have marked many records and you open the Image export 
window, the actual opening of that window may take a little time. 

That’s because the procedure has been designed in such a way that 
all marked records are loaded into memory during the opening of the 
window, ready to export. This might be annoying when opening the 
window, but has the advantage that the data no longer needs to be 
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loaded after the procedure has started: this allows you to continue 

working in Adlib when the export is in progress. 
Do note that this procedure will only process the records that you had 
marked before you opened the Image export window. Any records 

that you would mark after the window has already been opened, 
won’t be included in the export. 
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17. SDI 

SDI stands for Selective Dissemination of Information. This means 
that you can keep your customers (for instance library visitors or 
literature researchers) abreast with information that is relevant to 

them.  
In practice, it means that you can save interest profiles. Based on 
these profiles, the Adlib system is automatically searched for infor-
mation, which is then presented in a user-friendly format. You could 
use this to send your customers regular e-mails about new additions 
that are relevant to them. 
We have integrated this functionality into adlwin.exe (and the Internet 

Server/sdi.exe) so that it can also be used for other things. For in-
stance, it is possible to automatically generate reminders in the loans 
module, without having to press any buttons, and to send them out as 
e-mails. You can also automatically send out the list of most recent 
additions, or just an overview of additions pertaining to a particular 
subject, as can be indicated per customer. SDI is also very suitable for 

automatically reminding customers of reservations that are ready to 
be picked up, or about the expiry of a loans contract. 

17.1. Creating a search profile 

An interest profile in Adlib contains three parts: 

 
• the search query. This is regularly executed automatically; 

• the destination (e.g. an e-mail); 

• layout instructions. 

 
If you put together a profile yourself, use Adlib for this. As pointer files 
often already contain queries, SDI has been integrated with pointer 
files.  
 
1. Use the Advanced search window to enter an explicit search 

statement, as you would usually do.  
 

2. Turn the search query into a pointer file with the Write set button. 
Assign a title to indicate what the search query is about and pos-
sibly a number too. 
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3. Open the Pointer files window with the button in the Advanced 

search window or with the button in the Start menu (when a data 

source has been selected already) 
 

 
 

4. Right-click the pointer file of which you want to create, edit or 
view an SDI profile, and choose the Scheduled searches option in 
the pop-up menu which appears. On the SDI General, SDI Desti-

nations and SDI Schedule tabs in the Scheduled searches window 
you can set or view the SDI profile for the current pointer file. 
 

 
 

5. Specify the profile (see below) and click OK. The Adlib Internet 

Server or sdi.exe (depending on your license) on your server will 
now regularly and automatically process this profile. (You do not 
need to start an Adlib application first.) 

 
An SDI profile has the following properties: 

1. Language. Select the language in which the search statement for 
the pointer file has been put together. For example: if you used 
English field names in the search statement, then you should set 
the language here to English as well, otherwise Adlib cannot find 

the fields later on. 

2. Format. Enter the path to an adapl (without the .bin extension) or 

stylesheet (.xslt) to provide the layout for the output. The path 
must be relative to the folder which holds sdi.exe. For example: if 
sdi.exe is located in the Adlib \executables subfolder and a 
stylesheet is located in the Adlib \museum subfolder, then the 
path would be something comparable to 

..\museum\mystylesheet.xslt. If the adapl or stylesheet is located 
in the same folder as sdi.exe, then you only need to provide the 
file name, without path. 
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3. Pruning. The search result can be filtered before it is sent out. 

Choose New records to only show records that have not been re-

ported earlier, or report only new or modified records by selecting 
New or changed records. The option DM/DI changed does almost 
the same, but is application-dependent. You can also report the 
full search result by selecting No pruning. The Undefined option 
has no meaning; you have to choose one of the options below it. 
 

 
 

4. Limit. Specify the maximum number of records the search result 
may contain. 0 means that there is no limit. 

5. Subject. This field can be used to add a subject line to an e-mail. 

6. Comments. Note any comments about this SDI profile here. 
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7. Mode. The search result can be sent to two different output 

systems. Select Email or Printer. Both when you print or e-mail, all 

records will be placed underneath each other. The adapl can make 
use of the normal reserved tags to print headers, footers and rec-
ord separators. 

8. Printer destination. Fill in nothing to use the default printer. If 
you want to use another, then provide the full path to it here. 

9. E-mail format. Choose HTML if you’ve transformed the search 

result to an HTML page (by means of an XSLT stylesheet for ex-
ample). The e-mail will then show the browser display of that page 
instead of the HTML code itself. In all other cases, choose Plain 
text. 

10. E-mail addresses. Provide all e-mail addresses to which the 
result of the current search query has to be sent regularly. Type 
an e-mail address in the left entry field and move it to the list on 

the right by clicking the > button. Repeat this for all e-mail ad-
dresses. You can remove an address from the list by selecting it 
and clicking the < button. 

11. Frequency and Schedule. Times and dates when the user wants 
his or her search profile to be executed. First choose a frequency, 
then fill in more specific data on the right in the entry fields of 
Schedule that become active (which ones become active depends 

on the set frequency). This way you can set the Hour for Daily, 

and also the day for Weekly and Monthly, and for Yearly: Hour, 
Day and Month. 

Remember, however, that the frequency can be limited by the set-
tings of the SDI program on the server. If the network manager 
has set the program to update only once a day, you will not be 
able to receive a new update more often than that. 

12. Expiry date. Select a date after which you no longer want to 
execute the search profile. 

13. Suspended. As long as this option is marked, the profile will not 
be executed.  

14. Last run. The date on which a search profile was executed last. 
You cannot add or modify this date yourself. 

Before you can use SDI, your network manager must have configured 
this application. So ask your network manager for the possibilities. 
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18. Access rights for users 

Access rights for users may have been set up by your application 
manager. This would allow the restriction of access to a specific data-
base for certain groups of users, and maybe offer them only read-

access and prevent them from editing records. Your application man-
ager knows more about it. 
However, it is also possible that you, as a user/registrator, do not only 
have rights to enter, edit or remove records, but to specify access 
rights to each new record for other users as well. It is then your 
responsibility to exclude or include certain users per record. Adlib 
applications from version 4.2 on, are prepared for this possibility. 

Older applications may offer this functionality as a custom addition. 

18.1. Record owner and access rights per record 

On the Management details tab of several data sources like the Inter-
nal objects catalogue, Books or Visual documentation databases in 4.2 
model applications or higher, you’ll find the (repeated) field group 
Record access. The name or role (which is kind of a group name) of 
the person who enters and saves the record first, will be filled in 

automatically on saving, unless another name or role has been en-
tered manually. From then on, only the owner (or another user with 

the same role) can fill in the other two fields, to assign specific access 
rights to certain users for this record. All other users can never adjust 
the contents of these three fields. If they have access to the record, 
then at the most they can read these fields, even if they have full 
access. 

In the model application, all users who are not mentioned, have full 
access. However, your application manager may have applied different 
settings. Repeat (Ctrl+Enter) the field group for each user, role or 

group to whom you want to assign access rights. 
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The field group has the following three fields:  

• User / group: enter the user name* or role of the person or group 

to whom you want to assign access rights. (User names are de-
pendent on the authentication method that your application uses. 
See the Designer Help for more information.) 
You may repeat this field group to specify access rights for multi-
ple users. Users who are not listed may have Full access implicitly 
although this might have been set differently. 

 
* If in the application definition a user has been assigned a role, 
then always (!) enter the name of that role here, never the user 
name. The entered access rights then apply to all users with that 
role. Only enter user names if they haven't got a role. Your appli-

cation manager can tell you which users have which roles. 

• Rights: enter the desired access rights for this user, role or group. 

You can choose from: 
None  - The user can never access this record. 
Read only - The user can view, but not edit, delete or copy this 
record. 
Read and write - The user can view, edit and copy but not delete 
this record. 
Full - The user can view, edit, copy and delete this record. 

• Owner: the user name or role of the person who has ownership of 
this record. Only the user or (users with the) role named in this 

field can edit the fields in this field group. So it’s he or she or they 
alone that are allowed in this record to set/change which users 
have which access rights, or transfer the record to another record 
owner (the latter for instance when the current record owner 

changes employment). The owner always has full access rights to 
the record. 
If no owner is entered, then ownership defaults to the user name 
or role of the person who created the record. The name will auto-
matically be entered on storage of the record. This name is de-
termined through the login of the current user. Application set-
tings determine whether the user name or role will be entered. 

Each time that a user now tries to open and/or edit a record, Adlib will 

check if that user has the appropriate access rights. 

 

http://documentation.axiell.com/alm/en/index.html?ds_appspropertiesauthentication.html
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19. The Collection Cloud 

The Collection Cloud (http://www.thecollectioncloud.com/) is a special 
initiative by Axiell ALM Netherlands, with which internet users can 
search the collections and catalogues of a great many museums, 

libraries and archives all at once, via a single website or app. The goal 
is to create a central, international and easily searchable online ar-
chive in the “cloud”, of the many objects and documents managed by 
these institutions all around the world. We welcome your participation! 

 

When you have an Adlib Museum, Archive or Library application (Adlib 

Lite applies as well), you can take part (uploading your first 1000 
records will be free: above that, a subscription model will apply) and 
use your application to easily publish your collection or catalogue 
(completely or partially, as desired) on the website of The Collection 
Cloud. 
You don’t need to buy any new software or install something: Axiell 

ALM Netherlands manages The Collection Cloud on its own servers. An 

extra condition is that you have your own (freely requestable) MyAdlib 
account so that you can log on to The Collection Cloud. Per record in 
your database you then decide, in your own time of course, whether 
you want to make it accessible through The Collection Cloud: a single 
click on a button is enough to upload a (copy of the) all marked rec-
ords. (With the same ease though, you can remove earlier uploaded 
records from The Collection Cloud as well.) 

http://www.thecollectioncloud.com/
http://my.adlibsoft.com/
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 Uploading records 

1. As soon as you’ve marked one or more records in the brief display 
of a search result or in the detailed display of a record, the Upload 
record(s) button becomes active in the Publish menu when those 
records describe objects, archival items or documents. Click it to 
upload the marked records to The Collection Cloud. Uploading 

means that those records will remain stored in your own local da-
tabase and that just a copy of those records (and only a fixed se-
lection of fields*) will be sent to the database server of The Collec-
tion Cloud, via your internet connection. 
 

 

2. The first time you do this, you’ll still have to log in explicitly using 
your MyAdlib login details; every next time though, this happens 
in the background, automatically using these login details. 
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If you do not have a MyAdlib account yet, you may create it now 

via the MyAdlib site link in the window. Mark the I accept these 

terms and conditions checkbox and click OK. 
After your first login you’ll receive an automatically generated e-
mail with important information about further use of The Collec-
tion Cloud. 

3. Uploading proceeds automatically in three successive steps. Click 
OK in the last step to close the message. 

 

 
 

 
 

 

4. You can now find your uploaded records via the AdlibBrowser app 
for tablets and on the website of The Collection Cloud: 

http://www.thecollectioncloud.com/ 
 

* Field selection for uploading 

Of any record to be uploaded, the following fixed selection of fields 
will be copied (if filled):  

• Common fields: priref, title, object_number, creator, maker, 
creator.role, maker_role; 

http://www.thecollectioncloud.com/
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• Museum fields (valid from application version 2.0.1): institu-

tion.name, production.date.start.prec, production.date.start, pro-
duction.date.end.prec, production.date.end, production.place, 
production.period, production.reason, description, material, tech-

nique, object_name, dimension.value, dimension.type, dimen-
sion.unit, dimension.part, credit_line, alternative_number.type, 
alternative_number. 
Museum fields (valid in application versions 1.1.3 up to and in-
cluding 2.0.0): institution_name, date_early, date_late,  
date_early_precision, date_late_precision, date_period, produc-
tion_place, dimension_part, dimension_unit, dimension_value, 

dimension; 

• Library fields: author.name, author.role, corporate_author, pub-
lisher, year_of_publication, place_of_publication, notes, materi-
al_type, dimensions, edition, pagination, illustrations, isbn, digi-
tal_reference, keyword.contents, geographical_keyword, per-
son.keyword.name, copy.number, abstract; 

• Archive fields: description_level, production.date.notes, con-

tent.description, physical_description, object_history_note, di-
mension.free, inscription.language, closed_until, 
part_of_reference, parts_reference, related_object.reference. 

Any other fields in the record won’t be uploaded.  
The copied fields are as much as possible application version inde-
pendent but have all been defined in the Collect or Document data-

base. Records from other databases cannot be uploaded; The Collec-
tion Cloud server will check for this. For the fields to be copied, the 
field name is the identifying factor, not the field tag.  
Image fields are processed separately: of any images linked to the 
record, only the first image will be uploaded. Note that uploaded 
images won’t be scaled down to a smaller format and the uploading 
of large images may take some time. Also, the upload function won’t 

apply a watermark or any other copy protection to images either. 

 

Notes 

• You need to have an active internet connection to be able to 
upload records. 

• If the Upload record(s) button is greyed out while you have one or 
more records marked, it may be that your access rights (as set by 
your application manager) are not sufficient to upload records to 

The Collection Cloud. If you are sure you have enough rights, it 
may be that your internet connection is not available temporarily 
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or that the database server of The Collection Cloud is offline tem-

porarily: then try again later. 

• A list of records that you’ve uploaded earlier to The Collection 
Cloud from within the current data source, can be requested in 
your application. Click the List records button in the Publish menu 
of Adlib to show all relevant records in the list display. The button 
is available from several locations in Adlib, after selecting the de-
sired data source in Step 1 of the Search wizard. 

It is important to realize that Adlib uses the original record num-
bers of the records you uploaded earlier to be able to show those 
records in the list display now. This means that applicable records 
which have since been removed from your database, cannot be 
shown. 

• If some of the records you are uploading have been uploaded to 
The Collection Cloud before, then the records which are already 

present in The Collection Cloud will be update to the new uploaded 
version automatically. So you can’t create redundancy accidentally 
by uploading the same records more than once. 

• In principle, the language in which your records have been 
registered is not relevant, but if your data has been created in, for 
example, Dutch, it won’t be easily accessible to foreign speakers. 

• Of multilingual records, all language values will be uploaded (as 

far as they appear in the fields to be uploaded). After that, the 

language values will be displayed as separate occurrences per field 
in record detailed display in The Collection Cloud: on a single line, 
separated by semi-colons. So you can’t switch between data 
languages in The Collection Cloud: all language values will be 
presented together. 

 

 

 Removing records 

1. Removing records from The Collection Cloud is easy. In the brief 

display of a search result, mark one or more records that were 
once uploaded to The Collection Cloud and click the Remove rec-
ord(s) button in the Publish menu. 
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2. During the automatic removal you’ll be kept up to date of the 
process by means of a progress bar. 
 

 

3. Afterwards you’ll be notified of the number of records removed 
from The Collection Cloud. Click OK. 
 

 

Notes 

• You can only remove records which were uploaded before by you 

or your colleagues. The Collection Cloud uses the original record 
number and the name of your institution or company (retrieved 
via your MyAdlib login), as the identifying aspects of a record. 

• The Remove record(s) button will only become active if at least 
one of the marked records has ever been uploaded to The Collec-

tion Cloud and your access rights to this functionality (as set up by 
your application manager) are sufficient. 

• There’s no harm in including records in the marked selection, 
which have never been uploaded to The Collection Cloud: of 
course those records cannot be removed, but they won’t generate 
an error message. So if you want to remove all records (belonging 
to a certain database) ever uploaded to The Collection Cloud, then 
just mark all records in that database and click Remove record(s). 



Adlib User Guide The Collection Cloud 

 349  

• Removing records from The Collection Cloud will never delete 

those records from your own database. Do keep in mind to use 

the Remove record(s) button in the Collection Cloud section of the 
Publish menu (not the Delete button in the Record section of the 
Start menu). 

 Searching in The Collection Cloud 

Via http://www.thecollectioncloud.com/, the standard URL to The 
Collection Cloud, you search the full database via your web browser if 
you select simple or advanced search without having clicked one of 
the institution logos. However, if you first click the tile of a specific 
museum, library or archive, then you can only find records which have 
been uploaded by the relevant institution; instead of clicking a tile, 

you may as well enter the special TCC URL for a specific institution in 

the address box of the browser, if you know the URL. 

The Adlib Browser app for tablets 

Instead of using a web browser you may choose to visit The Collec-
tion Cloud via the Adlib Browser app, currently freely available for 
Apple tablets in the iTunes App Store and also for Microsoft Surface 
tablets (running on Windows 8.1 or higher) in the Windows Store: 
click here for the English version of the app and here for the Dutch 
version. Read more about the app in the separate documentation. 

 

In The Collection Cloud you can search for records in three ways: via 
the Simple search tab, via the Advanced search tab or via browsing 
through already displayed object images. 

Simple search – click the Simple search label, type one or more 
complete or partial words in the entry field above it and press Enter 

(or click the magnifying glass). 

 

• You will only find records which contain all entered words, in 
random order but all together, in one of the tags TI (title), OC 
(object category), BE (description) and VV (creator) of the record. 

• Entering multiple search keys is only sensible if you think they all 
appear in the title or description. A record won’t show up in the 

http://www.thecollectioncloud.com/
https://itunes.apple.com/nl/app/adlibbrowser/id725418584?l=en&mt=8
http://apps.microsoft.com/windows/en-us/app/9886d84c-e6fb-4dcb-9765-22a01acf668d
http://apps.microsoft.com/windows/nl-nl/app/9886d84c-e6fb-4dcb-9765-22a01acf668d
http://www.adlibsoft.com/support/manuals/user-guides/adlib-browser-app-and-service
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search result if not all search keys together appear in any one of 

the search fields in the record. So you can’t search on an object 

category and a word from the title simultaneously, for example. 

• If you search on a creator name, then only enter the surname or 
just the first couple of letters of the surname. 

• To search on an object category, you typically enter a single term 
or just the first few letters of it. 

• Of each search key you enter, it is assumed that you’d also like to 

find words starting with that key: in Adlib jargon this is called 
“automatic (right) truncated searching”. So if you were to search 
on com for instance, you could find records containing words like 

combination, compliment, computer or company in the search 

fields.  
For example, if you search on the two keys tree magi, you could 

find a record with the title The Magic Apple Tree. 

Advanced search – click the Advanced search label, type a complete 
or partial search key in one or more of the entry fields and click Go or 
press Enter. During typing, a drop-down list may open with terms or 

names starting with the letters entered by you: if the word you are 

entering already appears in the list, you don’t need to continue typing 
because you can click the desired term or name directly. 

 

• Adlib implicitly searches all entered terms combined with a Boole-
an AND: this means that a record can only be found if all searched 

terms appear in the appropriate fields in the record. 

• All entered search keys are searched automatically right truncat-
ed. 

• In the When fields from and to you can enter a date. You can 
enter dates in ISO date format or as a European date. Valid input 
would be, for example: 1553, 1999-04, 2012-07-26, 01-12-1705 

of 10/07/2000. If you enter both a from and a to date, then the 
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search is limited to all dates in between the two, but you can enter 

just a from or to date as well. 

• Click the Clear button if you want to empty all search fields at 
once. 

 

Search fields 

In the background, Adlib always searches multiple fields simulta-
neously, dependent on the entry field in which you’ve entered your 
search key(s), namely: 

Who: creator, author.name, corporate_author, content.person.name, 

person.keyword.name; 

What: title, description, abstract, object_name, keyword.contents, 
content.subject, object_category, creator, author.name, 
corporate_author, content.person.name, person.keyword.name; 

Where: production.place, field_coll.place, geographical_keyword, 
content.subject, place_of_publication; 

When: production.date.start, production.date.end, 
year_of_publication, production.period. 

 

Searching via browsing – as soon as you’ve selected the collection 

of a particular institution or when a search has produced multiple 
records, you can browse through the results by clicking the arrows 
pointing left and right next to the search result, both in the brief 
display and in the detailed display. 

 

You can also click a tile directly to open that record in detailed display. 



The Collection Cloud Adlib User Guide 

 352  

 

Searching via links – in detailed display you can see that some 
terms or names have been underlined: click one of them to start a 
new search with which you’ll search on that value in the relevant field.  

 

Click an image in detailed display to zoom in on that image and 
display it at 100% of its original size. 

 Adjusting your own entry to the collection 

Besides the general URL to The Collection Cloud, you can use a cus-
tom URL to allow visitors to search records from your own institution 
exclusively. The design of your own part of The Collection Cloud can 
be adjusted somewhat. You do this via the so-called dashboard which 

is available at the following URL: 
http://www.thecollectioncloud.com/dashboard. First you’ll be 

asked to log in with your MyAdlib login details:  
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If login was succesful, a screen with some options opens: 
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• If you want to allow for the possibility to search the records up-

loaded by your own institution exclusively, you’ll have to confirm 

or set an alias for your institution name first. Your future visitors 
will have to enter this alias behind the standard URL to The Collec-
tion Cloud, to gain access to your own entry to the collection in 
The Collection Cloud.  
In the Friendly URL field, enter the desired name or accept the 
name assigned by default: use only the letters a through z, digits 

and/or hyphens (no spaces, special characters or accents). In the 
example above, the final URL becomes: 
http://www.thecollectioncloud.com/our-museum. 
In your communications you can even point visitors to a specific 
object in detailed display, by adding the relevant record number to 

the URL, for example: 
http://www.thecollectioncloud.com/Deutsches-Sport--Olympia-

Museum/2505. 

• Use the Browse button behind the Logo field to search your sys-
tem for an image of a logo of your institution. That file will then be 
copied to the server of The Collection Cloud and will be used in the 
layout of your own part of The Collection Cloud. (Large images will 
automatically be resized to more suitable dimensions.) 

• Open the Theme drop-down list to set a colour scheme. The De-

fault setting is the blue theme in which The Collection Cloud ap-
pears by default.  

Your choices will be saved as soon as you click the Submit button at 
the bottom of the webpage. Go back to your own search page within 
The Collection Cloud and press Ctrl+F5 to make the changes visible. 

 Setting up access rights 

To enable the uploading of records to The Collection Cloud, no setup is 
required: by default you can upload records from within the Objects, 
Archives and the Library catalogue. 

If Adlib Designer is available to you, you have the possibility to set up 
access rights for this functionality, to limit its use. Therefor you must 
first add the Publish records to TheCollectionCloud method to the 

desired data sources in your application definition. Proceed as follows: 

1. Suppose you want to apply access rights to the ability to upload 
records to The Collection Cloud from within the Internal object 
catalogue data source in your Museum application. Then open the 
Museum application definition in the Application browser of Adlib 
Designer 7.1.0.30 or higher. 
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2. Expand the Internal object catalogue data source node, right-click 

the Methods header and select New > Method in the pop-up 

menu. 
 

 

3. In the properties of the new method now set the Method type to 
Publish records to TheCollectionCloud. Also provide one or more 
translations of a name for this method: that name can only be 
seen here in the Application browser, in the methods list, not in 
your Adlib application. 

 

 

Now specify the desired access rights on the Access rights tab. If you 
do not set access rights, then in principle all users still have the possi-
bility to upload and remove records (as far as access rights set on a 
higher level do not prevent that, of course). 
Further note that uploading cannot be separated from the possibility 

to delete records from The Collection Cloud: the Full and Write access 
rights allow for uploading and deleting, while Read and None access 
rights switch both functions off for the relevant users. 
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20. Uploading data to Europeana 

Adlib offers integrated access to the Europeana Connection Kit (ECK) 
enabling you to upload selected records to a so-called aggregator for 
Europeana, the European cultural and scientific heritage collaboration 

offering an internet portal to millions of digitized books, paintings, 
films, museum objects and archival records.  
The ECK was developed in the Europeana Inside project, a cooperative 
project funded by the EU, in which Axiell ALM participated as a tech-
nical partner. The goal of the ECK is to facilitate the contribution of 
data to the Europeana portal. 

Records will not be uploaded to Europeana directly: first you’ll upload 

records to the ECK, an intermediate third-party web service, allowing 
you to prepare your data online for the aggregator (like for example: 
http://euinside.k-int.com/dpp/home) and ultimately for Europeana, 
giving you full control over the final data which will be collected by 
Europeana at some later time. As a content provider you’ll solely have 
to deal with the aggregator as you’ll have no influence over the plan-

ning and procedures involved in Europeana’s harvesting of the data 
from your selected aggregator. 

Before you can start using this functionality in Adlib, we recommend 
you contact the Collections Trust: http://www.collectionstrust.org.uk/ 
to obtain more information about how to participate. 

Prior to Adlib 7.2, the preparation and submission of collection data to 
Europeana was quite labour-intensive and for Adlib users it usually 

meant having to install an OAI server/repository which had to be 
harvested by an aggregator, a process over which you have no con-
trol. 
As more and more institutions open up their collections by sharing 
their data on the internet (as already possible on Axiell ALM’s The 
Collection Cloud for example), the ECK and its direct accessibility from 
within the Adlib user interface is therefore again a leap forward as it 

allows you to easily “push” your object data to an aggregator for 
Europeana without requiring an OAI server (instead of having to rely 

on the “pull” of aggregator harvesting), also giving you much more 
control over exactly which data will be submitted. 

After the initial setup (see the Designer Help), you’ll find two active 
buttons in the Publish menu in Adlib, allowing (authorized) users to 

upload a selection of records to the relevant ECK web service and 
subsequently to push the validated and converted data (LIDO or EDM) 
to the aggregator. 

http://www.europeana.eu/portal/
http://euinside.k-int.com/dpp/home
http://www.collectionstrust.org.uk/
http://www.thecollectioncloud.com/
http://www.thecollectioncloud.com/
http://documentation.axiell.com/alm/en/index.html?ds_generaltopicseuropeanauploadconfig.html
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20.1. Uploading and pushing data, the quick way 

Since the upload and ECK functionality offer many advanced options, 
which you won’t always need, let’s first discuss the quick route 
through the forest: 

1. In your object catalogue, find some records you wish to upload 
and mark them in the brief display. 

2. Click the Upload record(s) button. Adlib will generate a temporary 
Adlib XML file of the records to upload and will then open the Eu-

ropeana upload wizard. Typically, you can just click Next here, un-
less you want to create some reference of your upload, which you 
can do by marking the Create pointer file from selection option 
and/or the Retain the output files (xml, lido, zip) option. 
 

 

3. The next page in the upload wizard shows you the procedural 
steps in the automatic upload process as they take place. You’ll 
notice the Adlib XML is transformed and validated to LIDO and 

finally transferred to the record set manager at the ECK web 
service. Click Next. 
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4. The final step of the wizard displays a log of the processed 
actions. If you want, you can copy the log to the clipboard or save 
it to a file, for future reference. Click Finish to close the wizard. 
 

 

5. We’re almost done now. Next, click the Manage record(s) button 
in the Publish menu to open the Europeana set manager. This 
looks quite complicated but if all the records you’ve uploaded are 
reported here as being Valid and Ready, then all you need to do 

now is click the Data push option in the right window pane to push 
your data to the aggregator (where it will wait for Europeana to 
harvest it). Before you do so, you may select one of the records in 
the list and click Preview to see how it will look on Europeana. If 
you’re not happy with the result, just don’t click Data push but 
instead Delete the problematic (selected) records from the list and 

Close the Europeana set manager. 
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6. Wait for the transfer of your data to the aggregator to finish and 
click Close in the final message. 
 

  

20.2. Uploading and pushing data, your own way 

If you’d like to have more control over the different procedural steps 
or if errors occur while uploading and/or pushing your data, you’ll 
have to know a little bit about the advanced options available.  

20.2.1. Upload options 

• Input file and Destination set – There are really two ways to 
create a record selection to upload.  
The first is to mark records in the brief display of Adlib. This will 
cause the Input file and Destination set options to be read-only. 

The Input file box will show the path to the temporary XML file 
which will be created by Adlib and Destination set displays the cur-

Object number 

Validation status 

Ready status 
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rent dataset name (being both source and destination) and next to 

it the real database name it represents. 

 

 
 
The second way is to not mark any records before you start the 
Europeana upload wizard and select an earlier made XML file 

(formatted as “grouped” XML) containing the data to be uploaded. 
Click the Browse button to select the desired XML file on your 
system. The XML file can be the result of an earlier export to 
grouped XML from within Adlib or the saved result of an earlier 
upload to the ECK (see the Retain the output files (xml, lido, zip) 
option). Why you would want to do it like this is up to you: maybe 
you’d just like to check the bare source data before uploading it. 

 

 
 

The Destination set drop-down list then allows you to select the 
“set” into which these records should be uploaded. You’ll find this 
list effectively contains the names of all the data sources in your 
Adlib application. For the time being, the rule of thumb here is to 
simply select the source dataset of the record XML. The option is 
here really for internal or future use, as its purpose is actually to 

set the folder name (namely the relevant Adlib database name as 

indicated behind the list , e.g. collect) in the record set manager 
of the ECK, into which the uploaded records will be stored, while 
Europeana has no subdivision in such datasets nor is there in the 
record set manager currently a filter to allow you to show 
uploaded records per dataset or something like that. Also, the 
currently available stylesheet that will transform your Adlib XML to 
LIDO, will only do that for (unilingual) object records. So the 
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recommendation is to select the name of the original data source 

of the uploaded records here. 

• Retain the output files (xml, lido, zip) – Particularly for a 
hand-picked record selection you may want to check the different 
stages the record XML is put through before it is uploaded to the 
ECK. Mark this checkbox to automatically save these stages in 
four different XML files in your Windows Documents\Adlib\ 
<database name_date>\ folder, namely: input.xml (containing the 

source grouped XML), parsed.xml (the XML after it has been 
parsed, maybe only showing different indentation), lido.xml (the 
XML after initial conversion to the LIDO format) and lido_pid.xml 
(in which the image references and LIDO record IDs have been 
resolved to proper URLs using your configuration settings). The 

lido_pid.xml file is also present in the output.zip file, renamed to 
adlib_lido.xml. 

• Delete existing records from the set – Set this option if you’d 
like to remove all present records from the ECK record set 
manager before the currently uploaded records are inserted. You 
may want to do this if previous uploads were not satisfactory. 
Even though record contents will be deleted, a reference to the old 
record will remain, flagged as deleted, and you can still list those 
deleted records in the record set manager.  

To make things even more complicated, records will only be 
deleted if you do not also mark the Don’t make the records ready 
(update only) option below: if you do mark that option too, the 

only records that will be removed now will be records that were 
never made Ready before (more about this in the section: The 
record set on the ECK web service). 

Also realize that data which has already been pushed to the 
aggregator cannot be deleted from the aggregator anymore: dele-
tion of uploaded data is currently only really possible before it has 
been pushed. It is possible though that a future version of the ECK 
will allow deletion from the aggregator, but that hasn’t been 
implemented so far.   

• Don’t make the records ready (update only) – Select this 

option only if you want to upload records and have them validated 

but not yet commited. This advanced option is for experienced 
users only since it may cause two versions of each record to exist 
temporarily in the ECK record set (if those records were uploaded 
before). This allows you to upload records just to see if they 
validate and maybe because you’d like to preview them, without 
overwriting any earlier uploaded data in the record set which 

already has the Ready status. 
If you mark this option, you’ll have to do a manual Commit in the 
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Europeana set manager later on to make the newly uploaded 

records Ready for data pushing, if desired. If you don’t, you can 

still push the “old” version of those records though, before dele-
ting the newly uploaded ones. 
For more details about the workings of the ECK record set, see the 
section: The record set on the ECK web service. 

• Create pointer file from selection – If you’d like Adlib to auto-
matically create a pointer file for the records that you marked in 

the brief display, then select this option. You can use the pointer 
file for later reference, to check which records have already been 
uploaded, for instance. The pointer file name will be formatted like 
this: Records uploaded to set: <database name>. The Create 
pointer file from selection option will be inactive if you haven’t 

marked any records because you are planning to use an input file 
instead. 

20.2.2. Europeana set manager options 

 

 

The upper list box in the Europeana set manager will display uploaded 

records (even deleted ones), their latest update date and time (from 
the server) here and their validation Status and Ready status.  
It may take several seconds before your uploaded records become 
visible or before any updates have been processed, so please be 
patient. The actions which are still awaiting to be processed on the 
server are listed in the Queue box. As long as the Next update in 15 

seconds option at the bottom of the window is marked, the set man-
ager will check with the server and update the list and the information 

Actions 
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on the other tabs every 15 seconds automatically, but it may take 

even longer than that for an update to be processed. Instead of wait-

ing for the next 15 seconds you may also choose to click the update 
now option next to it to see if the results are in yet. The Queue will 
become empty after all queued actions have been processed. 

 Status values 

Possible Status values are: 

• Valid – Validation of the uploaded LIDO XML has passed. 

• Invalid – Validation of the uploaded LIDO XML has not passed. 
Information about the error leading to the failure can be found on 
the Errors tab. If the error states: Failed to communicate with web 

service, the error lies with the third-party web service but is prob-
ably temporary. Then click the Validate option on the right, re-

peatedly if necessary, to try again until succesful. 

• Not checked – The ECK web service hasn’t come around to 
validating your upload yet. Please just wait until it does. 

 Ready values 

Possible Ready values are: 

• Yes – The relevant records have been validated and are ready to 
be pushed to the aggregator, using the Data push option in the 
right window pane. 

• Yes (old) – The relevant records have been validated and are 
ready to be pushed to the aggregator, using the Data push option 
in the right window pane. However, there’s also a newer version 

of these records present in the record set (unless their Status is 
Deleted), which you can view by clicking the Preview option. If 
you like the newer version better than the old one (which can’t be 
previewed anymore), you’ll have to (Validate and) Commit to 
overwrite the old version with the new one. Yes (old) will change 
to Yes. 

•      – If the Ready status is empty it means No. You’ll have to 

(Validate these records, if not Valid already and) Commit them to 

make them Ready Yes. 

 Available actions 

Possible actions to perform on the listed records can be started by 

clicking one of the options in the right window pane. Some only work 
on a single selected record, others on all records or on one or more 
selected records (Ctrl+click to select multiple records): 
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• Preview – Shows an HTML display of the selected record in your 

default browser. This is how the record data will be presented on 

Europeana. A record needs to be Valid to be previewed. 
If two versions of a record are present in the set, the newer ver-
sion will be shown. 

• Validate – Tries to validate the uploaded LIDO XML of selected 
records or all records, regardless of their status.  
If two versions of a record are present in the set, the newer ver-

sion will be validated. 

• Delete – Deletes the selected records or all records, regardless of 
their status and readyness. Although record content will be delet-
ed, a reference to the record will remain present, with a Deleted 

flag attached to it. Record data which has already been pushed to 
the aggregator won’t be deleted from the aggregator. 
If two versions of a record are present in the set, both versions 

will be deleted. 

• Commit – Commits all Valid records which are not ready yet, to 
make them Ready Yes. If certain records weren’t validated yet, 
Commit tries to validate those first. And if the aggregator requires 
the pushed data to be formatted as EDM, Commit will also trans-
form the LIDO XML to EDM XML (as set up in your ECK configura-
tion). 

The Commit option will be temporarily disabled if the Queue al-
ready contains a commit action. 

Any Ready Yes (old) records will be overwritten by Valid new ver-
sions of those records. 

• Data push – Pushes the data from all records with the Ready 
statusses Yes and Yes (old) to the aggregator. You cannot undo 

this data push. Data push does not work with the queue: it has to 
wait for a reply from the server and you’ll be notified so. The pro-
gress of the push procedure will be displayed in a message. 

 Screen tabs 

The tabs available in the Europeana set manager are: 

• Records – Shows the records uploaded from your institution. The 

“subtabs” Show all, Pending (records not processed yet), Valid, 
Invalid, Ready and Deleted are filters. A blue filter is an active fil-
ter. Click the filter label to switch it between active and inactive. 
For example: to only show all valid records, activate the Valid fil-
ter and deactivate the others. Or, to only show all valid and invalid 

records, activate the Valid and Invalid filters and deactivate the 
others. Adlib will retain your filter choice. 
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• Errors – Displays any validation errors from the web service if 

records didn’t pass validation. They may give a clue about what’s 

wrong, allowing you to fix it and upload the relevant records 
again. 

• History – Shows a part of the log of all actions processed on the 
server. Click the Get more option in the upper right corner if you’d 
like to see more log entries.  

• Messages – Shows sort of a log of errors, warnings and other 

information. Errors and warnings will cause a yellow warning icon 
to appear in the tab label:  
Before you report any errors to our helpdesk, it’s good to know 
that not all possible errors are caused by Adlib or your configu-

ration. After you click the Data Push option, for example, basically 
all non-Exception type errors will be caused by the ECK web 
service and you’ll have to contact your aggregator to report those 

errors. 

The record set on the ECK web service 

All records that you or your colleagues upload to the ECK will end up 
in a record set that divides the records into two groups: the ones that 
are Ready to be pushed to the aggregator because they have been 
“commited”, which means they have been validated and possibly 
converted to the EDM format (if that, instead of LIDO, would be the 

XML format required by the relevant aggregator) and the ones that 

are not ready because they haven’t been validated and/or commited 
yet. This division provides the condition for a unique, albeit confus-
ing, characteristic allowing any record to be present in this record set 
twice, once with the Ready status and once without it: however, a 
duplicate record will only be visibly listed in the record set once! The 
Status column will display the validation status of the newly uploaded 

version of a record if an older version of the record is present as well, 
while the Status column will display the validation status of the only 
available version of a record if no newer version is present. The 
Ready column on the other hand, will display the status Yes for a 
ready record that has no competition from a newer upload, while it 
will display Yes (old) if there’s and “old” record version ready to be 

pushed to the aggregator while there’s also a newer, different or 

deleted version of the record in the set, which hasn’t been commited 
yet. 
If you never upload a record more than once, this situation will surely 
never occur; neither will it if you never mark the Don’t make the 
records ready (update only) option in the wizard when uploading 
data. Normally, you’ll upload a record only once and even if you 
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accidentally upload the same record twice, it will overwrite the exist-

ing version of the record in the record set on the ECK web service (if 
validation succeeds and the record is automatically commited, that 
is). The exception to the rule, causing two versions of a record to be 

present in the set, is when you upload a record more than once while 
having marked the Don’t make the records ready (update only) 
checkbox in the wizard, or when you upload a record more than once 
and find it doesn’t pass automatic validation the second time. 
 
Having two versions of a record in the record set is no problem but 
you need to be aware of the consequences if it does occur. As men-

tioned above, the way to tell if a record is present in the record set 
twice, even though it’s only listed once, is if the Ready status of that 

record reads Yes (old):  

• When you push data, only data which has the Ready status Yes 
or Yes (old) will be pushed. If you want a newly uploaded copy 
(or maybe an altered version) of an earlier uploaded Ready: Yes 
(old) record to overwrite it, you simply have to (Validate and 

then) Commit the selected record via these options in the Euro-
peana set manager. The new version of the record will overwrite 
the old one and only one version of the record will remain in the 
record set. 

• If you delete one or more records from within the Europeana set 
manager, using the Delete option in the right window pane, both 

versions of double records will be deleted from the record set.  
On the other hand, if during upload of a second version of a rec-
ord you had marked both the Delete existing records from the set 
and the Don’t make the records ready (update only) option, then 
you can tell from the Status: Deleted and Ready-ness Yes (old) of 
all pre-existing records which you haven’t uploaded again just 
now, that even though these records have now been flagged as 

deleted, the deletion hasn’t been commited because of the up-
date only option. So here too, Yes (old) indicates that there still is 
an old version present in the record set, ready to be pushed or 
commited. If you Commit, all Ready: Yes (old) records flagged as 
Deleted will indeed be deleted this time.  

• Of the selected record, the Preview option in the right window 
pane of the Europeana set manager, displays the latest uploaded 

version, even if an older Ready version is present as well.  
If there’s only a single version of the record present in the record 
set, then of course this version will be used in the preview. 
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21. Appendix 1: Adlib Museum features 

21.1. Museum Basis 

Adlib Museum Basis is an excellent package for small museums, and 
offers more limited possibilities for registering objects – i.e. fewer 
fields and fewer data sources – than Adlib Museum (previously Muse-

um Standard).  

21.1.1. Available data sources 

 

Figure 21.1: Choose a database to work with. 
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In Adlib Museum Basis 4.2 you can choose from nine databases (Ob-

jects, Library catalogue, Visual documentation, Persons and institu-

tions, Thesaurus, Assessments and treatments, Locations, Currencies 
and Series). Dependent on your installation, this menu may list more 
or fewer, and different data sources than by default. 

In one of the two datasets of the Objects database you of course 
register the objects in your collection.  

The images (e.g. photos or scans) that have been made of those 

objects, can be described in the Visual documentation file; so in there 
you can save information about the images, such as when they were 
made, and by whom, and of course you can make a link to the images 
themselves. 

Objects and Visual documentation are databases that are linked to 
each other. From the objects collection you can link to image repro-
ductions that you have already made, or from the collection you can 

easily create new image reproductions to immediately link to. See 
chapter 12.2 for a further explanation of linking images to records. 

Persons and institutions and Thesaurus are authority databases (as 
described earlier in this manual), in which you store names and terms 
to which certain fields in Objects and Visual documentation must be 
validated, for instance to enforce the use of preferred spelling, or the 
use of certain jargon. 

21.2. Museum (standard) 

21.2.1. Data sources and relations 

In Adlib Museum 4.2 you can choose from nineteen databases and 
seven datasets of two of those, the datasets being the Internal object 

catalogue and the External object catalogue and five Library catalogue 
datasets. Dependent on your installation, there will be more or fewer, 
or other data sources than by default. 

In the object catalogue you register the objects in your own collection. 
Note that in Objects (the total collection) you can only do searches; if 

you want to enter a description, then you’ll have to choose one of the 

two datasets in which this database is divided. 
The images (for instance photos or scans) that you make, or have 
made, of those objects, can be described in Visual documentation; so 
in there you can save information about the images, such as when 
they were made, and by whom, and of course you can create a link to 
the images themselves. 
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Each of the object catalogues, and Visual documentation, are data-

bases that are linked to each other. From the collection (Reproduc-

tions tab) you can link to image reproductions that you have already 
made or from the collection you can easily create new image repro-
ductions to immediately link to. See chapter 12.2 for a further expla-
nation of linking images to records. 

In the other data sources you will also regularly come across the 
possibility to create links to records in the other files. In Documenta-

tion you can register internal documents (books, articles, avm, re-
ports, etc.). You can link to these records from for instance one of the 
object catalogues in the Title field on the Documentation tab. 
Also, in Incoming loans you can draw up the incoming loans agree-
ment, and in the External object catalogue you can describe the object 

that came in via the loan. Then you can establish a link between these 
two databases, on the Loans tab in the External object catalogue. 

And from the object catalogues in the Exhibition name field on the 
Exhibitions tab, you may create a link to records in the Exhibitions 
database. 

 Creating linked records 

In general you can create linked records in two ways: 

• First describe and save the record to which you want to link, then 
open the desired database, for instance an object catalogue, go to 
the proper tab, put the cursor in the linked field and click the List 

button in the Edit menu to search for the reference in the linked 
database and fill it in. 
 

 
 
This button is only available when the cursor is in a linked field. 
These fields might be linked to either an authority database or to 
just an “ordinary” database. 

• The second way is from an object catalogue (or any other data-
base from which you want to create a reference), while you regis-
ter an object. Place the cursor in the desired linked field and click 

the Make/edit linked record button: 
 

 
 
Now a zoom screen opens in which you can create the linked rec-
ord, although often you can only fill in a limited number of fields 
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here. Later you can retrieve the linked record in the linked data-

base, and reopen it to fill it in more extensively and possibly link it 

to yet other records. 

See an earlier chapter in this manual for more information about filling 
in linked fields. 

Persons and institutions and the Thesaurus are authority databases, in 
which you store names and terms to which certain fields in other 
databases must be validated, for instance to enforce the use of pre-

ferred spelling, or the use of certain jargon, for registration. 

21.2.2. Relations between objects themselves  

 

Figure 21.2: The display of the relationship between a main object and its 
parts. 

Relationships can be established between objects in the same dataset. 
For instance, relationships between parts of a dinner service within the 

Internal object catalogue. To create a relationship between a main 
object and accompanying parts, Adlib uses the record numbers of 
each description. You can create such a relationship on the Num-
bers/relationships tab. On this tab, you will see the fields Part of, Parts 
and Related object in which object numbers of the concerning objects 
must be entered in order to create a relationship. To create a relation-
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ship from a main object to its parts, you must already have entered the 

parts. Conversely, there must already be a main object entered if you 

want to create a relationship from a part to a main object.  

Place the cursor in one of said fields and click the List button in the 
Edit menu to open a search form; in here you can search for the other 
objects. The data of the chosen object will then be copied. 
Adlib will then automatically link these two records. In the record for 
the main object, a reference will be included to the record of the part. 

Vice versa, the record of the part will contain a reference to the record 
of the main object. You therefore always only have to establish the 
relationship from one side. 

To enter subsequent parts for a main object, you’ll have to insert 

extra occurrences to the relevant field (Parts).  

In figure 21.2 you’ll see an example of a relationship between a main 
object and three parts. 

21.3. Deriving records 

Deriving records from other databases creates the possibility to copy 
or move records entirely from on dataset to the other dataset – 
searching for these records is like searching in a linked database. This 
is useful when you are describing objects that contain similar data. 
Your application builder can enable this option by creating one or more 

‘similar’ or ‘friendly’ databases, from which records can be copied.  

When you open a new object record for editing, you can choose to 
derive a record, so that the data in it will be copied to the new record. 

Choose Start  Derive and choose the desired friendly database. (If 
the button is greyed out, no similar database has been set.) 

 

When your application builder has set, for instance, the External 
object catalogue dataset as a friendly database in the Internal object 
catalogue dataset, then open the Internal object catalogue file, choose 

Start  Derive  Cut a record from External object catalogue and a 

search form opens with which you can search through the friendly 
database External object catalogue.  

The search result will be shown in the Available data window. Click 
Details to display a record, and click Select to copy the record to a 
new record in the Internal object catalogue. Dependent on the set-
tings, the original record will or won’t be deleted; in this case the 
removal of the original record is probably desirable. 
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21.4. Change locations efficiently 

On the Location | Future movements screen tab in the object cata-

logues (Internal object catalogue/External object catalogue) or archive 
datasets of 4.2 model applications and higher, you can register the 
normal location, the current location and any planned future move-
ments. In model applications 3.5 and older, this functionality differs 
from that in model applications 4.2 and higher: see further down for 
more information. 

 

Figure 21.3: A screenshot from a 4.2 application: other application versions 
may show different screens and fields. 

The Change locations procedure allows you to simultaneously change 
the current location of one or more marked records in the Brief 
display. This is handy if a part of, or all of the collection changes 
location and you have actually moved the objects. (Do not open any 
of these records in detailed display, otherwise only that record will be 
processed by the procedure, unless that is what you want.) 

1. You can start this function from within the Edit menu: click the 

Change locations button. (This button can only become active if 
certain application settings have been made.) Or use the key 
combination Ctrl+E instead. 

 

  
 
The Change object locations window opens. 
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Figure 21.4: The Change object locations window as presented in 4.2 
model applications and higher. 

2. In the first section in this window you can enter the new current 
location for all marked objects (this must be a location which 
already has been registered in the relevant database*), the 
movement date and time (which doesn’t need to be today), the 
name of the executor*** of the physical move of the objects (if 

you are not that executor), a remark about the suitability of the 
new location, the name of the authoriser for the new location and 
any notes about the new location. A location can also be entered 
quickly, based on a scanned barcode****. 
By marking the To normal location checkbox, this procedure 

allows you to change the current location of the marked records 
all at once to the normal location as registered per record. The 

Location field in this dialog can no longer be filled in once you 
mark the To normal location checkbox. (In other words: the 
marked checkbox makes sure that the location registered in the 
Normal location field in the marked records, will be copied to the 
Current location field. No changes will be made to the value 
registered in the Normal location field.) If one or more of the 
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processed records does not have a Normal location (tag NL), then 

those records will be skipped and you will be notified so. Other 

records that do have a normal location will be processed as you 
would expect. 
In the second section you register any details about the 
movement, like the movement method, its reference number, a 
contact person and possibly some notes about the movement. 
If you do not use the To normal location checkbox, then the 

Location field is mandatory while the rest is optional. 

3. Click the Apply button to start the procedure. During execution, 
the Progress box displays a summary of the progress of the 
running procedure, such as rejected (unprocessed) records, suc-
cessfully processed records and the end result. Any errors will be 

listed here too. The messages which appear here can be selected 
with the mouse or with the (right-click) pop-up menu and copied 

to a text file, so you can save them for possible verification 
afterwards. 

* Validating an entered term - The List buttons behind the 
Location, Authoriser, Method and Contact fields allow you to select an 
existing term or name. Actually, these are validated fields and you can 
only enter an existing term or name here, with or without the help of 
the List function. 

 

As soon as you type a term or name in such a field and leave it, the 
value will be validated.  
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If the value doesn’t exist, you’ll be notified so and you will still have to 

choose an already existing term or name. Before, during or after 

entering a value, you can click the List button behind the field to open 
the Find data for the field… window, in which you can validate the 
value yourself before Adlib does. 

In the first entry field underneath Find, you must select a field from 
the linked record in which you would like to search for a value (one or 
more fields are available**); if only one field is available, it will be 

selected by default. In the next entry field you must enter a partial or 
complete value to search on (you cannot leave the entry field empty). 
Then press Enter or click the Search button to retrieve all values 

from the relevant index, that start with the search key. Subsequently 
select one of the found keys and click Select to copy the value to the 

Change object locations window. 

If you want to use a location which hasn’t been registered yet, you’ll 
have to describe it first in the Locations data source (or as a term in 
the location (LOCAT) domain in the Thesaurus of certain older applica-
tions). Any new movement method can be registered in the move-
ment method (MOVEMENT) domain in the Thesaurus. A new contact 
or authoriser, on the other hand, can be described in Persons and 

institutions, in the curator (CURATOR) domain. 

** Available search fields for term validation - Which fields are 
available in the drop-down list underneath Find, is determined by the 
link definition of the current linked field. Only the linked field itself and 

any merged-in fields which have been indexed in the linked database, 
will appear in the list. Moreover, the list displays the field names as 

they have been specified in the linked database, and those might be 
slightly different from the labels presented in the user interface. 
In fields in the linked database that are represented by a drop-down 
list, you can only search on the interface language neutral values of 
the list: in package_location for example (the possibly merged-in field 
with the linked field location in custom applications, in which you have 
registered whether the record pertains to a location or a package) you 
can choose from exactly two values to search on: package and 

location. 

*** An overridable executor – Prior to Adlib 7.3, by default the 

name of the currently logged-in user was taken as the name of the 
executor, the person executing the change location procedure in Adlib. 
From 7.3 that is still the case if you leave the Executor entry field 
empty during the procedure: only if you enter data in the entry field 
(a different name), that name will be included as the executor of the 
move. This way there’s no need for the actual executor of the move of 
objects to be the person registering that move in Adlib. 
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By the way: the Executor field is only present by default on the Loca-

tion | Future movements and Location history screens, from model 

application 4.5. 

**** Location entry by scanning a barcode – From Adlib 7.3, in 
the change locations procedure, there’s a quicker way to enter a 
location based on a barcode to be scanned. (From model application 
4.5, barcodes are registered in a separate field.) First put the cursor in 
the Location entry field in the Change object locations window. Scan 

the desired barcode and note that it is entered in the entry field. 

 

As soon as you leave the entry field or fill in other fields, the location 
name associated with the barcode will be retrieved by means of that 
barcode. The barcode in the entry field will be replaced by the location 

name, but the barcode will still be displayed underneath the Location 
entry field. 

 

In the Location entry field you can still just type the name of the 

desired location as well. This will also be validated and if it exists, it 
will be repeated underneath the entry field. 

Should Adlib not be able to find the entered name or barcode in the 

linked Locations and containers data source, then still the Find data 
for the field window will open, allowing you to search for the proper 
location name or barcode: in the Find drop-down list you will have to 
indicate whether you’d like to search on name or barcode, though. 
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 What the procedure does 

As soon as you click the Apply button, the procedure starts processing 
all marked records one by one. This involves the following: 

1. If the processed record already contains a current location, all its 
details will be transferred to the location history. The date entered 
in the procedure will become the End date (Removel date) of the 

previous location just created implicitly. In 4.2 applications and 
higher, the history can be found on the separate Location history 
tab, while in older applications the history is summed up under-
neath the current location. Any movement details, as entered in 
the 4.2 Change object locations window, will also be added to the 
previous location just created. 

2. The details of the new location you entered in the Change object 

locations window, will be copied to the record fields for the Cur-
rent location. If you’ve marked the To normal location checkbox, 
then the Current location will become the same as the Normal 
location.  

Note that any registered, planned Future movements will be ignored 
by this procedure from now on, so they won’t have any effect on what 

you’re doing. Any future movement data won’t be used or checked or 
deleted. This behaviour is in line with that of Axiell Move, which ig-
nores future movements as well.  
The Normal location will be kept intact too, of course. 

The procedure can be aborted during its progress, using the Cancel 
button. The procedure will finish its work on the currently processed 
record and will then stop. So the changes in already processed records 

won’t be made undone: the procedure will only be aborted and the 
progress report will tell you which records have been processed up 
until then. 
Further note that the procedure will process the marked records in 
record number sequence, which is not per se the order in which the 
marked records are listed in the Brief display. 

 Records which cannot be edited 

Records which couldn’t be edited by the procedure, for instance be-
cause those records were just being edited by colleagues, can be 
saved in a pointer file afterwards so that you can check what was 
going on and/or try to execute the procedure on those records again 

at a later time.  
The Save pointerfile dialog appears automatically if problematic rec-
ords have been found. Enter a name for the pointer file and click 
Save. (If you do not enter a name, Adlib will set a name automatical-
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ly.) An available number will automatically be assigned to the new 

pointer file, but you may also enter a number yourself in the entry 

field which contains the word Automatic. 

 Alternative ways to start the procedure 

• Locations can be changed from within the Advanced search too: in 
the expert search language, you could search for records in the 

Internal object catalogue, of which the location has to be changed. 
(Make sure that your search statement yields exactly those rec-
ords which you want to change.) Then right-click the result set, 
and choose Change locations in the pop-up menu that opens. The 
Change object locations window will open. 
 

 

• The Change locations procedure can be started as well for the 
currently opened record in detailed display, regardless of whether 

it is marked or not. Any other marked records won’t be processed 
from the detailed display. 

 Differences between application versions 

 

Figure 21.5: The Change object locations window as presented in 3.5 model 
applications and older: you can’t enter movement details here. 
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Some Museum or Archive model applications, version 3.5 or older, but 

possibly your older customized application as well, have a Location 

screen with the Start date, Location type, Location and Notes fields on 
it, and a Change locations button in the Edit menu – this button can 
only become active if certain application settings have been made. In 
these older applications, inserting a new current location means that 
the old current location moves down an occurrence, as are any other 
previous locations: so the location history can easily be read from the 

listing underneath the current location. 

Therefore the Change object locations procedure window looks differ-
ent from that in model applications 4.2 or newer: you can enter fewer 
details here. 

 

Figure 21.6: The Location | Future movements tab in 4.2. 

In Museum and Archive model applications 4.2 and higher, you’ll find 
the possibility for a more advanced registration of locations and pro-
cessing of movements. In the object and archive catalogues, two new 

tabs are present: Location | Future movements and Location history. 

As mentioned, the old Location tab offered a repeatable field group in 

which a new location simply had to be inserted at the top of the list, 
while the location history was apparent from the list below it. 
To make the current location more explicit and to also allow for the 
planning and registering of future movements, the two new screens 
have been created. On these screens, the movement method, the 

time of the movement, packaging and authoriser can be entered as 
well. The fields previously present on the Location tab, have been 
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moved to Location history. On Location | Movement you’ll find new 

fields for the current and future location and movement. 

Further note that the Change locations procedure always uses hard-
coded field tags. This means that on execution of this procedure, Adlib 
assumes that those field tags are not being used for other data. This 
assumption is of course true for the Adlib model applications, but not 
per se for homemade applications or for older applications which have 
been extended with extra fields through the years. In such case it 

might be sensible to have your application manager check whether 
your application is suited for the procedure, before you first start 
using it. The documentation about the required field mapping for this 
procedure can be found in the Designer Help.  

 

Figure 21.7: The Location history tab in 4.2. 

21.5. Locations and their upward hierarchy 

When you register the location of an object in your collection, it is 

sometimes handy to have an overview of the upwards hierarchy of 
that location displayed in the record as well. It is possible that your 
application manager has implemented such functionality. Below, you 
can see an example of this, in which an extra (read-only) field named 
Location hierarchy has been placed on the Location | Future move-
ments tab. After filling in a location in the field above it, Adlib will fill 
the Location hierarchy field with the hierarchical context of the loca-

tion, yet only its broader terms and the term itself, in the following 
syntax: top_term/bt/bt/…/bt/term. So the hierarchy is presented as 

a single string, its broader terms separated by slashes. 

 

http://documentation.axiell.com/alm/en/index.html?ds_generaltopicschangelocations.html
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If an entered location appears more than once in the database, which 

may easily be the case for general location names like “shelf 1” or 

“rack 3”, you must select the right term when you leave the field. The 
More than one preferred term found, select from list window opens 
automatically, listing the identical terms. Hover the mouse pointer 
over a term, and a tooltip should appear, showing the upwards 
hierarchy of the term. Do this over every term until you find the right 
one. Then select it and click OK. 

 

In the linked field, you can also press Shift+F4 to select the desired 

term in the Find data for the field… window. 

By the way, this functionality is not limited to locations. Your applica-
tion manager can set this up for all fields which link to an internally 
linked field.  
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22. Appendix 2: Adlib Library features 

22.1. Available data sources 

 

Figure 22.1: Choose a database or dataset to work with. 

In Adlib Library 4.2 you can choose from seven databases, one of 
which (Library catalogue) is divided into seven datasets. Dependent 

on your installation, this menu may list more or fewer, and different 
data sources than in this example. 

For searching for data you can use databases as well as datasets. 
When you’re searching for a book, you can do that in the Library 
catalogue as well as in Books. The advantage of choosing a dataset is 
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that it is smaller and that all operations you perform on it will execute 

faster than on the Full catalogue. Further, you prevent in this case 

that the results also contain serials and articles, etc. 

For entering or editing data it is important to always choose the small-
est collection of data: has a database been divided into datasets, then 
always choose a dataset; has a database not been divided, then 
simply choose the database itself. So if you want to register an newly 
acquired book in the example above, then select the Books data 

source, not Library catalogue. 

In Audio-visual materials, Articles, Serials and Loose-leafs you register 
the bibliographic data of the concerning materials. 

The Serials module 

In the Adlib Serials module 4.2 you have direct access to the Serials 
and Loose-leafs records in the Library catalogue, although in that 
module only limited bibliographic data is presented, because the 
Serials module is mainly used for the management of subscriptions 

(finances, subscription details, booking of issues, etc.). 

 

In Resources, you can describe internet sources, multimedia, objects 
or documents, in accordance with the Dublin Core metadata standard. 
(Data is entered in the other datasets in compliance with the ISBD 

cataloguing rules). The Dublin Core standard is a set of 15 elements 
with which a wide range of objects can be described. This kind of 
descriptions, so called metadata, has the following advantages:  

• easy to create; 
• easy to index; 
• enables accurate searches; 
• promotes interoperability and standardization (e.g. allowing simul-

taneous searches of disparate collections); 
• multidisciplinary by nature. 
 

This standard is maintained by the ‘Dublin Core Metadata Initiative’. 
For more information about this subject, see the web site: 

http://purl.org/DC/.  

In Desiderata you can register titles which are on the wish list (so, not 
in your possession yet). 

Persons and institutions, Thesaurus, and Series are authority data-

bases, in which you store names and terms to which other fields in 
other databases must be validated, for instance to enforce the use of 
preferred spelling, or the use of certain jargon, for registration. 

http://purl.org/DC/
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22.2. Relations (analytical cataloguing) 

 

Figure 22.2: An example of the relation between a main entry and its parts. 

Relations are used when an item consists of a number of parts. (It 

does not apply to series, which are continued). To create a relation-
ship between a main entry and its parts, Adlib uses the record num-
bers of both descriptions. The relationship is created on the Relations 
tab of the datasets Books, Audio-visual materials, Articles, Serials and 
Loose-leafs. This tab contains the fields Part of and Consists of. This is 
where the record numbers must be filled in to create the relationship. 
In the Volume column, you fill in the appropriate volume (e.g. vol. II). 

To create a relationship from a main entry to its parts, the parts must 

have been registered first already. Conversely, to make a relationship 
from a part to a main entry, a main entry must already have been 
created.  

 

If you do not know the record number of a part or a main entry that 
has previously been entered, you can click the List button in the Edit 
menu to open a search form, in which you can enter details of the 

main entry or part you are looking for (or click the List button again to 
search the authority database for a certain linked field). Then click the 
Search button, and Adlib will show records in which the details you 

entered occur.  

 

Select a part or main entry as appropriate and click Select. Adlib will 
then automatically create a link between the two records: the descrip-

tion of the main entry will contain a reference to the part. Or vice 
versa: the description of the part will contain a reference to the main 
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entry. You therefore always only need to establish the relationship on 

one side. 

If you want to enter a number of subsequent parts for a main entry, 
you can add new occurrences to the Consists of field, using 
Ctrl+Enter or by clicking the Append occurrence beneath button.  

 

22.3. Deriving records 

Deriving records from other databases or datasets is useful when you 

are describing documents that contain similar data. Your application 
builder can enable this option by creating a ‘similar’ or ‘friendly’ data-
base, from which records can be copied.  

You can call up or derive a record when you want to create a new 
record for a document for which you need that data. (The Derive 
command can be found in the Start menu.)  

 

If you want move records from e.g. the Serials to the Books dataset 
(for instance a bound volume of a periodical) or vice versa, then you 

most likely don’t want to keep the original records in the friendly 
database. Whether or not the original record must be deleted, can be 
set by your application manager. 

The deriving of records looks like the linking of e.g. a main entry to a 
part, for which you (search) and enter record numbers in the Part of 
field on the Relations tab. The derive function works similarly. 
When your application builder has set, for instance, the Serials dataset 
as a friendly database in the Books dataset, then open the Books 

dataset, choose Start  Derive  Serials and a zoom screen opens 
(for example a search form) with which you can search the friendly 
database Serials.  

The search result will be shown in the Available data window. Click 

Details to display a record, and click Select to copy or move the record 
to a new record in Books. 

 Deriving from external sources 

A friendly database may be a local database, but may also be an 

external source which has to be approached over the internet. In 
some model applications, but possibly in your customized application 
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as well, external sources may have been defined as friendly data-

bases. In Adlib Library Lite 3.4 and Adlib Xplus 4.2 for example, the 

following external sources are available for the Books dataset: 

• National Library of the Netherlands 
• Cut a record from Desiderata 
• Library of Congress  
• German National Bibliography 
• Gemeinsamer Verbundkatalog (GVK - German) 

 
For example, to derive a record from the Library of Congress, you 

open the Books dataset, choose Start  Derive  Library of Congress 
to open a search form with which you can search in the external 
source.  

Original records will never be deleted from the external sources, of 
course. 

22.4. Printing accessions lists 

To print an accessions list, first find the relevant records using the 

access points Input date or Acquisition date.  

Adlib supplies the Input date automatically: this is the date on which a 
new record is entered.  

Acquisition date is the date on which a document was purchased, and 

you should enter this date manually on the Management details tab. If 
you are delayed in entering data, this field can be handy: you can fill 
in the old date on which the item was actually acquired, so that these 

records won’t be included in an accessions list if you search on an 
Acquisition date after this old date. 

So search on Input date or Acquisition date, and mark the records you 
want to print in the accessions list. If desired, sort the marked records 
now (e.g. on subject term or author), open the submenu of the Out-
put formats button in the File menu, and select the Accession list print 

format. Then click OK to start printing. 
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23. Appendix 3: Adlib Archive features 

23.1. Standards 

23.1.1. Relevant standards 

The standards applied in Adlib Archive, or those relevant to archival 
recording in general, are amongst others: 

• The second edition of ISAD-(G) (International Standard for Ar-
chival Description – General), by ICA (International Councel of Ar-

chives), forms the basis of Adlib Archive (version 3.2 and higher). 

The specification of this standard can be found on: 
http://www.icacds.org.uk/eng/standards.htm (also see the next 
paragraph). 

• EAD (Encoded Archival Description) is the XML standard for the 
exchange of data between archives. ISAD-(G), the basis of Adlib 
Archive, can be expressed comfortably in EAD. The specification 
for this standard can be found on: http://www.loc.gov/ead/  

• The AAT (Art & Architecture Thesaurus) is a controlled and struc-
tured subject term list containing terms, names, and other infor-
mation about people, places, things, and concepts relating to art, 

architecture, and material culture.  
The AAT was produced by Getty Research Institute. The AAT is be-
ing applied worldwide as a means of disclosing architectural, art 

and historical collections in museums, libraries, knowledge cen-
tres, archives and documentation institutions. The AAT can be 
found on: 
http://www.getty.edu/research/conducting_research/vocabularies
/aat/  

• ISAAR(CPF) stands for International Standard Archival Authority 
Record for Corporate Bodies, Persons and Families, by ICA, and 

specifies the standard for authority databases for names of institu-
tions and people. The specification of this standard can be found 

on: http://www.icacds.org.uk/eng/standards.htm 

• The UNESCO Thesaurus (United Nations Educational, Scientific and 
Cultural Organisation) is a controlled list of subject terms contain-
ing terminology for the following areas of knowledge: education, 
science, culture, social and human sciences, information and 

communication, and politics, law and economics. It also includes 
the names of countries and groupings of countries: political, eco-

http://www.icacds.org.uk/eng/standards.htm
http://www.loc.gov/ead/
http://www.getty.edu/research/conducting_research/vocabularies/aat/
http://www.getty.edu/research/conducting_research/vocabularies/aat/
http://www.icacds.org.uk/eng/standards.htm
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nomic, geographic, ethnic and religious, and linguistic groupings. 

The UNESCO Thesaurus is located at 

http://databases.unesco.org/thesaurus/  

• The UKAT (United Kingdom Archival Thesaurus) contains subject 
terms collected by and for the archive sector in the UK. The the-
saurus can be found on: http://www.ukat.org.uk/  

23.1.2. ISAD-(G) applied in Adlib Archive 

 Areas of information 

 

Figure 23.1: Each ISAD-(G) area of information has its own tab. 

According to ISAD-(G), an archive (catalogue) record can be divided 

into the following areas of information: 

• the Identity statement area, containing reference codes, a title, 
date(s), the level of description, and extent and medium of unit; 

• the Context area, for registering names of the archive creators, 
the administrative/biographical history, the archival history, and 
immediate source of acquisition or transfer; 

http://databases.unesco.org/thesaurus/
http://www.ukat.org.uk/
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• the Content and structure area, pertaining to scope and content, 

appraisal, destruction and scheduling, accruals, and the system of 

arrangement; 

• the Conditions of access and use area, to contain conditions gov-
erning access, conditions governing reproduction, language/ 
scripts, physical characteristics and technical requirements, and 
finding aids; 

• the Allied materials area, for information about the existence and 

location of originals, the existence and location of copies, related 
units of description, and a publication note; 

• the Notes and description control area, for the archivist’s note, 
rules or conventions, and date(s) of description. 

See: http://www.ica.org/ for the full specification of ISAD-(G). 

In a record in Adlib Archive, each of these areas has a its own corre-
sponding screen tab (detail screen). Other, mostly administrative 

information is grouped and located on detail screens not marked 
“(ISAD)”. 

 Hierarchical levels 

Further, an archival description is hierarchical, according to ISAD-(G), 

and goes from general to specific. Specific levels are not mandatory. 
Levels can be subdivided if the complexity of the administrative struc-

ture requires it. There are five basic ISAD-(G) levels of description: 

• fonds; 
• sub-fonds; 
• series; 
• files;  

• items. 
 

For a record in the Archives (catalogue) dataset there are six levels 
available by default: the extra level is “sub-series” (see the figure 
below). 

 

Figure 23.2: In the catalogue there are 6 levels of description available by 
default. 

http://www.ica.org/
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Using Adlib Designer, you can delete or add levels to this drop-down 

list, or change the names of the levels (for instance if you usually 

speak of a group or collection instead of a fonds, and of classes and 
items instead of series and files), and customize the possibilities of 
your archive hierarchy this way, if desired. 

In ISAD-(G), accessions (newly acquired items) and accruals (fore-
seen additions to the unit of information), are recorded non-
hierarchically. Therefore the Archives (accessions) dataset in Adlib 
Archive does not offer the possibility to specify the level of the de-

scription as in the catalogue, nor to select any parent or child units of 
description. 

23.2. Archives 

23.2.1. Accessions and the catalogue 

Of all databases and datasets which you can choose from in the list of 

data sources in the Archive application (see the figure below) only the 
top two are unique in this application: Archives (accessions) and 
Archives (catalogue). 
In archives there are commonly separate datasets for accessions and 
catalogue registrations. In the accessions, a quick and succinct de-
scription of new archive material is made, shortly after its arrival. At a 

later time (sometimes much later), maybe a complete description of 

such “new” items will be made, and this is done in the catalogue. For 
such a definitive description you don’t have to re-enter data already in 
the accessions record: you can derive (say copy) that data from 
Archives (accessions) to Archives (catalogue) and then alter or com-
plete it. In the catalogue you derive a (database) record from the 
accessions via the menu: Record > Derive record > Copy a record 

from Archives (accessions).  
From a catalogue record you may refer (link) to an accessions record 
(in the Accession number field), if desired. 

The number and nature of the screens in accessions is almost the 
same as in the catalogue, even though in the accessions you can also 

find a screen pertaining to the origin of the material, which is not in 
the catalogue. Therefore, all acquisition data is not copied along when 

deriving an accessions record; this applies to input and edit data of 
the original record too. 
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Figure 23.3: All databases and datasets in Adlib Archive 4.2. 

23.2.2. Working with description levels in the catalogue 

 Setting the description level per unit 

The Archives (accessions) and Archives (catalogue) datasets are 

sections of one and the same database. 

The system name of this database is COLLECT (as can be seen 
in Adlib Designer), which also happens to be the database in 
which museum objects can be registered in Adlib Museum, in 
their own datasets of course. This is possible because descrip-
tions of museum and archive objects differ only little: many da-
tabase fields are the same, and even the screens look similar 

(although the entry field labels in Adlib Archive have been ad-
justed where necessary). 
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So description units of all levels are stored together in one database 

too, in the same dataset even. You therefore have to set the descrip-

tion level per catalogue record, although you don’t have to do this 
directly; the level is saved as a normal field value with the record in 
the database. 

 

Figure 23.4: For each catalogue record you have to set its level of description. 

 Building the hierarchy of the digital archive 

In two other fields in the record (on the Context tab) you can select 
the description units of the parent and child level, with which you build 

up the hierarchy of your digital archive. (By the way, Adlib makes no 

demands on the structure of the hierarchy.) 

 

 

Figure 23.5: Specify the place of the current record in the archive hierarchy. 
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Put the cursor in the desired linked field, and press Shift+F4 to look 

up the proper description unit via a search form. 

The two level fields are internally linked fields, via the broad-

er-narrower construction which is used in the Adlib thesaurus 
as well. This means that Adlib automatically updates the linked 
records of the parent and/or child units of description filled in 
in the current record (updated after saving that is), with mir-
rored data: after all, in the parent unit of description, the cur-
rent unit must be a linked child unit, etc. 

When you link a record to a unit of a higher description level, the title 

and the level of that unit are retrieved and shown with this link if you 
place the record in display mode. No other data is copied. 

 

Figure 23.6: The title and level of the linked record are retrieved. 

If you would like to have a look at the data of the parent record, then 
click the underlined link to that record here; the parent level unit of 
description will then be opened. To return from the parent record, you 
have to click the relevant link to the previous, child record (in the 

Parts field). 

 Using reference codes 

In archive records, Reference code is a mandatory field. This reference 
is used as the identification of the record, to be able to create links 

between units of description of different levels, and therefore has to 
be unique. 

If you use Adlib Archive in combination with Adlib Museum (as 
in Adlib Archive+Museum or Adlib XPlus), then note that mu-
seum object numbers are stored in the same database field as 
reference codes; therefore a reference code cannot be identi-

cal to an object number, since both have to be unique.  

In Adlib you can also enter your existing reference codes, regardless 
their format, provided that every code is unique. So the reference 
codes need not necessarily be formatted hierarchically or incremental-
ly, or have any meaning; that is up to you. 
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 Searching on description level 

Only in the Archives (catalogue) dataset, you can search on descrip-
tion level. In the access points menu (the second step in the Search 
wizard), you must choose the Level access point, after which you 
select one of the description levels specified in your application, from 
a drop-down list in step 3. Then the search result will only contain 

records of that description level. 
If you wish to continue searching within this level, you may combine 
the current search result with a new search. Or use the Advanced 
search to execute a combined search statement at once.  

To be able to search the catalogue, for instance on title, creator or 
reference, regardless of the description level of a unit, you simply 
choose this dataset in the first step of the Search wizard, and in step 2 

select the desired access point. This way you can find records of all 
description levels, in which the concerning title, creator or reference 
occurs. 

 Quickly finding level information in an opened record 

In every record in Archives (catalogue), the current description level is 
noted at the top of each detail screen, with the reference and the title 
of the present unit – except on the Identity statement (ISAD) tab. 

 

Figure 23.7: At the top of each tab, you’ll find the title, reference and level of 
this record. 

And with the links of the parent and child units of description, the 
associated level is also shown. 

 

Figure 23.8: The level of the linked record is noted too. 
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 Showing and/or editing the hierarchy of the entire archive 

The Adlib Hierarchy browser, which can be opened by e.g. the Hierar-
chy browser button in the View menu in the detailed display of a 
record, shows the structure of the entire archive.  

 

Click a plus or minus sign in front of a title, to fold the relevant level in 
or out. Or double-click a title to open that record in detailed display. 

To the left of the title, the reference and level of each unit of descrip-
tion are stated as well. 

 

Figure 23.9: The complete hierarchy of the archive, in the Hierarchy browser. 

If somewhere in this overview you see a unit of description which 

should be moved in the hierarchy, for example a file which fits better 

in another series, then you can do this here in the Hierarchy browser. 
Click the unit which you want to move, hold the mouse button pressed 
down, drag the unit to the desired parent unit of description under-
neath which it must be placed, and release the mouse button. A dialog 
will ask you for confirmation, before the change is actually processed. 
The internally linked fields Part of and Parts in all relevant records are 

automatically adjusted for you, so you don’t have to do this yourself. 
But the description level of a moved record will never be adjusted 



Appendix 3: Adlib Archive features Adlib User Guide 

 400  

automatically! So if you have moved a unit to a different level of 

description, you’ll have to set the new level of that record manually, 

by explicitly editing it.   
Further, the right-click pop-up menu allows you to add one or more 
new records semi-automatically to the hierarchy (see chapter 13.5 for 
more information about the available functionality here). 

23.2.3. Using retention schedules 

Model applications 4.4 or higher containing the Archive module, offer 
the possibility to create retention schedules for archival items and link 
to any of them from within each record in the Archives (catalogue) 
data source. On creation (or edit at a later time) of the Adlib record 
for the archival item, linking a retention schedule to the item allows 

you to set a fixed period of retention and decide in advance what must 
be done with the item after that period has passed, at the so-called 
Action date: in Adlib, the default options are destroy, transfer or 
review.  

 The Retention data source 

Retention schedules must be defined in the Retention data source, at 
the bottom of the data sources list in Step 1 of the Search wizard. You 
may create as many schedules as you want.  

 

Enter a unique name for each schedule and possibly a description, 

provide a material type (this field is validated to the Thesaurus), 

select an Action, enter a Period in whole years and finalize the record 
by entering the name of the person who authorised the schedule: in 
general, start with the surname and possible suffixes, followed by a 
comma, then followed by the initials or first name and middle name, 
like Vriezeveen, P.K. (this field is validated to the Persons and institu-

tions data source). 

One important thing to remember about the schedules you create 
here is that once you’ve linked an Archives (catalogue) record to a 
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schedule, you should never again edit this schedule record. This is 

because there’s no automatic procedure in place to process any 

changes made here, like a change in period, into the relevant Archives 
(catalogue) records. Instead, whenever you wish to apply a different 
retention period to certain Archives (catalogue) records which are 
already linking to some retention schedule record, you should create a 
new retention schedule record in the Retention data source (or use an 
appropriate existing schedule record) and then perform a search-and-

replace in selected records in your Archives (catalogue) data source, 
to replace the old retention reference by the new one. This then will 
automatically calculate new action dates if required. 

 The Archives (catalogue) data source 

From any Archives (catalogue) record you can link to an earlier creat-

ed retention schedule in the Retention reference field on the Retention 
schedule screen tab. Relevant details from the schedule will be re-
trieved automatically and displayed in the appropriate fields below. 
These are read-only fields because you shouldn’t change the details of 
a retention schedule once it’s been linked to an Archives (catalogue) 
record. (You can always link a record to a different schedule, but don’t 

change the details of an existing schedule once linked.) 
Using the merged-in data from the retention schedule, a new (Action) 
Date will be calculated, if possible: a requirement is that the Date 
(late) value on the Identity statement (ISAD) tab of the Archives 
(catalogue) record contains a valid date. The action date will be calcu-

lated by adding the period from the schedule to the date from the 
Date (late) field. 

Anytime you link to a different retention schedule, here in the Reten-
tion reference field and leave this field, an after-field procedure is 
carried out to calculate the new action date. This after-field procedure 
is also carried out after leaving the Date (early) or Date (late) fields 
on the Identity statement (ISAD) screen and also after writing a  
production period end date from the thesaurus to Date (late). After 
leaving the Retention reference field (tag rn) in the Archives (cata-

logue) record, the calculation is only executed if the contents of the rn 

tag have changed while this record was in edit mode. In cases where 
no new action date can be calculated, while an action date is present 

in the record, the user is asked whether it should be emptied or not: it 
won't be written to the history though.  

If the current retention reference details must be copied to the history 
on the Retention schedule history tab, the user must click the check-
box for this functionality at the bottom of the Retention schedule 
screen tab, before making changes to the other fields.  
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In one other situation, the recalculation of the action date only takes 
place just before storage, but only if the after-field part hasn't taken 

care of the recalculation: this occurs when the Retention reference or 
Date (late) have been changed be means of a search-and-replace 
procedure. Any error messages or warnings during the recalculation of 
the action date cannot be accumulated in a single text file in this case, 
so each occurring message will then be displayed on screen during the 

search-and-replace. Further note that a search-and-replace which 
leads to the action date being recalculated, will also cause the current 
retention schedule details to be copied to the Retention schedule 
history screen. 

The other fields will usually only be filled in when the action date has 
passed and disposal or transferral are in effect.   

23.2.4. Remarks 

• The design choice to register all levels in one and the same da-
taset, currently still has the consequence in Adlib that the same 
detail screens are offered for all description levels, even when one 

or more of those screens aren’t relevant for the current level of 
description. (In the Help texts for the concerning screens this is 
noted.) For example, for description units of the fonds and series 
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levels, the screens Condition/conservation, Location (history), Ex-

hibitions and Loans are not of interest, since at this level no physi-

cal units are being described. 

• If, on registering a unit of description, the structure of (the rele-
vant part of) the archive is not yet clear, then at first specify no 
level. The same applies to links to parent and child units of de-
scription: just postpone their creation until you have an overview 
of the archive material. Although some hierarchical links can per-

fectly well be created before you have assigned a description level 
to the relevant records, for instance because you are certain that 
there exists no in-between level. 
But remember to assign a level to every catalogue record eventu-
ally, and to complete the hierarchical links. 

• In Adlib Archive itself, you’ll find data entry instructions for each 
field, in the online Help. Open this Help with F1. In a record in edit 

mode you’ll then be presented with information about the field 

which currently contains the cursor. In a record in display mode 
you’ll see the same information as soon as you move the mouse 
pointer over a field (now you don’t need to click the field). 
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24. Appendix 4: buttons and shortcuts 

Button Description Keys 

   

 Navigating and browsing  

 

Return to the beginning of the application to 
choose another data source. 

F8 

 

Step back to an earlier screen. F7 

 

Go to the first record in the list.  

 

Go to the previous record in the list. F6 

 

End entry/editing and save the record.  

 

Start entry of data (editing). F11 

 

Go to the next record in the list. F5 

 

Go to the last record in the list.  

 

Open the Advanced search for complex 
searches. 

Ctrl+F 

 

Open the Pointer files window to retrieve 
saved search results. 

 

 

Make settings for sorting the order of the 
retrieved records. 

 

 

Click the Hierarchy browser button in the 
detail presentation of records from hierarchi-
cally built databases like an archive database, 
the Thesaurus, or Persons and institutions, to 
display the tree structure of all records that 
are linked internally to the currently displayed 
record through broader and narrower terms. 
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Button Description Keys 

   

 Entry, deletion and editing  

 

Add a new record. Ctrl+N 

 

Copy the current record. Shift+F5 

 

Delete selected records. Delete 

 

Start editing or, if already in edit mode,  

stop editing and save. 

F11 

 

Stop entry/editing and save.  

 

Add occurrence (above selected occurrence).  

 

Add occurrence (below selected occurrence). Ctrl+Enter 

 

Empty this field.  

 

Delete the selected occurrence. Ctrl+L 

 

Add occurrence at bottom of list.  

 

Link to a document outside Adlib.  

 

Link to an image.  

 

Create a new image via a scanner or camera, 
and directly link it to the current record. (This 
functionality is called Windows Image Acquisi-
tion.) 

 

 

Open the Find data for the field... window to 

view the linked database for the current field.  

Shift+F4 
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Button Description Keys 

 

Edit data in the linked record. F10 

 

Search-and-replace text in marked records.  

 

This button is active if the cursor is in a (SQL) 

multilingual field, and makes it possible to edit 
all translations of the field value in one dialog 
window. 

Ctrl+M 

   

 Marking and printing  

 

Mark the current record. F3 

 

Invert the check marks. F4 

 

Limit the list to all marked records.  

 

Remove all marks.  

 

Printing with an interactively created output 

format. 

 

 

Printing with an existing Word template.  

 

Printing with an existing output format.  

 

Save the selection of marked records as a 

pointer file. 

 

 

Add the marked records to a pointer file of 

your choice. 

 

 

Remove the marked records from a pointer 

file of your choice. 
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Button Description Keys 

 Media Viewer (Media menu)  

 

Print.  

 

Zoom in. Ctrl+= 

Ctrl++ 

 

Zoom out. Ctrl+- 

 

Display image in original size. Ctrl+0 

 

First image.  

 

Previous image.  

 

Next image.  

 

Last image.  

 

Remove the current occurrence.  

 

Display the Media Viewer on each screen.  

 

With this button you can save a displayed 
image in a folder of your choice and in a 
different image format if desired. This function 
is particularly useful if your linked images are 
located in an SQL or Oracle database, and you 
wish to use one or more of those images for 

other purposes and need to copy them to your 

hard drive. 

 

 

Start playing the music or movie file.  

 

Pause playing the music or movie file.  
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Button Description Keys 

 

Mark the start point of a media fragment.  

 

Mark the end point of a media fragment.  

 

Temporarily rotate the image clockwise a 

quarter of a turn. 

 

 

Temporarily rotate the image counterclock-

wise a quarter of a turn. 

 

 

Remove the link to this image from the cur-

rent record. 

 

   

 Search by form (Search form  menu)  

 

Step back one level. F7 

 

Start the search.  

 

Empty all fields on the search form.  

 

Remove selected occurrence.  

 

Add occurrence (below selected  
occurrence). 

Ctrl+Enter 

 

Empty the current field.  

 

Open the list of pointer files for this database.  

 

Open the Find data for the field... window. Shift+F4 
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Button Description Keys 

 

 Combined searches  

 

AND  

 

OR  

 

NOT  

   

 Online Help  

 
Open context-sensitive help text. F1 

   

 Function keys and key combinations 

A number of functions in Adlib can be started from the keyboard, 
through a function key or key combination. Especially if you often use 
a certain function, such a key combination can ease your work. With 
key combinations you have to press two or three keys ‘simultaneous-

ly’: keep the firstly indicated key pressed, and then press the second 
key (and possibly the third). Such a key combination is indicated by a 
plus character (or hyphen) between the relevant keys, for instance: 
Ctrl+C. 

 
Key combination 

 
Function 
 

Ctrl+A selects all text in the field that has the cursor. 

Ctrl+C copies selected text to the Windows clipboard. 

Ctrl+D copies the active field and its content to the 

Adlib clipboard.  
 

Ctrl+F opens the Advanced search window. 

Ctrl+H opens the Search and replace window, for 
marked records in a search result. 
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Ctrl+J pastes all cut or copied fields and their content 

in the same fields (in another opened record), 
regardless of in which field the cursor is. 
 

Ctrl+K pastes the cut or copied field and its content in 
the same field (in another opened record), if 

the cursor is in that field. 
 

Ctrl+M opens a dialog window to edit all translations of 
the value of an (active) multilingual field at the 
same time. 
 

Ctrl+N opens a new record. 

Ctrl+P opens the Print wizard for the currently dis-
played record, or for the marked records in the 
search result list. 
 

Ctrl+R opens an overview with record information, 

handy for application management. It’ll show 
you the contents of all fields in the record that 
have been filled in, and per field the field name 
in the current interface language, the tag, the 
occurrence number and any data language 
between square brackets. The tooltip which 
appears when you hover the mouse pointer 

over a row in the window, is meant for debug-
ging purposes as well. It concerns information 
about whether the indicated field has currently 
(in edit mode) been edited or not, whether a 
linked record has already been created for new 
values in linked fields, whether a linked value 
has been “resolved” or not, whether it concerns 

a temporary field which should not be stored 
and whether the value in the field has been 
locked or not. 
You can resize the window by dragging its 
borders. The width of each column can be 

changed by moving the mouse pointer to the 

right edge of the label of a column until the 
mouse pointer changes into a black double 
arrow, after which you click and hold the mouse 
button down while you drag the label’s edge. 
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Ctrl+Alt+S opens an overview with information about the 

screen design of the active tab, handy for 
application management. 
 

Ctrl+S closes the current record and saves it if desired. 

Ctrl+V pastes copied or cut text in the active field. 

Ctrl+X cuts selected text to the Windows clipboard. 

Ctrl+Y cuts the active field and its content to the Adlib 
clipboard. 
 

Ctrl+F5 jumps to the last record in the search result list. 

Ctrl+F6 jumps to the first record in the search result 
list. 

 
Ctrl+F7 opens the spelling checker for the current tab if 

the record is in edit mode. 
 

Ctrl+Enter adds an occurrence (field repetition) under-

neath the active field, if the field is repeatable. 
 

Ctrl+Tab displays the next tab. 
 

Ctrl+Shift+Tab displays the previous tab. 

Ctrl+Home moves the cursor to the beginning of the active 

field. 
 

Home moves the cursor to the beginning of the cur-
rent line. 
 

Ctrl+End moves the cursor to the end of the active field. 

End moves the cursor to the end of the current line. 

Tab moves the cursor to the next field, if the record 
is in edit mode. 

 
Shift+Tab moves the cursor to the previous field, if the 

record is in edit mode. 
 

Shift+Enter 

or Enter 
starts a new paragraph in the active text field of 

a record in edit mode. 
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Shift+F3 removes all non-marked records from the 

search result list. 
 

Shift+F4 opens the Find data for the field... window to be 
able to compare the content of the active field 
with a terms list (if the active field is a linked 

field). 
 

Shift+F5 copies the current record. 

F1 displays (or hides) a Help text about the active 
field, about the current screen or about the 
functionality you can use. 

 
F2 starts the search which you just entered in a 

search form. 
 

F3 marks the current or selected record. 

F4 inverts check marks. 
 

F5 displays the next record from the search result 
list, if a record is in detail display mode. 
F5 just selects the next record if you are in the 

list display (also on the Thumbnails and Film-
strip screen tabs). 

 
F6 displays the previous record from the search 

result list, if a record is in detail display mode. 
F6 just selects the previous record if you are in 

the list display (also on the Thumbnails and 
Filmstrip screen tabs). 
 

F7 shows the previous step during searching and 
display of records. 

 
F8 opens the first step of the Search wizard, so 

that you can choose another database or da-

taset to work with. 
 

F9 opens or closes the Hierarchy browser. 

F10 opens the linked record in edit mode, from 

within the filled-in active field, if that is a linked 
field, or it opens a new linked record in edit 
mode if the linked field is empty. 
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F11 opens the current record in edit mode, if it is in 

display mode now, or it closes the current 
record (and saves it if desired), if it is already in 
edit mode. 
 

Alt+Enter opens the Field properties window for the 

current field. 
 

Alt+P  opens the Pointer files window from within the 
Advanced search. 
 

Alt+<letter in 

menu> 
opens a menu option, e.g. Alt+F, to open the 

File menu. Choose another letter of the desired 

function in the opened menu. 
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25. Appendix 5: change text/button size 

The font type used on detail and list screens can be set to your liking 
from within the Adlib user interface. In the View menu, click the 
Change font button to open the Font window. 

 

You can set the font type, style and size to lay out field and screen 
labels and data on said screens (and only there) as desired. The 
default font is Segoe UI, Regular, 9 points. 
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Windows itself has options to improve the readability of all texts on 

the screen as well (not just those of Adlib) by enlarging the size of 

fonts and icons. You can set this up via the Windows 8 Control panel 
(Appearance and Personalization > Display). 
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26. Appendix 6: device properties 

In Adlib you’ll find the Device properties function in the File menu. In 
there, you can make settings for serial (barcode) scanner devices 
connected to your computer, and of which you want to import the 

output into Adlib. (USB scanners that emulate a keyboard need not be 
set up here, you can enter data with them immediately.)  
The function is active only if adperiph.dll has been installed and load-
ed. Adperiph.dll will be loaded by starting adlwin.exe (via your appli-
cation shortcut) with the –adperiph parameter. 

So choose File > Device properties to open the settings windows with 

the same name. There are four COM# tabs. This means that up to 
four scanning devices (connected to the serial ports of your computer) 

can be set up for use with Adlib. If you have connected only one 
device, to COM port 1, then only fill in the COM1 tab. 

1. In the Peripheral type drop-down list, select the specific type of 
the device which you have connected, or try the Generic scanner if 
your scanner is not listed.  

2. In Borrower ID regular expression you may provide a regular 
expression to which borrower numbers must comply. This is be-

cause with the scanner you can scan borrower numbers from li-
brary cards as well as copy numbers from e.g. books. But the 

scanner doesn’t differentiate between such numbers. So with the 
regular expression you specify the format of the borrower num-
ber; all borrower numbers which do not comply to this format, will 
be considered copy numbers by Adlib. (See the Designer Help for 
more information about regular expressions.) 

3. Click the Port settings button to set up the port for the specific 
device you connect to it. The documentation of the relevant device 
should provide information about the settings to make here (port 
settings must be set to the requirements of the device). 

To import a number to be scanned into Adlib, first put the desired 
record in edit mode, then place the cursor in the field into which the 

number must be entered. Now scan the barcode, and the derived 
number will automatically be entered into the active field. 

This functionality is expressed best in Adlib Circulation, when issuing, 
returning of reserving materials in a library. There you’ll find this 
option in the View menu. On the opened tab (Issues, Returns or 
Reservations) a scanned number will be entered automatically into the 
Borrower number or Copy number entry field. 

http://documentation.axiell.com/alm/en/index.html?ds_generaltopicsregularexpressions.html
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27. Appendix 7: registry settings 

Your preferences in Adlib, like the interface language in which you are 
working, which messages and screen tabs you wish to see and your 
favorite terms and such, are always saved in the Windows registry. By 

choosing different settings in Adlib, the stored preferences will 
automatically be changed as well.  

However, sometimes it can be handy to erase all those preferences, 
for instance to investigate whether the settings have been corrupted 
or to (also) erase the lists of favorite terms. To this end you can use 
the adlwin.exe –reset command-line option. (See the general 

installation guide for more information about command-line options.) 
A faster way than the command-line option though, is to hold the 

Ctrl key down while starting Adlib: press the Ctrl key and keep it 

pressed down, (double)-click your Adlib shortcut and only let go of the 
Ctrl key when the Adlib logo appears. The Ctrl option also works 

for Adloan Circulation. Subsequently, Adlib will ask you to confirm 
your choice. If you select Yes, the relevant Adlib registry settings will 
be erased. The Quick access toolbar will be present in its default 
composition again, hidden screens will be displayed and any disabled 
messages will be shown again as well. 

If you were to include the option in a shortcut, then all Adlib registry 
settings would be erased each time you start Adlib: that is not 

convenient when you yourself start and use Adlib every day via that 
shortcut, but it might be if different people use Adlib via the relevant 
shortcut without having to log in. 
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